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General  
 
Important notice: This Manual is written in the masculine gender, but is 
directed to both sexes equally. 
 
This following chapter generally discusses the capabilities of the program, 
starting with the distribution and organization of the data on your screen, 
the grouping of general activities and so forth. This chapter which serves 
as the opening chapter offers basic understanding in the preliminary 
operation of the software. 
 
The issues discussed in this chapter are: 
 

 Drawing environment - working with AutoCAD ® (Autodesk) or 
Bricscad ® (Bricscad). 

 Screen division. 
 Toolbars. 
 Working with projects. 
 Noname and Prototype projects (recovering of lost information). 
 Dealing with layers. 
 Differences between Pick, Locate, Select and Unused.  
 Initializing the system. 
 Saving the project for moving from one computer to another 

(Zip). 
 Using CivilCAD 2016 Help. 
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Drawing environment - working with AutoCAD® 
(Autodesk), Bricscad® (Bricscad) or ZWCAD 
 
CivilCAD 2016 can work with one of the two followings drawing 
environments: 

 AutoCAD (Autodesk) – all versions of AutoCAD starting from 
AutoCAD 14 to AutoCAD 20XX*. 

 Bricscad (Bricscad) – Bricscad (former Bricscad's IntelliCAD) version 5 
and up. 

 ZWCAD – ZWCAD14+ and above 
 
* AutoCAD 20XX – any version of AutoCAD from AutoCAD 14 to AutoCAD 

2017. 
 
CivilCAD 2016 uses one of the two drawing environments as their main 
drawing tool. The same package of CivilCAD 2016 can be configured to 
link to either AutoCAD or Bricscad. Each new version of CivilCAD 2016 
supports former versions of AutoCAD starting at AutoCAD 14 and up. 
Bricscad is a good DWG (AutoCAD's native file formats) environment for 
users that does not own AutoCAD. As a unique solution we deliver a 
complete package for roads design, surveying, mapping, underground 
infrastructures design, land development and more, working with DWG 
environment even when you do not have AuotCAD. 
Note: there are a number of options that are operational only for working 
with AutoCAD, later to be described.   
 
To choose your drawing environment working method, follow these steps: 

 Start CivilCAD 2016. 
 From the main menu choose : ‘File  Open Project’ 
 Choose the ‘Prototype’ Project  

 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Prototype.prj\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Protorype.prj\ 

 
 After the project has been opened, choose File  Configuration. A 

window will open.  
 Choose the first tab (“General settings”) from the top of the window.  
 Next to the caption “Auto launch”, choose the desired working method. 
 Choose ‘OK’. 
 Go to: File  Exit, and choose ‘Yes’ to save the changes.  

 
From this point on, your software will work as been configured.  
Note: All references to AutoCAD in this manual relates to Bricscad as well. 
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Screen Division 
 
When starting, CivilCAD 2016 window is divided into 2 parts: 

 The drawing window 
 The coordinates editing window. 

 
When choosing an option from the main menu, CivilCAD 2016 displays a 
third panel. 
 

 
The drawing window 
The drawing window, situated at the top side of your screen, is the main 
window that takes up most of the work area .This window displays the 
program drawing and the preset project. It is important to mention that this 
window is not designed for free-hand drawing (CivilCAD 2016 is not a 
substitute for a drawing program, but is a helpful tool for activities that 
cannot be performed using a standard drawing program). CivilCAD 2016 
shows data graphically using functions that allow the drawing scan, adding 
data and so on (there are many functions that are actually drawing 
functions, but they exist only within the standard functions, like adding 
points from the drawing, adding lines and so on (these functions will be 
discussed in the other chapters). When working with other CAD programs, 
this window will be replaced with the drawing window of the program that 
AutoCAD is working with. 
 

The coordinates editing window 
The coordinates editing window holds the list of points of the existing 
ground level (measurement coordinates) and /or the points of design 
ground level (measurements coordinates after measurement, design points 
and so on). This window can be hidden at any stage of work, to enable a 
bigger working area (by clicking the “X” button at the top right of the 
window).The many functions of this window will be detailed in chapter 2 –
“Coordinates Database”. 
 
Work tables 
Work table is the window at the right side of the screen. On this window will 
appear different screens that display the program’s capabilities like 
calculation and drawing of contour heights, 3D drawings, geometrical 
computation and more. 
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Toolbars 
CivilCAD 2016 toolbars, include 2 main toolbars: 

1. The standard toolbar. 
2. Stand-alone working mode toolbar. 

 
The standard toolbar 
The toolbar is located below the program’s main menu and above the 
drawing environment. It can be moved to any position and can be locked in 
different areas of the screen (can’t be locked inside the drawing 
environment application). Every action on the toolbar can be executed also 
from the main menu. The toolbar enables these actions: 
 

  New – Open a new project. 
 

 Open – Open an existing project. 
 

 Rotate Points – Rotate points by single line or by line at layer. 

 To rotate points by single line, click on ‘Rotate Points’ button and select 
‘Rotate by single line’ option. In Command line type ‘S’ + Enter to select 
specific points for rotation or ‘A’ + Enter to rotate all points and click 
Enter. 

 In command line, type the desired angle for rotation and click Enter. 

 Click on ‘Refresh button’. Points on drawing will be rotated according to 
the line and angle definition. 

 

 To rotate points by line at layer, click on ‘Rotate Points’ button and select 
‘Rotate by line at layer’ option. ‘Rotate points’ blocks’ window will open: 

 

 
 

 Select the desired layer and angle from the list. 

 To select a layer from drawing, click on ‘Select’ button, select the layer 
from the drawing and click Enter. The selected layer will be marked in 
layers list. 

 Click OK to save definitions. 
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 Click on ‘Refresh button’. Points on drawing will be rotated according to 
the layer and angle definition. 

 

 Pick height – Sampling ground level. After pressing this button, select 
desired point on the drawing and left click on the mouse, the program 
will display the ground levels at the screen’s bottom next to: “Height_D” 
and “Height_T” (D for design and T for Topography). 

 

 Layers control – Opens the layers control window. 
 

 Add To Zip – Pressing this button will 'Volume size Auto detect' – Add 
the entire project files into one zip file. 
 

 Extract From Zip – Pressing this button will Extract from zip – Opens 
a CivilCAD project directly from a zip file. 

 

  Configuration – Displays the project’s main configurations window. 
 

 Extract – Quick extract operation. 
 

 Tutorials – Viewing flash tutorials movies for learning CivilCAD 2016. 
 

 Help – Displays the help window (will be displayed at the language 
according to the language settings at the main configuration window). 

 

 Refresh - Refreshing the drawings layers (Coordinates layers will 
be updated according to the last changes in the coordinate’s lists). 
 

 Refresh All - Refreshing the coordinates, lines and plans layers. 
 
 
Stand alone toolbar 
The toolbar is located below the program’s main menu and above the 
drawing environment. It can be moved to any position and can be locked in 
different areas of the screen (can’t be locked inside the drawing 
environment application). Every action on the toolbar can be executed also 
from the main menu. The toolbar enables these actions: 
 

 Window – Press this button and move to drawing area, left click the 
mouse to define the first corner and left click again to define the window’s 
second corner. The drawing area will be set according to the window 
boundaries you have selected. The program will make sure that the 
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drawing will not be deformed. That is why the entire drawing area 
presented will be “almost” identical to the selected area, but its width/length 
will match each other as to avoid deformation. 

 

 Zoom extends - Clicking this button will transfer the drawing window 
to view the entire drawing. This command is very useful in situations where 
you do not know at which location of the drawing you are at.   
Note: there may be cases where this command will not respond. Such 
cases will occur when the drawing borders are too large for the display. For 
example: if you have placed a point where its coordinate has deviated from 
the drawing area by a great deal (like typing a local coordinate in the world 
coordinate system), when activating this option the program will try to 
centralize the entire drawing area, in case it does not succeed, no 
comment will be given. 
 

 Zoom dynamic – choosing a drawing display using a dynamic 
window  
After pressing this button, the entire drawing will automatically. Go to the 
drawing area and move with the window to the area you wish to enlarge. 
Use the left mouse button to dynamically reduce and enlarge the window. 
After you finish, click the right mouse button to finalize this command. The 
drawing area will be set according to the window boundaries you selected.     
 

 Zoom focus – enlarging a specific area 
After pressing this button, with your mouse to the drawing area, move the 
cursor to the location you wish to enlarge and click on the mouse button. 
The new center of the drawing display will be the point which you have 
previously marked. The area surrounding the center point will be three 
times larger (multiplied by 3).  
 

 Pan – scanning the drawing. 
Press this button and go to the drawing area. Bring the cursor to a 
particular point and click your mouse. Drag your mouse to a different area 
in the drawing (a line that marks the direction of the scanning will appear), 
and click again. The drawing area will move according to the marks you 
had made – first click – from where, and second click where to.  
 

 Reducing the Drawing Area by 2 
Clicking this button will reduce the drawing area by half, bringing the center 
in the current drawing 2 times closer. 

 

 Enlarging the Drawing Area by 2 
Clicking this button will enlarge the drawing area times 2, pushing the 
center in the current drawing 2 times back.  
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Working with projects 
 

Every new job you start, whether for extensive topography mapping 
purposes, or for the purpose of basic geometric computations, will be 
organized under a certain project. The first thing that needs to be done in 
the program in order to start working (unless you open an existing project) 
is to open a new project (see details on project ‘Noname’). 
 
To open a project, go to: ‘File -> New Project’ 
A “File dialog box” will open (in this case it will have the title: New project). 
 
To open an existing project, go to: ‘FileOpen Project’ or double click on 
the *.prj icon. 

 
Working with the file dialog box 

 
Under the title (New project) appears the writing: Look in/ with a frame next 
to it. This frame shows in which library/directory you are looking at. If, for 
example, CivilCAD 2016 is written in the frame, you will know that you are 
now in the CivilCAD 2016 library (that is located in C:\Program Files 
directory). By clicking the small button with the arrow, you can get the 
mapping of your computer with all the libraries. This way you can browse in 
a different library to decide where you want to open the new project 
(instead of directory CivilCAD 2016). 

 
There are two additional function buttons in this window (left of the writing): 
 

  Click this button to go one level up. For example you would use this 
button, if you are currently in one library and would like to view the library 
which your library is in. 
 

   Click this button to create a new library. Right after clicking, you will 
be asked to name your library. Enter the name and click ‘Enter’ when you 
finish. 
 
From the bottom of the dialog box you can see the “file type” line. This line 
is a “filter” for the type of files that will be presented in the window. In our 
example appears the filter: Project files (*.prj). This implies that the box will 
present only *prj. file types (the sub-library will always be presented, with 
no connection to the filter). There might be cases in which the filter has 
numerous options. To browse between filter options, click on the small 
arrow button left of the filter and choose the filter type you want (in our 
example there are only Prj file type filters). 
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Recommended work procedure 

 
As aforesaid, to open a new project, you must go to ‘File -> New project’, 
type the name of the desired project in the ‘File name’ line, and click on the 
‘Enter’ button from your key-board, or the ‘open’ button. The new project 
will open in the name of the library that appears in the title, which is the 
project library. For each project, the program will open a large number of 
files with the same name as the project, but with a different ending. This 
state, of opening many files, might sometimes cause inconvenience at 
work. It is recommended, therefore to open a sub library for each project. 
To do so all you need to do is use the 'Create a new library' button, name 
the library, enter the library you made (double click on the library drawing 
that appears in the window), type the desired library name in the “File 
name”. The project will open in the library that was created and all the 
project files will be created in it.   

 

 
Projects Noname and Prototype (recovering of 
lost information) 
 
CivilCAD 2016 has two unique permanent projects that are installed in the 
main library of the program (usually it will be in the \CivilCAD 2016 library 
unless determined otherwise during the installation). 
 
Prototype project 
 
Prototype project, as it is named, serves as a prototype for all the projects 
that are opened by the program. As a rule, the Prototype will not affect the 
previous projects that already exist in the system, and any change to it will 
come to terms only in the new projects.   
 
In project ‘Prototype’ it is possible to set permanent definitions that will be 
used during the entire work procedure. Examples of such definitions are 
changing the company title in the printed reports, determining the work 
scale etc.  
 
To change a definition you must perform the following steps: 

 Open a new ‘Prototype’ project. 
 Change the requested definition. 
 Leave the project while saving the changes.  

 
From this stage on, the changes will be saved, and each new project that 
is opened will automatically “inherit” these characteristics.  
 
No-name project and the recovering of destroyed information 
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No-name project is the first project that comes up with the program once it 
is activated. This project is not meant for use, and you must open a new 
project in order to start working. Project ‘No-name’ can be used regularly 
with the program, but will be deleted immediately when the program is 
closed or when you go to a new project. Nonetheless, if you had started 
working on project ‘No-name’ you can go to ‘Save as’ and save the work 
you had done under a new name.  

 
Project ‘No-name’ has an important role in restoring information. There 
might be cases were an illegal exit was made from the program, without 
the saving of data (voltage drop, problems in starting Windows, etc.). 
CivilCAD 2016 creates during the time it is activated, backups for 
transactions that were made, and saves them in hidden files. In case an 
illegal exit was made from the program (such as ‘File -> Exit’), CivilCAD 
will recognize this, and when re-activated (first time after the program had 
crashed), will try to restore the last project it had worked on. The 
restoration made (whether part or full), will be copied automatically into 
project ‘No-name’ and presented at the end of the restoration process. At 
this stage you must immediately save the project under a new name using 
‘File -> Save as’.  

 
Note: CivilCAD 2016 might have restored data, but the data does not 
appear in the drawing. In this case you can “force” the program to refresh 
the drawing in the following manner: 

 
 Bring the cursor to the points editing line. 
 Click ‘Enter’. 

 Click on the 'Refresh' button  from the main Toolbar above the 
drawing. 

 Activate ‘Zoom Extents’. 

 

Dealing with layers 
 
In CivilCAD 2016, drawings are divided by layers. The “perception” of 
layers is common with many CAD tools that divide the drawing by layers, 
giving each part of the drawing a different layer, making it easy to control 
the display and color of a particular layer. 

 
For example: if you wish to create a design on existing contour lines, you 
might, for the sake of convenience, move the contour lines to serve as a 
working background by painting them a brighter color. CivilCAD 2016 
creates fixed layers. This means that during the activation of the program, 
specific layers will be created according to the type of activity performed 
(this fact has a number of exceptions like the code layers for which specific 
names can be determined).  

 
Layers control window activity 
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 Use the ‘Layers control’ window to control the layers display. To 
activate this screen, click on the ‘layers’ button from the main toolbar 
above the drawing area. The layers window will open from the right. This 
window shows the list of all existing layers in the specific project. 

 
At the bottom area of this window are located all the possible layer 
options*: freezing a layer, changing the color of a layer, erasing a layer, 
creating a new layer, and creating a DXF file of the layer/ specific layers. 

 
*Note: When working in an AutoCAD environment, the only option that will 
appear is erasing a layer. All other options of freezing layers and changing 
colors will be done by the AutoCAD ‘Layer control’ (CivilCAD 2016 will 
create the new layers simultaneously both in its ‘Layer control’ and in the 
AutoCAD ‘Layer control’. The layers will be identical except for a slight 
change of their names, for example: Topography contours 0 in CivilCAD 
2016 and Tcontours0 in AutoCAD). 
In order to define styles to DWT layers in Layers Control: 

From CivilCAD main toolbar, click on ‘Layers Control’ button . ‘Layers 
Control’ window will open. 

On the right side of the screen, click on ‘Layers Settings’ button . 
Define a style for each DWT layer, by choosing it from the styles list. 

Click on  button to save the styles definitions. 

Click on  button to load the styles definitions in a new project. 
 
 

 

Freezing a layer 
 
It is possible to make an entire layer disappear from the drawing. This layer 
will not be erased, but temporarily hidden. To freeze a layer(s) mark them 
from the ‘Layers list’. You can mark one layer or a number of layers 
together*. After marking the desired layers, check ‘v’ next to the word 
‘Freeze’. You will notice the immediate disappearance of the proposed 
layers.  
Marking numerous layers together can be done in one of the following 
ways: 
Dragging the cursor while pressing the mouse button onto the desired 
layers. 
Marking the first layer in the group. To mark click with your mouse on the 
last layer in the group, Hold the ‘Shift’ button from your key-board click and 
mark the last desired layer. 
Mark a layer, hold the ‘Ctrl’ button from your key-board and mark the 
remaining layers.                                                                          
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Changing the layer color 
 
Changing the color of a layer/s is done by clicking on the colored square 
right of the word ‘Color’. This will open the color selection window. Mark 
the desired color and click ‘OK’ to confirm. The color of the layer/s will 
change accordingly.    
 

 

Erasing a layer 
 
Mark the layers you wish to delete and click on the ‘Erase’ button. You will 
get a message confirming the erasing of the layers. After confirming the 
layers will be erased from the drawing. Please notice that you cannot 
‘undo’ this command. The restoration of a deleted layer will be done by 
repeating the desired command in the program (for example: if you deleted 
the points layer and you would like to present them again, you will have to 

make a certain change in the points list and click the 'Refresh' button . 
The change does not have to be significant - it is enough that for example 
you insert an extra space in one of the lines, or even click ‘Enter’ when 
you’re working on a particular line – it is enough to make the change that 

when clicking  will restore these layers). 
 

 

Creating a DXF layer file 

 
Exporting a DXF file of the drawing can be done in two ways: 
Exporting the entire drawing using the main ‘DXF’ button from the drawing 
window/ and/or using the DXF button from the layers window. To create a 
DXF file of a specific layer/s, first mark these layers and click the ‘DXF’ 
button. A file dialog box will appear and you will be asked to enter the 
required DXF file name. Type in the name and click ‘Enter’. The program 
will create a ‘DXF’ file that includes only the marked layers. 

 
In the right bottom side of your screen appears the ‘View’ window. This 
window is the control center command of the drawing display. These are 
its available options: 
 
* Note: When working with AutoCAD most of the commands in this window 
overlap the – ‘Zoom’, ‘Pan’, etc. commands in AutoCAD.  
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Difference between Pick, Locate, Select and 

Unused 
 
In many program screens appears a box that includes these four options: 
‘Pick’, ‘Locate’, ‘Select’, and ‘Unused’ (the box can include all four options 
or a combine parts of them. The option ‘Select’ appears only in the 
AutoCAD version). 
 
This box has similar usage in all screens: at each time it relates to the 
screen which he is in. When the screen that includes this box opens, its 
primary value will always be ‘Unused’. This value signifies that this option 
is useless and lacks influence at this point.  

 
 
The three additional values are: 
Pick – Choosing a point “freely”, which means that wherever you position 
your cursor, is where the point is chosen. 
We will demonstrate the use of this command on the ‘Topography -> 
planes: 

 Go to ‘Topography -> planes. A window will open from the right that 
includes this box.  

 Mark the work ‘pick’ and go to the drawing area. 
 Click with your mouse on a certain area in the drawing and – you will 

notice that the coordinate for the selected point was added to the 
bottom coordinates list and also a point was added to list of points that 
define the area from the right.  

 
Note: Clicking on the right mouse button will immediately cancel all present 
activity and return to boxes position to ‘Unused’.  

 
Locate – Joining (locating) a point that is already in the bottom coordinates 
supply. When you are using ‘Locate’, the *mouse cursor changes to a 
square. In order to join a certain point, bring this point into the square (it 
does not matter where as long as it is in the square) and click your mouse. 
The point will be “located” according to the desired command. Please 
notice that the reference in ‘Locate’ is always to the specific point itself, so 
there cannot be a  situation where ‘Locate’ will be joined, for example, with 
the text lettering. 

 
* In AutoCAD version an ‘ObjectSnap’ to point will come instead of the 
square. 

 
Tip: A common mistake is to try and trap points by crossing points between 
the topography coordinate list and the designed coordinate list. For 
example, there is a project with points in the topography coordinates list 
and more points in the designed coordinates list and you see both lists in 
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the drawing. Say you have activated the ‘Topography planes’ command. 
This command relates only to the existing status, as the ‘Locate’ command 
for this activity will locate only points from the ‘Topography coordinates’ list. 
If you try to join a point appearing in ‘Designed coordinates’, using this 
command even if you stick to the cursor rules, this point will not be 
trapped. 

 
Select – Choosing an existing line from the drawing (possible only in 
AutoCAD version). Assuming you have drawn a certain point that is 
supposed to serve as a breakline, a line for defining contour line borders or 
any other usage, and you would like to choose it to serve the purpose for 
which it was designed. In this case, you must choose the ‘Select’ option, 
go to the drawing area, choose the desired line and click ‘Enter’.  Now you 
can use the chosen line for its designed purpose. 

 

Initializing the system  
CivilCAD 2016 makes it possible to determine the definitions for the work 
form in each new project that you begin. To determine or change 
permanent definitions, open the designated project: ‘Prototype’. 
 

In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Prototype.prj\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Protorype.prj\ 

 
Change the definitions and save the project.  
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Defining the Work Language 
 
CivilCAD 2016 makes it possible to work both in Hebrew and English. The 
project language will determine the language in which the different 
program reports will be presented, as well as the sections drawings. To 
determine the work language, follow these steps: 

 Go to ‘File-> Open project’  
 Choose ‘Prototype.prj’ project and click ‘OK’.  
 Go ‘File -> Configuration’ 
 Change the language to the desired language from ‘Language’ 
 Click ‘OK’ 
 Leave the program by : ‘File -> Exit’ 
 Confirm the changes you have made. 

Defining the auto save 
 
CivilCAD 2016 can save your project automatically. In order to define the 
auto save, follow these steps: 

 Go to ‘File-> Open project’  
 Choose ‘Prototype.prj’ project and click ‘OK’.  
 Go to ‘File Configuration’ 
 In 'General' tab, check mark the Auto Save cell and define the 

cyclicality (in minutes). 
 Click ‘OK’ 
 Leave the program by : ‘FileExit’ 
 Confirm the changes you have made. 

 

 
Defining the Company Title for Printed Reports 

 
CivilCAD 2016 makes it possible to print out many reports including 
coordinates lists, distomat data calculations, Earthworks calculations, axis 
data calculations etc. It is possible to determine a title for the program that 
will serve these reports when they are printed.  

 
Go to ‘General Caption’ from the main tool bar to open the title setting 
window. From this window you can define the title (like company name), 
details of the report producer, and add any free wording you want to 
appear on the report. To finish click ‘OK’. From now on the data you 
entered will appear in each report printed in the current project (and only in 
it),.  

 
You will probably also be interested in entering a fixed title that will serve 
all the projects you are working on (so it will not be necessary to enter it for 
each project separately). To do so follow these steps:  
 

 Go to ‘FileOpen project’  
 Choose ‘Prototype.prj’ project and click ‘OK’.  
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 Go to ‘GeneralCaption’ 
 Change the company title to the desired title. 
 Click ‘OK’ 
 Leave the program by : ‘FileExit’ 
 Confirm the changes you have made. 

 
From now on, each new project will automatically “inherit” the title inserted 
(you can change this title at any time in a specific project in the same way 
mentioned above).  
 
 
Choosing a CAD Software for the Graphic Environment 

 
CivilCAD 2016 can work as stand-alone or with other Tibam softwares as:  
AutoCAD 14-2017 and IntelliCAD2000. In order to choose the program that 
will serve as graphic environment of your work in CivilCAD 2016, follow the 
steps below: 
 

 Activate: ‘FileOpen Project 
 Choose project ‘Prototype.prj’, and click ‘O.K’ 
 Activate: ‘FileConfiguration 
 Choose from ‘Auto launch’ the desired program 
 Click ‘O.K’ 
 Exit the program: ‘FileExit’ 
 Confirm the changes you have made 

 
From now on each time you activate CivilCAD 2016, the program will be 
activated in the graphics environment of your choice.  
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Defining Roads Work Modes 

 
First we will follow these steps to go to Roads setting mode: 

 Activate ‘File  Open project 
 Choose project ‘Prototype.prj’, and click ‘O.K’. 
 Open: ‘Roads  Cross sections’  

 
Defining the Station and Numbering of Cross Sections 

Click on  button from the right window (Define sections). 
The cross sections definition window will open.  

 Start at station – the station of the first section. The default is ‘0’. At 
most times, we will want the station for the first section in the designed 
segment of the center line, to be ‘0’.  

 End at station – the station for the last section. The default is 
according to the length of the center line as it was computed by the 
program (this length appears immediately when the cross section 
window opens – ‘Roads length’). 

 Distance between sections – the distance between the cross 
sections. The default is 20 meters.  

 Name of first section – the name of the first section (number). The 
program will number the remaining sections in an ascending order.  

 By stations/By Ips – this box proposes a choice between defining a 
road/center line, with its cross sections arranged in ascending order, 
and the definition of a center line with predetermined sections by the 
IPs of the horizontal alignment. Moving to ‘By Ips’ status, will remove 
the other fields from your screen.  

 Presentation of section names: 
 Format 1: the names of the sections presented before they are entered 

in the section’s table. 
 Format 2: the names of the sections presented by permanent initial 

distance + station for example: 0+20. 

 
Definition and Presentation of Section’s Width 

 

 Activate  button from the right window to open the ‘Define sections 
width’ window. 

 Define the width of section for the project. We are referring to the width 
of the ground that the program will sample for the existing status out of 
the topography. We will define a station from the center line to the left 
and a station from the center line to the right - that when combined will 
define the width of the ground strip. The left end of the section we will 
defined in the ‘Left’ field (default of – 20 meters), and its right end in the 
‘Right’ field (default – 20 meters). 

 Transfer from Elevation to dH. Using CivilCAD 2016 you can define 
cross sections of absolute heights, or sections of relative heights.  
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 Move from Earthworks to Design. This option defines the graphic 
presentation form of the section. The program has two options for 
defining the section: a section for presenting Earthworks, and a section 
for presenting designed sections. The difference in presentation will be 
shown both by the sections’ form in the drawing window, by printing via 
the program, and by creating sections file on an AutoCAD sheet. We 
will discuss the main differences between the two forms in Chapter 15 – 
‘Roads Design’.  

 
After choosing the definitions, exit the sections window by clicking ‘Cancel. 
Exit the program by ‘File -> Exit’ and saving the data. 
 
More options in roads work mode 

 From the main menu, activate Roads->Horizontal alignment. 

 From the right window, press  - Options buttons. 
 The program will display the general options window with the layout 

options, to understand these options, look in Roads-design chapter.  

 
Defining Distomat data work mode 

 
CivilCAD 2016 makes it possible to predetermine the work mode for the 
distomats data. In order to determine the program options, follow the steps 
below: 

  
 Go to ‘File-> Open project’  
 Choose ‘Prototype.prj’ project and click ‘OK’.  
 Go ‘Geometry -> Distomats data’ 

 Click on the options button . 
 Choose the type of angle Degrees/Grads 
 Choose the measuring format – meters/centimeters 
 Click ‘OK’ 
 Exit the program : ‘File -> Exit’ 
 Confirm the changes you have made. 

 

 

Saving the project for moving from one computer 
to another (Zip) 
 
When CivilCAD 2016 saves a project, it creates a number of files with the 
same name (project name), but with a different ending. When you want to 
transfer a project from one computer to another, or to a project send via e-
mail, the best way is to zip the project into a single zip file. Once the project 
is zipped, you can open it straight from CivilCAD 2016. 
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Creating a Zipped project In One Zip File 
 

 Open the project you wish to zip – ‘File ->Open’ 
 Activate ‘File ->Add to zip 

 
The program will automatically save the zipped project in the project 
library’s original file. 
 
The program will automatically save the zipped project in the project’s 
original library. Open the library in which the project is in. If the zipped 
project does not exceed 1.44MB, you will see the program has created a 
single file. If not, you will see a number of ZIP files were created. The 
numbering is as follows: if for example, your project’s name is ‘MyRoad’ – 
the program will create such file names: MyRoad001, MyRoad002…….. 
MyRoad007   
Now you can copy the files created into floppy 1.44 diskettes. 
 

 

Opening a Zipped Project from CivilCAD 2016   

 
To open a zipped project from a Zip File containing the entire project - 
perform the following: 
 

 Activate ‘File ->Extract from zip’ 
 Choose the zip file you wish to open 
 If the project can be zipped into a few zip files, choose the latest file  

 
The program will open the project automatically and arrange its files in the 
directory where the zip file is located.  
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Using CivilCAD 2016 Help  
 

In the CivilCAD 2016, there is an option to launch a Help window. In order 
to launch this window, click on the main menu Help -> Help, or, from the 

main toolbar, press . The Help window will be opened in the language 
designated at the setting window of the software. 
In order to change the window's language setting, execute the following 
actions: 
 

 Enter: File ->Configuration. 
 Change to desired language on caption "Language". 
 Click "OK". 
 Re-activate the window by: Help->Help.  

 

Viewing of the demonstration clips (new) 

Demonstration clips that show the operating steps can be viewed. In order 

to view these clips, click  (on the main toolbar) or click from the main 
menu Help-> Tutorials and the window containing the list of clips will be 
opened. 
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Chapter 2: Coordinates 
database 
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Coordinates database 
 
This chapter discusses the input of coordinates, lists their editing, 
processing, and presentation in a drawing.  
 
At the bottom of the window, there is another window composed of an 
Editor and a group of buttons that affect this editor. This window is called 
the “Points Editing Window”, and is used for the functions mentioned 
above, i.e. importing and editing the points. Please note: the window title 
(white with a blue background) is Topography Coordinates, meaning that 
the list at hand is a list of coordinates that represent the point of existing 
ground level. 
 
Closing the coordinates editor window enable a larger work-space for the 
drawing environment, to do so, click the small ‘x’ button at the top right of 
the editor window. To open the editor window again, activate from the main 
menu: Topography/Design->Coordinates. 

 
We will emphasize that it is possible to deal with two different lists: 

 List of Topography Coordinates, ground level – refer to the current list. 
 List of Designed Coordinates, ground level - an additional list used for 

the design and input of topography coordinates after the project was 
done, and more. 

 
* The separation between the two lists (layers) and their function will be 
discussed later on; we would only like to point out now that functions 
performed on the Topography Coordinates lists can also be done on the 
Designed Coordinates list. 

 
The Topography Coordinates window can be divided according to the 
following: 

 The list of coordinates 
 Command buttons related to the list 
 Functions that can be done on the drawing, which would affect the list. 
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Coordinates list   
 
The list of coordinates is a scroll down list , that can contain an unlimited 
number of points (the program does not limit the number of points it can 
receive. However, if you are working on a computer  that is low on memory 
and/or processing abilities, it is possible that the software will work very 
slowly or even ‘get stuck’ if the lists are too long). The list itself presents 
the points, and above it there is a point editing line (the line below the 
Topography Coordinates), used for adjusting and adding points. The 
following is a short exercise that will help demonstrate this topic: 

 
 
Example project  
 

When starting a new project, every new job requires you to open and 
attribute it to a specific project. Project Noname that is loaded when the 
program is activated is not meant to be used as a work project. 
 

 Go to: File  New Project. A New Project dialogue box will appear. 
 Type in the project name: we will type in a project called ‘Coortest’. 

Click Enter when you finish. 
 Notice that blue title at the top of the window now contains the project 

name (Coortest), along with its full path. 

 
 
Ceating the coordinates list manually  
 
Type in the following list of coordinates: 
 

                                                                                                   
 bm300 200  100.32 75.67 

 1  125.32 132.27 

 2  131.23 80.76  60.31 

 3  50  50.41  62.23 

 /small grid 

 4  50            50  61.55 

 5  60            50  63.23  

 6  100           50  63.23  

 7  100           100  62.50 

 8  50            100  62.27 

 

How should the list be typed? Bring the text cursor to the points editing 
line. In order to do that, bring the mouse to this line and click on it. You will 
notice a hook-shaped cursor appearing within the line. Type in the first 
point in the sequence, with a one space or more between each parameter; 
first type in the point name (bm300), space, (200) x, space, (100.32) y, 



 

 

Page 30 of 508  
 
 

CivilCAD 2016 Reference manual 

space, and height (75.67). When you have finished typing in the points 
parameters, press Enter. You will notice that the point was entered into the 
list of points and that the points editing line has positioned itself on a new 
line. Continue entering the remaining points in the same manner. 
 
* Comment: the following line is NOT a coordinate: /Small grid. Type in this 
line precisely as it appears. This line is listed here in order to demonstrate 
an option of inserting comments between the lists of coordinates, which 
may be useful for organizing and arranging the lists. A comment starts with 
a / sign, which tells the program that this line is a comment line and should 
not be treated as a coordinate. Continue to enter the remaining 
coordinates in the list. 

 
Loading coordinates from Excel file 

 
It is possible to load coordinates from Excel file. To do so follow the next 
steps: 

1. Create Excel file with the coordinates data according to the picture 
bellow (no need to type the yellow row). 

 

 
 

2. Go to 'FileSave As', select the option 'CSV' (Comma 
Delimited) (*.csv), under 'Save as type', define the file's name 
and click the 'Save' button. 

3. Open the *.csv file with Notepad (Windows Text Editor). The 
data in the file will be separated by comma. 
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4. Go to 'EditReplace'. 'Replace window will open. 
 

 
 

5. In 'Find what' cell, type comma (","). 
6. In 'Replace with' cell, type space (hit the space button in the 

keyboard). 
7. Click the 'Replace All' button. The data will now be separated 

by space. 
 

 
 

8. Go to 'FileSave As', select the option 'TXT' Text Documents 
(*.txt) under 'Save as type', define the file's name and click the 
'Save' button. 
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9. From CivilCAD main menu, go to: 'TopographyCoordinates'. 

10. Click the 'Load from text file'  button. Select the option Text 
Files (*.txt) under 'File of type', select the desired file and click 
the 'Open' button. 

 

 
Coordinates structure 

 
A coordinate will be composed of four parameters: 
Point Name / Number x y Height 
Point Name / Number is necessary and can contain any alpha-numeric 
character, except for a space, so that: 
A1, 1, 10095, bm300, At30…. 
 
Are correct names, whereas: 
A 1, bm 300 
are incorrect names. 
 
X – Necessary – means the geometric ‘X’ which can be any number. It is 
not necessary to enter zeros after the decimal as: 132.00 is similar to 132.  
  
Y – Necessary 
 
Height – Optional – a point with no height will serve as a regular point, but 
commands that are dependent on height, as Earthworks calculations or 
contour line drawings, will not take this point into consideration. 
 
Note: Another value which can be added to the fifth column is the code 
point, which will not be discussed in this chapter. 

 
 

 
Editing the coordinates list  
 
You can scroll the list up and down using the arrows right of the list. If you 
wish to change a point you  
can bring it to the points editing line by pointing to it with your mouse. 
When the point will appear in the top line, bring the text cursor to the line 
and change the point. You can also change and edit this list without using 
your mouse – bring the text cursor to the points editing line (again using 
your mouse). From this stage use the standard editing keys: 
 
One line up – an arrow pointing up 
One line down - an arrow pointing down 
One page up – Pg Up 
One page down – Pg Dn 
Ctrl-End – jump to the end of the list 
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Ctrl-Home - jump to the beginning of the list 
 
CivilCAD can mark and freeze exceptional coordinates (with exceptional 
distance or height) automatically. 
 

 From CivilCAD main menu, go to ‘Design / TopographyCoordinates’. 

 Click ‘Options’  button. 
 Checkmark the ‘Auto freeze exceptional points’ option and click the 

‘OK’ button. 
 Click the ‘Refresh’ button. In case of existing exceptional points, a 

message window will appear. Click the ‘OK’ button. 
 
Points with exceptional distance or height will automatically freeze and will 
not be taken under consideration in the interpolation buildup (contours). 
 
 
       
Drawing the points 
 
After you finished typing the coordinates list, you will probably want to 

present them in the window. Click the  button from the main toolbar 
below the main menu to refresh drawing. This command instructs the 
program to screen the coordinates list, locate changes in the list (in this 
case the entire list is new), and to draw the up-to-date list. In the same 
manner, each time you make a change in the list, (add coord, change 
coord., of a certain point etc.) and wish to receive the change on the 
drawing, click on the key, and the drawing will be updated accordingly. 
 
Deleting overlapping area between two measurement 
 
CivilCAD enables deleting the overlapping area between two 

measurements. 

 From CivilCAD main menu, go to ‘TopographyCoordinates’. 

 In ‘General Settings’ Tab, mark ‘V’ in ‘Save Backup’ option. 

 Click the 'Options' button  and checkmark 'Subtract coordinates 

from overlap area’ option. 

 Click the ‘OK’ button to save definitions. 

 Load the first measurement file and then load the second 

measurement file. 

 In the opened window, select one of the following options: 
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 Select the first option to leave both measurements without 

deleting anything from the overlapping area. 

 Select the second option to leave the first measurement data in 

the overlapping area. 

 Select the third option to leave the second measurement data in 

the overlapping area. 

 Click the ‘OK’ button to save definitions and execute the operation. 

 

 

 

Command buttons connected to the list 
 
In the points editing window (bottom window), you will find a group of 
buttons for activating the points list. We will go over all these commands. 
 

 Reordering the coordinates 
Click on this button to space the coordinates list in the columns by: 
 
 NAME     X     Y     Z     CODE 
 
As each column is straightened to the left. 
(Note: we mean the geometric X - east). 
        
Please notice: this command assumes that the coordinates list is legal. If 
you click this button, when the list is not legal, the lines that are not legal 
can change contrary to the expected. For example: 
 
0     BM30     153700.25     179600.32     323.35               
Since this line is not legal (there is an unnecessary 0 column on the left), 
the program will identify the 0 as the point name –bm300 as coordinate X 
(a mistake!) and so forth, to the point that 323.35 will be erased completely 
from the line since it is the last data and the program does not know where 
to put it.  
 
Note: The reordering is not supported by the ‘Undo’ command. 

 

 

 Save as text file 
Clicking this button will cause the dialog text-box to appear – ‘save as text 
file’ (blue title), from which you will be asked to choose a library and type 
the file name. The program will open a new file by the name that was 
typed, and save the coordinates into it as a clean ‘Ascii’ file. The opened 
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Ascii file will open will remain exactly as it is in the coordinates list (will 
include space lines or comments if any exist). It is possible to save the 
coordinates file in different formats. To do so you can use this option: In 
the ‘Save as text file’ dialog box appears the ‘Filter’ line with the writing ‘All 
files (*.*)’. Click on the small arrow button on the left and choose your 
desired format (Reg, Med etc.). From here on, if you issue a command to 
save a text file, you will get a file with the ending you chose and in the 
desired format.  
 
Note – This command is supported when working with blocks, so it is 
possible to save only a part of the list.  

 

 

 Load from text file 
Clicking this button will cause the ‘load from text file’ dialog box to appear. 
In this box you will be asked to pick the name of the file you wish to load. 
The file will be loaded and appear in the coordinates list. Please take 
notice that the current points list, if there is one, is not erased, and that the 
file data is added to the end of the list. This way it is possible to join a 
number of files and enlarge the measuring areas. If you still want this list to 
“run over” the existing list, you will need to first click on the ‘erase all 
coordinates’ button, and only then to load the new list.
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 Print Coordinates list 
Activating this button will create the printer dialog box. Make sure the 
printer is connected and ready to print and click on “confirm” to print the list 
of points. 
 
Note: this command is supported by working with blocks, so it is possible 
to print only part of the list. 
 

 Undo 
While you are using the CivilCAD 2016, the program saves all the 
commands, changes and additions you made in the points list. Each word 
typing, erasing of line, block changes and (erasing a column for example) 
etc. is saved. Each time you click ‘Undo’ it will take you one step back in 
the coordinates list. Take notice that the ‘Undo’ relates only to the 
coordinates list (and not the drawing for example). For example, if you 
delete a certain point from the drawing and click ‘refresh’, the point will not 
appear on the drawing. By clicking ‘Undo’, you are making this point 
reappear on the drawing. Don’t forget to refresh the drawing. There are 
several commands for which you cannot use the ‘Undo’, such as erasing 
the list of coordinates and reordering. 
 

 Erase all – Erase coordinates list 
The erase command will erase all the coordinates in the list. This warning 
will appear before erasing: “All coordinates will be erased”. Click ‘OK’ to 
confirm.  
 
Note: This command is not supported by the ‘Undo’ command, and is not 
possible to restore. 
 

 Erasing Point/s 
This button is for erasing a single point or a block of 3 points. Mark the 
point with your mouse (in the list) and click this button. The point will be 
erased from the list. 
Note: this command support working with blocks. 
 

 Copy 
This command, in collaboration with the ‘Copy’ command, serves for 
copying coordinates. You can copy a single point or a block of points.  
See this example for the usage of this command: 

 Mark 3 points from the coordinates list using you mouse. (mark your first 
point, hold the mouse, click and drag the cursor on the two successive 
points to the point you have marked). 

 Mark the points as a block – click with your mouse on the square left of the 
word ‘block’. 

 Click on ‘Copy’ 
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Now the points have been copied to the computer’s memory (don’t expect 
a response – the points will be copied without a confirmation). 
See a continuation of this example in the ‘Paste’ command below. 
  

 Paste   
This command, in collaboration with the ‘Copy’ command, is for copying 
coordinates. Assuming you are using this command to copy a certain 
segment from a particular block (or single line) to memory, you can copy it 
(and paste) anywhere you like inside the points list. Study this example 
that began with ‘Copy’: 

 After marking and copying a block of 3 points to memory, browse until 
you reach the end of the points list. 

 Bring the last line in the list to the points editing line (just mark it) and 
move with the text cursor to this line (point your mouse to the points 
editing line). 

 Click ‘Enter’ to go one line down – since there are no more lines – a 
new line will be made. 

 Click ‘Enter; again to create a space line (not necessary – is here only 
for the sake of this example). 

 In the new line, write the next remark (again, this remark is not 
necessary): A copy sample/ and ‘Enter’.  

 Click on the ‘Paste’ button – you will notice that the points copied to 
memory have been pasted from the line in which you are in. In order to 
form a distinction between these points to the points that already exist, 
a ‘*’ will be added before every point.  

We will comment here, without demonstrating, that it is possible to copy in 
the same fashion, a group of points from the existing topography 
coordinates list to the designed coordinates list. 

 

  Find  
This command is for locating a point (s) in the list by name or elevation or 
code. Pushing this button will cause the ‘Find’ dialog box to appear: 
 
For locating a point by name: 
From the ‘Find what’ menu – move the search to ‘Name’  
Enter the name you want to locate and click ‘Enter’ or ‘OK’.  
Option for an advanced search: 
 
To search for a few names click for example: 1000, 1002, 2003. To 
search in a certain range click for example: 1000- 1004. There is also the 
option of doing a combined search: 40-10, 50, 60. There is no meaning to 
the order of typed parameters in the search box.  
The point located, will be marked in blue and appear in the points editing 
line. Another click on ‘Enter’ will locate the next point in the list of the same 
name (if there is one) and so on. In order for the program to directly mark 
all the search results in the list, switch in ‘Search Mode’ from ‘StepByStep’ 
to ‘All’ status. 
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To locate a point by elevation:  
We have shown the uses of locating points by name. In the same way it is 
possible to locate points by their elevation: 

 From the ‘Find what’ menu, move the search from ‘Name’ status to ‘ 
Height’. 

 Enter the elevation you wish to locate and click ‘Enter’ or ‘OK’.  
 Option for advanced search: 
 To search for elevations above a certain height change from ‘Search  
 Mode’ to ‘At Least’. 
 To search for elevations below a certain height change from ‘Search  
 Mode’ to ‘At Most’. 
 There is also the possibility of an advanced search for using the 

methods mentioned for search by name.  
 
To locate a point by code: 
From the ‘Find what’ menu, move the search to ‘Code’. 
Type the code you wish to locate and click ‘Enter’ or ‘OK’. 
 

 Insert and empty line 
Clicking this button will add an empty line before the line you have marked. 
To activate mark the line in front of which you want to add a new line and 
click this button.  
 

 Mark them all  
The ‘All’ button colors the entire points list including a space line and 
comments. This makes it easier to mark the entire list when working on the 
block of points. 
 

 Displaying coordinates mode options  
The options window is for controlling the type and size of the points 
labeling. Click this button to open the ‘options dialog box'. CivilCAD 2016 
will display the general options window with the coordinate’s options at the 
bottom. We will go through these options: 
 
Standard mode – displaying the coordinates in text format: 

 Names – Displaying the point’s names. If this option is checked, the 
name of the point will appear attached to the point. 

 Elevations- The point's elevation. 
 Codes –The point's code.  
 Circles - Showing a circle around the point. 
 Crosses – Showing a cross on the point. 
 Brackets - Showing brackets around the elevation point. You can 

choose between numerous brackets types or cancel this option by 
choosing ‘None’. 
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 Scale – Choosing the text font size. The text height will be according to 
the general scale settings (for more details please refer to "Chapter 24, 
Configurations window"). 

 Format – The format in which the points will be shown. There are two 
formats of presenting the points (beside ‘Blocks’). 

 Format 1- the elevation of the point will appear on both sides of the 
point itself – meters left of the point and centimeters to its right. 

 Format 2 – the elevation of the point will appear above it 
 
Blocks mode – displaying the coordinates as blocks entities: 
 
After choosing this option, all entities displaying the coordinate (height, 
name and symbol) will be displayed as one block. These blocks will be 
displayed according to the blocks library and the coordinates’ code 
numbers (to learn more about working with codes please refer to chapter 
3).  
 
Note: for using this option you must set the "drawing options" into "blocks 
mode" by following the next steps*: 

 From the main menu activate: File->Configuration. 
 Select the second tab (“Drawing environment”). 
 Under “Drawing options” select the “blocks mode” option. 
 Press OK to save the changes and close the configuration window. 

 
* Tip: to set the software to always work in blocks mode, set both the 
"drawing options" in the "configurations" window and the coordinate's 
settings in the "Options" window into "Block mode". 
 
To make a change and save it, click ‘OK’. Click on ‘Cancel’ to cancel any 

change. After closing the options window press  to refresh the drawing 
according to the last settings. 

 

 Sort    
This command is for sorting the points list by their number. When you click 
this button the warning “All coordinates will be sorted” will appear. Click to 
confirm. The list of points will be sorted in an ascending order. All points 
with an alphanumeric name will be transferred to the top of the list. 
Note: The reordering command is not supported by the ‘Undo’ command. 
 

 Auto numbers -  
 
Changing the Point Name 
This option is for automatically changing the point’s names. Clicking this 
button will open a window with the options below: 

 Start column – positioning the first character in the list for the new 
point’s name 
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 End column – positioning the last character in the list for the new 
names (the program will not go past this position). 

 Start counting from – the value for the counting beginning. 
After clicking ‘OK’, the program will present a window to confirm the 
change,  and after the change has been made, it will change all the points’ 
names from the list. In case some of the list is marked by ‘Block’, the 
changes will be made for this section only.   

 

 Freezing a point(s) 
This command is for neutralizing a point in the computation. A frozen point 
will appear in the drawing, but will not be included in the drawing during the 
creating contour lines phase. This way you can freeze sewage cells, pits 
and more. To freeze a point, mark it from the list and click this button. The 
sign <Fr> will appear left of the point. Continue to mark the points you wish 
to freeze. Refresh the drawing when you are done – and the frozen point 
will appear in the drawing. When you go back to compute the contour lines 
you will be able to view the change caused by the freezing of points. In 
order to “unfreeze" a point, mark it and click again on the ‘Freeze’ button.    
*Note: it is also possible to freeze a measuring point by adding the code 
‘Fr’ to the desired point.    

 

 Locate a point in the drawing (Fix) 
Use this command to locate a point from the list on the drawing. Mark the 
point (in the list) you wish to locate and click this button. 
In Stand-alone version: the mouse cursor will jump to the point and 
position itself on it, on the  
condition the point is in the drawing area that appears in the window.  
In AutoCAD version: the desired point will be located and placed in the 
center of the drawing.   

 

 Calculating the point elevation (+H) 
This command enables you to compute the elevation of the point 
interpolation by its coordinates. The elevation calculation will be done only 
if there are contour lines on the drawing. 
We will demonstrate the use of this option. 
 
For example: you have a project with contour lines, and you wish to locate 
the elevation of a point with known coordinates. 

 Add the new point to the coordinates list. 
 Mark with your mouse the point inside the list.  
 Click this button. 

You will notice that for this point the elevation had been calculated. In case 
you made a design, you can calculate the point’s elevations from the 
designed topography by using this command on the list of designed points. 
This command supports working with blocks. 
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 Adding elevation to point (Add Height) 
This command is for adding/reducing elevation from all the points or from a 
group of points marked as a block. To operate click this button. Enter the 
desired addition of elevation in the box that opens. To reduce elevations 
enter a negative number. 
Click ‘OK’ to activate or click ‘Cancel’ to cancel it. 
Note: to add/reduce elevation for some of the points only, mark them first, 
and then set them as a ‘Block’.  
 

 Direct input of points from total station  
Click this button to open the communication window. Make certain you 
have the proper tool and that the communication data matches the data 
tuned inside the tool. Click ‘Receive’ to get the data from the tool or ‘Send’ 
data to it. 
If you wish to send only half the points, you can do so by marking the 
desired ones, setting them as a ‘Block’ and clicking ‘Send’. A message will 
appear notifying that the ‘Block’ points were sent (not all the points). 
 

 Changing coordinates 
This button will replace the coordinates ‘X’ with ‘Y’ in the points list. To 

view the influence of this command in the drawing,  click . Activate 
‘Zoom extents’ to move to the new drawing area. 
 

  Update block’s rotation 
Click on this button will update coordinates angle (in coordinates list) of 
coordinates that has been rotated on drawing. 

 

 saving changes in location of coordinates' name and height 
which are made graphically on drawing to CivilCAD database. 
This option is available only in 'Standard Mode' and in 'Format 2'.  

 From CivilCAD main menu, go to ‘Design / TopographyCoordinates’. 

 Click ‘Options’  button. 'Options' window will open. 

 Checkmark the ‘Standard Mode’ option and select Format 2. 

 Click the ‘OK’ button to save definitions. 

 Notice that now, 'Save Coordinates Text According To Definitions' 

button  in ‘Design / TopographyCoordinates’ menu is accessible. 

 After changing the coordinates' name or height location on drawing, 

click the  button for saving the changes to CivilCAD database. 
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The database will be displayed in ‘Design / TopographyCoordinates’ list 

with the new coordinates of the point's name and height. 

 

 

Drawing commands affecting the list 
 
In the coordinates list window at the bottom of the screen the following list 
appears on the right: 
    Unused, Pick, Locate, Erase, Move  
 
This list enables you to operate on the drawing as these commands will 
directly influence the coordinates list. In this section of this chapter we will 
discuss these commands.   
In all commands, there is a difference between operating in ‘Stand-Alone’ 
(as a separate unit, without AutoCAD), and working with AutoCAD. These 
differences will be detailed for each command separately.  

 
Unused 
 
The state in which none of the commands are active. This is a default 
situation of the list. 
 
Pick  
 
Adding a point from the drawing. 
 
Stand-Alone: To activate, click on ‘Pick’ from the list so it is marked in 
blue. Move with your mouse  
to the drawing area, stand on the point you wish to add and click the 
mouse button again. The point will be added to the coordinates list. 
Another click on the mouse will create and additional point, and so on. To 
finish, click on the ‘Unused’ button or on the right mouse button.  
 
AutoCAD: To activate click on ‘Pick’ from the list to mark it in blue. From 
the AutoCAD line of commands appears the writing : ‘Pick point 
<XXX>/(Esc)nd>. The number in brackets is the number that will be given 
the point you choose. To change this number click the desired number and 
‘Enter’. Move with the mouse cursor to the drawing area, stand on a point 
you wish to add and click on the mouse button – you will see that the point 
that had been added to the coordinates list. Another click on the mouse will 
create an additional point, and so on. To finish click ‘Esc’.   
 
Point elevations:  as before said ,  each click will add a point to the list. In a 
project where contour lines were computed (‘TopographyContours’), the 
program will perform interpolation to the elevation of the new point and add 
it automatically into the list of coordinates. 
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You will notice that the point that was added, automatically received a 
name/number. You can control the points names that are added (other 
than of manually changing the name of the point after it was added), the 
following way: 
 

 Go to ‘File -> Configuration’ from the main menu (the command ruler at 
the head of the drawing).  

 From the window that opens select “coordinates format” tab and select 
from the 2 options under “New points counter”: 

 
 The automatic numbering – to operate check ‘v’ next to ‘Auto 

names’. This option instructs the computer to automatically give a 
name that does not appear in the list. These names will open with 
the letter ‘T’ for ‘Topography coordinates’ and with the letter ‘D’ for 
‘Designed points.’  

 Ascending numbering– It is possible to instruct the computer to 
number the added points in an ascending order, starting from a 
defined number. To the right of ‘Start counting from’ appears a text 
line. Enter in this text line the point number from which the 
numbering will begin.   

 
You will notice that the ‘v’ marking left of ‘Auto names’ has 
disappeared. From this point on, every new point you add will be 
numbered in an ascending order of the number you typed. 
Nevertheless the program will *not prevent duality in the point’s 
names.  
Note: When working with AutoCAD, this function is similar to 
entering a point number directly in the AutoCAD line. 

 
 After choosing click ‘OK’.  

 
Note: *It is possible to give an identical name to two different point. In such 
a case the points will be presented at their proper place on the drawing, 
and you will be able to calculate contour lines for them. Problems with 
names duality will occur only when these points are included in the 
designed plane, breaklines, center lines, etc. In such cases you should 
avoid giving different points identical names.  

 
Locate 
 
Locating a point/group of points from the list in the drawing. 
 
Stand-Alone: To activate click on ‘Locate’ from the list of commands. After 
activating, you will notice that a new option list had opened instead of the 
previous list. The list contains the following options: Cancel, Single, Win in, 
Win out. 
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 Cancel – Canceling the command (you can also cancel by clicking on 
the right mouse button). 

 Single – Locating a single point (default option). We will demonstrate 
the use of this option: choose the option and bring your cursor to the 
drawing area. You will notice that the cursor had changed from a cross 
to a small square. Bring the square so that the point you wish to locate 
will appear inside and click on your mouse button (please notice that 
the point itself – the center of the cross or circle of the point are inside 
the square and not the name or elevation). If the point “gets trapped” it 
will be brought to the new editing points line at the bottom list and get 
marked in blue.  

 Win In – Activating this option will allow you to locate a number of 
points according to the window definition. To activate click on this 
command and move to the drawing area. Mark the window including 
the points you wish to locate (click on the mouse button to begin 
marking the window – move the mouse to mark the window and click 
again to finish). All the points inside the window will be located in the list 
and marked in blue (you can scroll the list up and down to see all the 
marked points). 

 Win Out – Locating points outside a defined window. To activate, click 
on this option and move to the drawing area. Mark the window. When 
you finish marking, all the points outside this window will be located and 
be marked in blue.  

 
AutoCAD: To activate click on ‘Locate’ from the list of commands. In the 
AutoCAD command line you will see this writing: 

 
PolygonIn/PolygonOut/<Single>/(Esc)nd: 

 
 (Esc)nd – Click on Esc to finish the command. 
 Single – default. Locating a single point. In AutoCAD ‘Object Point to 

Snap’ will be automatically operated. If a certain point is chosen, it will 
be located from the bottom list and be painted blue.  

 PolygonIn – Locating points inside a closed shape. Click ‘I’ and ‘Enter’ 
to activate this command. Mark a polygon around the desired points 
and click ‘C’ and ‘Enter’ to close it. All the points inside the Polygon will 
be located and colored in blue.  

 PolygonOut – Locating points outside a closed shape. Click on ‘O’ and 
‘Enter’ to activate this command. Draw a polygon around the desired 
shape. Click ‘C’ and 'Enter' to end. All the points outside the polygon 
will be located and colored blue. 

 Freeze - Freezing a point/s from the list in the drawing. The point that 
was frozen will appear on the screen but its elevation will not affect the 
contour lines drawing. 

 Stand-Alone: To activate click on ‘Freeze’ from the list of commands. 
After activating this command a new options list will open instead of the 
previous list. The list contains the following options: Cancel, Single, Win 
in, Win out.  
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 Cancel – Canceling the command (you can also cancel by clicking on 

the right mouse button). 
 Single – Freezing a single point (default option). We will demonstrate 

the use of this option: activate this option and bring your cursor to the 
drawing area. You will notice that the cursor had changed from a cross 
to a small square. Bring the square so that the point you wish to freeze 
will appear inside and click on your mouse button (please notice that 
the point itself – the center of the cross or circle of the point are inside 
the square and not the name or height). If the point “got trapped” it will 
freeze, and next to it will appear ‘<Fr>’. After freezing all the desired 

points, click  show the frozen points in the window. 
 
Note: The freezing of points will not affect directly contour lines that 
have been drawn. You will have to activate option ‘Topography -> 

Contours’ again, after you have refreshed the drawing using , in 
order for the ‘freezing’ to appear.  
 

 Win In – Activating this option will allow you to freeze a number of 
points according to the window definition. To activate click on this 
command and move to the drawing area. Mark the window with the 
points you wish to freeze (click on the mouse button to begin marking 
the window – move the mouse to the window marking and click again to 
finish marking). All the points inside the window will be frozen in the list 
(you can scroll the list up and down to see all the marked points). Click 

 to show the frozen points in the window. 
 Win Out –Freezing points outside a defined window. To activate, click 

on this option and move to the drawing area. Mark the window. When 
you finish marking, all the points outside this window will be frozen. 

Click  to show the frozen points in the window. 

 
AutoCAD: To activate click on ‘Freeze’ from the list of commands. In the 
AutoCAD command line you will see this writing: 
PolygonIn/polygonOut/<Single>/(Esc)nd: 
 

 (Esc)nd – Click on Esc to finish the command. 
 Single – default. Locating a single point. In AutoCAD ‘Object Point to 

Snap’ will be automatically operated. If a certain point is chosen, it will 
be located from the bottom list and get frozen. After you have froze all 

the desired points, click  to show the frozen points in the window. 
 PolygonIn –Freezing points inside a closed shape. Click ‘I’ and ‘Enter’ 

to activate this command. Mark a polygon around the desired points 
and click ‘C’ and ‘Enter’ to close it. All the points inside the Polygon will 

be located and frozen. Click  to show the frozen points in the 
window. 
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 PolygonOut – Freezing points outside a closed shape. Click on ‘O’ and 
‘Enter’ to activate this command. Draw a polygon around the desired 
shape. Click ‘C’ to end. All the points outside the polygon will be frozen 

and colored blue. Click  to show the frozen points in the window. 
 
Erase 
 
Erasing a point(s) from the list using the drawing. To activate click on 
‘Erase’ from the list of commands. Here as well, the possible options will 
appear for working with Stand-Alone and for working combined with 
AutoCAD (see ‘Freeze’), but here the same commands will erase points.  
One of the best uses for the ‘Erase’ command is to limit the project area to 
a defined space, or to erase the deviating coordinates in your project. 
 
We will demonstrate this issue: say you have a new project into which you 
have imported a measurement coordinates file, and in this file are also the 
measurement stations and coordinates of the station’s orientation points. In 
many cases, these points are far from the measurement area and so after 
importing a file and refreshing it (R), you will get a group of points (the 
project area) and a small number of remote points that are of no use. You 
can use the option ‘Erase -> Win out’ or ‘Erase -> polygonIn’ (depending 
on the work configuration  (  to erase the remote points from your project. 

After erasing, click on  to refresh the drawing.  
 
Move 
 
Moving a point/s from the list.  
Stand-Alone: To activate click on ‘Move’ from the list of commands. 
Choose the point you want to move and mark its desired location. The 
point coordinates will change according to its new location.  
In order to move a group of points you must perform the following steps: 

 Choose ‘Locate’ from the command list. 
 Choose ‘Win in’ from the list that opened. 
 Move to the drawing and draw a window around the points you wish to 

move. 
 Check ‘v’ next to the word ‘Block’. 
 Click ‘Cancel’ and choose ‘Move’ from the list. 
 Choose both a point that will be used as a relevance point for moving 

the other points, and the new location of the point. All points marked in 
the window will move accordingly.  

 
AutoCAD: It is a common mistake to think that moving a point with 
AutoCAD (the ordinary ‘Move’ command) will change the coordinates of 
the same point in the bottom list. However, it is possible to use the ‘Move’ 
option described here to physically move a point, while simultaneously 
changing its coordinates in the list.  
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To activate click on ‘Move’ from the list of commands. In the AutoCAD 
command line this writing will appear: 
PolygonIn/polygonOut/<Single>/(Esc)nd: 

 (Esc)nd – Click on Esc to finish the command. 
 Single – default. Moving a single point. In AutoCAD ‘Object Point to 

Snap’ will be automatically operated. After selecting a certain point, you 
will be asked to mark the first location that will serve as the reference 
point for movement, and then mark the place you want the points to 
move to. The coordinates of the selected point will change according to 
its new location and according to the yellow cross marking. When you 

finish moving all the desired points, click  to refresh the drawing. 
 PolygonIn – Moving points inside a closed shape. Click ‘I’ and ‘Enter’ 

to activate this command. Mark a polygon around the desired points 
and click ‘C’ and ‘Enter’ to close it. All the points inside the Polygon will 
be located. Mark the first location that will serve as the reference point 
for movement, and then mark the place you want the points to move to. 

When you finish moving, click .   
 PolygonOut – Moving points located outside a closed shape. Click on 

‘O’ and ‘Enter’ to activate this command. Draw a polygon around the 
desired shape. Click ‘C’ and 'Enter' to end. All the points outside the 
polygon will be located. Mark the first location that will serve as the 
reference point for movement, and then mark the place you want the 

points to move to. When you finish moving, click .   

 

Working with blocks 
 
There are many commands such as ‘Copy’ ‘Freeze’ and more, that can be 
used for working with blocks. A block is actually a group of points on which 
certain commands that can be made. The following example will show how 
to use blocks. 
Follow these steps to print a section of the points list in your project: 
 

 Color in blue the points you want to print. 
 To do so mark the first point for printing in the list, move with the arrows 

right of the list to the last point of printing, hold the ‘shift’ key, and click 
and mark this point. All points between the two marked points will be 
colored in blue.  

 Now mark the points colored in blue as  ‘Block’. By checking ‘v’ next to 
the word ‘Block’. From here on, all the points marked in the list are 
“trapped” by ‘Block’.  

 Click on the ‘Print’ button (with the picture of a printer from the bottom 
group of buttons). You will get the message that only the ‘Block’ will be 
printed and not the entire list. Click ‘OK’ to continue the process and 
confirm the printing after the printer dialog box appears. 
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We have shown that working with blocks enables you to define a group of 
points together, making it possible to activate them as a group. We will 
now discuss an additional command (very useful!) possible for activation 
on blocks. This command allows simultaneous erasing and adding of 
columns to a group of lines. Study this example: 
Say you have a list of coordinates that was imported to the bottom list, but 
in the left column farthest on the left appears the code ‘0’, implying that a 
line from the list will look like this: 
0     Bm2000     500.32     100.37     30.15  

 

This line is not legal, as the parameter zero is unnecessary. You can, of-
course, move a line and erase this parameter, but it will take up much time. 
To do this with blocks: 

 

 Mark the first point on your list. 
 Move with the arrows to the last point on your list, hold the ‘Shift’ key 

and click (key-board), and mark the last point with your mouse. 
 Capture the group of points as –‘Block’ (by checking ‘v’ next to the work 

‘Block’). 
 Bring the text cursor to the points editing line, so it will stand in front of 

the parameter zero that appears on the same line. 
 Click on ‘Delete’ from your key-board – you will see that the entire 

column which has the cursor was erased from all relevant lines (the 
‘Block’ lines). 

 Clicking on the ‘v’ mark next to ‘Block’ will cancel the working with 
blocks. 

 
* In this example, it was possible to erase or add characters / spaces 
to columns in a group of points.   
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Chapter 3 : Working with 
blocks(code) 



 

 

Page 50 of 508  
 
 

CivilCAD 2016 Reference manual 

 

Working with blocks (Codes) 

 
One of the many options in working with CivilCAD 2016 is presenting the 
project coordinates on a drawing in the form of pre-defined blocks. This 
work mode is not possible when working with the program as an 
independent stand-alone format.  
 
Subsequent to CivilCAD 2016 installation, you will find the libraries 
containing the program’s blocks in library ‘Codes’ file. 
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Codes\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Codes\ 
 
 
The main libraries that you will be working with are the ‘MainHeb’ which 
contains the blocks in Hebrew, and ‘Main’ that contains the same blocks in 
English.  
 
By entering the ‘CODES’ file from Windows, you will see that for each 
blocks library there are additional ‘DXF’ files and ‘DWT’ files of the same 
name, for example: 
The ‘MainHeb’ library has a ‘MainHeb.dwt’ file, and a ‘MainHeb.dxf’ file. 
These are files in which all the library blocks are defined (see “Working 
with Codes” section in this chapter). 
 
 
Chapter topics are as follows:  
 

 Setting work mode in blocks. 
 Working with codes. 
 Loading a new background into a project with blocks. 
 Commands from ‘Topography -> Codes’ window. 
 Blocks in roads.  
 Defining colors in ‘Template’ file.  

 

Setting work mode in blocks 
 
Open project ‘Prototype’ in order to switch to ‘blocks’ work mode.  

 Open: ‘File->Open project’ 
 Choose ‘Prototype.prj’ project and click ‘OK’ 
 Open: ‘File->Configuration’  
 Select “Drawing environment’ tab. 
 Check ‘V’ in the ‘BlocksMode’ box 
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 Click ‘OK’ 

 
Now go to the ‘Code definition’ window: 

 
 Open: ‘Topography->Codes’ 
 Click on the yellow filing cabinet icon 
 From the ‘OpenSet’ window that opens, choose the desired codes 

library and click ‘OK’. Now you can see that the library’s name 
appearing at the top section of the window under ‘Set’. 

 
After you have picked the blocks library with which you want to work, you 
will need to define the project default block. The program will also use this 
block for coordinates that were not defined by a code from the list.  

 
 Choose the block number from the list in the top section of this window 

 Click on  ‘Update’ 
 The program will ask if you wish to convert to the block you have 

chosen. Click ‘Yes’. Now you can see the default block name 
appearing next to the ‘Update (Default)’ icon.  

 Open the Topography coordinates list by activating: Topography-
>Coordinates. 

 Press the options button  (above the coordinates list), at the bottom 
of the options window, mark the option: Blocks mode and press OK. 

 
Exit the program and save the changes: 

 
 Click ‘OK’ 
 Exist the program ‘File-> Exit’ 
 Confirm the saving of data 

 
From here on, every time you open a new project, you will work in blocks 
mode. When working on existing projects, the project will work in the mode 

defined for that project specifically.    
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Working with codes 
 
This exercise will explain how to work with codes.  
After determining the blocks mode, open a new project and perform the 
following: 

 
 Click on ‘Load from text file’ from the coordinates list (yellow filing 

cabinet icon) 
 Load the file: Sample7.tco 

 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Samples\Sample7\ 

 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7 

 Click on  to refresh the drawing. 
 
Now you can see that the program has loaded the drawing coordinates 
onto the drawing in the form of a permanent block. By not entering the 
representing code for each line in the coordinates list, the program used 
the default block that was defined earlier. 
 
Now change the list: 
Choose a number of lines from the list and enter at their ends different 
code numbers. The typing will be done in the editing line after the height.   
 For example: 1  1000  1000  100.37   23   

 (this point will be represented by block  code 23) 
 
These codes must exist in the block list of the existing library. In order to 
view the existing list of codes, open the ‘Topography –codes’ window and 
look at the top section.  

 
Following the typing click on the *’ReorderCoordinates’ button (the button 
with right and left arrows in the coordinates list). The spaces in the list will 
be arranged automatically.  

Click on  again and the program will change the blocks according to the 
changes made in the list.  
In order to change the blocks size in the drawing, click on the ‘Options’ 

button -  from the coordinates list and in the window that opens bring 
‘Scale’ to the desired size, and click ‘OK’.  

Press  to change the blocks size in the drawing. 
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*Unlike working without blocks, working with blocks requires aligning the 

points in the columns prior to clicking .  

 

Loading a new background into a project with 
blocks 
 
Every time you open a new project with blocks, CivilCAD 2016 loads a 
‘Template’ file containing all the blocks belonging to the blocks library with 
which you want to work. Loading a new background for the project via 
‘File->Open’ command from the AutoCAD menu, will erase the blocks 
defined in the ‘Template’ file.   
 
This is the reason for using the AutoCAD ‘Insert’ command for loading a 
project background. The background will be loaded as a block or a ‘dxf’. In 
case you have accidentally erased the blocks definition, follow these steps: 

 
 From AutoCAD menu go to: ‘File->Open’ 
 Choose from ‘File of types’: ‘Drawing template file(dwt)’ 
 Open the relevant ‘Template’ file from the ‘codes’ library, for example- 

‘Main.dwt’ 

 Activate  from the main toolbar below the main menu. 
 In AutoCAD activate zoom-extends. 

 
After the re-loading the template and reconstruction of layers it is possible 
to view the project. 
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Creating codes 
 
All codes must be created from “Prototype” project. 
 

1) Open prototype project and then, from CivilCAD main Menu, go to 
‘Topography–>Codes’.  

 

2) Click on ‘New Set’ button  (at the upper right side of the window) 

to create a new library or click on ‘Open Set’ button  in order to 
add codes to existing library. 

 

3) Click on ‘New block’ button  (at the lower right side of the 
window) to create a new block. 

 

4) Enter the desired code name, and click on ‘Browse file name’  
button to load the block’s DWG. 

 

  

5) Click on ‘Set the changes to the block’ button  to save the 
definitions. 
 

6) Repeat steps 3-5 for each code. 

 
7) After creating codes, open each code’s DWG in AutoCAD and save 

it as DXF file in the earliest version possible in AutoCAD. 

 
8) DXF and DWG file must have the same name and be located in the 

same library. 
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Commands from ‘Topography Codes’ window 
 
Creating, editing, and erasing a new blocks library (‘New Set’) 

 

 New Set – opening a new blocks library 
Clicking this button will present a window with the names of the existing 
libraries. Enter the new library name next to the heading ‘New set’ and 
click ‘OK’. The location of the blocks library is in ‘CODES’, from inside the 
installation library. 
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Codes\ 

 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Codes\ 

 

 

 Erase Set – clicking this button and choosing a library from the list that 
opens completely erases the library from the list and from the codes file. 

 

 

 Open Set – opening an existing blocks library 
Clicking this button will present the list of existing libraries in another 
window. After choosing the library click ‘OK’. 

 

 

 Set block as default – choosing a default block 
After selecting a block from the list of blocks in this window, click this 
button to set the chosen block as a default block. This block will be 
presented to the coordinate without a code in the coordinates list.  

 
 

 Preview – a preview of a block 
Clicking this button will load the block itself to the graphic environment and 
present it on the screen. Since this action will erase the existing diagram, it 

should be followed by a click on . Please notice that this command will 
only restore the layers connected to CivilCAD 2016 software.   
   
 

 Browse file name - choosing one block file from the blocks library  
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In order to choose a new block and add it to the library, open this window 
and choose the block you would like to define for the existing library. By 
clicking on one of the blocks from the list that opens, the name of the 
chosen block will automatically appear in the typing line.  
 
 

 New Block – choosing a new block 
Clicking this button defines a new block. In order to choose a block from 
the list, open the window with the list of blocks (the three-point button). 
After choosing the block from the list, the name of the file will appear next 
to the heading: 
‘File-name’. Enter the block’s name under ‘Blocks name’. Type the name 
of the layer in which the block will be entered next to the heading ‘Layer’. 
Use the same layer for all the blocks in the same library. Enter the chosen 
code name for the new layer next to the heading ‘Code’. To use this block 
- enter this code in the coordinates list. After defining all the data to the 
new block, click ‘OK’ to enter the block in the list of codes in the top 
section of this window.  

 
 

 Erase Block – erasing a block from the library 
This button erases the block from the list of blocks, but does not erase its 
file from its library, so that in the future it can be returned to the list.  

 

Block in roads 
 
In blocks mode, when working on a project with roads, CivilCAD 2016 
creates the layers representing the IPs data by using blocks in the form of 
signs, making it very easy to edit the drawing the software had created.  
 
In order to define the working mode in roads with blocks perform the 
following steps: 

 From the main menu, activate Roads->Horizontal alignment. 
 From the window at the right side of the screen press on the options 

button -  
 CivilCAD 2016 will display the options window, at the top of that window 

(under “Horizontal alignment”) notice the option IP’S Data in blocks 
mode, below that option mark the option: Show all data. 

 Press OK. 
 
In order to illustrate this, create a project with blocks and define a road. 
When the software creates the road layout, try to move one of the Ips signs 
from AutoCAD. You will see that the entire sign is made up of one block 
that you can enlarge or turn according to need.   
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Defining colors in ‘Template’ file 
 
Another advantage to working on a project with blocks in CivilCAD 2016, is 
the possibility to predefine colors for the layers the software creates. For 
example, you can determine the colors in the contour line the software will 
create.  
 

 From AutoCAD menu go to: ‘File->Open’. 
 Choose from ‘File of types’: ‘Drawing template file(dwt)’. 
 Open the relevant ‘Template’ file from the ‘codes’ library, for example- 

‘Main.dwt’. 
 Open the AutoCAD list of layers. 
 Change the colors in the ‘Tcontours’ as you desire. 
 Save the file. 
 Operate CivilCAD 2016 software. 
 Open a new project with blocks (in this case with MainHeb library). 
 Load the coordinates file into the ‘Topography coordinates’. 
 Run contour lines - ‘Topography -> contours’. 

 
Now you can see that the layers the software has created in order to show 
the contour lines, are presented in the colors you have defined earlier in 
the ‘Template’ file. Using this system you can predetermine the color for 
each layer the program creates.   
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Chapter 4: Creating 
contour lines 
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Creating contour lines 
 
In this chapter we will explain how to create contour lines. We will show 
how to create contour lines, starting with the most basic option. Preceding, 
we will discuss additional options, and finally advanced issues like defining 
breaklines.   
 

 Start using. 
 Basic issues and defining the range of contour lines. 
 Command buttons from the contours window. 
 Setting options. 
 Contour lines layers.  
 Processing points to create contour lines. 
 Breaklines. 

 

Start using 
 
To create contour lines, go to: ‘Topography -> Contours'. 
)Topography appears in the main menu at the head of the drawing window. 
  
To the right of the drawing, in the desk-top window, a contour lines window 
will appear with the blue heading: Topography Contours). 
 
Press Apply button in this window, to operate the contour lines 
computation. Contours data such as: Intervals, contour layers, and so 
forth, will be automatically chosen by the software according to the default 
settings.  

 

Basic issues and defining the range of contour 
lines 
 
Before we continue the discussion, in order to allow immediate application 
of the issues which we will discuss next, open a new project and enter the 
following list of points: 

 
15.50  40.00  20.00 1 
14.52 30.00 10.00 2 
15.00 20.00 0.00 3 
15.50 25.86 34.14 4 
14.52 15.86 24.14 5 
15.00 .865  14.14 6 
15.50 15.59 59.93 7 
14.52 2.19 54.12 8 
15.00 14.78-  52.33 9 
15.50 22.28 88.51 10 
14.52 5.76 97.44 11 
15.00 5.41-  107.27 12 
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15.50 42.76 109.95 13 
14.52 26.03 124.33 14 
15.00 12.70 138.97 15 

 

 

After entering the list, press the ‘Reorder button’    to align the list and 

press  to display the points on the drawing. 

 
1. Defining the intervals between the contour lines: In the ‘Contour 

Lines’ window you will find the ‘intervals’ field. To define the 
intervals between the contour lines, type the desired interval in the 
text-box to the right of ‘intervals’. To confirm, click Apply. 
(note: If the word ‘default’ appears in the text-box, erase it and enter 

the desired interval). 

 
2. Defining the interval calculation range: When opening the 

Counter Lines Window, you will notice a large frame that appears in 
the window with the word ‘Extents’. This word indicates that at the 
contour lines will be calculated now (after operating this command 
by clicking the Apply button) in all of the drawing area, and 
furthermore, the shape of the contour lines will be arched at all 
times. For example: 

 
  

                                                
 
In this drawing area the contour lines will be calculated also in the confined 
area between the following points 1->4->7->10->13->1 , and not as we 
might have preferred, without this area. To calculate the contour lines 
without this area, you must define it in the following manner :  
 
Choose ‘Locate’ from the list of options in the right window.  
  Go to the drawing area and choose the selected area by defining the its 
bordering points:          -- >3 --- >6 --- >9  2  1---> . 

When you are finished, click the  button from the right (for AutoCAD 
users you can click on ‘S’ and ‘Enter’ in the command line).   
After defining the range of the contour lines, click OK to create them.   
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There are more methods for defining the range of the contour lines. 
Let us observe two: 

 
 Inserting the points names into the range of contour lines: At the 

head of the right window appears a line of text. Go to this line with your 
cursor and insert the points that border the contour lines. Between each 
point click ‘Enter’. You can also simultaneously insert together a range 
of points on the condition that they are arranged in an ascending order, 
for example : 100-110. Click ‘Enter’ when finished. When you finish 

inserting all the points in the range, press the  button. Click Apply to 
receive the contour lines.  

 
 Using Polyline (for users of AutoCAD version only): In AutoCAD, 

draw a polyline between the points that border the contour lines. After 
drawing your polyline, choose ‘select’ from the options list on the right. 
Go to the drawing, choose the polyline you marked and click ‘Enter’. 
You can see that in the points list from the right window appears a 
<Noname< list. Press Apply to receive the contour lines.  

 
Note: You can do the polyline drawing in any layer you want. For 
your convenience, you can enlarge the AutoCAD window to 
maximum by closing the panels (from the right and below the 
AutoCAD window) by pressing the small ‘x’ button at the top of each 
panel. To restore the coordinates’ panel (panel below the AutoCAD) 
activate Topography->Coordinates. 

 
 Show Triangles: Present the Interpolation triangles in the drawing: 

checking this option means that for all contour lines calculations, the 
triangles which served as interpolation for the creation of the contour 
lines will be drawn. In order to compute the contour lines the program 
does triangulation (interpolation of triangles), so that the area being 
computed is “covered” with triangles. The program will choose the 
triangles itself, so that each point will be connected (as much as 
possible) to the two points closest to it, without the overlapping of 
triangles, or there will not be an area that is not covered in triangles.  

 
 Fix borders: Automatic border repair: As mentioned, the computation 

of contour lines will be done throughout the project (in all its areas), 
unless an exact border was defined. You can instruct the computer to 
automatically repair the border computation. Check this option and click 
‘OK’ to compute contour lines again. The program will try to minimize 
the computation borders, so that the triangles with an exceptionally long 
side will be removed automatically. This way we can avoid connection 
between distant points, ones that we do not need to connect.                                                     

Note: This option is based on the mathematical computation in 
which the program defines for each and every project what its 
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“longest side” is, according to the density of the project and the 
average distance between the points. This computation is not 
always the ideal solution, in which case we will turn to the other 
tools explained in this chapter. 

 
 Show borders: displaying the contours’ border, if a border was defined 

by the user CivilCAD 2016 will display that border otherwise; it will 
calculate the border for the whole contours area and display it. 

 
 Create triangles only: the contours will not be shown on the drawing, 

but the program will build the triangulation model in the computer’s 
memory, therefore CivilCAD 2016 will be able to do any calculation in 
the project even if the contours are invisible. 

 
 Smooth: Smoothing the contour lines – The program creates, by 

default, exact contour lines according to the triangles that were formed. 
You can order the program to “smooth” these contours. To do so check 
‘V’ in this field and click OK.  
       Note: After “smoothing”, the contours you receive will be less 
accurate. 

Smoothing level – You can choose the level of smoothness 
for the contour lines by selecting it from the ComboBox (near 
the "Smooth" label). There are 10 possible levels. By 
choosing a lower level the result will be less smooth but more 
accurate and vice versa. Please notice that the process in 
lower levels will be much slower. 
 

 Max Interpolation Length – Defining the maximum length for 
interpolation: CivilCAD 2016 creates, by default, triangular interpolation 
between all existing points. You can define maximum distance for the 
performance of this interpolation. Choose, for example, a value of 60 
meter (the work units for a field are in meters), and click OK. The 
program will perform interpolation only between the points that the 
distance between them is not over 60 meters. This way you can 
remove unwanted triangles, since they have a side that overpasses this 
distance.  

 
In order to use any one of the options mentioned above, check ‘v’ next to 
the option and press Apply. The program will compute the contours 
according to the definition that have been set, and draw them. If such 
contour lines already exist from previous definitions, the program will erase 
them and show only the new contours.  
 
 

 Pick height -  Eelevation labeling in a specific place: in some cases 
the elevation labeling chosen by the program is not satisfying or just not 
good. In such cases it is possible to add  elevation labeling in the 
following way:  
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Mark ‘Pick’ and move to the drawing area. Create a line between 
any two points (click your mouse button, hold and move to the new 
location), so that it will cut across a number of contour lines. After 
the line was drawn, elevations will be automatically drawn at the 
cross sections of the contours. You can also avoid labeling 
unwanted elevation layers by doing the following: enter the layers 
and freeze the ones for which you don’t want to draw elevations. Go 
back to the Contours Window and choose ‘pick height’ again in 
order to draw the intersection line. Now the elevations will be 
labeled only for the layers that are not frozen. When the labeling is 
finished, return to the frozen layers to “view” mode. The layers will 
return to the drawing, without the elevation labeling. 

 

 

Command buttons from the contours window: 
                   
We will discuss the functions of the buttons that appear in the Contours 
Window: 
 

 Emphasizes Contours instantly: Click this button to draw a yellow 
line   

around the Contour Lines area (zone). To erase the line click . 
 

 Erases the points list that define the contours range (field of 
area): click this icon to erase the points list that border the contours border 
. You will be returned to the state of computing the entire area. 
 

 Erases a point from the list of points that define the contour. Mark 
the   

point you want to delete from the list and click this icon. Click on  to  
confirm the change as final.  
 

 Set : After each change you make in the contours computation 
borders, click this icon to validate your choice. 
 

 Open Options Window : Open the contours Status Index. See details 
on  
‘Options’ from the chapter  ‘Settings’. 
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Setting options 

Activate the options Window by clicking the options icon ( ). These are 
the options available on the window (the contours options will appear at the 
upper-left corner of the window): 
 

 Auto elevations – When this option is checked, the program will 
automatically assign the numbering of the contour lines according to 
the plan. Removing this option and running the contours computation 
once again will result in the drawing contours without their elevation 
computation label. Since the contour lines are divided into layers 
according to intervals, it is easy to define for which layers the elevation 
will be written and for which not. This will be discussed in the course of 
this chapter.  

 
 Brackets – This option will cause square brackets to appear around 

the elevation labeling of the contours. This way you can differentiate 
between existing and designed contours.  

 
 Format ‘##’- this option sign will make the elevation labeling in format 

##. For example – whether the elevation label 3.25 was written in a 
marked or unmarked format, it will always be written as 3.25. On the 
other hand,  if the labeling is 3.20, the labeling  can be viewed in two 
different ways: 

 Without the option the elevation will be – 3.2 
 With the option it will be – 3.20 

 
 Scale – Choosing the text font size. The text height will be according to 

the general scale settings (for more details please refer to "Chapter 24, 
Configurations window"). 

 
Note: During the printing process, the labeling will be printed as it is viewed 
in the window. The font size 100 is compatible for printing on the scale of 
approximately 1:100. 

 

Contour lines layers  
 
The contour lines are divided into layers according to the intervals between 
them. For example - all contour lines with intervals of 1 meter will be 
grouped together into one layer (100, 101, 102 etc.). You can control the 
contour layers. The division into layers is dependant on the intervals 
between the contours that were determined during the computation. In the 
Options Window appears the label: ‘Layers’. This is a Layer contours scale 
(graph):  
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Each number represents a different layer. You can browse between layers 
by marking the layer you want using your mouse. The other details that 
appear in the frame, represent the characteristics of the highlighted layer. 
We will now discuss these characteristics: 

 
 Intervals –Intervals in contour lines. As aforesaid, we divide the 

contours to layers according to the intervals between them. In the 
‘Intervals’ Window you can characterize each layer by determining 
which contours will enter it. If, for example you enter 0.5, all contours 
with intervals of 0.5 will enter this layer. A zero interval will notify the 
program to include the lines for which no layers were defined, in the 0.5 
layer group.  

 
If, for example, the segmentation into layers is so:  
  

Interval (M) Layer 
10 0 

5 1 

1 2 

0.25 3 

0 4 

 

 
And you ask for contour lines every 0.1 meters, all contours that do not 
belong to any layers (100.1, 100.2 etc.), will be passed over to layer four.   

 
 Unused – This option will neutralize the marked layer, so that it won’t 

be formed at all. If, for example, you want all the contour lines to enter 
one layer, mark in layer 0, zero intervals, while marking all other layers 
as ‘unused’. 

 
 Auto Elevation – Automatic Elevation labeling. If the main ‘Auto 

Elevation’ option is checked, then all elevation labeling will be done 
automatically. This labeling is affected by the ‘Auto Elevation’ option. 
For a layer that doesn’t need automatic elevation labeling, uncheck the 
marking next to the layer. If, for example, you do not want Auto 
Elevation labeling for layer 0.25, highlight this layer in the list (say it was 
defined as layer 3), and cancel the ‘Auto Elevation’ next to it. 
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Processing points to create contour lines 
 
The creation of contour lines is dependant, aforesaid, on the measurement 
points of the project. There might be points in your project that you will not 
want to include in the creation of contour lines. There are a number of 
ways of dealing with such points: 

 
 Points without elevation – CivilCAD 2016 defines points with no 

elevation. Unlike other CAD tools, CivilCAD 2016 separates between 
points at elevation 0 and points of no elevation. CivilCAD 2016 will 
recognize points with no elevation, and will automatically exclude them 
from the creation of contour lines. 

 
 Freezing points – You can freeze the points that have elevation, yet 

you do not want to include in the creation of contour lines. Freezing the 
points can be done in two ways: 

a. From the list (see details in chapter 
“Coordinates database - icons that affect the list 
and are connected to it”). 

b. From the drawing (see chapter “Coordinate 
database - drawing commands affecting the 
list”). 

 
Let us review the process of freezing a point: 

 
 Click on the word ‘freeze’ from the list of functions in the bottom 

window. 
 Move your cursor to the drawing area and capture one of the points you 

wish to freeze. You will notice that the point had been located in the 
bottom list and that the word ,’<Fr>’ has been added beside it. 

 Click on  and you will be able to view the “freezing” in the drawing. 
 Open the contour lines drawing window and perform line computation. 

 
You will be able to notice the change done to the contour lines according to 
the point you have frozen. If you add the interpolation triangles drawing to 
the contour line computation, you will see that the triangles have been re-
arranged in order to overlook the frozen coordinate.  

 
 Canceling coordinates in the drawing – There may be points in the 

list that you will not want to see in the drawing. Unlike the frozen points, 
these points will not appear in the drawing and will not be included in 
the contour lines computation. In order to remove a point from the 
drawing, you must perform the following steps :   

 Mark the designed point from the bottom list of points. 
 Stand on the points editing line, before the desired point and add 

the “/” mark at the beginning. 
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 Click on  and the point will be erased from the drawing. 

 
 Freezing a point by its code – Even if you don’t want to change the 

point or its original name in the drawing, you might still not want it to 
affect its contour. In this case you can freeze the point by giving it a 
code. The point code will appear in the fifth column of the point (after 
the elevation). Remember that the point that you want to code must 
have some kind of elevation (it can even be zero). The code added to 
the frozen point will be “FR”. 

 
Please see the sample below: 
Our point is: 15    175346.32    176728.76    153.14 

 
 Add the “FR” code in the following manner –  

15    175346.32    176728.76    153.14       FR. 
 Click on the ‘Reorder points’ button (the button with the two blue arrows 

from the bottom, to make the code appear in the proper column). 

 Click on  to update the drawing. 
 To view the change, go back and compute more contour lines.  

 

 

Breaklines 
 
Naming and defining the problem: A breakline is actually a geometric 
definition of a line that will not allow two points that appear on one side of 
the line and the other, to form a triangle, during the contour triangle 
interpolation of the contour lines stage.  
 
This example of a surveyed road will clear things up: 
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From this diagram you can immediately tell that the contour lines received 
are not correct. If you look at the triangle interpolation (see next diagram) 
that was made for this road, you can tell that it is also not correct. Take for 
example points 6, 7, 5, and 15. The interpolation that was received for 
these points is for triangles: 6,7,15 and 5,15,7. Point 7 is an elevated point, 
and you will not necessarily want point 15 to connect to it.  
We would like this interpolation to be made: 5,15,6 and 5, 7, 6. 

 

 
 
Defining the Lines – An example: we will now use breaklines to 
solve the problem. To continue the discussion and run this example, 
open a new project and type in the following list :  

 
147.45 1722.34 1334.69           1  
147.91 1720.00 1336.84           2  
151.64 1719.62 1336.45           3  
148.74 1719.59 1344.39           4  
150.10 1716.48 1355.17           5  
151.15 1712.62 1363.76           6  
151.38 1713.75 1356.89           7  
153.82 1713.68 1356.38           8  
146.83 1728.75 1333.23           9  
146.95 1730.88 1333.64         10  
149.94 1730.88 1333.71         11  
149.63 1723.60 1352.31         12  
149.75 1724.98 1352.80         13  
152.66 1725.29 1354.37         14  
151.10 1719.02 1364.38         15  
151.13 1720.42 1365.50         16  
153.09 1720.61 1366.42         17  
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After you open a new project – open the Breaklines Window and go to – 
Topography->Lines. The Breaklines Window will appear from the right. 
This window is divided into two sections (for more details see Chapter 5 – 
‘Lines Connections’) 

 
 The bottom which contains the breaklines list and enables 

changes in the list, such as deleting an entire line, saving files as 
.dis type files and more. 

 The top which shows the highlighted line (the same line that is 
highlighted in the lines List) and enables to make changes such as 
adding and deleting points from it.  

 
Defining Breaklines  

 
Defining breaklines using ‘Locate’ to choose the points - when this 
window is opened, a new line by the name of 1 will open automatically. 
Click on ‘Locate’ from the options list in the upper window to go to the 
drawing area, and mark a line between coordinates 5 and 6 (mark the line 

by catching first point 5, and then 6). When you finish, click on the  
button to set the line (AutoCAD users can click on ‘S’ from the AutoCAD 
command line). 
 
This definition of breakline will compel the program to perform the correct 
interpolation that will solve the problem (to repeat the interpolation you will 
have to run the contour lines once again). Continue to define more lines : 

Click on  button from the bottom of the breaklines window. A new line 
will open (line number 2). Define this line between points 15,12,9 (click 
again on ‘Locate’ and mark the points according to order. Don’t forget to 

click on  when you finish). 

 
Defining breaklines by typing in point names – open a new line and 
define it Between points 1,4,5. After opening a new line, move with your 
mouse to the text line at the top of the window and point to it. Type the 
number ‘1’ and click ‘Enter’. Continue to type the coordinates 4 and 5. 
When you finish, click ‘Set’. 
We have finished defining the breaklines. Go to ‘Topography -> Contours’ 
and choose the intervals 0.5, and click ‘Apply. The new breaklines will be 
calculated and you will receive the following diagram:   
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You can complete the diagram by defining a specific range for the 
breaklines (as was explained in the section “Basic issues and the defining 
of breaklines range”.  

 
Defining breaklines using Polyline (this option exists for AutoCAD users 
only). 
In addition to the two previous options, you can also define a breakline by 
choosing 3D Polyline from AutoCAD (the breaklines have to be 3D 
Polylines, because Polylines in two dimensions cannot serve as such). To 
use this option, follow these steps: 

 
 Draw a 3D  polylines in AutoCAD that will be used as breaklines. (you 

can use Object Snap for Node and connect between the points 
CivilCAD 2016 had created).  

 Enter the ‘Topography Lines’ window and choose ‘select’ from the 
window on the right.  

 Move to the AutoCAD drawing area and choose the line you want. Click 
‘Enter’. The line will be recorded in the right window.  

 Open a new line (   button) and choose the next line.  

 
Continue and choose all your selected lines.  
 
 
 
Expanding the creation of breaklines: 

 
Creating breaklines for points which were not measured (do not exist in the 
file). Occasionally you will need to draw breaklines for points that have not 
been measured (e.g. building borders etc.). In this case you will need to 
manually add the points to the file in order to connect them. To do so 
please follow the steps below: 
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 Run the contour lines in the project as usual. 
 Use ‘pick’ from the bottom window and choose the points you want to 

add (for a review of this action see the section – “Coordinates Database  
- Drawing commands affecting the list”). Since you are working on a 
three-dimensional background of contour lines, the chosen coordinates 
will automatically get the altitude of the existing model. 

 Click on  to refresh. 
 Go to Topography -> Contours and connect the breaklines between the 

coordinates that were formed.  
 Creating groups of breaking lines from an AutoCAD layer – see chapter 

“Dealing with DWG files – extracting coordinates and lines from a DWG 
file”. 
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Chapter 5: Lines 
connections 
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Lines connections 
 
CivilCAD 2016 makes it possible to define measuring lines – lines usually 
defined as breaklines. This chapter will explain how to define these lines 
using several different methods. While we will be referring in this chapter to 
‘Existing status’ breaklines, all activations described are relevant to ‘Design 
status’ measuring lines. 

 
The topics in this chapter are: 
 

 Defining measuring lines. 
 Changing the lines definition. 
 Commands from ‘Topography/Design lines’ window. 
 Filtering lines from a DWG file. 

 

Defining measuring lines 

 
CivilCAD 2016 software has a few different ways to define measuring lines. 
Using this example will show how to define the measuring lines in a project 
including all possible options (while this sample refers to the creation of 
measuring lines for ‘Existing’ status, it is also relevant to ‘Designed’ 
status measuring lines). 

 
1. From menu activate ‘Topography -> Lines’  
2. In the ‘Lines list’ (under the heading ‘Lines list’) you will find the list 

of lines with one line and no points. Define this line using one of the 
following methods: 

 
 ‘Locate’ – Click on ‘Locate’, go to the drawing window and click on 

points that are already defined in the project and are on the drawing. 
After clicking on each point, the program will add the name of the 
point to the points list (at the top of the ‘Topography lines’ window). 
These points represent the current line (marked in blue) from the 
‘Lines list’.  

 ‘Select’ – Defining a line by choosing a drawn line from the drawing. 
After clicking on ‘Select’, choose a Polyline from the drawing (it is 
preferable that this line is defined a 3D Polyline), and click ‘Enter’. 
The program will create new points starting with ‘DIS’ and add them 
to the coordinates list. In section ‘Filtering Lines from DWG Files’ 
in this chapter, we will show how to filter a number of lines from a 
number of layers in a single command.  

 Typing point names – It is also possible to enter the point names 
manually (if they exist in the coordinates list), by clicking on ‘Name’ 
and entering the name. After entering all the names and clicking 
‘Enter’, the program will draw the line on the drawing according to 
the points.  If there are sequential points (of consequent names), for 
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example: 1000, 1001, 1002, 1003, it is possible to enter 1000 and 
1003 and click ‘Enter’. The program will enter all the points 
sequentially in the ‘Lines list’ and create the line.    

 
 Defining Radiuses – It is possible to define a radius for every line 

using two optional systems: 
1. Defining a radius by entering its value between two points 
and typing the radius value under ‘2Points+R’, in the second 
points line of the two points. 

 

 
 

2. For defining a radius by three points on a line, enter ‘V’ in 
the cell located on the middle points line under ‘3Points’, by 
double-clicking on this field.  

 

 
 

Click on the  button to define the line. To define additional click on  
and repeat sections 2 to4.  
  

After completing the line definition, ‘refresh’ the drawing by clicking  
and the new points and lines will be added to the drawing. The contour 
lines will be updated by activating ‘Topography->Contours’ and clicking 
on the Apply button. 

 

Changing the lines definition 
 

It is possible to determine the presentation of each line in the lines list, and 
the effect it will have on the contour lines. In order to determine these 
settings, mark the desired line or lines from the lines list, and click on the 

Options button -  , the options window will appear: 
 
We will explain the options in this window: 

 

 ‘Type’ - The presentation of the line on the drawing 
 ‘Continues’ – a sequential line (default) 
 ‘Fence’ – a fence sign 
 ‘Left/Right cliff’ – a cliff sign. The direction of the cliff “edges” will 

be determined by choosing ‘Left/or Right’.  
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 ‘Left/Right slope’ – a slope sign. The direction of the cliff “edges” 
will be determined by choosing ‘Left/or Right’. 

 ‘Distances’ – the marking of the intermediate distances between 
and along the line segments. The lettering size will be determined 
according to ‘Width’.  

 

 ‘Layer’ - The layer in which the lines are formed. As default the 
program will create all the lines in one layer. Choosing a different line 
for a certain line, will create it in the chosen layer.  

 
 ‘Width’ – The line width. The width of the line is the parameter for the 

determination of its size. The size will affect the line according to its 
type: 

 
 ‘Fence’ – will be drawn wider, ‘Distances’ – larger lettering for 

distances and so on. 
 

 ‘Closed’ – Open/Closed line: checking this box will turn the breakline 
into a close line. The contour lines will not be calculated for this line and 
a 3D model will not be built. This makes it possible to determine 
structures and other closed forms for which we do not want to draw 
contour lines, or want to add to the volumes calculations. (For more 
details see Chapter 4 “Creating Contour Lines – Defining Areas Not for 
Computation”). 

 

 ‘Breakline’ – Throughout the entire chapter we have shown the usage 
of the ‘Lines’ option for the creation of breaklines only. This 
withstanding, we have also shown many options from this window for a 
quick and easy drawing of lines that are not necessarily breaklines. In 
order to continue using the ‘Topography lines’ window for drawing 
lines that are not breaklines, use the same options as shown, by un-
checking the ‘V’ mark in the field ‘Breakline’. The line will remain in the 
drawing but will not affect the creation of contour lines. 

 
   

Add or reduce dH to break Lines 
 

 From CivilCAD main menu, go to ‘TopographyLines' or 
'DesignLines'. 

 Mark the desired break lines from the lines list and click the 'Add dH to 

selected lines'  button'. 
 In the opened window, enter dH (in meters). Positive value will add dH 

and negative value will reduce dH. 
 Click the 'OK' button. 

 Click the 'Refresh'  button to update the drawing. 
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 From CivilCAD main menu, go to 'TopographyContours' or 
'DesignContours' and rebuild the surface 3D model (contours). 
 

 

Commands from ‘Topography/Design lines’ 
window 
 
In the following section we will review all the options from the ‘Breaklines’ 
window. 

 
1. Top Window: 

 

 - Erasing a point from the list of points that define the line. Mark the 
point that should be erased and click this button. After the change click 
‘Set’.  
 

 - Setting the current line: until the ‘set’ button is activated, the new 
line definitions will not take place (adding/ dropping points, line type etc.). 
 

 - Determining the height for current line according to existing 
status: clicking this button will adjust the line heights for each point 
according to the previous contour lines of the existing status the program 
has created. The program will also change the heights in the coordinates 
list at the relevant points.   
 

 - Determining the existing contour line by the existing status: 
clicking this button will adjust the line heights to each point according to the 
previous existing status contours the program has created. The program 
will also change the heights in the coordinates list with the relevant points.   
 

 - Determination of settings for current line. See detailing in section 
‘Changing the Lines Definitions’ section from this chapter.  
 

 - Filtering lines from the drawing. See detailing in ‘Filtering Lines’ 
section in this chapter. 
 
‘Find’ – Locating a point from the list in the drawing (option ‘Find’ from the 
box ‘Locate’ ‘Select’ etc.). This option exists only for users of AutoCAD. 
Choose ‘Find’ from the list on the right and move to the drawing area. 
Choose the line you wish to locate and click ‘Enter’. The program will 
locate the chosen line from the list and mark it in the ‘Lines List’.  
 
‘Select’ – Defining a line by selecting a drawn line from the drawing.  
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‘Locate’ – Defining a line by locating defined points on the drawing.  
 
 
2.  Bottom Window: 

 

 - Opening a new work line. 
  

 - Erasing a line or a group of lines. Clicking this button will open a 
window with the following options: 

  ‘Only selected lines’ – erasing the marked lines from the lines list. 
 ‘All lines’ – erasing all lines from the list 
 ‘Lines above height factor’ – erasing all lines that include heights 

above the given height, at ‘Height factor’. 
 ‘Lines below height factor’ – erasing all lines that include heights 

below the given height at ‘Height factor’. 
 

 - Importing DIS files. This option is for importing DIS files used to 
define breaklines. Clicking the button will open the files dialog box. Choose 
the file you wish to import. The file will be entered into the project in the 
form of a breakline. The breakline points will be attached upon need to the 
coordinates list (bottom window ‘Topography Coordinates’) and the lines 
definition (line points) will be added to the breaklines list.  
 
The imported dis file is divided to several colums by:    x     y       h        line    
name/point number. In different files there can be a different arrangement 
of columns. By default, the program reads the columns according to a 
certain order. It is possible to control the ‘reading’ by arranging the 
columns according to the file structure (for more details see Chapter 24 – 
“General issues – General Configuration Definitions”). 
 

 - Exporting DIS files. Following the definition of breaklines, it is 
possible to export a DIS file format of these lines. Clicking the button will 
open the files dialog box. Choose the location of the new file and enter its 
name. 
 
CivilCAD allows saving the break lines to file including its definitions 
(Break/Closed/Type etc.). 
 
In order to load these files which were created by CivilCAD: 
 
For break lines of Existing G.L. will be saved in a *.tbl file. 
For break lines of Designed G.L. will be saved in a *.dbl file. 
 

 - Emphasizing an existing line. In cases where the work zone is 
large and built up from many breaklines, it is often a problem to identify 
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pre-defined lines. This option is for emphasizing the lines for recognition 
purposes. Mark the line you wish to identify from the list (see ‘Lines list’), 

and click this button. The line will be colored in yellow. Clicking  will 
cancel this emphasis. 
 

 - Add or Reduce dH to break lines. 
 

 

Filtering lines from a DWG file 
 
CivilCAD 2016 makes it possible to define breaklines by filtering lines 
defined in a DWG file. It is possible to filter all types of lines (Line, 
LwPolyline, 3dPolyline, 2dPolyline). It is best if these lines have heights, 
still it possible to filter the lines without heights and to determine their 
height at a later stage. Using this example we will explain how to operate 
the filter. 

 
 Open a new project in CivilCAD 2016 by selecting ‘File->New Project’. 
 From the AutoCAD menu select ‘File -> Open’ and choose the drawing 

from which you wish to filter the lines.  
 From the CivilCAD 2016 menu select - ‘Topography -> Lines’.  

 Click on  (‘Filter breaklines from DWG file’) 
 From the window that opens choose the shape under ‘Entities’ and the 

layer under ‘Layers’. You can mark this automatically by clicking on 
‘Select’ and marking the line or lines that represent the layer and the 
type of file for filtering.  

 Click ‘Apply, and the program will present a message that will enquire if 
you wish in addition to filtering lines, to add the points of the filtered 
lines to the coordinates list (clicking NO will add them). 

 If there are lines in the list, the program will inquire if you wish to delete 
the existing list or add the new lines to this list.  

 Click on  to refresh the lines in the drawing.  
 Refresh the contour lines in the drawing by choosing ‘Topography -> 

Contours’ and click ‘Apply. If the program gives out the message that a 
few points are without height, it is possible that the filtering was done 
for lines that were missing height for certain points. It is possible to fix 
this by doing one of the following: 

 
1. Correcting the list manually – it is possible to locate the points 

and fix them manually by operating the search button (the button 

). Enter the height (0) in the window that opens, mark ‘Accurate 
Height’ and click ‘OK’. The program will mark the points with height 
‘0’ in the coordinates list. Enter the proper height for each of these 
points.  
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2. Erasing certain lines – it is possible to erase certain lines by 
marking them in the lines list or according to a certain height. (see 
‘Topography->Design lines’ window).    

3. Determining lines height according to topography – mark the 

lines that are missing heights in the lines list and click on  for 

getting the height according to ‘existing status’, or  to get the 
height by ‘designed status’ (see window ‘Topography/Design lines). 

 
 

After fixing the heights of the desired lines, click on  to update the lines 
according to the changes in the coordinates list.  
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Chapter 6: Area 
calculations 
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General  
 
This chapter discusses area computation possibilities using CivilCAD 
2016. The program can perform area computations while integrating the 
data in summarizing graphs. In order to explain the usage of area 
computations, we will perform this demonstration. 
 

1. Open a new project (File: -> New project). 
2. Type in the following list which was measured on the local 

coordinate system: 

 

   
100.0 100.0 1 

133.75 125.32 2 

105.20 129.22 3 

116.56 137.87 4 

108.92 120.28 5 

123.54 126.52 6 

112.83 108.74 7 

125.40 111.06 8 

112.79 98.96 9 

124.70 97.10 10 

112.79 108.96 11 

 
 

After you have finished typing click  to receive the points on your 
screen. If the points do not appear, operate the Zoom Extents from the 

AutoCAD Window or press  (Located in the view toolbar only in stand-
alone mode). 

 
We will now approach area computations: 

 
3. From main menu activate : Topography -> Planes. The Topography 

Planes window will open from the right.  

 
This window is divided into two sections: top and bottom. 

 Bottom – in this section a list of all planes existing in the project will 
appear. 

 Top – this part shows the plane that is currently being worked on – 
introduces its list of points and options. 

 
Opening this window will automatically open a new plane in the 
program bearing the name “1”, assuming there are no other planes 
existing in the project. 
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4.  Changing plane name –change the name of this plane to “a1”. The 

cursor is currently at the top of this window next to –‘Name’. Erase 
(using the key-board) the name “1”, enter the new name (“a1”) and 
click ‘Enter’ when finished. You will see that the name has been 
registered in the Planes list at the bottom of the screen. 

 
 

Defining planes 
 
We will now show how to define planes in the program. 
Note: this explanation is based on the example from the first page of 
this chapter. 

 
 1. Click on 'Locate' from the right window status box:  
 

            
 
 
 

 
Move to the drawing area. Stand on point number 3 (bottom right point) and 
select it with a single mouse click. Continue to choose the remaining points : 
4---> 5---> 6  (4 top right, 5 left, 6 under 5). To close this plane click on the 

 button from the window on the right (users of AutoCAD can enter ‘C’ and 
‘Enter’ from the AutoCAD command line). 
 
We will continue to define the remaining planes: 
 

2.  Adding a new plane: click on the New Plane button ( ) 

 
 
A new plane will be added to the planes list (‘Planes List’ right window). 
Continue to define the boundaries of this plane. Click again on ‘Locate’ and 
move to the drawing area. Mark point 5 as the first point on the plane (the 
point that is at the far left of the previous plane we have defined). Continue 
to connect point 7 as a continuation of the border, but make sure you 
choose it and not point 11 which is close to it  and continue to mark the 

points on the field : 8 (over 7) -->  6 (to the right of 7) and  (or C in the 
AutoCAD command line) to go back to point 5.  

 
Continue to define area 2 in the same way, by points --> 7 --> 9 --> 10 --> 

8 --> 7. After you finish defining the planes, click . The planes names 
will appear on the drawing. 
 

Unused 
Locate  
Pick     
Select   
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Defining planes with radiuses 

There are two methods to define planes with radiuses: 
-To define a radius by entering its value between two points, type the 
radius value below caption 2Points+R on the second point line among 

the two designated points. 
 

 

 
 

 - To define the radius by three points located on the line, click "V" by 
double-clicking the mouse in field 3Point. 

 

 
 

 

Additional Options from the Topography planes window  

 
Top window - more possibilities for the specific plane at hand : 
 

Locating the plane of the points in the bottom points list – Button . Click 
this button to locate in the bottom graph all the coordinates in the current 
plane. They will be marked so that changes can be made on them using 
the various ‘Block’ options. 
Erasing a point from the list of points that define the plane - mark the point 

you wish to erase and click on the erase button - . Click  to confirm 
the change. 

 

 
Bottom window – options on all planes:  

 

 Reading plane files – . Click the button to open the file dialog box. 
You can choose between .dpl type files and .tpl type files, which are 
plane files created by CivilCAD 2016, and .lot type files. This option is 
useful for transferring plane files between projects.  

 Erasing a plane/group of planes – mark the desired plane/s and click 

on the ‘Erase’ button . After the confirmation warning, the planes will 
be erased. 
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 Location of a plane in the drawing – . In order to locate a plane in 
the drawing area, mark the desired plane and click the button. The 

plane will be located and its borders colored in yellow. Click  to 
remove the marking. 
  

 

Display definitions 
 
We have shown how to define planes in the program. Now we will show 
you how to change the characteristics of the planes as they are presented 
in the drawing, namely, in addition to the name of the plane we will show 
its area, border distances and so on.   

 
To control the planes display, please perform the following steps: 
1. In the Planes list, mark the planes for which you wish to change the 

display. To choose a number of planes, use the Ctrl, or Shift buttons. 

2. Click on the Options button -  from the window .The options window 
will appear on the Planes Window. 

3. Here are all possible options from this window: 
 The font scale – to change the plane font size (plane name size, the 

labeling area, and so forth), click on the small arrow to the right of 
‘Default’ in the ‘Scale’ field. Choose your size from the list that will open 
(to view/edit scales table select file->configuration, select the drawing 
environment tab and press on 'system scale'). 

 Coloring the area – Solid + Fill color – If you wish to color the marked 
area, you will first have to mark it as Solid. Afterwards you can choose 
a color to fill in the area by clicking on the square of paint near the label 
‘Fill color’. Choose a color from the window that opens. 

 Plane Names – the presentation of the plane in the drawing (this option 
is marked as default). 

 Area – presenting the area of the plane. 
 Perimeter - presenting the perimeter of the plane. 
 Distances - presenting the distance of the plane by its perimeter. 
 Names of border points – the names of the plane border points. 

Please note that CivilCAD 2016 creates a layer of border points as part 
of the existing points layer. Showing the points name in this option will 
create them in the planes data layer, and position the points labeling in 
a way that is more convenient and easy to read. 

 Elevations of border points – presenting the elevations of the border 
points. 

 Circled – the drawing of circles around the plane’s border points. 
 Border coordinates – presenting the near coordinates border points. 

 
To change the display status, mark ‘V’ in the requested fields and 
click OK. To close the window without making any changes, click 
‘Cancel’. 
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Summarizing table 
 
Once you have finished defining the planes, you can record them in a 
summarizing report. 
 
1. Go to ‘Earthworks -> Topo.Planes’ from the top  bar. A window will 

open from the right with all the data in a summarizing table.  
2. Click ‘Apply’ to receive the Planes Report. In the top part of the window 

appears the list of planes with the word ‘Total’ at the end. When this 
window is opened, the list is automatically marked (colored). When the 
order to show this table is given, (the report-by clicking Apply) , a table 
will be computed and shown for the marked planes only. If you wish to 
narrow the table, you will need to mark only the planes you want and 
click ‘Apply again. The word total signifies whether to introduce the 
summarizing line at the end of the table or not.    

 

3. Present the planes table on the drawing -  
Once clicked, this button adds the quantity table to the drawing. 
Click to go to the drawing area, and choose a location for the table:  

 
 Users of stand alone version – Position the table and click your mouse. 

The table will appear at the chosen location .AutoCAD users Position 
the table and click your mouse A temporary yellow  

 frame will appear at the chosen location. If you wish to change the 
location of the table, choose a new location and mouse click again. 
After choosing a new location, enter “S” (option ‘Set”) in the AutoCAD 
command line. The table will be formed in the chosen spot. 

 
 
More possibilities from this window 

 
It is possible you might want a limited table that will not contain all the data 
(for example: only a list of the planes names and their areas). You can 
reduce the table by controlling the parameters appearing in it: 

 
Area - presenting area columns in the table 
Perimeter - presenting perimeter columns in the table  
Full Report - the detailed definition list of each and every plane in the 

report 
Scale - setting the table font size as it will appear on the drawing   
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Creating a Survey Plan 
 
Creating a Survey Plan with CivilCAD 2016 is very easy. Using the 
following example, we will explain how to operate this module. 
 
First, we need to configure the correct working mode. 
 
1. From CivilCAD main menu, go to: 'FileOpen Project'. 
2. Select 'prototype.prj' project and click the 'Open' button. 

 
 In Windows XP OS, the default location is: 

C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\prototype.prj\ 

 In Windows 7 OS, the default location is: 

C:\ProgramData\SivanDesign\CivilCAD\prototype.prj\ 

3. From CivilCAD main menu, go to: 'FileConfiguration'. 
In 'Drawing environment' Tab, define the desired scale (1:250 ; 1:500 ; 
1:1000) and checkmark the option 'Survey format'. 

4. Click the 'OK' button to save the definitions. 
5. From CivilCAD main menu, go to: 'FileExit'. Click the 'Yes' button to 

save the changes. 
6. From CivilCAD main menu, go to: 'FileNew Project'. 'New Project' 

window will open. 
7. Create a new folder (For example: NG-MN-4592) and in 'File Name' 

define the project's name (For example: NG-MN-4592). 
8. Click the 'Open' button. 
9. In 'Topography Coordinates' menu (at the bottom of the screen), type 

the following coordinates: 
 

100010.500 100020.350 BM7958  

100011.699  99980.258  BM7959 

100026.026 99983.259   BM7960 

100027.944 100015.609 BM7961 

 
10. Click the 'Refresh' button to display the coordinates in the drawing. 

If you cannot see the coordinates, in AutoCAD command line, type: 
ZENTER and then EENTER (Zoom Extents). 
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Note: You can also Load Coordinates list from Excel file. For 
loading coordinates from Excel file – see chapter 2 on pages 30-32. 

11. From CivilCAD main menu, go to: 'TopographyPlanes'. 'Topography 
Planes' menu will open on the right side of the screen. 

12. Type the coordinates' names by order under 'Name' column. 
 

 
 

Note: make sure that after typing each name, you hit the 'ENTER' 
button, otherwise the coordinates will not be stored in CivilCAD's data 
base. 



 

 

Page 88 of 508  
 
 

CivilCAD 2016 Reference manual 

 

13. Click the 'SET'  button and then click the 'Apply' button. 
 

 

 

14. In order to hide the coordinates which were created by CivilCAD (CIVIL 
Layer), in AutoCAD main menu, click the 'Layers Properties Manager' 

button  or type in the command line 'LA' and hit the 'ENTER' button. 
In the opened window, freeze 'CIVIL' layer by clicking the 'Sun' icon. 
The icon will change to 'Snowflake' icon. 

 

 

15. Click the 'X' on the upper left corner of to close the Layers window. 
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Note: The data in the drawing is according to the default definitions 

of 'Survey format' working mode, which was defined prior to the 

Survey Plan creation (in prototype project). 

 

16. To change the drawing scale, in 'TopographyPlanes' menu, click the 

'Options' button . 'Options' window will open. 
Click the Scale button and select the scale from the list. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Note: To change the data display in the drawing, see last paragraph 
(on page 93). 
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17. In order to export the Survey Plan to Layout, from 

'TopographyPlanes' menu, click the 'Create Plan Layout' button . 
18. CivilCAD will create a Layout in AutoCAD by the name: 'SurveyA4'. 
19. Double click on the Header. An Attribute window will open. 

Define the details, e.g.: Plan Number, Owner's Name, Location, etc. 
20. Double click on the Footer. An Attribute window will open. 

Define the details, e.g.: Surveyed By, Prepared By, Checked By, etc. 
 

 

21. In order to move the plan in the layout, double click on the layout within 
the plane's area. A border will be displayed. Use AutoCAD 'Pan' button 

 to move and locate the plane in the layout. 
22. If, the scale was changed while moving the plane, in AutoCAD click the 

'Viewport Scale' button (located under the layout window (on the 
bottom right side) and select the scale from the list (1:250 ; 1:500 ; 
1:1000). 
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23. For printing the Layout, right click on the 'SurveyA4' Layout Tab and 
select the 'Plot' option. 
 

 

24. In the 'Plot' window, define the printer's name and make sure that the 
paper size is changed from 'ISO A4 (210.00 x 297.00 MM)' to 'A4'. 
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25. You can click the 'Preview' button to see the layout before printing. 
26. Click the 'OK' button to print. 
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27. To change the data display in the drawing, in 'TopographyPlanes' 

menu, click the 'Options' button . 'Options' window will open. 
 

 
 

 

 

 

 

 

 

 

Define the plane's 
borders display – 
double lines with 
offset or single 
lines 

 

Define the 
units display 

Define the 
accuracy after 
the decimal 
period  

Define the display 
of the plane's 
border 
coordinates  

Define the trimming 
of the plane's 
border with the 
corner circles 

Define the angles 
display – separated 
or joined, outside or 
inside the plane's 
borders 

 

Define the display of 
Names/Area/Perimeter/D
istances inside or 
outside, top or bottom the 
plane's border 
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Chapter 7: Computations 

of earthworks volumes 
using planes   
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Volumes computations using planes   

 
This chapter and the one following, will deal with the two methods of computing 
Earthworks. Another way to calculate Earthworks that is not discussed in these 
chapters, is using the sections method, which will be elaborated in chapters: 
“Earthworks on Roads” and “Roads Design”.  
 
We will now explain briefly the principle difference between both our methods 
presented in this chapter and the following chapter:  

 
 Computation volumes using planes – this method allows you to 

divide the work area into planes (see planes definition next), according 
to your own personal design division method. When studying this 
method, you will learn what a plane is, how to define a plane, along with 
defining a slope and the computation of dibbling lines. 

 
 Volumes computation using the model to model system – using 

this method you can compute the quantities by dressing the designed 
ground level (a designed ground level can also be the status after 
activation) on the existing ground level, and computation quantity 
intervals between the two layers. 

 
As a rule, in both cases you can receive a detailed report in which the project 
area will be divided into a grid for computing volumes according to our definition, 
as the volumes grid will be “set” on the drawing.   

 

Defining topography status 
 
To begin working, you must prepare a design of the existing topography. You will 
find samples and methods on how to prepare an existing ground level topography 
design in chapter “Road Planning – preparation of settings”. In this chapter you will 
find more methods: 

 
We will now discuss the full list of commands that must be followed in order to 
compute Earthworks using planes division. This explanation will include all the 
steps (from starting a new project to receiving an Earthworks quantity report), and 
might repeat some topics discussed in previous chapters. It is recommended to 
read this chapter thoroughly and follow the instructions step-by-step in order to 
avoid mistakes and repetition.  

 
 Opening a project –To keep things simple, open a new project, name 

it ‘test’ and save it in the CivilCAD/ directory. (Saving in the /CivilCAD 
directory is usually not recommended. It is both more convenient and 
orderly to open a new directory for each project.) From the main menu 
open : File -> New Project. You will see a ‘New Project’ files dialog 
box. Click in the project name ‘test’ in the empty line situated left to the 
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“file name” and click ‘Enter’. The program will transfer you to the new 
project environment (you can see this by the new blue heading that will 
appear at the top of the page and will include the library and the new 
project name you are currently working on (for example: C:\Program 
Files\CivilCAD\Test). 

 
 Creating/importing a coordinator file – existing status. In the 

following example, two methods on how to prepare an existing ground 
level will be detailed: 

 
1. Type the coordinates 
2. Import an external file 
(note - it is possible to fully combine the two methods). 

 
1. Typing the Coordinates 
Bring the text cursor to the points editing line (the empty line is exactly 
under the blue label: ‘Topography Coordinates’ at the bottom of the screen. 
Remember: to bring the text cursor to the line, point on it with your mouse 
and single mouse click).             Type the following coordinates list :  

 
10.15 0 0 1 

11.3 0 100 2 

12 100 100 3 

11.5 100 0 4 

13.5 50 50 C1 

 
Arrange the points in the columns: click on the arrange columns button in 
the (left top button from the list of buttons at the bottom of the screen).  

Refresh the drawing by clicking .  
 
 
2. Reading an External Coordinates File  

 
As promised, it is possible to import an external coordinates file in ASCII 
format. On this file must be a simple text file (as files with a .reg type 
ending, text files with .txt type endings, .pin type files etc.). The program 
can read any type of ASCII file format but in order to work with it, you will 
have to edit the file after reading it (in order to get the existing status). The 
program supplies strong work tools for dealing with ASCII files (reduction 
of columns, addition of characters etc.),  in order to enable compatibility to 
all files types existing in the market.  

 
In this chapter we will not be discussing these options, only mention that at 
the end we must work with ASCII file format :  elevation   x    y   name/point 
number.  Note- elevation is not necessary.     

   

Click on ‘Load’ ( ): to open the dialog box – ‘Load from text file’. Now 
you must tell the program the name of the file you wish to import. In the 
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sample before you, you can exercise on a coordinates file from a different 
project that exists in your computer (example project that was installed with 
the program). Enter the ‘Samples’ directory and choose file Sample7.Tco. 
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Samples\Sample7\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 
 

 
Building the existing ground level – You will now be instructed how to build 
an existing topography design that will serve as a working background. For 
this purpose you will need to build contour lines from the topography points 
at hand. From the main menu choose: ‘Topography -> Contours’. On the 
right side of the screen, in the work board area, a contour lines drawing 
window will appear. Since we are practicing working in optimal conditions 
with only minimum commands, all you need to do in order to draw the 
contour lines is to click ‘Apply”. The program will compute and draw the 
contour lines. 
 
We have now finished preparing the existing ground level topography.  

 

Defining designed planes 
 
After having learned to prepare the existing topography, you can proceed 
to defining the designed planes. 

 
CivilCAD 2016 stores two lists of coordinates for each project – the existing 
status list of coordinates, and the design status list. At the bottom window 
appears the list of points for the existing topography status. By choosing 
‘Design -> Coordinates’ from the main menu, you can transfer to viewing 
the designed status list of points. In order to return and watch the existing 
status points list, choose – ‘Topography -> Coordinates’. 

 
1. Transfer to designed coordinates list (‘Design -> Coordinates’), and click 
the following points:  

 
11.2 20 30 D1 
11.2 30.5 60 D2 
14.3 80 20 1 
14.3 70 70 2 
14.3 72.3 85 3 
14.3 27.5 80 4 

 

2. Space the column coordinates using the ‘Reorder’ button  . 
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3. Click  to refresh the drawing.  
 
Defining planes – Before we start to define the planes in the project, we 
will talk about the definition of a plane. We will distinguish between two 
types of planes : 

 
 A plane that has been defined by border points will be a closed 

shape of any kind. The plane ground level will be computed only by its 
border points (meaning that if there are additional points within the 
shape, after defining the shape, the program will ignore these points 
and build the plane only by its border points). 

 
 A plane that is a base line and slope is defined by the two points that 

are the base slope and the slope ratio (1:2, 1:3 and so on) for cut and 
fill. The plane will be built automatically up to the dibbling line and 
ground. 

 
In our example we will make use of two methods, but instead of defining a 
separate base line and slope for each area, we will order the program to 
build us a “continues slope” for all areas at one time (this will be made 
clearer later on). 

 
1. From the main menu activate : ‘Design->Planes’. In the 

right screen a ‘designed planes’ will appear. Since no planes 
were defined previously, the program had automatically 
opened a new plane, giving it the name ‘1’. This plane will 
appear in the planes list at the bottom of the designed 
planes window, and its definition will appear at the upper 
side of this window (see: plane name). We will continue to 
the definition of the plane. 

 
2. Defining the first plane (1 in our example): using your 

mouse – move the work status from the status list (a list in 
the designed planes window that contains 3 positions), from 
‘unused’ status to ‘locate’ by pointing your mouse to the 
word ‘locate’ from the list. Move your mouse to the plane 
drawing area and choose point ‘1’. Continue to choose the 
following points according to this order: D1, D2, 2. When 
you finish choosing the points, click ‘C' in AutoCAD 
Command Line ('C'= Close). The program will close the 
plane for the first point that was chosen. 

 
3. Opening and defining a new plane – In order to define the 

second plane, you must first open it. Click on  from the 
right window. A new plane, labeled ‘2’, will be added to the 
planes list, and its definition will appear at the top’ designed 
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planes’ window. Define the new plane by these points: 2, 3, 
4, D2. 

 

4. Refresh the drawing – Click the  button above the 
drawing. The drawing will be refreshed the planes names 
will appear on it.  

 
 *Note: “Refreshing” is not mandatory at this present stage. In our 
example we used it   to emphasize the importance of this button 
that actually “reorganizes” our drawing for us.  

 
No marginal slopes were defines for the planes in this chapter, so they will 
be built vertically. In the next chapter we will show how to define planes 
that will carry the borders up to the dibbling line.  

 

More options from the ‘Designed planes' window 
 
Top Window allows activity on the specific plane at hand: 
 

 Locating the plane points from the bottom list of designed points 

– button  click this button, to locate the all the designed points in the 
in the current plane. These points will be marked so they can be edited 
and changed using the various – ‘Block’ commands.  

 Erasing a point from the list of points that define the plane – mark 

the point you wish to delete and press . 
 
 
From the bottom window options you can work on all planes: 

 

 Reading plane files – use the  button to open the file dialog box. 
You can choose between .dpl type files and .tpl type files that are 
planes files created by CivilCAD 2016 and Lot files. This option is 
useful for transferring planes files that were created in a surveying 
setting of a particular project, onto a new surveying background in a 
new project. Please notice that in addition to the .dpl type file that 
should be read from the other project, the designed points list file 
(.dco), should also be read into the designed coordinates list window at 
the bottom.  

 
 Deleting a plane/groups of planes – mark the desired plane/group of 

planes and click on the erase button - . After a warning confirmation 
the files will be deleted.  
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 Locating a plane in the drawing –  in order to locate a plane in the 
drawing, mark the plane you want and click the button. The marked 
plane will be located and its borders painted in yellow. To remove the 

marking click .  
 

 Re-building the planes – button with picture of wall – it is possible that 
a group of planes had been lowered or elevated, by changing the 
elevation of the border points that have created them. In this case, after 

clicking , the program will automatically change the plane elevation 
according to elevation points that were changed. However, in places 
where elevated planes were created and defined as base line and 
slope, the program must again compute the dibbling lines of those 

planes. This is not done automatically (meaning after you click ). To 
activate this option, you must click on the present button. The program 
will notify when this procedure has been completed. After confirmation, 
all planes will be re-built, including all slopes according to the new 
dibbling lines. 

 

 Filtering planes with their names from DWG file -  click  button. 
‘Filtering’ wintow will open on the right side of the screen.Click ‘Select’ 

button .  Select planes’ layer from the drawing and click ‘Enter’. 
The layer and its entity will be marked in the right window relevant 
tables. 

 To filter planes names from DWG file, click on  button. The window 
on Notice that the right has changed to ‘Options’ window. 
Mark ‘V’ in ‘Scan planes names’ and select the planes names layer 
from the list. 
 

 
 
Click OK to return to ‘Filtering’ window and ‘Apply’ to run filter 
operation. 
When filter operation is finished a message window will appear: ‘X 
planes were filtered’. Click OK. 
Notice that the right window has changed to ‘Design planes’ window. 
Click ‘Apply’ to build planes and update drawing. 
 

 Finding a plane in planes list – click on  button. Enter plane’s 
name and click OK. You can also find a plane by clicking ‘Find’ from 
right window status box and click inside plane’s area on drawing. 
The plane will be marked in blue in planes list.   
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Defining slopes 
 
In this chapter we will show how to define slopes according to base line 
and slope definition. When joined with planes that have been defined by 
border points, these planes can serve as slopes for closing up to the 
dibbling point. 

 
The explanation in this chapter relies on the example from the previous 
section –“Defining Designed Planes”. 
 
Create Continuous slope 

 Click on the ‘continuous slope’ button – the button from the right 

. The secondary “continuous slope” window will open, enabling to 
define a continuous slope.  

 
 Enter the “slope in ‘cut’ area and in ‘fill’ area” – bring the cursor to 

the field with the lettering “S1. Cut 1:”, and enter the cut (insert “3” for 
the example). Click ‘Enter’ and the cursor will move to the box on the 
right for defining the fill: “S1. Fill  1:”. Click 2. 

 
 Transfer the status table from the ‘continuous slope’ to ‘Locate’ 

position and mark the points that define the slope according to the 
following order:   

 D1, D2, 4, 3, 2, 1 and close to 1. Please notice that unlike the defining 
of a plane according to border points, you will have to go back and 
close point 1. When you have finished choosing the points, click ‘S' (for 
'Set') in AutoCAD Command Line. 

 Click  to refresh the drawing.  
 
Create line slope 

 Click on the ‘Create line slope’ button . 

 The option 'Select plane' will appear at the command line. 

 Select the desired plane by clicking inside the plane's area. The plane's 
border will be marked in yellow. 

 The option 'Select side' will appear at the command line. 

 Click on the drawing, outside the plane's area. 

 Type the desired slope at the command line and click 'Enter'. 

The software will create slope on the selected side.  
 

 Build corners slopes - click on 'Locate'   , mark the corner's 

points and click on the 'Rebuild' button . 
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Changing plane characteristics 
 
Once you define the designed planes and refresh the drawing (R button), 
the names of all the planes will appear on the drawing. CivilCAD 2016 can 
add many data fields in addition to name such as, cut volume, fill volume, 
area and so on. This chapter will discuss the Status Index options of 
designed planes. 

 
The explanation in this chapter relies on the example introduced earlier in 
this chapter, in the section –“Volume Calculations Using Planes”. 

 
1. Mark the planes that you want to change in the ‘planes list’ from 

the right window . To mark a group of planes, click on the first, 
scroll the list to the last plane of your choice, hold the ‘shift’ 
button and mark.     

2. Go into the plane's options using the ‘options button - . The 
options window will appear. Any change in the options will affect 
all the planes marked in the “planes list”. 

 
 
 
Options from the options window: 

 
 Font size - Scale – to change the plane font size (plane name, 

quantities, etc.), click on the little arrow to the right of ‘Default’ in the 
Scale field. Chose the desired font size from the list that will open. (To 
view/edit the scales list activate: File->Configuration, press on the 
drawing environment tab and click on 'system scale' button) 

 Color Area – Fill color + Solid – If you want to color the marked area, 
you must first mark it as ‘Solid’. Afterwards you can choose the color 
you wish to fill the area by clicking the color square next to the label ‘fill 
color’. Choose the color you want from the window that opens. 

 Cut volume – Show the plan’s cut volume. For the program to 
calculate the cut volume of a certain plain, each of its border points 
must have elevation (in a base line and slope plane, this condition 
exists from the very definition of a plane).   

 Fill volume – Show the plane’s fill volume. 
 Area – Show the plane’s area. 
 Perimeter - Show the plane’s perimeter. 
 Distances - Show the plane’s perimeter distances. 
 Show contours -  Draw the contours of the designed plane. The 

intervals between the contour lines are the same as those in the 
Intervals field in the designed contours window. 

 Names – The names of planes border points. Please note that 
CivilCAD 2016 creates a layer of border points already as part of the 
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designed points. The presentation of point names in this option will 
create them in the plane’s data layer, positioning the writing in a 
convenient and easy-to-read place. 

 Elevations – The designed elevations of the plane’s border points. 
 Circled – Drawing circles around the plane’s border points. 
 Topo. Elevations – Elevation of existing topography status border 

points. The elevation will be will be computed in interpolation from the 
contour lines. 

 Height intervals – Presentation of elevation intervals between existing 
topography status to designed border points status.   

 Coor_ borders – Presentation of border points coordinates. 
 Location – The location of the labeling next to the border points. One 

of the biggest problems that occurs when you show the border point’s 
data on a drawing (elevation interval, designated elevation, current 
elevation, etc.), is the excess of information. Most often, since one 
border point belongs to one or more planes, and has a different 
elevation in each (and for the most part, different intervals), the labels 
will overlap. In order to solve this problem, define a different location for 
each of the data labels: 

 Top – Inserting the elevation name above the point. 
 Inside - Inserting the elevation name inside the plane to which it 

belongs. If you choose –“inside” for joint elevations and a scale that is 
not too big, the data will be inserted into the planes without overlapping.  

 
After you have chosen the desired planes definitions, click ‘OK’ to close the 
options window and Apply on the planes window from the right. The 
program will present the data on the drawing in the relevant locations. 

 

 Clear unused plane's names from coordinates list - . After 
erasing a plane from planes list, click this button to erase unused 
planes coordinates from coordinates list.  
 

 Update current plane - . When designing a large 
number of planes, use this option to update planes without performing 
3D model. 
Changes will appear on screen but 3D model of planes with the new 
changes will not be built. 
Note: earthworks will be calculated according to the last 3D model 
performed. 
 

 Update all planes - . After designing a large number of 
planes, use this option to build planes 3D model. 
Changes will appear on screen and 3d model of planes with the new 
changes will be built. 

 Sort - . Click this button to sort planes list by name automatically. 
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 Order planes list - . Select the desired plane from planes list and 
click 'Up' arrow or 'Down' arrow to move the plane up or down in the 
Planes list. 
 

 Add Height To Current Plane - . Click this button. 
1. Select the plane by clicking inside its area. The plane's border will be 

marked in Yellow. 

2. At the command line, type the height and click 'Enter'. 

 
 Define Planes Height By Line & Slope  

 

1. Click the ‘Add height to current plane’  button. 

2. In AutoCAD Command line, you will be asked to select a plane. 

3. Click using the left mouse button inside the plane on the drawing. The 
plane’s contour will be marked in yellow. 

4. In AutoCAD Command line, type ‘S’ for ‘Slope’ and hit ‘Enter’ button. 

5. In AutoCAD Command line, you will be asked to select a side. 

6. Click using the left mouse button inside the plane close to the side 
where you want the slope to begin from. 

7. In AutoCAD Command line, you will be asked to enter height for the 
first point. 

8. Type the height for the first point (clockwise). 

9. In AutoCAD Command line, you will be asked to enter height for the 
second point. 

10. Type the height for the second point (clockwise). 

11.  In AutoCAD Command line, you will be asked to enter the slope. 

12. Type the desired slope (%) and hit ‘Enter’ button. 

13. CivilCAD will calculate the planes heights in each vertex according to 
definitions. 

14. Click ‘Apply’ button to build the 3D model of the plane. 

 

Note: The heights will be calculated in perpendicular to the side of the 
plane which was selected. 

 

The heights will be added to the plane's corners according to the slope.  
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The Height will be calculated perpendicular to the selected line for 
the slope to start from. 

 

 

Design planes with corner radius 
 
1. From CivilCAD main menu, go to ‘DesignPlanes’. 

2. Select the polyline of the plane and hit the ‘Enter’ button. The plane 
should have a corner radius in one or more of its corners. 

3. ‘Arc Segmentation’ window will be opened. 

4. Define the segment’s length (in meters) and click the ‘OK’ button. 

 

5. CivilCAD will create the plane and divide the radius to segments. 

 
 
 

Calculate plane’s heights according to 3 points 
(with heights) 
 
1. From CivilCAD main menu, go to ‘DesignPlanes’. 

2. Design a plane a click the ‘Apply’ button to build 3D model of the 
plane. 

3. Click the ‘Add height to current plane’  button. 

4. In AutoCAD Command line, you will be asked to select a plane. 

5. Click using the left mouse button inside the plane on the drawing. The 
plane’s contour will be marked in yellow. 

6. In AutoCAD Command line, type ‘C’ for ‘Calculate Heights by 3 Points’ 
and hit ‘Enter’ button. 

7. In AutoCAD Command line, you will be asked to mark the first point. 

8. Click using the left mouse button on one of the plane’s vertex (with 
height). 

9. In AutoCAD Command line, you will be asked to mark the second 
point. 
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10. Click using the left mouse button on one of the plane’s vertex (with 
height). 

11. In AutoCAD Command line, you will be asked to mark the third point. 

12. Click again using the left mouse button on one of the plane’s vertex 
(with height). 

13. CivilCAD will calculate the plane’s heights according to these 3 points. 

14. Click ‘Apply’ button to build 3D model of the plane. 

 

 
 

Summarizing table 
 
In section “Volumes computations using planes”, we have explained how 
to define designed planes. At the final stage of the planes definition 
process, you will receive the cut and fill volume quantities summarizing 
table. 

 
 
Use the example from chapter “Volume computations using planes” and 
apply in to this section: 

 
1. From the main menu go to – Earthworks  --> Designed planes, from 

the right side of the screen the ‘Designed Planes Earthwork” window 
will open. 

 
2. Check ‘v’ next to the ‘full report’ option and click Apply. The 

Earthworks report will appear. The report will include a summarizing 
table with the list of all the planes that were defined in the project, 
including slopes. For each plane the following data will appear – cut 
volume, fill volume, cut area, fill area, the entire area and perimeter. 
To scroll the report, use the arrows from the right. You will get 
details on the coordinates that define each and every plane. 

 
3. Please note that the ‘full report’ mark introduces a full report that 

includes the detailing of planes data but does not include the 
summarizing report. 

 
4. Print the report by clicking the ‘print’ button at the bottom. In the 

print window that opens, define the parameters you want and click 
‘continue’.  

 
5. We will now go over the options for this window:  

 
 Plane’s list – This list will contain all the designed planes in the project 

with the addition of the ‘Total’ line. When the window opens, all the 



 

 

Page 107 of 508  
 
 

CivilCAD 2016 Reference manual 

planes will be marked automatically including ‘total’. When you click 
‘Apply’ to get the report, the data will be computed for all the marked 
planes. If you wish to present only some of the planes in the report, 
mark the ones you wish to display. The word ‘Total’ signifies that in 
addition to the chosen planes data, the summarizing/full report will 
include a total line.  

 
 dH - The height interval field allows a quick and easy leveling of 

Earthworks. With the help of this field it is possible to know the 
Earthworks height, had you changed the height of all designed planes 
by a certain interval. Insert the desired height interval in this field, in 
meters, and click ‘Apply. The new report that will appear will be based 
on the original designed elevation in addition to the height intervals that 
were inserted. This makes it easy to get quantity estimations for the 
different elevations, and after you have attained the proper elevation, 
you can go back and manually change the designed elevation in the 
planes as you see fit. 

Note - To lower the elevation insert a negative height interval. 
 

 Setting the desired report data:   
Cut vol -.  The cut volume in planes. 

Fill vol -.  The fill volume in planes. 

Area- Plane Area. 

Cut area- The cut planes. 

Fill area- The fill planes area. 

Perimeter- The planes perimeter. 
 

 Full report – A detailed report of the planes (in addition to the 
summarizing table). 

 Scale – The font size of the quantity report, for when the report is 
added on the drawing (see button – “adding report onto drawing”).  

 Caption - The title of the report received. To change the title in the 

report erase the title “Planes earthworks” and insert the new title. Note: 
this option exists only for reports in English. 

 Adding the report to the drawing – . To activate click this button, 
move to the drawing area and choose the desired location for the 
report: 

 
Stand alone users only – position the report where you want it 
to appear and click your mouse. The report will appear in the 
location of your choice.  
AutoCAD users – position the report and click your mouse. A 
temporary yellow frame will appear in the location you chose. If 
you wish to change the location of the report, choose a new 
location and mouse click again. After you choosing, insert “S” 
(option ‘Set’) in the AutoCAD command line. The report will 
appear in the desired location.        
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Elaboration: designed elevation of planes 
 
During this chapter, in the “Defining designed planes” section, we have 
shown how to define designed planes in the program. We have inserted 
the elevations definition to the plane’s points as part of the coordinate of 

the point, in the ‘designed coordinates’ list. Each time you click on , 
CivilCAD goes through all the designed planes and updates the plane’s 
elevations points according to the bottom list.  This means that if you want 
to change the elevation of a designed plane, change it in the points list and 

click on . The elevation change will be inserted automatically into the 
plane’s point definition, so that if you point on a plane from the ‘planes list’ 
in order to view it in the upper side of the planes window, you will see that 
the elevation of the point has been updated.  One of the main problems 
occurs when a certain point has more than one elevation. When a point is 
joint to more than one plane, this creates a problem. One solution is 
creating a new point with a new name, at the same location as the existing 
point, and define it for the new plane. There is also another solution. 

 
Defining an elevation for a point can be done by these two methods: 

1. Inserting the elevation, as was demonstrated, as part of the 
coordinate of the point in the list of designed points. 

2. Inserting elevation to a point in the plane itself. To define 
elevation in the plane itself, choose the desired point in the plane 
from the list of the plane’s point list in the right window. The point 
will be transferred to the head of the window, to the editing line, and 
the cursor will be located exactly in the elevation field. Insert the 
new elevation and click ‘Enter’. After the change click on the ‘Apply' 
button. 

 
Please notice this important rule: If a point has elevation in the list of 
‘designed coordinates’ (bottom list), then the elevation is the one that 
“counts”. This means that even if you change this elevation in the point 

definition of the plane, after clicking on , the elevation from the bottom 
list will return and erase the inserted elevation. In order to insert elevation 
to a point using method 2 (in the plane definition  itself), you will first have 
to first erase the elevation of the point from the ‘Designed coordinates’ list, 
and only then change it in the plane itself.  
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Chapter 8: Computation of 
earthworks volumes using 

the model-to-model 
system 



 

 

Page 110 of 508  
 
 

CivilCAD 2016 Reference manual 

 

Computation of earthworks volumes using the 
model-to-model system 
 
In the last chapter we discussed the computation of volumes by division 
into planes. This method of quantity computation is typical of an area that 
underwent homogenous development work such as ground leveling, 
parcellation division etc. The part of the chapter discusses quantity 
computations on the entire work area. The advantage of this method is that 
is compatible with all area types. Its disadvantage in comparison to the first 
method, is that it is harder and less convenient to control when applied to 
the above-mentioned areas (parceling etc.). 

 
We shall demonstrate the computation method in this chapter using an 
example. In this example, we will briefly cover the basic line of operations 
for a standard project, and will go into detail on subjects connected to 
quantity computations. The computation steps are as follows: 

 
1. Open a new project  
2. Input the data for the existing topography – define “existing 

topography” as the topography area before it was changed.  
3. Compute the contour lines of the existing topography. 
4. Input the data for the designed topography – define “designed 

topography” as the status of the area after it was changed. 
5. Process the designed data and define the computation area/ and 

the areas that are not for computation. 
6. Compute the contour lines designed topography status. 
7. Produce a report and detailing of the Earthwork quantity. 
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Preparing a model of the existing topography 
 
Preparing the contour lines of the topography for the purpose of computing 
quantities is identical to the preparation of contour lines, described in 
chapter 4: “Creating Contour lines”. We shall review the steps briefly: 
 

1. Open up a new project. 
2. Type in the following list of coordinates into the coordinate table in 

the bottom, “Topography Coordinates” window:  

 
11 0 0 1 
12.5 100 0 2 

  
13.2 

100 100 3 

10 0 100 4 
15.7 50 50 5 
14.8 37.25 25 6 
11.5 10 10 7 
11.7 10 80 8 
11.9 90.5 11 

 
9 

 
These coordinates will constitute an existing Topography status, i.e. the 
topography area before it was changed. When you have finished typing the 

list, click on  to present it in the drawing. 
 

Note: the example used here uses manual data typing. In order to read the 

measurement data from the file, click on the ‘files open’ button , and 
select the desired file (see example in chapter “Creating Contour Lines”). 

 
3. Computation of contour lines  

From the main menu, go to Topography -> Contours. On the right 
side of the screen, the  ‘Topography Contours’ window will open. 
Click OK to compute contour lines. Since the spaces between 
contour lines have not been defined, they will be selected 
automatically and will be set to 1 meter (for space definitions see 
chapter 4)  
 
At this stage, the three-dimensional model which will be used as a 
basis for volumes computation has been prepared. This mode will 
be computed in triangles interpolation.  
 
You can see the interpolation elevations by bringing the cursor to 
the drawing area and clicking the left mouse button. The existing 
elevation of the cursor position will appear at the bottom of the 
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window, near the Height_T label. Please notice the Height_D label, 
showing the designed elevation (if available). 
Note AutoCAD users- to get the existing elevation, please press the 

Pick height ( ) button (located in CivilCAD 2016 standard toolbar), 
go to the drawing area and click to receive the elevation of the 
cursor position. 
 
By clicking your mouse button in different areas of the drawing, you 
can know precisely where the designed model was computed, even 
if the drawing layer of the designed contour lines was frozen, erased 
or more simply there were no designed contour lines in the area (i.e. 
a plateau). All you have to do is move on the drawing, click your 
mouse and locate the intervals between Height_T and Height_D. 

 
4. Changing the color of the Existing Topography layer:  

For the sake of convenience, change the color of the existing 
topography layers to light gray, so that it will seem as background. 
CivilCAD 2016 creates fixed layers to existing topography contour 
lines, and fixed layers for the designed topography contour lines. 
The contour lines layers of the existing topography will start at 
‘Topography Contours’ (for AutoCAD users, the names of these 
layers will start at ‘Tcontours’). 
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Input of designed topography data/ or As Made 
 
As mentioned above, we defined the as made data as the design data. In 
this part of the chapter, we will now show how to input the designed data 
onto the existing topography.  
The example relies on the same example from an earlier section in this 
chapter “Computation of Earthworks Volumes Using the Model to Model 
System”. 

 
1. Go to Design -> Coordinates. The list of coordinates in the bottom 

window will change from ‘Topography Coordinates’ to ‘Designed 
Coordinates’. 

 
2. Type in the following list as designed coordinates: 

 
Name East North Height  
1 51.66   78.79 14.15 
2 71.13 66.72  15.01 
3 62.90 45.29 14.94 
4 85.94 39.29 12.72 
5 69.21 22.01 13.42 
6 77.71 14.06 12.51 
7 48.64 11.87 12.35 
8 22.59 23.39 13.59 
9 11.34 40.39 12.28 
10 20.67 67.82 13.86 
11 50.56 25.58 13.98 
12 56.32 36.55 14.94 
13 40.96 36.55 15.10 
14 46.45 30.52 14.50 
15 46.45 19.82 13.30 
16 59.34 21.19 13.44 

 
 

After typing the list click on  to refresh the draw and present the points. 

 
CivilCAD 2016 manages two lists for each project: a list of points for the 
existing topography and a list of coordinates for the designed topography. 
When CivilCAD 2016 is activated, it presents in the bottom window the 
existing Topography list only (Topography Coordinates). You can browse 
from one list to the other by choosing between ‘Topography -> 
Coordinates’ and ‘Design -> Topography’ from the main menu. With each 
selection, the bottom list will be replaced with the list of your choice. 
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Defining zones excluded from the earthworks 
computation 
 
Often enough, you will come across areas on which you will not 

want to perform volumes computations. In order to define these 
areas, we will have to make sure that the CivilCAD 2016 does not 

create contour lines for them. The CivilCAD 2016 program 
computes volumes only for areas where there is an overlap 

between existing and designed contour lines (unless one of the 
areas is a plateau, and even then in the program will do the 

volumes computations). The best way to define an area that is 
not intended to undergo volume computations is to border it with 

a breakline that is defined as closed. It shall be noted that a 

closed breakline can be defined both in the Existing and in the 
Designed Topography, so that for every area defined by such a 

line, either in the Existing or in the Designed Topography (or in 
both), the program will not perform volume computations. 

 
Note: for a detailed explanation on defining a closed breakline, 

see “Creating Contour lines – breaklines/defining ranges to be 
excluded from the contours computation”. 

 

We shall continue with the example we have been using in the 
present chapter to explain the subject.  

 
From the main menu toolbar, choose Design -> Lines. On the 

right, the Design-Lines window will appear. 
 

Several methods for defining or choosing coordinates for defining 
breaklines have been enumerated in this booklet. We shall use 

one of these methods: 
 

Make sure that the text cursor (a blinking hook) is located within 
the breaklines typing line. This is the empty line located under 

the blue title ‘Designed Lines on the right side of the screen (if 
the text cursor is not within this line, you can bring it there by 

clicking the mouse cursor on the said line). Type in the following 

list: 3,5,16,15,11,14,13,12,3 (press ENTER after each number). 
  Since we wish a closed shape without contours, we will open the 

options window and define this line as closed. To open the 

options window, click on button  and mark "V" near the 

caption 'Closed' in the opened window (below caption "Lines").In 
certain situations, we may wish a closed  breakline that will 

contain the contours (and earthworks computation) . To do so, 
we'll close the form as we did earlier but this time, we won't 
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mark "V" near the caption 'Closed. To finish the line/shape 

definition, click 'OK ' and in the right window click . 
  

 

Defining zones that are included in the 
earthworks computation 
 

The volumes computation area will include areas where there is 
an overlap between the Existing Topography contour lines, and 

the Designed Topography contour lines. Defining the range of an 
existing contour lines area is not highly important for computing 

volumes. In contrast the defining a range of the designed contour 

lines area is important and has to be done in a meticulous 
manner. When running contour lines for a designed topography 

without defining the range, we run the risk of having the program 
perform interpolations we do not want. These interpolations will 

mainly be at the edges of the topography, since the program 
performs interpolations between every two adjacent coordinates, 

even if they are far apart from each other, which sometimes 
leads to the creation of unwanted triangles (interpolation 

triangles). There are 3 main methods that we can use in order to 
avoid creating such triangles. These 3 methods are activated in 

the Design ->Contours window (activation from the main menu 
toolbar): 

 
Defining a border with border coordinates – defining a 

precise border by defining its perimeter, within which the 

program will create the designed contour lines.  
The ‘Fix Borders’ method – activating an automatic option, 

with which the program will minimize the designed contour line 
borders to an optimum, set in a way that is not in the user’s 

control. 
The Max Interpolation Length method – defining a maximum 

distance for interpolating between coordinates. After defining 
such a distance, the program will create interpolation triangles 

only between coordinates that are separated by a length shorter 
than the one that has been defined. 

 
For a detailed explanation of operating each of these methods, 

see “Creating contour lines - basic issues and defining the range 
of contour lines”. 
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Preparing a model of the designed topography  
 

In principle, the process of creating contour lines for the 
designed topography is almost entirely identical to the process of 

creating contour lines for the existing topography, except for the 

screens in which the process is carried out. The contour lines for 
the designed topography can be created only on the background 

of contour lines for an existing topography. CivilCAD 2016 will 
create these lines automatically in new layers for the existing 

topography contours layers. 
 

From the main menu toolbar, go to Design -> Coordinates. On 
the right-hand side, a contour line creation window will open.  

In the right-hand side window, click Apply. The program will 
compute contour lines and will create them. 

 
As explained, in the two previous parts of the chapter (“Defining 

zone to be excluded from the computation” and “Defining zone to 
be excluded from the computation”), the same operations that 

can be performed on the designed contour lines, can be 

performed on existing contours. All the operations having to do 
with designed contour lines will be performed on the designed list 

of coordinates, i.e. ‘Designed Coordinates’ (the contour lines of 
the existing topography are computed on the existing list of 

coordinates – ‘Topography Coordinates’), the breaklines will be 
defined in the ‘Designed Lines’ window, and as mentioned above, 

the borders of the designed contour lines will be defined in the 
‘Designed Contours’ window.  

 
After computing the designed contour lines, the program creates 

a new three-dimensional model, in addition to the existing 
model. If we go in the drawing, to an area where both existing 

contour lines and designed contour lines were computed (overlap 
areas), and click with the mouse button, we will be able to see 

two elevations for these areas. These elevations can be viewed in 

both fields, Height_T for the existing and Height_D for the 
designed, which appear under the drawing window. AutoCAD 

users will use the ‘Pick Height’ option for carrying out this 

process, as follows: Click on , located above the drawing 

window on the main toolbar, with a ‘v’. Go over to the drawing 
area and click with the mouse on an area of contour lines 

overlap. You will notice that the program presents the 
interpolation in the Height_T and Height_D fields as explained 

above.  
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Volumes table – 'General Earthworks' window 
 

In the course of this chapter, we followed the steps for 
performing earthworks computations using the “model to model” 

system. Having finished the computation for the designed 

contour lines, all that is left to do, is to obtain the sum of the 
quantity computations. In order to do so, we will open the 

General Earthworks window. From the main menu toolbar, go to 
Earthworks  General. On the right-hand side, a “General 

Earthworks” window will open.  
 

Computing general earthworks without a grid (“the exact 
method”) – in the window that has opened, click OK. The 

program will compute the differences between the two layers 
(existing topography model and designed topography model), for 

the entire project, and present a volumes report, which will 

include: cut volume, fill volume, cut area (approximately), fill 
area (approximately).CivilCAD 2016 offers several methods for 

computing Earthworks (one of these methods, “the squares grid 
method”), will be explained shortly. Inevitably, there will be 

differences between these methods. It shall be noted that the 
method that had just been presented (clicking OK in the window 

with no prior definitions), is the most exact method, hence its 
name. The problem with this method is lies in verifying the 

computation. This method does not allow for any follow-up of the 
way the quantities were computed (by the user), and this leads 

to problems in presenting these quantities, for example, for 
inspection purposes.  

 
The squares/quadrangular grid method – in the right-hand 

window, mark with a ‘v’ the ‘Create Full Grid’ field. In the “Grid’s 
steps” fields, type in X and Y the spaces in the squares grid, in 

the X direction and in the Y direction (default is 10x10). Click 

‘OK’ in this window. The program will compute volumes for the 
entire project, using the squares method. The grid division will 

appear on the drawing, and in addition the program will create a 
quantities report in which the ‘cut’ and ‘fill’ volumes will be 

mentioned for each square, intermediate sums for every 10 
squares, and the total concentrated quantities for the entire 

project. Differences in result in   calculation will exist if the box 
near caption "Create full grid" was marked or not. In order to get 

an accurate result when the “create full grid” box is marked, click 
"V" near the caption “Use accurate system" (this caption will be 
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displayed only when "Create full grid" option is marked) and click 

"Apply"  
 

Defining the volumes computation area – in the methods 
that we have just seen, the computation of quantities for the 

entire project was presented. In general, the computation area 
can be defined by the designed contour lines area. However, in 

the squares grid method, when computing quantities for the 
entire project, a grid will be created even in areas where there is 

no overlap between an existing topography and a designed 
topography. The cut volume for these squares will be 0, and 

therefore they will not affect the volume computations. For 
aesthetical and convenience reasons, we may therefore prefer to 

minimize the grid (which includes minimizing the accompanying 

report). In order to define an area for volume computations (both 
for the squares method and for the exact method), perform the 

following steps: 
 

- In the right-hand window, make sure you are using the desired 
method (‘Create full grid’ – marked for the squares grid method 

or unmarked for the exact method). 
- Select ‘Pick’ in the check box on the right, go over to the 

drawing area and define the borders for the desired area for 
computation purposes. To complete defining the borders, click on 

the “Set” button on the right (AutoCAD users can type in ‘S’ in 
the commands line). AutoCAD users can define the computation 

borders by taking the following steps: 
 
Draw a polyline that will define the computation area. 
Choose ‘Select’ from the check box on the right. 
Go over to the drawing area and select the polyline that you have drawn. 

  

- Click Apply. The program will compute the volumes according to 
the defined method within the selected area only. 

 
 

Balancing quantities using the Add to design field – this 
field is intended mainly for Earthworks leveling in a designed 

project. Such a project can be a water reservoir, designed planes 
or contour lines designed according to elevation points. This field 

can be used by entering the desired elevation addition to the 
project (in meters) and clicking OK. The program will compute 

and present a new report in which quantities will be computed so 
that the project’s design is higher than the original design by the 

elevation that has been entered. To lower the project’s elevation, 
enter a negative addition (for example: “-1.05”). Using this 
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method of changing the designed height of the project, a leveling 

of earthworks can be easily obtained, without changing the 
physical contours. Note: In the quantities report that is obtained, 

you will also see the ratio between the cut and the fill in the 
project. This data allows for easier follow-up of the leveling that 

was obtained. 
 

Stripping earthworks - Stripping depth – to compute 
volumes in a project that requires stripping of the work area, 

enter the stripping depth (in meters) in the cut area (Cut ar.), 
and in the fill area (Full ar.), and click ‘OK’. The program will 

recompute the project volumes, and will present a report which 
will include earthworks quantities after taking into account the 

depth of the stripping that has been entered, including the 

stripping volumes for ‘cut’ and ‘fill’. 
 

Note: if there is no stripping in one of the areas (cut or ‘fill’), 
leave the desired field blank or enter “0”. 

 
Presenting the quantities report on the drawing – to 

present the quantities report on the drawing, perform the 
following steps: 
First, produce a report in a regular manner by clicking OK. 

Click on the button . 
Go over to the drawing area: 
 
For Stand alone version : place the table in the desired area, and click with 
the mouse. The program will create a layer for the report. 
For AutoCAD version : place the table in the desired area, and click with 
the mouse. A yellow frame will appear in the place that is intended for the 
report. If the placement is acceptable, enter “S” in the command line. If not, 
go back and place the table in the desired place. After clicking “S”, a layer 
containing the desired report will be created.  

 
 
Buttons appearing in this window and their functions: 

 

Locating the computation borders –  - clicking this button will locate 
the volume computation borders and color them yellow. After clicking “R” 
(the big button on the right side of the drawing), these borders will 
disappear. This way you can locate the borders of the volumes 
computations which you have defined. 
 

Erasing the computation borders –  – after clicking this button, the 
program will warn you that it is about to erase the computation borders that 
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have been defined. After confirming this notice, if no new borders are 
defined, the next set of computations will be made for the entire area of the 
project. 
 

Erasing a border coordinate –  – highlight the point in the right-hand 
window and click this button. The point will be erased from the list and the 
new computation borders will be redefined. To confirm this action, click on 
the “Set” button. Clicking OK will lead to a re-computation according to the 
new borders. Using this function combined with the ‘Pick’ function, you can 
edit the volumes computation borders as desired. It shall be noted that in 
order to modify the computation borders, it is possible to highlight one of 
the points in the points list on the right, click on ‘Pick’ once more and go to 
the drawing area. The program will draw a line from the points to which you 
were pointing, so that choosing new computation border points will be 
added after the highlighted point. 
 

Modifying the computation border for the entire project –  – after 
clicking this button, a warning notice will appear. After confirming this 
notice, the volume computation borders will be modified so that the 
computed area will be that of the entire project. This action is in effect 
identical to the action of erasing drawing borders. 
 

The Options button  – window definitions for the general Earthworks 
window – this button will open the Definition window that is part of the 
general earthworks window. For more options from this window, continue 
reading. 
 
 
Options from the Status window (general earthworks definition 
window): 

 
Scale – setting the text size – in this field, you can define the text size in 
both the volumes grid and the volumes report location in the drawing. To 
modify the presented size, click on the small arrow button on the right side 
of the field, and re-select the size. The presented size is a factor. With 
each larger factor, the text size will be larger. 
 
 *Note: the text size will not change immediately. Click ‘OK’ to confirm 
the change, and perform an additional computation (OK button) in the 
main window. To construct a new volume table, go back and repeat 
the necessary steps. 
 
Volumes – presenting volumes within the grid. For each square in the 
volumes grid, the square number and its cut and fill volumes are 
presented. Unchecking the ‘v’ from this field will remove the volumes 
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labeling within the drawing, and will leave only the square number. The 
quantities report accompanying the drawing will not change. 
 
Designed elevations – presenting the designed height in every corner of 
the grid. Unchecking the ‘v’ from this field will remove the presentation of 
this elevation.  
 Brackets - Presenting the designed elevation in brackets. 
 
Topo. Elevations – presenting the existing elevation in every corner of the 
grid. Removing the ‘v’ from this field will remove the presentation of the 
existing elevation. 
Barracks - Presenting the existing elevation in brackets. 
 
Height intervals – presenting the heights intervals between the existing 
and the designed in the grid corners. Unchecking the ‘v’ from the field will 
remove the presentation of these intervals. 
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Chapter 9: Earthworks - 
additional issues 
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Earthworks - additional issues 

 
In chapters “Volumes computations using planes” and “Volumes 
computations using the Model-to-Model system”, two methods for 
computing Earthworks were taught: 
 
Showing the quantities in a planes report – this method is possible only 
when you are computing quantities by planes – for details see chapter 6 
“Volumes computations using planes – receiving a summary report”. 
 
Showing the quantities in the exact method – this method is possible both 
for computation using the planes method, and the mode-to-model method. 
For details see chapter 7 “Volumes computations using the Model-to- 
Model system – receiving the volumes table general Earthworks Window”.  
 
Showing the quantities using a square grid – this method is possible 
computation using both the planes method, and the mode-to-model 
method. For details see chapter 7 “Volumes computations using the 
Model-to-Model system – receiving the volumes table general Earthworks 
Window”.  
 
 
This chapter introduces a number of issues connected with Earthworks 
made possible by our program, and that have not been specified in 
previous chapters: 
 
Earthworks computations using triangles. 
Earthworks leveling grid. 
Earthworks contour lines (including the "0" line). 
 

 

Earthworks computations using the triangles 
system 
 
As a rule, computing Earthworks in the triangles system is possible only 
when you compute volumes in the “Model to Model” system. 
This system enables the presenting of volumes computations in the 
drawing, and is accompanied by a triangle interpolation report of the 
designed contour lines. We will go over the steps to operate this option: 
 

 Go back and compute the topography contour lines 
against the designed contour lines, as explained in 
chapter 7 “Computing Volumes in the Model to Model 
System”. After you finish preparing the designed 
contour lines, continue to follow the instructions from 
this chapter (not in the original chapter). 
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 After you have the original contour lines on the 
existing contour lines, activate: ‘Earthworks -> 
Triangles’, from the main menu. The triangles 
computation window will open from the right.  

 Click ‘OK’ from the window that opens. The program 
will compute and show the triangle grid on the 
drawing. For each triangle the program will show a 
serial number and the existing and designed height 
interval intervals at its edges. A report showing the 
area and volume for ‘cut’ and ‘fill’ for each of these 
triangles, will accompany the drawing.       
 
The triangle grid will be built on the basis of the contour lines and the 
designed breaklines. In each triangle corner, a triangle grid data of the 
drawing layer will be received along with the designed elevation points 
layer. 

 
Additional options from this window 

 
1. Adding to the designed elevation – Add to design – in this field you 

can enter an addition to the designed elevation (in meters), so the 
report is computed according to this addition. To lower the elevation, 
enter a negative number (for example “-1.05”). The advantage here is 
the speed of operation – the program will not change the elevation of 
the designed points in the project, but compute the quantities and 
present the report according to this change. 

 
2. Stripping depth – to a project that has stripping in the work area. Enter 

the stripping as depth (in meters), while separating to stripping depth 
‘cut’ area (Cut ar.) and stripping depth ‘fill’ area. Enter ‘0’ (or leave the 
field empty) for the desired area, in a project in which there is stripping 
for only one of its areas. The program will compute the quantities 
according to the stripping that was entered, as the stripping depth in 
‘cut’ will reduce from the cut quantity, and the stripping depth in ‘fill’ will 
add to the fill quantity.  

 

3. Adding the Volumes table to the drawing -  – allows for adding 
the volumes table in a desired place in the drawing. To operate follow 
these steps: 

 
Note: These steps are possible only after computing a report as explained 
in the beginning of the chapter, and producing an ordinary report. Go over 
the following steps in order to position the report in the drawing: 
 

 Click on the button. 
  Move to the drawing area and position the table in 

the desired location. 
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 Users of Stand-Alone version – click with your 
mouse to set the table in the drawing. The program 
will create a layer of the report that will be saved as 
part of the drawing.  

 Users of AutoCAD – click with your mouse to set 
the table. A yellow frame will appear on the 
drawing, in which the table will be positioned. To 
choose a different location, move to the new area 
and click again with your mouse. After choosing 
the new location, enter “S” in the AutoCAD 
command line. The yellow frames will be deleted, 
and the report will be positioned in the last chosen 
location. 

 

4. Triangle grid display settings– the ‘Status’ button -  - click this 
button to open the triangle grid display window. More details on 
functions from this window are introduced below. 

 
Options from the triangle display window (Status) 

 
1. Scale – enlarging the font size – in this field you can define the text 

font size both in the triangle grid and in the volumes report on the 
drawing. To change the size that appears click on the small arrow 
button right of the field, and choose the new size. The numbers 
presented are a certain factor and as the factor grows, so will the 
font size. 

 
Note: The font size will not change immediately. Click ‘OK’ to 
confirm the change, go back and compute (Apply button) from the 
main window. To build a new volumes report, go back and perform 
the proper function. 
 

2. Designed elevations – Presenting the designed heights in the 
triangles corners. Uncheck the ‘v’ from the field and remove the 
presentation of these elevations.  
Brackets - Present the designed heights in 
brackets. 

 
3. Topo. Elevations - Presenting the elevations of the existing ground 

in the triangles corners. Uncheck the ‘v’ mark from this field to 
remove the presentation of these elevations.  
Brackets - Present the designed elevations in 
brackets. 

 
4. Height intervals – Presenting the difference between the designed 

height to the existing height in the triangle corners. Uncheck the ‘v’ 
mark from this field to remove the presentation of these intervals. 
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5. Cancel/OK – confirm/cancel the changes from this window. 

 

 
Earthworks leveling grid 

 
The option for Earthworks computations in the balancing grid system is 
possible for volumes computation in the “Planes system” and for 
computing volumes in the “Mode-to-model system”. This system allows for 
the reception of a grid of volume squares, at desired spaces. The 
computation and presentation system here is very similar to the volume 
computation method learned in chapter 7 “Computing Volumes using the 
Model-to-Model System – receiving a volumes table – general Earthworks 
window”, but different in two major points: 
 

1. The grid presentation. 
2. The Earthworks leveling grid can be made in any 

desired direction, while the volume square grid can be 
made only in the North direction. 
 

We will now go over the steps for operating this option: 
 

1. Return and perform all the steps in the quantity computations – in the 
planes system, do the steps until you finish defining the designed 
planes, and in the mode-to-model system, do the steps until you get 
the designed contours.  
 

2. After you have the designed contour lines on existing contour lines, 
(or designed planes on existing contour lines), go to ‘Earthworks -> 
Grid’ from the main menu. From the right hand window, the 
‘Earthworks leveling grid’ window will open.  
 

3. In the ‘Grid steps’ field, enter the desired space in direction ‘X’ and 
the desired space in direction ‘Y’ (the default is 10X10). 
 

4. Defining the grid boundaries – the measurements of the window in 
which the grid will be made, will be defined by three points: two points 
that will define the base window and a third point that will define its 
elevation. From the right window you will see the coordinates (X and 
Y), of the coordinates grid three border points, with ‘Base first’ and 
‘Base second’ as the base points, and ‘End corner’ as the closing 
point. There are three methods to define the window grid: 
 
 Type in the points coordinates that define the grid in the following 

fields. 
 Use ‘Pick’ – click on ‘Pick’ to move to the drawing area and mark 

(using a mouse click), the left bottom border point of the grid.  Move 
and mark the bottom right border point, to create the grid base line. 
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Continue to mark the base line cross point with which you can 
define the grid elevation (from this line). The points coordinates you 
have defined will appear in the right window fields. 

 
 Using ‘Select’ for AutoCAD users only – first, transfer two lines in 

AutoCAD that will that will define the coordinates grid in the 
following way: the first line will define the grid base line and the 
second line will define the grid elevation in relation to the base line. 
After drawing the lines choose ‘Select’. Move to the drawing area 
and choose the lines you have defined by the following order: first 
the baseline then the line that defines the grid height. The points 
coordinates that have been defined meaning the lines you chose, 
will appear in the right window. 

 
 

5. Click ‘Apply’ from the right window. The program will create a 
coordinates grid by the existing definitions. The grid will be formed 
perpendicular to the baseline, as in each corner of the grid the 
topography height and the designed height will appear along with the 
difference between them (if design data is available at these points). 
Every square in the grid will be numbered in an ascending order, and 
in each square will appear the ‘cut’ and ‘fill’ volume. The grid will be 
accompanied by a detailed report in which the ‘cut’ and ‘fill’ volume 
will appear for every square, with a partial summary of the 
computation and an over-all summary of the computed volumes. 
*Note: This computation is been done according to the averages 
sum of the squares corners. To receive an accurate computation 
of each square, check the "Use accurate system" option that 
appears in the window. 
 

6. It is possible to calculate earthworks by defining a border which 
volumes will not be calculated within its area. 
In addition to picking 3 points option, earthworks can be 
calculated only on desired area by creating a border 
around the area which will not be calculated (such as 
road), and selecting the border. 
The area within the border will not be calculated. 
To use this feature: 
Create a border on the drawing by Polyline. 
From CivilCAD main menu, go to 'EarthworksGrid'.  
On the upper right side of the window, click on ‘Select’ 
and select the Polyline.  
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Note : If a border is selected, the Borders table will be 
filled with ‘Noname’ (red arrow) and the grid will be 
created according to the 3 points but the area outside 
the border will not be calculated. 
If the border is not selected, the Borders table will be 
filled with ‘Extents’ (blue arrow) and the grid will be 
created only according to the 3 points, meaning the 
whole area within the grid will be calculated. 
At the middle right side of the window, click on ‘Pick’ to 
create 3 points or ‘Select’ to select the border for the 
earthworks calculation. 
 

 
 
Note : the grid, made by 3 points (Pick option) or 
Polyline (Select option), must include the whole area for 
calculation (including the border made by Polyline or 
Pick option). 
If no border has been defined as a specific area to be 
calculated, the calculation will include the whole area 
according to the grid! 
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Additional options from this window 
 

1. Creating a coordinates list of a rotated grid. This option is for 
receiving a coordinates list of a certain grid when the baseline and 
grid elevation are known. This option is very useful for computing 
the grid coordinates, even with no relation to the Earthworks. To 
create a coordinates list follow these steps: 
 

 Define the grid spaces as explained in at the top of section three.  
 Define the desired grid borders for computing in one of the 

systems detailed at the top, section 4.  
 Click the blue ‘Topo’ button. The program will add to the existing 

coordinates list, (the ‘Topography coordinates’ list in the bottom 
window), the coordinates grid points that were defined. To create 
points in the designed coordinates list, push the red button with 
the ‘Design’ label.    

 Click the  button to get the points list on the drawing.  
 

2. Erasing grid definition fields –  – clicking this button will 
clear the grid fields. 
 

3. Define the grid borders for the entire project area –  – click 
this button to enter the project borders as the border points of the 
grid in its proper fields. Click ‘OK’ (or on one of the Topo/Design 
buttons) to create the desired grid.  
 

4. Stripping depth – stripping depth is made for a project with 
stripping in the work area. Enter the stripping as depth (in meters), 
while separating between the stripping depth and the cut area and 
between the stripping depth and the Fill area. Enter ‘0’ (or leave 
the field empty) for the desired area, in a project which has 
stripping for only one of its areas. The program will compute the 
quantities according to the stripping that was entered, as the 
stripping depth in ‘dig’ will reduce from the cut quantity, and the 
stripping depth in ‘fill’ will add to the fill quantity.  

 
 

5. Adding the Volumes table to the drawing –  – this function 
is for adding the volumes table in a desired location in the 
drawing. To operate follow these steps: 
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Note: These steps are possible only after a computing the report, as 
explained in the beginning of the chapter. After the regular report was 
produced, go over the next steps to position the report in the drawing. 
 

 Click on the button. 
 Move to the drawing area and position the report in the desired place. 
 Users of Stand-Alone – click with your mouse to set the table in the 

drawing. The program will create a layer of the report that will be saved 
as part of the drawing.  

 Users of AutoCAD – click with your mouse to set the table. A yellow 
frame will appear on the drawing, in which the table will be positioned. 
To choose a different position move to the new area and click again 
with your mouse. After you have chosen the desired location, enter “S” 
in the AutoCAD command line. The yellow frames you had created will 
be erased, and the report positioned in the last place that was chosen. 

 

6. Defining a triangle grid display –  - click this button to open 
the triangle grid display window. More details on functions from 
this window are coming up. 

 
 
A detailing of the triangle display window (Status): 

 
1. Scale – setting the text size – in this field, you can define the text 

size in both the volumes grid and the volumes report location in the 
drawing. To modify the presented size, click on the small arrow 
button on the right side of the field, and re-select the size. The 
presented size is a factor. With each larger factor, the text size will 
be larger. Note: the text size will not change immediately. Click ‘OK’ 
to confirm the change, and perform an additional computation 
(Apply button) in the main window. To construct a new volume table, 
go back and repeat the steps from section 5 above. 

 
2. Volumes – presenting volumes within the grid. For each square in 

the volumes grid, the square number and its cut and fill volumes are 
presented. Unchecking the ‘v’ from this field will remove the 
volumes labeling within the drawing, and will leave only the square 
number. The quantities report accompanying the drawing will not 
change. 

 
3. Designed elevations – presenting the designed height in every 

corner of the grid. Unchecking the ‘v’ from this field will remove the 
presentation of this elevation.  

 Brackets - Presenting the designed elevation in brackets. 
 

4. Topo. Elevations – presenting the existing elevation in every 
corner of the grid.  
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Removing the ‘v’ from this field will remove the presentation of the 
existing  

elevation. 
 - Brackets - Presenting the existing elevation in brackets. 

 
5. Height intervals – presenting the heights intervals between the 

existing and the designed in the grid corners. Unchecking the ‘v’ from 
the field will remove the presentation of these intervals. 

 

Earthworks contour lines (including the “0” line) 
 
The “0 line” is the line that separates the cut area from the fill area in the 
area of the project. Presenting this line on the program allows clear 
distinction between the different areas. The Earthworks contour lines are 
contour lines + or – relative to the zero line. CivilCAD 2016 enables the 
drawing of these lines in a project where Earthworks were computed in one 
of these two methods – computing using planes, and computing using the 
model-to-model system.  
We will go over the necessary steps for creating these lines: 
 

1. Compute the Earthworks in one of these two existing 
systems according to the steps detailed in chapters 
“Computing Volumes using Planes” and “Computing Volumes 
using the Model-to-Model System”. 

2. From the main menu go to ‘Earthworks -> Contours’. From 
the right, the creating designed contour lines window will 
open. 

3. The contour lines intervals default in the window are 100 
meters (see ‘Intervals’ field). This implies that for any project 
in which the elevation intervals between cut and fill are not 
over a 100 meters (and these are most of the projects), the 
program will create the zero line. Click ‘OK’ to receive the 
Earthworks contour lines. The contour lines will be computed 
and drawn in the new layer. 

 
More functions from this window: 
 

1. Changing the contour lines intervals so that additional Earthworks 
contour lines are formed for the zero line – enter the desired interval 
in the ‘Intervals’ field (for example 1 meter), and click ‘Apply’. The 
program will create a new layer for the lines it had computed. Make 
sure the ‘0 line’ is kept in a separate layer.  
 

2. ‘Auto Elevations’ labeling – the default of the program is automatic 
elevation labeling on the contour lines. Removing the ‘v’ from this 
field, will cancel this command. Use the ‘Pick’ command to manually 
add elevation labeling.  
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3. Brackets for elevation labeling – this field is for presenting 
Earthworks contour lines in with brackets or without. 
 

4. Elevation labeling format – format “#.##” – elevation labeling on 
contour lines in a two digit format after the decimal point. Elevation 
“1” for example, will appear as “1.00”. 
 

5. Emphasizing the zero line as a double line ‘Doubled (0) – this option 
will cause the zero line to appear in bold.  
 

6. Changing the elevation labeling font (Scale) – the elevation labeling 
font on the contour line (size of text) is set by the factor appearing in 
this field. Changing the factor to a bigger number will increase the 
elevation labeling size and the opposite – a smaller number will 
decrease its size. 
 

7. Manual elevation labeling on the contour line - ‘Pick’ – in order to 
add contour lines labeling in the desired place in the drawing follow 
these steps: 

 
-     Mark the ‘Pick’ field 
-     Move to the drawing area and draw a line that will cross the  
      contour lines at the desired location for elevation labeling. 
      The program will add elevations at the cross points, between 
the  
      line that was drawn to the contour line. You can continue to  
      add elevations as you wish. To finish click ‘Esc’ from the  
      AutoCAD command line (in Stand-Alone version remove the  
      ‘V’ from the ‘Pick’ field).  

Note: All the options mentioned above (except ‘Pick’), require a new 
“running” of the Earthworks contour lines (and a new click on ‘Apply’) in 
order to view the changes made.  
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Chapter 10: Quick sections 
and the 3D model 
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Quick sections 
 
CivilCAD 2016 supports the creation of sections upon existing and 
designed ground, roads, and designed planes by marking two points that 
are the two ends of the section on the plan. The advantage of this system 
is that it is quick, and easy to operate. Its disadvantages are detailed 
below: 

1. Accuracy of the system – The ground section performed by this 
system is computed differently from the computation of the ground 
section in the cross sections or vertical alignment of the road 
(Roads menu). In this system the sections will be computed very 
quickly, but not very accurately. While the sections in the roads 
design, will be computed at a very high accuracy interpolation level 
(by millimeters), the cross sections in this system will be computed 
by approximately based on the parameter definitions of the project 
(for detail see chapter – “General Issues – changing the Accuracy 
Model”). The more accurate you are at defining the parameters, the 
more accurate are the sections you make using this system.   

2. This system does not allow for the making of road sections, only 
planes, or planes that have been computed using only the Two 
Model System only.  

3. This system only supports creating a section between two points. 
 

We will now go over the steps required for a quick section: 
Note- To create a section, you must make, at least, existing contour lines.  
 

1. Choose: Design-> Sections from the main menu. From the right, 
the quick section window. will open the  

2. Use any one of these methods to make a section: 
 Insert the section coordinates manually – in the X, and Y field of the 

‘First corner’ and ‘End corner’. Insert the coordinates of the two end 
points of the section (beginning and end) and click ‘Apply'. The 
program will show a section between these two points.  

 Using Pick – Choose ‘pick’ from the list on the right. Move to the 
drawing area and draw a line between the two points needed to make 
the section. The program will show the section between these two 
points. For users of Stand alone version only, click ‘Apply’ to receive 
the section.  

 Using Locate – (for stand alone version only) – Choose ‘Locate’ from 
the list on the right. Move to the drawing area and choose the two 
points between which the section will be made. Click ‘Apply’ to receive 
the section. The two points must be points that appear in the 
coordinates list from the bottom window (or the ‘Topography 
coordinates’ list or the ‘Designed coordinates’ list). This option allows 
(for users of Stand alone version only), the transference of a section 
between two given points unlike the use of the ‘pick’ option.  
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 Using Select – (AutoCAD version) – Draw a line in AutoCAD that will 
be the section you wish to see. Choose ‘Select’ from the window on the 
right and, move to the drawing area and choose the drawn line. The 
program will show the section across this line.  

 
Additional options from this window 

 

1. Erasing the coordinate fields of the section edges –  – 
Click on this button to erase the coordinates fields of the 
beginning and end sections. 

 
2. Adding elevation to points – ‘Pick Height’ – As part of the 

creation of a section, CivilCAD 2016 creates a data report of 
the existing status, designed status, and the (running) 
distance throughout the section. The elevations will be 
presented in a running distance according to the elevation 
status window (see status next section). Elevations can be 
added on to the section, graphically at the desired running 
distance, not including the elevations that the program 
created automatically.  
To add elevation to a section check “v” next to the ‘Pick 
Height’ field. Move to the area of the section and click your 
mouse on the desired running distance. The program will 
add the running distance that had been chosen automatically 
from the from the bottom data table, as well as in the 
‘Design’, ‘Exist’, and ‘Dist’ fields in the right window.  

 

3. The ‘Status’ elevations labeling Window -  – clicking 
this button will open will open the elevations labeling status 
window from the right. This window defines the automatic 
settings for the elevations labeling on the drawing (as 
explained in the previous paragraph, 2, it is possible to add 
the labeling manually). The options from this window are: 

 
 Dibbling points – Elevations labeling names at the cross-points of the 

existing and designed ground. 
 Turning Points -   Elevations labeling at points where there is a strong 

slope change in the ground (ground break points). 
 Steps - Elevations labeling names at a fixed running distance. The 

elevations will be written upon the section at running distances that 
were determined in the field. 

 

4. Manual removal of elevations labeling –  – click this 
button to remove from the drawing all the manually inserted 
elevations labeling using the ‘Pick height’ command. 
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5. Changing the color of the section layers – in the color 
fields under the heading “color”, appear the different color 
layers of the section. Click on the layer’s color square to open 
CivilCAD’s 2012 color window. Pick the color you want from 
the window and click ‘Apply’. The color of the layer will 
change accordingly. 

 
 Activities in the drawing section window 

 

1. Print section –  – clicking on this button will open a window 
on the right. Insert the scale for the ‘Height’ and ‘Long’ (width) of 
the section. To print click ‘OK’. The ‘Print Section’ window also 
support these additional options: 
 
Choosing a ‘New Origin’ for the section drawing – if you 
wish to print the section, not in the bottom left hand corner 
of the page (new origin), you can set a new origin. The 
new axis origin will be given in meter units, relative to the 
scale of the drawing, in direction X and direction Y. 
 

2. Creating a DXF file of the section –  – clicking this button 
will open the window on the right. Insert the scale for the ‘Height’ 
and ‘Long’ (width) of the section and click ‘OK’. Enter the file 
name of the section in the file window that opens and click  

 

Three-dimensional model 
 
During the computation of present status contour lines, CivilCAD 2016 
creates a 3D Model. The program uses this model to make the different 
sections, the computations of Earthworks quantities, and also allows 
receipt of elevation at desirable points by choosing ‘Pick height’. The 
program can store two models simultaneously for a single project, one for 
the existing status and one for the designed status. In the situation of 
designed contour lines, designed planes or any other form of design, the 
program will create a second model and “dress” it on the existing one. 
 
The 3D Model allows the presentation of each of the models (existing and 
design) in 3D perspective. 
 

1. To start this option, open ‘Design -> 3D view’, from the main 
menu. The 3D model presentation window will open from the 
right.  

2. Click ‘OK’ from the right window. The program will compute the 
model and present it on a separate window. Clicking on the left 
mouse button from inside the drawing will bring it closer, while 
right-clicking will move it further away. It is possible to use the 
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scroll-bar to scroll the drawing. Click ‘OK’ to present the entire 
drawing. 

 
More options using this window 

 
1. Defining the area of Model Presentation as default - CivilCAD 2016 

presents a model of each area of the project. The coordinates of 
the area of the designated window for presentation appear in the 
fields- ‘First corner’ and ‘End corner’ in the right window. It is 
possible to define a specific window in which the model will be 
computed. For this you have these two options: 

 
 A manual change of the coordinates in the corners of the window. 

Define the coordinates range of the window, bottom left hand corner 
and top right hand corner, and click ‘OK’. The model presented will 
be according to the defined range.  

 Marking the desired window upon the drawing – check “V” in the 
‘Windows’ field in the right window, and move to the drawing area. 
Choose a window, bottom left hand corner and top right hand 
corner. The program will update the coordinates at the right fields, 
and present the 3D model of the chosen window.  

 
2. Returning the Boundaries to the entire area of the project – if the 

borders of the project have been changed, by Windows or 
manually, you can return the project’s  coordinates drawing limits to 
the fields by clicking on the ‘Set’ button.  
 

3. ‘Height factor’ - in this field, you can decide on an elevation 3D-
model distortion coefficient. The default of this field is the coefficient 
“1”. The more we enlarge the coefficient distortion, the more the 
model will “stretch” perpendicularly. It situations where the height 
intervals in the project are small, enlarging the coefficient will cause 
distortion of ground to elevation so that the height intervals will be 
felt more radically. After changing the coefficient click ‘OK’ to get 
the new model.     
 

4. Extrapolate borders – CivilCAD 2016 creates a rectangular model. 
When the model is not rectangular, the program completes the 
borders of the rectangle by extrapolation of elevations. This act is of 
aesthetic importance, that might effect in a model that lacks 
accuracy. To cancel the extrapolation uncheck the “v” mark and 
click ‘OK’ again.  
 

5. ‘Layer- exist/design’ - Switching between the existing and designed 
model. By default, the program presents the designed ground 
model. When there is no designed ground model (no design), the 
program will show the existing ground status. If both models do 
exist in the project (exist and design), and you wish to view the 
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existing model, move the layer field in the window from ‘Design’ to 
‘Exist’, and click ‘OK’. 

 
6. Viewing Direction  - the program creates, by definition, a “frontal” 

viewing angle of the model. This direction is the bottom side of the 
project. You can change the viewing angle in the model in one out 
of the following directions – front, right, rear, and left. After 
changing this field, click ‘OK’ to get the updated drawing. 
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Chapter 11: Distomat data 
computations 
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Distomat data computations 
 
This chapter discusses the way the computation of data observations 
(distances, angels) received from a Distomat tool. CivilCAD 2016 provides 
an easy-to-use flexible appliance for editing distomats data, making 
changes and various coordinations, and computing the coordinates file 
along with a detailed traverse report. 
 
The topics covered in this chapter are:  
 

 Activating the Distomat window. 
 Stations shifting. 
 Traverse adjustment. 
 Options window review. 
 Input angles formats. 
 Options from the Distomats data window 
 Appendix 1 – Least square traverse adjustment 

 
 

Activating the Distomat window 
 
To activate, open menu : Geometry  Distomat data, from the 
main menu.  
 
We will now perform a short exercise which will exemplify the use of this 
option: 
(start the exercise by opening a new project- File  New project). 
 

1. Bring the cursor to the Points editing line in the Topography 
coordinates (bottom window). The Distomat data window uses the 
existing list of coordinates to compute the data. Enter the following 
known control points (Name East North Elevation Code): 

 

CP 100 1000 1000 ST1 

CP 100 1000 2000 TRG0 

Note: Enter the data with at least one space between each entry. The 
CP code is used to define the point as a Control Point (known/ fixed). 
 
2. Open Distomats data window by opening menu Geometry 

Distomats window. 
3. Bring the cursor to the first line in the table and type the station 

name and tool height like so : move to the forth column (under 
'Station') and enter ST1, move to the fifth column (under ‘Height’) 
and type 1.5. As a rule, the first line will always be the station (there 
is no significance to empty lines before the first line in the table). 
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4. Add another line by right clicking and choosing ‘New Line’. Enter 
the first observation – this point will serve as an orientation point 
(Backsight). In the third column (under ‘Name’), click ‘TRG0’ and in 
the forth column (under ‘Ho’), click 2500302.  

 
Note: The meaning of this line is that point ‘TRG0’ is the orientation by 
direction  2500302 – towards it. The horizontal angle (H) has been 
entered as 2500302 with no spaces, commas, or points (more details 
on angles format will be given in the next pages).  
In the Ve column enter 0951010 (vertical angle). In the Slope dist. 
Column enter 1005 – the sloped distance and in the Prism column 
enter 1.6. When you finish click ‘Enter’. 

 
5. Enter the continuation of the list in the following fashion: 

 
  

  1.5 ST1  

1.6 1005 0951010 2500302 TRG0 

1.6 50 0901515 030210 100 

1.6 78.76 0900000 2121010 101 

     

 
  
6. Click Apply button and you’ll get the following message: 
 
 
 
 
 
7. Click OK . A calculations report will be displayed. The report will 

include the computed coordinates and the errors: 
a.  

 
 
 
 
 
 
We got a Max. Delta L error – a parameter which can be defined in the 
options window (see details in the next pages). The default is 0.1 m. In 
our example the difference between the measured distance to the point 
(0.912 m – in horizontal distance) and the computed distance is larger 
than 0.1 m, the software displays an error warning. 

b. For the Traverse adjustment we got: 
 
 
 

Errors have been found in the 
computations. 

Please check errors report. 
 

Error in DISTANCE check points: ST1 - TRG0 

Max delta L = 0.100 

Distances' difference = 0.912. 

Measured distance = 1000.912. 

Computed distance = 1000.000 

VTPV = No adjustment 
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Note: The meaning of such message is that there is no traverse, there 
is no closure, so it’s not possible to compute the adjustment (see 
appendix 1 at the end of this chapter). 

c. We got a detailed coordinates report – known and computed. 
 

8. Close the ‘Distomat data’ window. 
 

9. Click on the -  - button to refresh the drawing and get the new 
computed points on the drawing. 

 
10. Save the project as ‘Distomat1’. 

 

Stations shifting 
 
We’ll demonstrate how to move to the next station and continuing our 
coordinates computation from the new station. We’ll continue the project 
from the last chapter: 

1. Open the ‘Distomat1’ project. Open window GeometryDistomats 
data 

2. Let’s add some new observations. Add an empty line after the last 

line in the table (by pressing ENTER or  button). Type the 
information for point ST2 and press ENTER again to create another 
empty line. 

3. complete the table as follows: 
 

  1.5 ST1  

1.6 1005 0951010 2500302 TRG0 

1.6 50 0901515 030210 100 

1.6 78.76 0900000 2121010 101 

 100.5 0803040 0402015 ST2 

     

  1.6 ST2  

1.6 100.5 2205054 2204532 ST1 

1.6 25 0752101 0402211 103 

1.6 49.25 0900530 0500304 104 

1.6 85.56 0801020 2100503 105 

 
Note: It’s obligatory to insert at least 1 empty line when shifting to the 
next station. 
 
4. Press Apply, then OK and Yes to All – that means that changes 

were applied to the coordinates and we can overwrite the old ones. 
In addition to the former error we got the following message: 

 
 
 

Error in MEASURED DISTANCES check points: ST1 - ST2 

Max delta L = 0.100 

Distances' difference = 1.375. 

Measured distance ST1-ST2 = 99.125. 

Measured distance ST2-ST1 = 100.500 
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We got a difference of 1.375m between the measured distance 
between ST1 to ST2 and the measured distance between ST2 to ST1 
(back measured distance) 
5. Close the report and the distomats data windows. Click Refresh to 

view the new points in the drawing. Save the project. 
 

Traverse adjustment 
 
We’ll demonstrate how adjust a traverse. Let’s start with an open-fixed 
traverse with 2 known (fixed) points at the start and 2 known (fixed) points 
at the end. 

 
1. Open the sample project ‘Traverse-4CP. 
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Samples\Traverse-4CP\ 

 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Traverse-4CP\ 
 
 
2. Open Geometry->Distomats data 
3. Pay attention to how the measurements are displayed (space line 

when moving to the next station). Press Apply. We’ll get the 
following errors: 

a.  
 
 
 
 

The software located a traverse starting with 48R and ending 
with 25R. We got this warning since the max bearing difference 
in our options is 0º00’10” and the bearings diference we got is 
0º00’45” (see a detailed description of the options window in the 
next pages). 
b. The next 2 warnings point out the linear difference in X and Y 

axis in the same traverse (48R & 25R). Try to change the 
values of e(X) and e(Y) in the options window and see what 
happens after pressing Apply. 

c. The traverse iteration number equals to 3 and the VTPV is 
1.337851 (more details in appendix 1). We also got 2 reports 
– traverse report for adjustment of all points with correction in 
angles, distances and error ellipse values (see details ahead) 
and computed points and stations report. 

Error in BEARINGS DIFFERENCE check traverse: 48R - 25R 

Max bearings difference = 10.000. 

Bearings difference = 0°00’45” 
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4. Close the report and the distomats data windows. Click Refresh to 
view the new points in the drawing. Save the project. 

 
In the next sample we’ll demonstrate on a closed-loop traverse with 2 
known (fixed) points at the start at the end (same 2 points). 

1. Open project ‘Traverse_round_4CP.prj’ from the Samples folder. 
 
2. Open GeometryDistomats data 
 
3. Press Apply to get the computations report, but this time without 

any warnings. 
 
4. Close the report window and open the Options window by 

pressing the  button. Change the ‘Max bearings difference’ to 
100 instead of 500 and close the options window. Press Apply 
again to re-compute the traverse. This time we got a warning 
error. Click OK and ‘Yes to all’. The report shows the error of 
bearing difference of 0º2’19” which is larger than the max. value 
we defined – 100”. 

 
5. Close the report window by pressing ‘Close’. 
 
6. Open the traverse diagram window by pressing ‘Preview 

traverse diagram’ button . Use the right and left mouse 
buttons to zoom in and out. Use the scrolling bars to move up/ 
down and left/ right. The known points are displayed as red 
triangles and the computed points are displayed with the error 
ellipse around them (see error ellipse chapter). It’s possible to 

print the screen, or to save it as DXF file by pressing  or . 
 

In our last example we’ll demonstrate a case of a traverse which 
closes with only 1 known point at the end. The minimum 
requirement for such traverse is measured direction and distance 
from the known station to this point (*): 

 
  -  Known 
  -  Computed 

 
                 )*( 
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We’ll use the same file from the last example ‘Traverse_4CP.prj’. 
We’ll delete the known point 25R from the Topography coordinates 
list. In addition we’ll delete from the distomat data window all the 
rows from the last station 24R till the end. Press Apply to get the 
complete report and computed points. To view the traverse diagram 

click on . 
 

Options window review 
 
The options window defines all the parameters of the traverse adjustment 

computations. Open the options window by pressing the  button. 

 
 Working units –  

 Angles - define the working units for angles by degrees or 
grads. Grads angles can be used either with or without decimal 
point. 

 Distances – Work either with meters or centimeters. 
 Traverse iteration – the number of iterations which the software 

runs in order to get the correct solution. Auto – the default value is 3 
iterations. When the user assume it’s possible to get a solution with 
more than 3 iterations, it’s possible to change this value. 

 Standard deviation 
 Bearings precision (STDD) – the standard deviation for the 

direction. This value will be used to determine the weights of the 
bearings in the adjustment. The default value is 15”. 

 Distances precision (STDL) – the standard deviation for the 
distance. This value will be used to determine the weights of the 
distances in the adjustment. The default value is 25mm. 

 Traverse miscolusre 
 Max bearings difference – the maximum allowed difference for 

the total bearings misclosure. The system will display a warning 
when the computed bearings difference is higher than the 
defined (default value is 500”).  





n

i

ni AznAz
0

0 )1(180difference bearings 
 

 i  - the bearings in all the traverse stations. 
 n – the number of traverse stations. 

 nAzAz ,0  - the first and last azimuths. 

The software will continue the computation even if the result is 
higher than the allowed, but will only display it. 

 Max linear difference – the maximum allowed linear misclosure 
for X and Y axis. The software will display a warning when the 
computed linear difference is higher than the defined. Default 
value is 0.3m both for e(X) and e(Y). 
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 Max. misclosure/ distance – the maximum allowed relative 
misclosure (the total linear difference divided by the total 
traverse distance). Default value is 1/3000. 

 Face Right/ Left –  
 Max epsilon – The software checks the difference between 

measurements of Face Right and measurements made with 
Face Left between each 2 points. The warning message will 
appear if the computed value is higher than the defined. The 
default value is 100”. 

 Max delta L – the software warns in the following cases: 
 When the difference between the computed and measured 

distance between 2 known points is higher than the allowed 
(default value is 0.1 m). 

 In every station an average of the distance measured to a 
certain station (x) is calculated. These distances include 
several measurements in the same “face” or in both “faces” 
(left & right). The software will display a warning when the 
difference between one of the measured distances to target x 
and the average distance is higher than the allowed value. 

 When the difference between the measured distance (or the 
average of measured distances) from one point to another 
and the measured distance from the back side is higher than 
the allowed. 

 Max orient. difference – check of orientation in stations which from 
them a direction was measured to at least 2 known points. In the 
first phase, the azimuths will be calculated using the known 
coordinates. In the second phase, the bearings between the 
measured orientation will be calculated. In the last phase, the 
bearings will be calculated using the azimnnuths from the first 
phase. If the bearings difference is higher then allowed, a warning 
will be displayed. The default value is 100”. 

 Max height difference – check of heights difference between 2 
known points. The software will display a warning if the difference 
between the measured height and the known height is larger than 
the allowed (default value is 0.2m). 

 Report – a list of reports to display: 
 Non computed points – the software will display a list of points 

which could not be computed due to lack of information. 
 Traverse adjustment – the adjustment report: 

 Full Report – the computation report will include the 
topography points and adjustment, in addition to the 
adjustment of the known stations and points. 

 Semi-major | semi-manor – displaying the error ellipse 
parameters: semi-manor axis, semi-major axis and the 
orientation angle of the semi-major axis. 

 ΣY| ΣXY ΣX – Displaying the precision of the coordinates X, 
Y and the covariance of them (see appendix 1). 

 Poitns – The software will display the points report. 
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 Display –  
 Max distance – the maximum distance of a point to be 

displayed in the traverse diagram. If the distance between the 
points is above the defined (default value is 2000m) then the 
far points will be displayed only schematically). 

 
 

Input angle format 
 

1. Working in Degrees: 
As a rule, both the horizontal and vertical angles will be in format: 
DDDMMSS, meaning: 3 digits for degrees, 2 digits for minutes, 2 
digits for seconds.  
 
Examples: 1732010,  2122012,  53230, (meaning 5 degrees, 32 
minutes, and 30 seconds). The numbers will be entered with no 
space, comma, or period between them. The two digits for 
minutes and seconds are mandatory, while only 1, 2, or 3 digits 
may be entered for the degrees. There is one exception to this 
rule: In case less than 5 digits are entered (a total for all angles), 
the entered number will be read as degrees only (for example, if 
you type 173-it will be interpreted as exactly 173 degrees – 
1730000). Therefore, entering zero is an option and it is not 
necessary to type – 00000 (it’s possible to type 0 only, instead of 
00000). 

 
2. Working in Grads:  

In grads the angles will be typed in a simple numerical manner. It’s 
possible to use the decimal point by choosing the ‘Decimal point’ from 
the options window.  
For example : 89.723, 135.231 – with decimal point 
   89723, 135231 – without decimal point 
Note: Pay attention that working without decimal point, the software is 
reading the 4 most right digits as numbers before the decimal point. 

 

Options from the Distomat Data window 
  

1.  Exporting the entire distomat table to an Excel file. The 
program will open the Excel file (if installed) and automatically fill a 
sheet with all the report data. 

2.   Load from text file – reading the data from a distomat data file – 
this option support reading a distomat data file in different formats. 
The file will be read and automatically translated to a format which 
the program is familiar with, so that it can be arranged in the 
proper columns for processing, editing and computing.  
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It is possible to import data from these files formats:   
 
 (txt) – Text files 
 (job) – Job files     
 (dat/ gt7/ gts7)  - Data files (Topcon GTS7) 
 (gsi/gif)   - Leica data tc300/tc700 
 (gsi/gif) - Leica data tc1100 
 (crd/sdr) – Sokkia data files 
 (dat) – NTS600 data files 

 
To set the format which the program uses during the reading of the file, 
activate ‘File-> configuration’ from the main menu. The ‘configuration’ 
window will open from the right. In the ‘Save/Load from text file’ frame, you 
can determine the type of format that will be used by the program. 
 
(A reminder – In order to determine a format that will be used as a default by 
all projects, enter project ‘Prototype’ and change the name of this option). 

 

Available formats: 

 Standard Ascii – Reading the format in its original form as it will 
appear without a change in every Dos editor. 

 Geodimeter-Geotool – Reading from a job/are file that is read 
from a Geodimeter tool using the communication program 
Geotool. 

 Pentax – Sc5/CMT Mc II (Kermit) – Reading a file that has 
been transferred from the Sc5-collector data of a Pentax tool 
using a Kermit program or any other similar program. 

 Pentax-DC-1Z – Reading from a file that had been transferred 
from a data collector –DCIZ of a Pentax tool using a Kermit 
program or any other program similar to it. 

 TopCon –210 - Reading from a file that was created using the 
communication program TopComm, from a TopCon-210 tool. 
(note – there is no need to use the Converter, the program will 
read the transferred file directly. 

 TopCon-Fc5 – As TopCon210, only for the Fc-5 data collector. 
 Hp-48/Topcon_700 - Reading a “raw” file that was made by the 

standard communication program for the transference of files 
from – HP to - 48. 

 Topcon_700- Dat files –  Reading a Dat file that can be read 
directly from a disconnected server (PCMCIA) of a Topcon_700 
model tool. 

 Topcon_2102  - Reading from a file created with help of the 
communication program TopComm, from the TopCon-210 tool. 
The difference is the transference type from inside the Topcon. 

 NTS600 - Reading a Dat file from NTS600 (Chinese 'South' 
Company) 

 



 

 

Page 149 of 508  
 
 

CivilCAD 2016 Reference manual 

 

3.  Save as text file – save the data in a ‘Text’ file. After clicking this 
button, a dialog files text box will appear. The distomat data will be 
saved in a file that was determined in Ascii format (for example for 
work and process in DOS).  

4.  Print – printing the file data. As a rule it is best to enter a report that 
was received as a result of the computation and to print it. 

 

5.  Preview traverse diagram – The traverse diagram can be 
displayed only after the computation was completed (by pressing 
Apply) 

 

6.  Clear all  - clears all the distomat existing data (in case the data 
was read from an external file using the ‘Load form text file’, the 
original file will not be damaged). 

 

7.  Erase – erasing a line or a block of lines.  
 

8.  Mark all – marking all the lines. 
 

9.  Insert – inserting a space line. It is important to mention that the 
existing space line has a crucial effect on the distomat data – as it 
signifies the moving of a passage. 

 

10.     Copy - copies a line or a block of lines to memory. The content that 
had been copied can be pasted anywhere using ‘paste’. 

 

11.  Paste – pastes the content in memory (that had been copied using 
the ‘Copy’ command) into the desired location – the location of the 
cursor. 

 

12.     Undo – go one step back. Remember that the undo button is 
relevant only for the action completed from the distomat data 
window. 

 

13.  Distomats Data – reading data from a Distomat toll. Clicking this 
button will open the distomat data input window (see attachment b’ 
– “communication and compliance to tools”). 

 

14.  Report – viewing the distomat data computation report. 
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15.  Status – opening the Distomat data ‘Status’ window. 
 

16.   Intersection 2 distances – this command supports the 
intersection of two known points, using a given distance for each 
of the points. Click this button to open the intersection window 
from the right from two distances. The data on which we are about 
to perform the intersection will be automatically copied to the 
correct cells. 
 Station name (assuming you want to compute the station’s 

coordinates), will be entered as ‘New point’.  
 The first reading under the station line will be inserted as the left 

point from our point of view, and the distance measured to it, will 
be translated into horizontal distance and will be entered into 
‘Radius 1’ field. 

 The second reading under the station line will be entered as a 
right point. The distance to it will be translated to horizontal 
distance and will be entered into ‘Radius 2’ field. 

 Click ‘OK’ to do the computation – the coordinates will be 
computed, and the point will be added to your coordinates list so 
that you can perform various activities on it (such as the 
continuation of the computation of all distomat data). 

 

17.   Intersection 3 angles (Resection) - click this button to open the 
intersection window from the right, from three directions. 
 The first three readings will be copied to this window immediately 

following the station.  
 The data will be copied in an ascending order from left to right, 

as for each point will be copied the reading horizontal to it.  
 The station will be copied as ‘New point’. Click ‘OK’ to perform 

the computation and store the results in the coordinates list, so 
that now you can compute the distomat data from this station. 
 

18.    Intersection 2 angels & distance - click this button to open the 
intersection window from two angels & distance. The data of the 
first two points after the station will be copied to this window from 
left to right. For the first point the reading and distance will be 
copied, and for the second point, only the reading will be copied 
(the distance copied will be automatically translated to horizontal 
distance). The station will be copied in the ‘New point’ field. Click 
‘OK’ to compute the station and add it to the list of coordinates, so 
that it can be operated on again. 
 

19. Apply – pressing this button will run the computation and creation of the 
report. 
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20. Close – The distomat data is stored in the memory and it’s possible to 
open the window again any time. 

 
21. It’s possible to freeze points which we want to neglect in the 

computation of the traverse adjustment. Mark the row you wish to 
freeze and right click on the mouse. Choose the option ‘Freeze 
Points’. It’s also possible to double click the left column “Fr”. To 
unfreeze double click again or choose the option “Unfreeze all 
points” from the right click options. 

  
22. Prism height definition for 2D surveying 

 
In case 2D surveying is required (Coordinates that needs to 
appear on drawing without being considered at interpolation), you 
can define prism height as -99 in the total station and when you 
will perform traverse adjustment, all coordinates with prism height 
-99 definition will be recognized as 0.00. 
To locate all points with height 0.00 in coordinates list, click on 

‘Find’ button . 
 
In ‘Find’ Window, define search by accurate height, type 0.00 or 0 
and click ‘Find All’ button. 
All points with 0.00 heights in coordinates list will be marked in 
blue. 
Mark ‘V’ in ‘Block’ checkbox (on the right side of coordinates list) 

and click ‘Freeze current line\block’ button . <Fr.> symbol will 
be added to selected point’s names. 
This operation will freeze the selected points and they will not be 
considered at interpolation 
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Appendix 1 – Least Square Traverse adjustment 
 
Computation process 
 

 The software allocates all available traverses. 
 Each traverses are defined as one of the following 3 types: 

 Open traverse. 
 Closed (fixed) traverse to a single known point 
 Closed (fixed) traverse with 2 known points. 

 The software computes the whole traverses and takes into account 
the weights and precisions of each point. 

 The software can also solve a reverse traverse – starting at 2 
unknown points and closing to 2 known points (open traverse). 

 In addition, the software can solve closed-round traverse (where the 
2 known points are at the start and at the end of the traverse). 

 
Types of traverses 
 
An open traverse is the simplest traverse. It is based on two known points 
and is not accurate since there is no control on the measurement. The 
error along the traverse is growing without ability to control and maintain. 
 

 
 

 
Figure A-1, Type I, Open traverse 

 
A Closed traverse to single known point at the end, enables a better 
control on the results. Looking at figure A-2, the traverse must comply with 
the computed coordinated for point C. Meaning, if we compute the traverse 
as an open one (without considering point C as known point), we’ll get 
computed coordinates for point C. In reality, due to errors in 
measurements, errors in the equipment and operator errors it would never 
be the same. The traverse adjustment makes correction to all the angles 
and distances and location point C in its real (known) coordinates. 
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Figure A-2, type II, Close traverse to single Known point at the end 
 
A Closed traverse to 2 known points at the end (C and D), enables to add 
additional equations for the solution. Computing the first azimuth and the 
azimuth in each station, it’s possible to compute the azimuth of line CD, but 
this azimuth should be different then the azimuth computed by using only 
the known points C & D. The difference between these azimuths is called 
bearings misclosure. As long as the total bearings misclose is acceptable, 
the difference will be computed along the traverse by the traverse 
adjustment.  

 
 
Figure A-3, type III, Close polygon to 2 Known points at the end 
 
During surveying in the field it’s recommended to measure additional 
measurements if possible. For example, if a surveyor is standing at P3 and 
taking a reading to P2 and to P4, he should also take the reading to P1 (if 
possible). That will add better control to the measurements and might 
improve the precision of the computation in some points. 
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The least square traverse adjustment process automatically identify all the 
possible connections and equations. The meaning of minimum least 
square solution is that the sum of the adjustments squares must be the 
minimum possible. 
 
Each country has its own standards of linear and bearings misclosure. The 
software will run the computation without almost any limitation but it will 
display warnings for errors as been defined by the user in the options 
window. In case the bearings misclosure is above a certain limit, the 
software will stop the computation. The limit in CivilCAD 2016 is W1< 
5*n^0.5, where W1 is the bearings misclosure and n is the number of 
stations. 
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The error ellipse 
 
As part of the traverse adjustment, the precisions for each point are 
computed: 
ΣX – describe the precision of coordinate X 
ΣY – describe the precision of coordinate Y 
ΣXY – describe the dependency between X & Y 
 
For example: 

 

 

X = 302341.23 +/- 3Cm 
Y = 122555.20 +/- 4Cm 

 
ΣX = 3Cm 
ΣY = 4Cm 

 

If we assume that there is dependency 

between X & Y, then the covariance would be 

ΣXY = 0.5Cm  

It’s possible to find a direction for which we can 

get ΣXY = 0  .  

Given these values, it’s possible to define the precision of the point by the 

error ellipse. 

Remark: The error ellipse is computed with a 95% level of confidence. 

 

The error ellipse around a certain point is defined as follows: there is 

a probability of 76.18% that the correct coordinates of this point are inside 

the ellipse, which her semi-major and semi-manor axis are equal to the 

maximum and minimum values of the STD (standard deviation). 

Remark: MX & MY are not corrections but they are the precisions of X & Y. 

 
Error warnings for traverse adjustment 
 
During the computation process, the software is running a number of 
checks on height, angles and distances. The system will display a warning 
when there is a difference beyond normal. 
 
Here are the possible warnings of the system: 

Semi-

mMajor=M

ax 

Semi-
Manor=M

min 

Az 
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 The difference between the computed and measured distance or the 
difference between the forward distance and the back distance is 
higher than the maximum allowed (Max delta L). 

 The difference between the Face left measurement and the Face 
right measurement in the horizontal angle or the vertical angle is 
higher than the maximum allowed (Max epsilon). 

 The computed bearings difference is higher than the maximum 
allowed (Max bearings difference). 

 Error in MISCLOSURE ACCURACY check (Max. misclosure/ 
distance). 

 The computed linear difference is higher than the maximum allowed 
(Max linear difference). 

 Orientation control between 2 known points. The computed orient. 
difference is higher than the maximum allowed (Max orient. 
difference). 

 Height control between 2 known points. The computed height 
difference is higher than the maximum allowed (Max orient. 
difference). 

 There are not enough points to find a solution. Either the software 
could not find a traverse adjustment solution or we didn’t write the 
control points in the topography coordinates list (or we didn’t mark 
the known points with code ‘cp’). 
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Chapter 12: Coordinates 
geometry 
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Coordinates geometry 

 
This chapter discusses geometric computation on coordinates (COGO). It 
details all geometric activities possible from CivilCAD 2016. In addition to 
this chapter, separate chapters were dedicated to topics of - “Distomats 
Data Computation” (chapter 10), and “Polygon Adjustment” (chapter 11). 
Another geometric computation supported by the program, but not detailed 
in this chapter is coordinates computation – running distance and offsets 
across the horizontal alignment, straight or including arches. This 
computation is possible and will be explained in chapter 14 “Roads Design 
– geometric computation along the center line”.   

 

Coordinates geometry definitions 
 
As a rule, CivilCAD 2016 performs its computations on the basis of a 
“bank” of points. These points are entered in the coordinates list at the 
bottom window (‘Topography/Designed coordinates), so that all that needs 
to be added in the coordinates geometry windows are their name/number. 
There are a number of options for some of the geographic computations 
that enable the computation of new coordinates. CivilCAD 2016 works with 
two lists of coordinates – topography coordinates, and designed 
coordinates. The designed coordinates list is mostly useful in cases of 
computation of quantities/and or design, therefore in most cases of 
geographic computation you will not use this list at all. You can instruct 
CivilCAD 2016 with which of the lists you would like to work, and further 
yet, it possible to join the work between the two lists and define it in the 
program:  
 
From the main menu activate : Geometry -> Geometry parameters. From 
the right will open the geometric computations definition Window. 
In this window appears two frames: 
Points use – Choosing the list with which you wish to work (topography or 
designed or both). 
Working units –the working units for angles- grads or degrees. 
 
Points use: the options from this list are –  
Designed points only –All the commands will be done on the designed 
points list, only.  
Topo. Points only - All the commands will be done on the topography 
points list, only.  
Topo. + Designed- Create designed – The program will use the existing 
coordinates in both lists for the computations, but each new point 
computed will be created in the designed points list only.   
Topo. + Designed- Create topo - The program will use the existing 
coordinates in both lists for the computations, but each new point 
computed will be created in the topography points list only.   
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Working units - (for angles) 
 
The working units that are determined here, that will define the angle 
during the work process, will be in grads or degrees. These definitions will 
also change the work units for the ‘distomat data’ window and so for the 
horizontal and vertical observations in it. 
 
When you complete the definition changes click ‘OK’. Click ‘Cancel’ to 
cancel the changes that were made. 
 
Note: Changing the work units inside a certain project will have an affect 
only on the particular project. In order to set general definitions for the 
way the program works, you must first enter ‘Prototype’ project from the 
program’s installment library, and change the required definitions in it. After 
this adjustment was made, any new project opened by the program will 
work with the new definitions you have set.    

 

General remarks 
 
There are several possibilities shared for all or some of the geometric 
computations. We will focus here on explaining them: 
 
The options table : Unused, Pick, Locate, Select. This table enables an 
integration of the computations with the graphic option. 
  
Unused – the default for opening the window signifies that all activities in 
the list are not of use at this time.  
Pick – the arbitrary choosing of points from inside the drawing, which do 
not appear in the points list from the bottom window. To use this option, 
mark it, move to the drawing area and choose the points you want. 
Locate – Choose points that exist in the points list at the bottom window. 
The program will search for the chosen point, and finds in the bottom list – 
‘topography points’ or ‘designed points’ list, according to the definitions that 
were set (on choosing a list see section “Coordinates Geometry 
Definitions” in this chapter). 
Select – Choose a Polyline or Line that was drawn by AutoCAD. This 
option is useful, of-course, for users of AutoCAD version only.  
 

  – The erasing of the last point from the list of points, if such a list does 
exist. For commands with no points list, the erase button will be used to 
erase all the fields in the window.  
 

  – Erasing all the points in the commands that have a point list. 
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Please Notice: All geometric commands are arranged by alphabetical 
order, under ‘Geometry’ menu.   
 
 
Grouping Computation Reports: 
 
For each project, CivilCAD 2016 saves a report that groups all the 
geometric computations that were made. For each working stage, you can 
present or print the proper report. Inside the geometric computation activity 
windows, appears a ‘present report’ button (a button with a picture of a 
book). Press this button to present the report, print it, save it in an Ascii file, 
or delete it.   

 

Area computations 
 
Activate ‘Geometry -> Area’ from the main menu. The window will open 
from the right.  
 
This option enables to compute the area locked inside the points lists. Use 
‘Pick’ and ‘Locate’ as explained in section “General Remarks”. From the list 
on the right in the upper field - you can insert the list of points that borders 
the computation area. Enter the names of the points and click ‘Enter’. You 
can enter a group of points by entering the field in the form of: 10-15 and 
click ‘Enter’. In this case, all the points between 10 to 15 will be added to 
the list. To compute the area click ‘Apply’. The area between these points 
will appear under ‘area’ and will be added to the computation report for 
printing. 

 

Arc by center and point on arc 
 
Activate ‘Geometry -> Arc Center + 1 point’ from the main menu. The 
window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “General 
Remarks”. 
 
This option is for computing an arc by a known center point coordinates, 
and an additional known point on an arc. Enter the following details in the 
fields that appear in the window:  
 
Center point – The known arc center point. 
From point - This known point on the arc will serve as starting point for arc 
computations.  
Distance – The distance of the new point/points computed from the known 
point on the arc. This distance can be: 
A single space – in this case the single point will be computed according to 
   the distance that was entered.  
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A formula in format  X>Y : Z with ‘X’ as the distance of the first point to be 
created, ‘Y’ the distance of the last point to be created, and ‘Z’ the distance 
between the points. For example 10: 50<0. The program will distribute 
points across the arc at stations that vary from 0 to 50, each 10 meters.  
 
New point – the name of the new point the program will create. In case a 
group of  
       points is formulated, the program will number these points starting 
from the number  
       that has been entered in the field.  
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
To perform the computation click ‘Apply’. The program will compute the 
points and enter them into the points list (topography coordinates list or 
designed coordinates list), as was defined by in the ‘Setting Window’ (see 
section “Coordinates Geometry Definitions”). If a single point is computed, 
its coordinates will appear in fields ‘X’ and ‘Y’ in the window, as well.  
Clicking on the report button will activate the ‘report window’ in which the 
current computation will be displayed. 

 

Arc by two points and a radius 
 
Activate ‘Geometry -> Arc 2 points’ from the main menu. The window will 
open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “General 
Remarks”. 
 
This option is for computing an arc by two known points on an arc and 
radius. Enter the following data in the fields that appear in the window: 
 
From point – the first known point on the arc. 
From point - the second point on the arc. The second point will be on the 
continuation of the arc, clock-wise. 
Radius – the arc radius 
Distance – The distance of the new point/points computed from the first 
known point on the arc. This distance can be:  
 
 A single space – in this case the single point will be computed according 
to the distance that was entered.  
A formula in format  X>Y : Z with ‘X’ as the distance of the first point to the 
creation, ‘Y’ the distance of the last point to creation, and ‘Z’ the distance 
between the points. For example 10: 50<0. The program will distribute 
points across the arc at stations that vary from 0 to 50, each 10 meters.  
Division of the segment between the two known points to ‘X’ equal parts – 
“/X”. For example, entering /5, will divide the segment to- 5 equal parts.  
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Division of the segment between the two known points by the distance of 
‘X’ meters –“X:”. For example, entering 2:, will create points every 2 meters 
on the arc.  
 
New point – the name of the new point the program will create. In case a 
group of points is formulated, the program will number these points starting 
from the first number that was first entered in the field.  
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
To perform the computation click ‘Apply’. The program will compute the 
points and enter them into the points list (topography coordinates list or 
designed coordinates list), as was defined by in the ‘Setting Window’ (see 
section “Coordinates Geometry Definitions”). If a single point is computed, 
its coordinates will appear in fields ‘X’ and ‘Y’ in the window, as well.  
Clicking on the report button will activate the ‘report window’ in which the 
current computation will be displayed. 

 

Arc by three points  
 
Activate ‘Geometry -> Arc 3 points’ from the main menu. The window will 
open from the right.  
You can use ‘Pick’ and ‘Locate’ as explained in section “General 
Remarks”. 
This option is for computing an arc by three known points on an arc and 
radius. Enter the following data in the fields that appear in the window: 
 
Point 1 – the first known point on the arc. 
Point 2 - the second known point on the arc.  
Point 3 – the third known point on the arc.  
 
The three points will be arranged clock-wise on the arc.  
 
Distance – The distance of the new point/points computed from the first 
known point on the arc. This distance can be:  
A single space – in this case the single point will be computed according to 
the distance that was entered.  
A formula in format  X>Y : Z with ‘X’ as the distance of the first point to the 
creation, ‘Y’ the distance of the last point to creation, and ‘Z’ the distance 
between the points. For example 10: 50<0. The program will distribute 
points across the arc at stations that vary from 0 to 50, each 10 meters.  
Division of the segment between the first and the third known points on an 
Arc, to ‘X’ equal parts – “/X”. For example, entering /5, will divide the 
segment to- 5 equal parts.  
Division of the segment between the first and the third known points on an 
Arc by ‘X’ meters –“X:”. For example, entering 2:, will create points every 2 
meters on the arc.  
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New point – the name of the new point the program will create. In case a 
group of points is formulated, the program will number these points starting 
from the number that was first entered in the field.  
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
To perform the computation click ‘Apply’. The program will compute the 
points and enter them into the points list (topography coordinates list or 
designed coordinates list), as was defined by in the ‘Setting Window’ (see 
section “Coordinates Geometry Definitions”). If a single point is computed, 
its coordinates will appear in fields ‘X’ and ‘Y’ in the window, as well. 
Clicking on the report button will activate the ‘report window’ in which the 
current computation will be displayed. 

 

Arc by three outside points 
 
Activate ‘Geometry -> Arc 3 points’ from the main menu. The window will 
open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “General 
Remarks”. 
 
This option is for computing an arc by three known points that block the arc 
(see drawing in window), and the radius of the arc for the creation. Enter 
the following data in the fields that appear in the window: 
 
Point 1 – the first known point.  
Point 2 - the second known point.  
Point 3 – the third known point. 
Radius – the radius of the arc is blocked by the three points.   
 
The three points will be arranged so they block the arc clock-wise. 
 
 
       Note: You can move between the different fields in the window, by 
clicking ‘Enter’. 
 
To perform the computation click ‘Apply’. The program will compute the 
points across the arc. 
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Arc segment 
 
Activate ‘Geometry -> Arc segment’ from main menu. The window will 
open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “General 
Remarks”. 
 
This option is for computing the locked area between the arc and a straight 
line. In addition the program will compute the length of the straight line and 
the length of the arc segment that is blocking the area. To compute the 
field data, insert the following:  
 
From point  – the first known point of the segment. 
To point  - the second known point of the segment. 
Radius – the radius of the segment arc.  
 
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
To perform the computation click ‘Apply’. The program will compute the 
data segment and present them in the following fields:  
 
Arc – the length of the segment arc. 
Dist – the length of the straight line between the two points. 
Area – the area of the segment locked between the points. 
 
Clicking the report button to present the report window in which this recent 
computation will appear. 

 

Continuous distance 
 
Activate ‘Geometry -> Continuous distance’ from the main menu. The 
window will open from the right.  
 
This option is for computing the sum distance of a line defined by its 
number of points. You can use the ‘Pick’ and ‘Locate’ and ‘Select’ option 
as explained in section “general remarks”. From the list on the right -upper 
field, you can enter the list of points that define the line that is being 
computed. Enter the points names and click ‘Enter’. You can enter a group 
of points by entering the field in the form of: 15-10 and click ‘Enter’. In this 
case, all the points between 10 to 15 will be added to the list. To compute 
the station click ‘Apply’. The distance between these points will appear as 
‘Distance’. The detailing of the intermediate distances between the points 
including the accumulating and final distance will appear in the 
computation report.   
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Transformation of coordinates system 
 
Activate ‘Geometry -> Coordinates transformation’ from the main menu. 
The window will open from the right.  
 
This option is for transforming the points coordinates in the list by inserting 
the coordinates of two points in the current system, and inserting the 
coordinates of these two points in the new system to which we want to 
transform. Insert the following in the window on the right:  
 
 
Old system: 
  
Insert coordinates ‘X’ and ‘Y’ of the first point (point 1), and of the second 
point (point 2) known in the old system. 
 
New system:   
Insert the coordinates of the same two points in the new system.  
 
You can use ‘Select and ‘Pick’ in order to choose the two points in the old 
system (current), graphically out of the drawing.  
 
After entering these four points click ‘Apply’ to activate. Before you perform 
the transformation you will be requested to confirm this action. After the 
transformation, the new coordinates will appear in the bottom window. 
Click ‘R’ to draw them again on your screen. 
 
More options from this window: 
The program’s default is the transformation of two coordinates lists, both 
topography and designed coordinates. If you wish to transform only one of 
the lists, remove the ‘v’ mark next to one of the following: 
  
Topo points – the topography points list. 
Designed points - the designed points list. 

 

Distance and angle of a group of points 
 
Activate Geometry -> Distance & angle from the main menu. The window 
will open from the right.  
 
This option is for computation of distance, azimuth and relative angle of a 
known point (any station) to a group of points for marking. From the 
window on the right enter: 
 
Station -  the name of the station from which the data will be computed. 
Zero point – CivilCAD 2016 produces a report that includes both azimuth 
for points and orientation angles for points from stations that will serve as 
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the zero point. In the ‘Zero point’ field, enter the point that will serve as the 
zero point. If such a point does not exist, enter the station name as you 
entered in ‘Station’.  
To point list - To this list you can enter all the points whose data you wish 
to compute. Stand on the field at the top of the list and enter the required 
points. You can enter one point after another (click ‘Enter’ between them), 
a group of points by defining ‘from’ and ‘to’ (for example 1-10), or type the 
word ‘All’ and click ‘Enter’, in order to contain all the points in the points list.  
 
 
After you have the list, click ‘Apply’. The program will compute the list of 
distances and angles and present them in a report. Notice the difference 
between the Azimuth column and the angle column.  
 
Note: The report you get from this option does not belong to the inclusive 
computation report of the program, which can be received from activating 
other options.    

 

Distance and azimuth  
 
Activate – ‘Operate Geometry -> Distance & Azimuth’ from the main menu. 
The window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for computing the distance and angle between two known 
points. Enter the following data in the fields that appear in this window.  
 
From point – first known point. 
To point – second known point. 
 
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
After clicking ‘Enter’ in the ‘To point’ field, the program will compute the 
azimuth and distance between the two points and show the data in fields 
‘Distance’ and ‘Azimuth’. The program will also update the computation in 
the computation report. 
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Intersection by two distances 
 
Activate ‘Geometry -> Arc 2 points” from the main menu. The window will 
open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for finding a point by distance intersection into two known 
points. In the fields of this window enter:  
 
Center point 1 – the first intersection point. This is the left point to the 
observation (the definition of “left “is for minimizing the location of the 
intersection to a single point from the two points from which the distances 
are intersection).  
Distance 1 – The distance to the first known point (left point). 
Center point 2 – The second point from which the intersection is made. 
This point will be the right point to the observation. 
Distance 2 – The distance to the second known point (right point). 
New point – The name of the new point that will be formed. 
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
To perform the intersection click ‘Apply’. The program will show the 
coordinates intersection (if the distances intersect!), in fields ‘X’ and ‘Y’. 
The computation report will be updated accordingly. 

 

Intersection by two angles and a distance 
 
Activate - ‘Geometry -> Intersection – 2 angles + distance’ from the main 
menu. The window will open from the right.  
 
You can use ‘Locate’ as explained in section “general remarks”. 
 
This option is for finding a point by a intersecting between observations to 
two known points and the distance to the point on the left. 
 
Point 1 – first point from which the intersection is made. This point will be 
the left point to the observation (the left will be determined by the angle to 
the point). 
Angle 1 – The observation to the first point (the left). 
Distance – The distance to the first known point (left point) 
Point 2 – The second point from which the intersection is made. This point 
is the right point to the observation. 
Angle 2 – The observation to the second point (the right). 
New point – The name of the new point that will be created. 
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 Working in Degrees: 
 We emphasize here that the angles will be entered completely, 
separated by commas in the following fashion : DDD,MM,SS. Examples for 
angles : 5,17,10    56,12,10    186,22,32  and so on. It is possible to insert 
the given angles in full degrees, only by the degree grade, for example : 90 
(for 90 degrees). 
         Please notice : The angles format in Coordinates Geometry is 
different from the format at Distomat data computation, where angles are 
entered without separation.   
 
           Working in Grads:  
The angle in grads will be entered as usual, including a decimal point,  if 
needed.  
 
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
        Click ‘Apply’ to perform the intersection. The program will present the   
coordinates of the intersection (if the data is being intersected!), also in 
fields ‘X’ and ‘Y’. The computation report will be updated accordingly.    

 

Intersection by three angles  
 
Activate - ‘Geometry -> Intersection- 3 angles’ from the main menu. The 
window will open from the right.  
 
You can use ‘Locate’ as explained in section “general remarks”. 
 
This option is for finding a point by intersecting between observations to 
three known points. The accuracy of this intersection is affected directly 
from the difference in angles between the observations, and as long as this 
difference is equally distributed between all three directions (“Mercedes 
shape”), the more accurate the intersection will be. In the fields of this 
window enter:  
 
Point 1- the first intersection point.  
Angle 1 – observation for first station. 
Point 2 – the second intersection point.   
Angle 2 – observation to the second station. 
Point 3 – the third intersection point. 
Angle 3 – the observation to the third point. 
New point – the name of the new point that will be created. 
 
 Working in Degrees: 
We emphasize here that the angles will be entered completely, separated 
by commas in the following fashion : DDD,MM,SS. Examples for angles : 
5,17,10    56,12,10    186,22,32  and so on. It is possible to insert the given 
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angles in full degrees, only by the degree grade, for example : 90 (for 90 
degrees). 
Please notice : The angles format in Coordinates Geometry is different 
from the format at Distomat data computation, where angles are entered 
without separation.   
 
  Working in grads:  
  The angle in grads will be entered as usual, including a decimal point, if 
needed.  
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
Click ‘Apply’ to perform the intersection. The program will present the 
coordinates of the  
intersection (if the data is being intersected!), also in fields ‘X’ and ‘Y’. The 
computation report will be updated accordingly.  

 
 

Intersection by arc and a straight line  
 
Activate - ‘Geometry -> Intersection line-arc’ from the main menu. The 
window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for finding the intersection point between the arc defined by 
its center point and radius, and the line defined by two points. In the fields 
of this window enter:  
 
Center point -  the center point of the arc. 
Radius – the radius of the arc. 
From point – the first point on a straight line. 
To point - the second point on a straight line. 
New point 1- the name of the first intersection point for creation. 
New point 2 – the name of the second intersection point for creation. 
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
         Click ‘Apply’ to perform the intersection. The program will show the 
intersection 
coordinate points in fields ‘X’ and ‘Y’ of ‘Point 1’ and ‘Point 2’. The 
computation  
report will be updated accordingly.    

 

Intersection point between two lines 



 

 

Page 170 of 508  
 
 

CivilCAD 2016 Reference manual 

 
Activate - ‘Geometry -> Intersection line-line’ from the main menu. The 
window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for finding the intersection point between two lines. In the 
fields of this window enter:  
 
Point 1- the first point on the first line. 
Point 2 - the second point on the first line. 
Point 1 - the first point on the second line. 
Point 2 – the second point on the second line. 
New point – the point name to be created. 
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
Click ‘Apply’ to perform the intersection. The program will show the 
intersection coordinate points in fields ‘X’ and ‘Y’. The computation report 
will be updated accordingly.   

 

Locating points on a line 
 
Activate – ‘Operate Geometry -> Locate point on a line’ from the main 
menu. The window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for calculating points on a line. In the fields of this window 
enter:  
 
From point – A point on a straight line that serves as the starting point for 
computing points. (the starting point is the point from which distances are 
entered). 
To point – the second point on a line. 
 
Note: After the two points that define the line were gathered, the distance 
between these two points will appear in the bottom field (under the ‘X’ and 
‘Y’ fields).  
 
Distance – The distance of the new point/points computed from the first 
known point on the arc. This distance can be:  
 
A single space – in this case the single point will be computed according to 
the distance  
  that was entered.  
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A formula in format  X>Y : Z with ‘X’ as the distance of the first point to the 
creation, ‘Y’ the distance of the last point to creation, and ‘Z’ the distance 
between the points. For example 10: 50<0. The program will distribute 
points across the arc at stations that vary from 0 to 50, each 10 meters.  
Division of the segment between the two known points to ‘X’ equal parts – 
“/X”. For example, entering /5, will divide the segment to- 5 equal parts.  
Division of the segment between the two known points by the distance of 
‘X’ meters –“X:”. For example, entering 2:, will create points every 2 meters 
on the arc.  
 
New point – the name of the new point the program will create. In case a 
group of points is formulated, the program will number these points starting 
from the number that was first entered in the field.  
 
 Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
To perform the computation click ‘Apply’. The program will compute the 
points and enter them into the points list (topography coordinates list or 
designed coordinates list), as was defined by in the ‘Setting Window’ (see 
section “Coordinates Geometry Definitions”). If a single point is computed, 
its coordinates will appear in fields ‘X’ and ‘Y’ in the window, as well 
Clicking on the report button will activate the ‘report window’ in which the 
current computation will be displayed. 

 

Locating a point by azimuth and distance  
 
Activate – ‘Operate Geometry -> Locate point by azimuth’ from the main 
menu. The window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for computing a point by azimuth and distance from a known 
point. In the fields of this window enter:  
 
From point – the known point from which the other points will be computed. 
Azimuth – azimuth for the computed point.  
 
Working in degrees: 
we emphasize here that the azimuth will be entered completely, separated 
by commas in the following fashion : DDD,MM,SS. Examples for angles : 
5,17,10    56,12,10    186,22,32  and so on. It is possible to insert the given 
angles in full degrees, only by the degree grade, for example: 90 (for 90 
degrees). 
please notice : the angles format in the Coordinates Geometry is different 
from the format of the Distomat data computation where angles are 
entered without separation.   
 
Working with grads:  
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the angle in grids will be entered as usual, including a decimal point, if 
needed.  
 
 
Distance – the distance to the computed point.  
New point – the new point the program will create.  
 
 Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
To perform the computation click ‘Apply’. The program will compute the 
points and enter it into the points list (topography coordinates list or 
designed coordinates list), as was defined in the ‘Setting Window’ (see 
section “Coordinates Geometry Definitions”). The coordinates points will 
appear in fields ‘X’ and ‘Y’ of the window. Clicking on the report button will 
activate the ‘report window’ which will display the current computation. 

 
 

Locating a point by distance and angle 
 
Activate - ‘Operate Geometry -> Locate point by angle’ from the main 
menu. The window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for computing a point by distance from a known point, and 
orientation angle created from the same point and from another known 
point. In the fields of this window enter:  
 
From point – the known point from which points are computed.  
To point – another known point that will create the base-line (the o point) 
for determining direction. 
Angle – the opening angle from the base-line to the new point you wish to 
compute. 
 
We emphasize here that the angles will be entered completely, separated 
by commas in the following fashion : DDD,MM,SS. Examples for angles : 
5,17,10    56,12,10    186,22,32  and so on. It is possible to insert the given 
angles in full degrees, only by the degree grade, for example : 90 (for 90 
degrees). 
 
Please notice : The angles format in the Coordinates Geometry is different 
from the format of the Distomat data computation where angles are 
entered without separation.   
 
Distance – the distance to a new point.  
New point – the name of the new point the program will create.  
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Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
To perform the computation click ‘Apply’. The program will compute the 
points and enter it into the points list (topography coordinates list or 
designed coordinates list), as was defined in the ‘Setting Window’ (see 
section “Coordinates Geometry Definitions”). The coordinates points will 
appear in fields ‘X’ and ‘Y’ of the window. Clicking on the report button will 
activate the ‘report window’ which will display the current computation. 

 

Offset from a point to a line  
 
Activate – ‘Operate Geometry -> Offset on line’ from the main menu. The 
window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for computing an offset point of a known point external of any 
line, on the line itself. This offset point is the meeting place between the 
line and the line offset to it, leaving the known point (see diagram in 
window). In the fields of this window enter:  
 
From point – The first known point on the line. 
To point – Another known point on the line.  
External Point – A known point outside the line for which the offset point 
will be computed.  
New point – the name of the section point to be created. 
 
 Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
 
To perform the computation click ‘Apply’. The program will compute the 
points and enter it into the points list (topography coordinates list or 
designed coordinates list), as was defined in the ‘Setting Window’ (see 
section “Coordinates Geometry Definitions”). The coordinates points will 
appear in fields ‘X’ and ‘Y’ of the window. Clicking on the report button will 
activate the ‘report window’ which will display the current computation. 
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Parallel lines  
 
Activate – ‘Operate Geometry -> Parallel lines’ from the main menu. The 
window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for computing two points on a line parallel to the line with two 
known points, when the distance between the two line is known. In the 
fields of this window enter:  
 
 
Point 1 – The first known point on a line. 
Point 2 – The second known point on a line. 
Offset – The distance between the two parallel lines. This distance will be 
entered as a positive number when the parallel line is to the right to the 
known line, and as a negative number when the parallel line is left to the 
known line. The definitions “left” and “right” will be determined according to 
the order of the points that define the known line (Point 1, Point 2). 
New point 1 – the new point for computation on the parallel line. This point 
is counter to Point 1.  
New point 2 – the second parallel point for computation on the parallel line. 
This point is counter to Point 2.   
 
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
To perform the computation click ‘Apply’. The program will compute the 
points and enter it into the points list (topography coordinates list or 
designed coordinates list), as was defined in the ‘Setting Window’ (see 
section “Coordinates Geometry Definitions”). The coordinates points will 
appear in fields ‘X’ and ‘Y’ of the window. Clicking on the report button will 
activate the ‘report window’ which will display the current computation. 

 

Tangents 
 
Activate – ‘Operate Geometry -> Tangents’ from the main menu. The 
window will open from the right.  
 
You can use ‘Pick’ and ‘Locate’ as explained in section “general remarks”. 
 
This option is for computing two tangent points to the arc, when the known 
data are the arc center point, the arc radius, and a point outside the arc 
through which pass the tangents lines.  
In the fields of this window enter:  



 

 

Page 175 of 508  
 
 

CivilCAD 2016 Reference manual 

 
 
Center point – the known arc center point 
Radius – the known arc radius 
External point – the known point outside the arc through which the 
tangents lines cross. 
New Point 1 – The first computation tangents point.  
New Point 2 – The second computation tangents point. 
 
Note: You can move between the different fields in the window, by clicking 
‘Enter’. 
 
 
To perform the computation click ‘Apply’. The program will compute the 
points and enter it into the points list (topography coordinates list or 
designed coordinates list), as was defined in the ‘Setting Window’ (see 
section “Coordinates Geometry Definitions”). The coordinates points will 
appear in fields ‘X’ and ‘Y’ of the window. Clicking on the report button will 
activate the ‘report window’ which will display the current computation. 
 

 



 

 

Page 176 of 508  
 
 

CivilCAD 2016 Reference manual 

 

Chapter 13: Earthworks on 
roads 
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Earthworks computation on roads 

 
In this chapter we will discuss Earthworks on roads.  
CivilCAD 2016 is one of the leading, convenient programs for the 
computation of Earthworks across roads. CivilCAD 2016 is also the 
strongest tool for Roads Design. In this chapter we will focus, using 
examples, mostly on quantity computations and less on the design aspect, 
keeping in mind that it is not fully possible to break them up.   
 
In order to explain the use of this program for Earthworks computations on 
roads, we will look at samples that illustrate this process. During the 
discussion of the examples, we will review the program’s command 
buttons and study their functions.  
 
Note: In order to expand your knowledge on the operation of CivilCAD 
2016 for quantities computations, it is recommended to read section “Road 
Design’ in chapter 14. You will find a detailed description of all of the 
program’s functions along center lines and roads, which will be useful also 
for computing quantities in sections.  
 
Sample 

 
We will now demonstrate the work stages for computing Earthworks in 
sections. This example is relatively simple and does not combine the 
complex techniques that exist in the program.  
 
Open a new project (see: chapter 1 -working with projects) 
Activate ‘Roads -> Cross sections’ 

From the right window, click on the button  . The ‘Define sections’ 
window will open. Define the cross sections in the following manner: 
Start at station – station of the first section, we will leave the data ‘0’. 
End at station  - station of the last section, type ‘100’. 
Distance between stations – distance between sections, leave the data 
‘20’. 
Name of first section – the name of the first section, leave ‘1’.  
 
To end click ‘OK’. 
 
From the right window, click on the ‘Status’ button (picture of a hand 
holding a card-index). In the window that opens define the following:  
Sections width – define the maximum width to the sections left and right 
of the center line: Right, left. We will define a work range of “-20” – from the 
left (the distances to the left of the center line are negative), and “20” from 
the right.  
From ‘Sections format’ choose ‘Earthworks’, and mark ‘Existing’ and 
‘Design’. This definition sets the presentation of the section configuration in 
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the drawing. For computation of Earthworks quantities, we will use mostly 
the ‘Earthworks’ format, and for design – ‘Design’.  
Another work status that must be defined from this window is : Elevation 
(see Elevation and dH). This is where we tell the program that the heights 
entered are absolute in relation to the sea level (in contrast to relative 
heights to the vertical alignment that had been defined – see: “Roads 
Design”). To finish, click ‘OK’. 
 
Once the definition process is done, a chart will appear to the right of the 
sections list from ‘1’ to ‘6’ (Name), according to stations from ‘0’ to ‘100’. 
We will now add an intermediate section to the sections list at station ‘15’. 
Using your mouse, stand on section number ‘2’ and click ‘Enter’. Open an 
empty line. Stand on the empty line and insert section ‘1.1’, click on the 
right arrow to go to ‘Station’ column, and enter station ‘15’. 
 
Note: If you wish to delete a section that was entered by accident, you can 
do so in the following manner: stand on the desired section from the chart 

on the right and click the  button from the group of buttons.   
 
 
Now we will begin to enter the sections data. Mark section number ‘1’ from 
the chart on the right. You will notice that at the head of the screen in the 
head title appears the labeling: ‘Sections name: 1’, that implies that you are 
currently working on section number ‘1’. Move to the bottom left chart 
(Existing G.L) and begin to type the topography data of section number ‘1’.   
 
 
Segment  Offset  Elevation 
 -2  -10  100 
 -1  -5   100.32 
 0   0  100.17 
 1   5  99.15 
 2   10  100.15 
 3   20  100.37 
 
 
Offset is the distance (in meters) from the center line, when negative 
numbers are to the left of the center line, and the positive, to the right.  
Elevation is the height at the given distance. In the column on the far left 
appears the serial number that is the segment number. The serial numbers 
are between -40 to 40, so that for each section you can insert up to 81 
segments (40 X 2 + segment number 0). You can scroll the table up and 
down using the scroll bar from the right. When you finish entering the data, 
click ‘OK’ from the window on the right to get the drawing section.  
 
 
Move your mouse to the bottom right table (Designed G.L), and enter the 
following data as designed status: 
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Segment  Offset  Elevation 
-1  -5   99.5 
 0   0  99.5 
 1   5  99.5 
 
This entering of data is similar to the existing topography status. The third 
column (Slope%) represents the slope in percentage between the previous 
segment and the current one, in the direction leaving the center line. It is 
possible, therefore, to enter the data either as height or slope: when you 
enter one, the other will be automatically computed. The forth column 
(Cover), will not be discussed here, only in ‘Roads Design’. When you 
finish typing the data, click on the ‘OK’ button from the right. You will notice 
that the ends of the section slopes were built vertically. This is because we 
have not defined a dibbling slope. The following labeling will appear at both 
ends of the section, up and down:  
 
 
Slp. Left: Cut 1:                     Fill 1: 
 
 
Slp. Right: Cut 1:                   Fill 1: 
 
 
In these places it is possible to enter the dibbling slopes. Enter the left 
slope at the top, and the right slope at the bottom. In ‘Section’ enter the 
slope for ‘Cut’ and ‘Fill’ for fill status (the program will check whether the 
section is at “cut” or “fill” and use the correct data). Enter the slope dibbling 
as the ratio of ‘1’ to X, implying that if we want the ratio from the left side of 
the section, on the condition it is in ‘cut’ status, to be ‘1’ to ‘2’, we will enter 
under ‘Slp. Left:Cut1:’ - the data ‘2’ (note: the ratio of 2:1 we will enter as 
0.5). 
In our example, we will enter the section ratio of 1:2 for all positions. To do 
so, enter the data ‘2’ in all four boxes. Click ‘Apply’ in order to get the new 
section structure.  
 
 
 
Continue to fill the rest of the sections data. Move to section ‘2’ by marking 
it in the table from the right. Enter the following data into the tables.  
 
Existing Topography Status:  
 
Segment  Offset  Elevation 
-2  -7.5  100.97 
-1  -5     99.56 
 0   0    99.36 



 

 

Page 180 of 508  
 
 

CivilCAD 2016 Reference manual 

 1   5    99.15 
 2   7.2  100.15 
 3   15  100.55 
 
Designed Status:   
Segment  Offset  Elevation 
-1  -5  99.7 
 0   0  99.7 
 1   5  99.7 
 
Once again, enter the 1:2 slopes into all four positions. Click ‘Apply’ to get 
the structure of the section. 
 
We will not enter manually the remaining sections. Instead we will 
demonstrate here the use of interpolation between sections.  

Click on the  button of the existing topography status in order to copy 
this data into the computer’s memory (the Copy button is located to the left 
of the topography table).  
Move in the table right of the last section (section number 6). 

Click on  to the left of the topography table in order to copy this data 
into the current section. 
Click ‘Apply’.  
Go to the last section and enter the design data into this section. Click 
‘Apply’. 
We will now elevate the designed data in the last section by – 1 meter. 
Click on the dH button from the right window. Enter ‘1’ and click ‘OK’. In the 
window that opens, move from topography status to designed status 
(Designed G.L). Choose the last section from the ‘Section lists’ window 
and click ‘OK’ again. The designed state data will be elevated by the 
desired difference.  
Click ‘Apply’ to get the new dibbling. 
 
Now we have three sections in our project: ‘1’, ‘2’ and ‘6’ full, and the rest 
without data. We will now perform interpolation to the empty sections:   

Click on the interpolation button from the right window ( ). 
Choose ‘All’ and ‘OK’ from the window that opens. Now the interpolation 
for all the empty sections will be performed.  
Note: After the interpolation all the empty sections will be filled with data. 
To repeat the interpolation you will have to erase the desired data sections, 
and only then command its performance.  
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To print the sections click on the  button right of the drawing: 
Define the scale for Printing from the window that opens: Height scale, 
Long scale. Enter ‘100’, ‘100’ (scale of 1:100/1:100). Click ‘OK’ to continue.  
From the window that opens, define the type, size and other desired 
parameters connected   to the printer you have at hand. Click ‘OK’ (or 
“confirmation”) to continue.  
Now choose any one of the sections you would like to type. To choose all 
the sections click on the ‘A’ button from the bottom of the window. Click 
‘OK’ to print.  
 

The program will print the sections continuously, according to the language 
defined in the system. To change the language perform the following 
steps: 
Exist the ‘cross sections’ using ‘Cancel’.  
Activate – ‘File -> configuration’. 
From the right hand window, choose the desired language from under 
‘Languages’. 
Click ‘OK’ and return to cross sections - ‘File -> Cross sections’.   
Return and print the desired sections as we have shown. 
 

We will now go to quantity computation: 
Exit the ‘cross sections’ window by clicking ‘Cancel’ from the window on 
the right. The program will return to the main window. 
From the main menu activate : ‘Roads-> Earthworks’. The Earthworks 
quantity computation window will open from the right. 
Click ‘OK’ to get the summarizing table of the volumes computations. The 
reports window will open with two reports: 
Earthworks report. 
stripping areas report (this report follows the Earthworks report – to view, 
scroll the window downward using the scroll arrows).  
To print the report click on the ‘printer’ button at appears at the bottom.  
It is possible to choose the columns that will appear in the reports (in the 
Earthworks report and in the stripping areas report). To do so click on the 

‘Status’ button  from the right window. Check (or uncheck) the desired 
columns in your report. Click ‘OK’ to confirm.  
 
You can get a detailed report of all the sections data. Click on the ‘Sections 

data report’ , and a window will open with the report. For every section 
you will get the data that had been entered, the ‘cut’ section area, the ‘fill’ 
section area, and it’s length in ‘cut’ and in ‘fill’. Click on the ‘printer’ button 
at the bottom, to print the report.   
Earthworks report can be performed on selected roads from a list. 
From CivilCAD main menu, go to 'RoadsEarthworks’.  
Click ‘Select’, mark the desired roads for earthworks calculation and click 
‘OK’. 
Click on ‘Apply’ button to perform roads earthworks report. 
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In order to exclude ditches in roads earthworks report, from CivilCAD main 
menu, go to 'RoadsEarthworks’. 

Mark ‘V’ in ‘Exclude ditches’ option  and click ‘Apply’ to 
create roads earthworks report. 
 
Notice that ditches volume calculations are separated from cross sections 
volume calculations.  
 

 

Creating mass haul diagram using Excel 
 
A diagram of accumulated mass haul curve displaying the accumulated 
quantities (cut or fill) at each mass along the current centerline or in a non-
accumulated display (this option is possible only if Microsoft Excel is 
installed in the computer). 

Click button   "Excel mass haul diagram". A window will be opened 
presenting two options:  
Accumulated mass haul diagram – diagram presenting the accumulated 
cut/fill quantities along the centerline . 
Sections volumes diagram – diagram displaying the cut/fill quantities at 
each cross-section. 
Choose one of these options and click "OK". The software will display the 
diagram in the Excel window. 
This document has to be saved by the Excel because it's not saved with 
other project data. 
If Microsoft Excel isn't installed on the computer in which the software is 
activated, a warning will be displayed and the action will be terminated. 

  

Importing Excel data 
 
CivilCAD 2016 allows for the importing of sections data from an Excel file. 
To visualize this process go to the example below: 
 
Preparation of Data File 
 
Open a new Excel document and fill in the data according to the 
explanation below: 
Every line in the table represents a section. The first column represents a 
permanent value that will always be ’1’, the second column represents the 
section name and the third column represents the station for the same 
section. The remaining columns represent the section’s ‘Offset’ values and 
height accordingly. The values are entered in the order of Offset Height   
Offset Height…. Etc.  A negative value offset represents the distance from 
the left to the center of the section (see column drawing – D, E and so on). 
 
 



 

 

Page 183 of 508  
 
 

CivilCAD 2016 Reference manual 

                             
Permanent   Section's name   Station   Offset    Elevation …        

 
 
 
After entering the data, save it to Excel as a text file.  
From Excel menu open ‘File->save as’  
From the window that opens choose: Text (Tab delimited) (*.txt) 
Enter the file name and click ‘Save’ 
 
Importing of Excel data to CivilCAD 2016 
 
After creating a text file containing the data from the Excel sheet, it can be 
imported into the desired table in the cross sections.  
 
Activate CivilCAD 2016 and open a new project: 
 
Open ‘Roads -> Roads list’ 
Enter a road to the roads list. 
Open ‘Roads -> Cross Sections’ 

Click on the  button ‘Load sections from text file’ 
Choose - Text (Tab delimited) (*.txt): Files of type 
Choose the file with the data. 
From the window that opens, choose the table to which you would like to 
import the data. 
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Chapter 14: Roads design 
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Roads design 

 
This chapter will discuss one of the program’s main options – Roads 
Design. The process of Roads Design includes many aspects to which the 
program, as a whole, answers to. The arrangement of fields and lots at the 
side of the road, is not specified in this chapter, and can be read about in 
great length in chapter 7 - “Computation of Earthworks Volumes Using 
Planes”. This chapter will discuss design phases that include: 
 

 Preparing the background (existing background). 
 Organizing the project Roads list. 
 Horizontal Alignment. 
 Vertical Alignment. 
 Roads intersections in Vertical Alignment. 
 Alternative Vertical Alignment  
 Cross Sections. 
 Super Elevations. 
 Side Ditches and additional Cover functions.  
 Berms design. 
 Working with typical sections. 
 Advanced topics on cross sections. 
 Geometric computation along the centerline. 
 Changing the Horizontal Alignment. 
 Changing the road's alignment after a full design. 
 Automatic junctions design. 
 Field of view planning. 
 Breaking distance test. 
 Design lots between roads. 
 Bridges design. 
 Tunnels design. 

   
We will now proceed throughout the chapter step-by-step, observing all the 
aspects that are connected to roads design. The steps are presented by 
their recommended order. After gaining experience with the program, each 
user can define his/or her own work order according to his/her personal 
work habits. 
 

 

Preparing the background (existing background) 
 
Open a new Project (File-> New Project) and name it.  
From the AutoCAD/Bricscad menu, insert the background DWG file (if any) 
as a block (Insert -> Block command in the AutoCAD's menu) and explode 
it. 
Save your project (File -> Save, in the CivilCAD 2016 menu). 
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The key to CivilCAD 2016 is its 3-D model. On the basis of this model the 
program enables functions such as: taking out sections, quantity 
computation and so on. In order to create this model, the program must 
have a coordinates file. If you have a coordinates file in an ASCII (Text) 
format, read it into the project using the following steps: (If the file does not 
exist, skip these 3 steps).  

From the bottom window, click on  (‘Load from text file’ button) and 
choose the desired coordinates file. After choosing the file, a list of points 
will appear at the bottom window.  

Click on  button. The program will create a drawing layer of existing 
topography points from the list.  
 
To actualize the explanation we will use a coordinates' file that exists in the 
system and installed with the program. To do so, use the file – 
‘Sample7.Tco’ from folder ‘Samples’. 
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Samples\Sample7\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 
 
 - Continue to 5.  
 
As aforesaid, the program needs a coordinates file. If this file does not 
exist, the program can create it from the drawing file (the DWG), using the 
following procedure: 
 
From the main menu, activate – ‘General -> Filtering’. A window will open 
from the right. The key to creating a coordinates file from the drawing is to 
filter a layer (AutoCAD drawing layer), in which the points or contour line 
are at. Therefore, you must first trace the desired layer in AutoCAD. The 
entities in the layer must have a dimension of height.  
 
The right window is divided into two sections. In the top section appears a 
list of the drawing layers, and at the bottom an entities selection list. 
Mark the level you want to filter. 
Choose the entity type for filtering. 
 
Now we will specify how to determine the desired entity type. At first we will 
check if the drawing has a measured points' layer. If this layer does not 
exist, filter the contour lines layer instead (assuming it exists). After finding 
the layer/layers where the measured points are, check the entity type. As a 
rule, it is best to filter blocks by filtering the layer on which they lay. If the 
drawing does not have any blocks, check if there are points entities in the 
drawing, and if they have height (have z), filter them. At a lower priority you 
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can also filter the text entities, taking into account that the location of the 
text can be a bit different from the location of the measured point itself.  
 
If the file has no measured heights (measured points), move on to filtering 
contour lines. To do so, check if the contour lines are lines or polylines, 
and if they have height (z). 
When filtering contour line, the software will create a large number of 
points, especially in circular or complex contour line. Therefore, it's 
imperative to narrow the distance of filtered points. For full explanation on 
this option see clause "Narrowing the number of filtered points" in 
chapter "Handling DWG files". 
 
Choose the caption Topography (the program will filter the points to 
Topography Coordinates list).  
Click ‘Apply’ in the right window. The program will begin to filter the chosen 
layer by to entity type. At the end of this process the filtered coordinates list 
will appear at the bottom window (Topography coordinates). 

Click on the  button. The program will create a *new points layer on the 
drawing. 
 
* CivilCAD 2016 creates a new points list of its own. This layer will be in 
addition to an   already existing level.  
 
 
It is possible that the surveying file will have breaklines in addition to 
points. An extensive section in chapter 4 -“Creating Contour lines - 
Breaklines” is dedicated to this issue, so we will not discuss it further here. 
If such lines do exist (in the drawing or as a separated file), they are an 
inseparable part of the surveying file and must undergo another filtering 
process (in case you do not know whether there are breaklines in the 
drawing, skip to number 6). 
 
The same as for the coordinates file, the breaklines file can be either read 
from an ASCII (Text file) or can be filtered from the drawing. Use one of the 
two methods to read/create the breaklines file: 
 
Reading the breaklines file from an ASCII file: 
From the main menu activate: ‘Topography -> Lines’. A window will open 
form the right. 

Click on  (Load from text file button). The files window will open, and 
you will be asked to choose .dis file types only (the files type Filter is *.dis). 
Choose the breaklines file and press 'Yes' for the message. The file will 
load, and the list of breaklines will appear at the right window. The program 
will create a drawing layer of the breaklines.  
 
Filtering the breaklines from the drawing: 
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Activate Topography->Lines. 

Click on button  - Filter breaklines   
In the Filter breaklines window choose Select. Go over the drawing and 
click on one of the lines from the lines' layer or choose the layer and type 
of line from the lists at the right window.   
Press 'Apply'. In the message that appears - click ‘Yes’ to create breaklines 
only, without adding points to the existing topography points list. Click ‘No’ 
to create the breaklines and add the Vertex point of the breaklines, to the 
existing topography points list. 
 
Note: In most cases there is no need to add the vertex points to the 
existing list since these points already exist there. Therefore, click ‘No’ only 
if you know for certain that you wish to add the vertex point. In any other 
case, click ‘Yes’.  
 
After the confirmation notice, the breaklines will be filtered and added to 
the project.   
 
 
Creating Contour lines. 
 
The last stage in preparing the existing topography status is creating 
contour lines. Even     if you posses a DWG file that already has contour 
lines, you will have to perform this step, since during the creation of 
contour lines, the program creates also the 3D-model on which it is based. 
This model cannot be seen by the user (even though it is possible to 
present it), but important in order to continue working with the program.  
  
From the main menu activate: ‘Topography -> Contours’. A window will 
open from the right.  
From the right hand window, define the vertical interval between the 
contour lines. To do so, erase the word ‘default’ right to the ‘Intervals’, and 
enter the desired interval in meters (sample: 1). 
Click ‘Apply’. The program will begin to create contour lines. It is possible 
that the program will find a certain problem points in the points file, that will 
disenable the creation of lines. If the problem has a relatively simple 
solution, a message will be appear warning about the problem/problems. 
The detailing of the problems will appear in the Log file (that can be 
opened using a simple editor). Since we do not want to get into detail on 
the creation of contour lines, confirm the warning message, and the 
program will continue to work as usual.  
  
The process of creating contour lines is a function of the number of points 
in the project, and the number of breaklines (if you have any). There might 
be cases where the program will work for a long time. Wait patiently until 
this process is completed. The outcomes of this process, if executed 
properly, are compatible drawing layers, created by the program, in which 
the contour lines will appear. If such layers do not appear, then this is a 
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problem that cannot be solved automatically and you will have to process 
the coordinates file (on the creation and process of contour lines see 
separate chapter). 
 
We will now study how to perform regularity tests along with the 3-D 
model: 
 
Locating an existing height at a certain point. 
 

Click on the  (Pick Height) located over the drawing window. Move with 
your mouse to the drawing and place the "Pick Height" mark in the height 
line vicinity. Click the mouse. The point where your pointer is located, will 
appear on the lower side of the software's window near the caption 
height_d and height_t. 
 
This tool for locating height is the most convenient option to check the 
regulation of the 3-D model. H(T) is the existing topography height and 
H(D) is the designed height. With the ‘design’ lacking, these two heights 
will be equal.  
 

 
 

Organizing the project Roads list 
 
After you have finished preparing the background settings, you can start 
the design. You will learn in this section how CivilCAD 2016 organizes the 
relevant center lines for the current project.  
 
From the main menu activate:  ‘Roads-> Roads list’. A window will open to 
your right. In the window you will see the project center lines list. If there is 
no center line definition, CivilCAD 2016 automatically opens a center line 
labeled ‘Road 1’. If the center lines list screen (current screen) is entered, 
the center line will be erased and the list will be empty. 
Type in the table from the right the list of center lines in the current project. 
Every center line in the project must be given a name. The name can be a 
number or an alpha- numeric number. The names of the center lines are 
not important and there are only to help you organize the data. After each 
center line you name, click ‘Enter’. 
When you finish typing the list click ‘Cancel’. 
 
To assimilate this example enter a single center line and name it ‘Road 1’. 
 
At the head of every window that appears during the Roads design 
(defining the horizontal alignment and the vertical alignment design, etc.), 
will appear the road presently at work. If there are several center lines in 
the project, you can always browse through them using the small arrow 
that appears next to the name of the road in process.  



 

 

Page 190 of 508  
 
 

CivilCAD 2016 Reference manual 

 
A detailing of additional activity from this window: 
 

The  button is for deleting all center lines in the project. Before the 
operation you will receive the proper warning.  

The  button is for deleting a single center line. The center line erased 
is the center line marked on the list. Before the operation you will receive a 
warning notice. 

 - adding remarks. Mark (in the list) the road you want to add notes to, 
and press the remarks button. In the new window, enter the remark for this 
road and press OK. 
 

 

 

Horizontal Alignment 
 
Activate ‘Roads -> Horizontal Alignment’ from the main menu. The 
window will open from the right. Pay attention that the ‘Topography 
coordinates’ list at the bottom window had been replaced by a new, 
empty list, of the ‘Designed coordinates’.  
 
Entering the center line IP data. 
There are several methods of entering the IP center line data. We will 
study two: 
 
Method A: 
In AutoCAD, draw a Polyline (2D Polyline) that will serve as the Horizontal 
Alignment of the center line.  
Choose ‘Select’ from the table on the right (with the list of ‘Select, ‘Locate’, 
‘Pick’, ‘Unused’). 
In the AutoCAD's command line, press 'Enter' for <Polyline>. 
Move to the drawing area and choose the drawn Polyline and click ‘Enter’. 
The table from the window on the right will fill with the center line IP list. 
Every vertex in the Polyline will be set as the IP of the center line, and in 
the bottom window their coordinates list will appear.      
 
* Note: The names of the IP points to the center line will be determined by:  
‘xIPy’, with ‘x’ as the center line number, and ‘y’ as the IP number. In the 
first center line chosen, (first act of ‘Select’), the IP’s will be numbered in 
the following fashion: 1IP1, 1IP2, 1IP3, 1IP4, and so on. In each new act of 
‘Select’, the ‘x’ will grow.  
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Method B: 
In the bottom window, type the IP center line list. For example: 
 

256123.76 175143.56 IP1   

256325.56 175200.40 IP2   

256327.12 175256.00 IP3   
   

Type in the IP names as they were typed in the bottom list in the table from 
the right. Type the IP under the labeling – ‘IP’ in the table. In this example 
we will enter the list in the following manner:  
     

                   
 
 
 Entering the radius of the center line. 
The next step in the Horizontal Alignment is defining the radiuses at the IP 
points. If we do not define them, the program will regard the radiuses as – 
0.  
Enter the desired radius for each of the IP’s in the right table. Do not define 
a radius for the first and last radius. 
Click on the ‘Apply’ button from the right. The ‘Layout & contours’ window 
will open.  
Click ‘OK’ again in the window that opens (we will not detail here the uses 
of this window. Later on we will return to this window and explain its 
usage). 
 
The program will create the Horizontal Alignment of the center line, that will 
appear in  
several separate layers. Next to each IP will appear it’s coordinate, and 
next to each arc – the arc data.  
 
 
To assimilate the example (see two previous chapters), move a polyline in 
the project  
valley (surveying file \Samples\Sample7.Tco). Transfer the Polyline to 
include both the lines and the arcs (choose \Arc\ during the drawing of the 
– Polyline). Entering  : Clothoid 

 
Entering clothoides: 
To create clothoides in the center line, enter the transition length in the 
entrance to the arc, in the field ‘Clot.In’, and the length of the transition 
curve exiting the arc, in the field ‘Clot.Out’.  
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After entering the clothoides click ‘Apply’ and ‘OK’  to see all the changes 
on the drawing.  
 
After entering the clothoides and clicking ‘Apply’, you will notice the 
following changes on the arc: 
TS- transition from a straight segment to the transition curve 
SC-  transition from a transition arc to a full curve  
CS - transition from a full curve to an exit transition arc  
ST – exit from a transition curve back to a straight segment  
 
 
Changing the IP Location. 
 
The program binds the bottom list, in which appears the center line 
coordinates, and the top list (right), of the center line definition, according 
to points names. Therefore, as long as you keep similar name points, both 
in the top and bottom list, this connection will be kept. Changing the 
coordinate of a certain point, in the bottom list, and clicking ‘OK’ in the right 
window, and again ‘OK’ in the window that opens, will move the entire 
center line alignment according to the new location. Now you will see how 
to move IP not by manually changing the coordinate, but by making a 
graphic change: 
 
From the bottom window choose ‘Move’ from the list (Unused, Locate, Pick 
etc.).  
For AutoCAD users only: 
Move to the drawing and chose the point you wish to move (you will notice 
that the ‘Object Snap’ for ‘Node’ has been operated). 
Mark the reference point for movement (most likely that you will choose 
again the same point itself as the relevancy point). 
Mark the location to where you wish to move the point. 

To complete this action, click on the  button. This point will move to its 
new location.  
Click 'Apply' from the right window, and 'Ok' in the window that opens. The 
center line will move according to the new location of the IP. 
 
For users of the Stand Alone version: 
Move to the drawing and chose the desired point (enter the point in the 
square that appears). 
Mark the new location of the IP.  

Click  from the toolbar above the drawing.  
Click ‘Apply’ from the right window, and 'Ok' in the window that opens. The 
center line will move according to the new location of the IP. 
 
 When you finish defining the Horizontal Alignment, click ‘Close’. 
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Additional functions 
 

 - 'Load from text file' – reading the center line data from 
Dis/LLD/xml/Rds type file. 
 

 – deleting all center line data. A warning will appear before this 
function is activated. 
 

 – erasing a single IP in the center line. After erasing the IP, click 
‘OK’, and in the window that opens, click ‘OK’ again, to get the new center 
line alignment. 
 

 - Reversal order of IP's (reversal of the road's direction). After clicking 
this button, the program will alter the order of IP's. First IP will become last.  
on the coordinates' list - after creating the IP, the program will construct the 
road's layout in the opposite direction (click on 'Apply' and 'OK'). 
 

 - Reorder all roads  . This option is very useful when dealing with a 
project that includes multi roads, and whereas the numbering of the roads 
or IPs are not in order (for example, if we have deleted a certain road from 
the project and later add some new roads, the prefix of the IP's will not be 
following between the roads). To maintain the order in the project you can 
use this option. After pressing the button, a window with the following 
options will be opened: 
 
Option 1: Changing the numbers in the prefix and suffix of each IP 
(xIPy). 
Check the option "Rename roads numbers (xIPy) first number (X)". 
In the field, enter the first number (X) that will represent the current road's 
IPs prefixes. To apply the changes to the entire roads in the project (not 
only the current road) check the "Apply changes to all roads" option). For 
example enter 1. 
To renumber the inside numbering of IPs in each road (Y), check the 
"Rename IPs numbers (xIPy) first number (Y)" option, and enter the first 
number in the field. For the example enter 0.  
When checking the above option, another option labeled "Fit IPs names in 
layout boxed to IP" will appear. Checking this option will fit the inside 
number in each IP box (in the layout drawing) to the Y value. 
After pressing OK, the IPs numbers will change according to the settings 
you have entered. 
 
Option 2: Changing the numbers from the first IP to the last IP at a 
serial order (no roads numbers). 
Check the option: Rename all IPs in all roads without prefix number. 
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Enter the number of the first IP in the first road. For example you can enter 
0.  
After pressing OK, please notice that the first road's IPs is numbered as: 
IP0, IP1, IP2…, the second road's IPs starts after the last IP number of the 
first road and so on. 
  
Additional options in this window: 
Clear unused IPs from coordinates list – Checking this option and 
pressing OK will clear all the points (from the lower coordinates list) that 
their names contain the letters 'IP' and that are not included in one of the 
roads. This option is very useful after deleting roads from a project. 
Update layout automatically- Checking this option and pressing OK will 
perform a layout creation in addition to other changes applied in the 
window. 
  

 - Options button  – click on this button to open a new window. In this 
window you can determine these settings: 
 
Changing the ‘Scale’ font size. 
In order to change the font size in the center line data, choose your desired 
scale from the list. To do so click on the small arrow button next to the 
given number in the box, and choose your desired font size (the scale is in 
meter units according to the ratio of 1:X, with ‘X’ as the chosen size). After 
selecting click ‘OK’ to close this window. To change the drawing, you will 
need to click again on the ‘Apply’ button from the right, and ‘OK’ in the 
window that opens. 
 
Create Layout - the format of layout's drawing.  
2D Polyline + bulges - the software will draw the layout lines without noting 
elevation. This option is useful when the drawing file has to be reduced in 
size, because the software will draw fewer points on the line and use 
bulges (radiuses) to create curviness. 
3D Polyline - the software will draw the layout line with elevation but will 
also create the line of a larger number of points because in 3D mode, 
Drawing of Polyline comprised of radiuses is impossible.  
   
 
Changing the IP numbering when working with ‘Pick’ (“IP counter in 
coordinates”). 
You can define the Horizontal Alignment by selecting ‘pick’ from the list 
(see previous window – ‘Pick’, ‘Select’, ‘Locate’ etc.). To determine the IP 
numbering as it will be done using ‘Pick’, enter the desired number. The 
next time you use ‘pick’, the IP numbering will be determined by the 
number entered.  
 
IP counter in layout - changing the IP numbering in layout. 
For every center line, the program numbers an IP starting from –0 in an 
ascending order. We will emphasize that there is no connection between 
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the coordinate IP name as it appears in the center line alignment/ designed 
coordinates list, and the IP numbering on this layout. The assumption is 
that it is possible that in the table (IP Radius Clothoid) will appear the name 
of a certain point (that must be identical to the name that appears in the list 
from the bottom window), and on this layout, will appear a different 
numbering for the same IP. Entering a number in this current field will 
determine the number from which the IP names will be picked for the 
current center line on the layout.  
 
Define Sections - determination of cross sections. The software enables 
to determine the cross section distribution without defining the sections' 
data itself. After clicking on this window, the following options will be 
displayed:  
 
Sections format - sections numbering format. The first option is 
"Format1", displaying the sections' names in ascending order from the 
name of the first section onwards. In choosing "Format2" by altering the 
parameters displayed, the software will display the name of the section as 
follows: station+ KM, for example: the value at field KM remains 0, the 
software will display the sections as follows: 0+000, 0+025… 1+1000, 
1+025… 
Distance between sections - the distance between the cross sections. As 
the next chapters demonstrate, you can define serial cross sections, non-
serial cross section, or any combination of both methods. 
 
Show all sections - this option will instruct the program to display on the 
layout all the cross-sections' names (if cross-sections are defined and the 
distance between them is not necessarily serial).  
Show sections by steps - this option will instruct the software to display on 
the layout only the cross-sections in the constant running distances defined 
in option "Distance between sections". 
Show slopes on edges - in the event of a steep slope at the edges' 
vicinity. The software will outline lines (beard) according to necessity.  
Show side slopes – this option is possible when "Outside layout" option is 
marked. This option is displayed on the road over the section's mark. 
Show stations of tangents - the software will mark the tangents' location 
in addition to the sections. 
  
Cross-sections display 
Inside layout - The sections' names will appear on the layout near the 
centerline. 
Outside layout - The sections' names will appear outside the layout. 
 
Direction of the sections' names display (Format2 only) 
Parallel to C.L. - the sections' names will appear in parallel to the 
centerline. 
Perpendicular to C.L. - the sections' names will appear perpendicularly to 
the centerline. 
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Text position: 
 
According to the road's direction – The text along the road (sections' 
names, elevations etc.) will be written either to the left or to the right of the 
C.L, automatically defined by the software. 
Fixed to the right – The text along the road will always be written at the 
right side of the C.L. 
Fixed to the left – The text along the road will always be written at the left 
side of the C.L. 
 
Angle's units - angle's format on the road's elevations. 
Grads - the elevations' values will be displayed in grads. 
Degrees - the elevations' values will be displayed in degrees. 
 
IP's data 
IP's data in standard mode - the data display mode with text only. Mark 
the fields to be displayed on the layout. 
 
IP's data in blocks mode  
Show only coordinates - the software will display all coordinates with 
blocks. 
Show all data - the software will display all road and coordinates' data 
using blocks. 
 
Click ‘OK’ to confirm the changes, and ‘Cancel’ to leave without changes.  
 
Display the transition point between Cut Zone and Fill Zone in the 
Horizontal Alignment: 

 From CivilCAD main menu, go to ‘RoadsHorizontal Alignment’. 

 Click the ‘Options’  button. 

 Checkmark the 'Cut/Fill Zone Display' option. 

 Click the ‘OK’ button to save definitions. 

 In ‘RoadsHorizontal Alignment’ menu, click the 'Apply' button and 

then the 'OK' button. 

 CivilCAD will display a line representing the transition point from cut to 

fill or from fill to cut along the road's alignment. 
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Pick, Locate. 
The ‘Pick’ and ‘Locate’ commands enable a graphic definition of the center 
line, in addition to the ‘Select’ function that has been studied at the 
beginning of the chapter. We will show how to use these functions. 
 
Using ‘Pick’: 
Choose ‘Pick’ from the list. 
Move to the drawing area, and begin to mark the center line. When you 
finish, click ‘Set’ and ‘Enter’ (in the Stand-Alone version click on the right 
button to finish). 
Continue to insert radiuses and other road design steps.  
 
Using ‘Locate’: 
Choose ‘Locate’ from the list. 
Move to the drawing area and mark the points in the drawing that will form 
the IP. If you are using AutoCAD version, notice that in ‘Object Snap’ to 
‘Node’ has been automatically activated. In the Stand-Alone version, the 
cursor will turn into a square into which you should enter the chosen 
points. When you finish, click ‘Set’ and ‘Enter’ (in the Stand-Alone version, 
click on the right button). 
Continue to insert radiuses and go through the remaining stages of Roads 
design.  
 
The main difference between ‘Pick’ and ‘Locate’ is that ‘Pick’ creates 
new points, while locate’ chooses points that exist in the database. The 
advantage of ‘locate’ is that it does not “weight down” the list. Another 
important advantage is the addition of two center line by ‘Locate’, to the 
same point, so that if you move this point, the two center ines will move 
together. 
 

 - Pick Station – click the button and then click on the center line in the 
horizontal alignment to display station in AutoCAD command line. 
 
To add this station as an intermediate section to Cross Sections list – type 
'A' (for Add), click the 'Enter' button and then the 'O.K.' button. 
The station will be added to the Cross Sections list with nor Existing G.L. or 
Designed data. 

 
Horizontal alignment advanced design tools: 
 
CivilCAD 2016 Software enables an easy way to design horizontal 
alignment layout by using advanced tools. These tools enable designing a 
complete horizontal alignment layout by connecting lines and arcs. After 
the design is complete, CivilCAD 2016 can define the Road's layout in the 
project by selecting the design segments from the drawing. First, we will 
explain all these commands: 
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 Line Line Curve – Connecting a curve between two lines. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Line_Line_Curve. 
AutoCAD* will display: "Select first line", select the first line from the 
drawing. 
AutoCAD will display: "Select second line", select the second line from 
the drawing. 
AutoCAD will display: "Enter cloto in (0) **", Insert the length of the 
transition-curve in the entrance to the arc and press Enter. 
AutoCAD will display: "Enter radius", Insert the arc's radius value for the 
curve and press Enter. 
AutoCAD will display: "Enter cloto out (0)", Insert the length of the 
transition-curve exiting the arc and press Enter. 
In case a wrong radius value was entered and a tangent between the lines 
can't be created, CivilCAD 2016 will display message: "Tangent not on 
line". 
  

*  All the commands identicalness for both AutoCAD and IntelliCAD. 
**  Pressing enter without inserting a value will create an arc without a transition 

curve (Clot. length 0). 
 
 

 Line Line ReCurve – Connecting a reversed curve between two 
lines. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Line_Line_ReCurve. 
AutoCAD will display: "Select first line", select the first line from the 
drawing. 
AutoCAD will display: "Select second line", select the second line from 
the drawing. 
AutoCAD will display: "Enter cloto (0)", Insert the lengths for transition-
curve in the entrance and exit of the arc (same length) and press Enter. 
AutoCAD will display: "Enter radius", Insert the arc's radius value for the 
curve and press Enter. 
In case a wrong radius value was entered and a tangent between the lines 
can't be created, CivilCAD 2016 will display message: "Tangent not on 
line". 

 
 

 Line Line Fit Cloto (Radius) – Connecting a curve between two 
lines without arc, from 2 joined transition curves and by inserting 
their radius value. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Line_Line_Fit_Cloto(Rad). 
AutoCAD will display: "Select first line", select the first line from the 
drawing. 
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AutoCAD will display: "Select second line", select the second line from 
the drawing. 
AutoCAD will display: "Enter radius", Insert a maximum radius value for 
the curve and press Enter. 
In case a wrong radius value was entered and a tangent between the lines 
can't be created, CivilCAD 2016 will display message: "Tangent not on 
line". 
 
 

 Line Line Fit Cloto (Len) – Connecting a curve between two lines 
without arc, from 2 joined transition curves and by inserting their 
length value. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Line_Line_Fit_Cloto(Len). 
AutoCAD will display: "Select first line", select the first line from the 
drawing. 
AutoCAD will display: "Select second line", select the second line from 
the drawing. 
AutoCAD will display: "Enter cloto in (0)", Insert length for the first 
transition-curve and press Enter. 
AutoCAD will display: "Enter cloto out (0)", Insert length for the second 
transition-curve and press Enter. 
In case wrong length values were entered, CivilCAD 2016 will display 
message: "Tangent not on line". 

 
 

 Line Line Fit ReCloto  – Connecting a reversed curve between two 
lines without arc, from 2 joined transition curves and by inserting 
their radius value. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Line_Line_Fit_Recloto. 
AutoCAD will display: "Select first line", select the first line from the 
drawing. 
AutoCAD will display: "Select second line", select the second line from 
the drawing. 
AutoCAD will display: "Enter radius", Insert a maximum radius value for 
the curve and press Enter. 
In case a wrong radius value was entered and a tangent between the lines 
can't be created, CivilCAD 2016 will display message: "Tangent not on 
line". 

 

 

 Line Arc Line Fit Cloto – Connecting a curve from two lines and 
arc, by transition-curves. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Line_Arc_Line_Fit_Cloto. 
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AutoCAD will display: "Select first line", select the first line from the 
drawing. 
AutoCAD will display: "Select arc", select the arc from the drawing. 
AutoCAD will display: "Select second line", select the second line from 
the drawing. 
In case the curve can't be solved, CivilCAD 2016 will display message: 
"Can't create requested segment ". 

 

 

 Line Arc Line Fit ReCloto – Connecting a reversed curve from two 
lines and arc, by transition-curves. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Line_Arc_Line_Fit_ReCloto. 
AutoCAD will display: "Select first line", select the first line from the 
drawing. 
AutoCAD will display: "Select arc", select the arc from the drawing. 
AutoCAD will display: "Select second line", select the second line from 
the drawing. 
In case the curve can't be solved, CivilCAD 2016 will display message: 
"Can't create requested segment ". 

 
 

 Arc Arc Fit Tangent (Clo) – Connecting two arcs by tangent and 
two transition curves and by inserting the transition curves' lengths. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Arc_Arc_Fit_Tangent(Clo). 
AutoCAD will display: "Select first arc", select the first arc from the 
drawing. 
AutoCAD will display: "Select second arc", select the second arc from the 
drawing. 
AutoCAD will display: "Enter cloto out (0)", Insert length for the transition-
curve exiting the first arc and press Enter. 
AutoCAD will display: "Enter cloto in (0)", Insert length for the transition-
curve in the entrance to the second arc and press Enter. 
In case the curve can't be solved, CivilCAD 2016 will display message: 
"Can't create requested segment ". 

 
 

 Arc Arc Fit Tangent (Len) – Connecting two arcs by tangent and 
two transition curves and by inserting the tangent's length. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Arc_Arc_Fit_Tangent(Len). 
AutoCAD will display: "Select first arc", select the first arc from the 
drawing. 
AutoCAD will display: "Select second arc", select the second arc from the 
drawing. 



 

 

Page 201 of 508  
 
 

CivilCAD 2016 Reference manual 

AutoCAD will display: "Enter length", Insert length for the line between 
the 2 tangents and press Enter. 
In case the curve can't be solved, CivilCAD 2016 will display message: 
"Can't create requested segment ". 

 
 

 Arc Point Fit Tangent – Connecting point to arc by tangent 
(completing tangent by selecting a point). 
Press this button or from the main menu: Roads->Horizontal alignment  
tools->Arc_Point_Fit_Tangent. 
AutoCAD will display: "Select arc", select the arc from the drawing. 
AutoCAD will display: "Select point", select the end point of the tangent. 
AutoCAD will display: "Enter cloto (0)", Insert length for the transition-
curve exiting the arc and press Enter. 
In case of inserting irrational values, CivilCAD 2016 will display message: 
"Can't create requested segment ". 

 
 

 LineEdge Line Fit Arc – Connecting line-edge* to a tangent by 
arc**. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->LineEdge_Line_Fit_Arc. 
AutoCAD will display: "Select first line", select the line which its edge 
connects to the arc. 
AutoCAD will display: "Select second", select the tangent to the arc. 
 
* The arc will be connected to the Edge of the first line selected. 
**  The arc will be tangential to the second line selected. 
***  No transition curves values will be given in this function. 
 

 

 LineEdge Point Fit Arc – Connecting line-edge to a specific point 
by arc. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->LineEdge_Point_Fit_Arc. 
AutoCAD will display: "Select first line", select the line which its edge 
connects to the arc. 
AutoCAD will display: "Pick point", select the point which the arc will 
connect to. 
 
 

 LineEdge Radius Fit Arc – Connecting Line edge to arc by given 
radius. 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->LineEdge_Radius_Fit_Arc. 
AutoCAD will display: "Select first line", select the line which its edge 
connects to the arc. 
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AutoCAD will display: "Pick side", select side to define the arc direction 
from the line (left or right). 
AutoCAD will display: "Enter radius", Insert the arc's radius value and 
press Enter. 
 

 Line_Arc Fit Clotho - create a clothoid between line and arc. 
 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Line_Arc_Fit Clotho. 
AutoCAD will display: "Select line", select the line which its edge connects 
to the arc. 
AutoCAD will display: "Select arc", select the arc. 
CivilCAD will create a line and an arc with a clothoid between them. 
 

 Connect arc – Connect two arcs in a row. 
 
Press this button or from the main menu: Roads->Horizontal alignment 
tools->Connect arc. 
AutoCAD will display: "Select first arc", select the first arc from the 
drawing. 
AutoCAD will display: "Select second arc", select the second arc from the 
drawing. 
CivilCAD will create two arcs with in a row. 
 
 
 
 
Creating the road's layout from the drawing 
 
After finishing defining the layout by the tools above, we will create the 
road's layout from it. To do so, perform the following steps: 
 
From the main menu, activate: Roads->Horizontal alignment. 
Select the desired road name from the list above. 
Press "Select". 
AutoCAD will display: "Enter an option (<Polyline>/Segment)", Press "S" 
and Enter. 
Select each segment from the drawing by order. Notice that the program 
marked the segments by circles on the tangents. After each selection the 
program will add an arrow mark near the segment. 
Press Enter to finish. 
CivilCAD 2016 will automatically fill the IP's table and insert the radiuses 
and transition-curves values accordingly.  
To create the layout press Apply. A small window will appear, press OK. 
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Vertical Alignment 
 
After the definition of the horizontal alignment of the road, the longitudinal 
section should be defined. CivilCAD 2016 enables to plan the longitudinal 
section in two methods: 
Planning on the software's drawing environment (stand-alone 
environment). 
Planning on AutoCAD environment (available in AutoCAD version 2000 
and up).  
In order to define the work method, follow these steps: 
From the Main menu activate: File-> Configuration. 
Near caption "Vertical alignment mode", choose one of the following 
options:  
Stand alone - Working in the drawing environment of the software (old 
version). 
Drawing environment interface - AutoCAD work environment. 
 
Tip: For both methods it is recommended to read the entire chapter.   
 
Method 1 – Planning on the software's drawing environment  

 
For demonstrational purposes, Stand alone option is chosen. The second 
option will be explained in the next clause. 
From the main menu activate: ‘Roads -> Vertical Alignment’. The 
Vertical Alignment window will open. This window is divided into : 
The drawing area – the main area of this window (the black screen).  
The existing ground data table – the table from the left down (topo). 
The designed data table – the right bottom table. 
The function window - the window on the right. 
 
Click ‘Apply' in the right window. The program will move along the 
Horizontal Alignment and compute the heights of the Vertical Alignment. 
These heights appear in the existing status ‘Topo’ window (left bottom 
table), as a function of station and height. In the drawing window, the 
section drawing will appear vertically – existing status.  
 
We will clarify number of points: 
The section is given in a distorted scale of length in relation to height, 
mentioned in the field ‘Height factor’.  
The heights on the table at the bottom of the section appear according to 
the location of the cross sections. If, for example, the cross sections 
appear every 20 meters, the heights in the vertical alignment will appear 
every 20 meters. In order to control the given height’s location, press the 
option button in the right window, and change the data interval. Press 'OK' 
and 'Apply' to effect changes. 
Even if the Horizontal Alignment does not exist, or we do not have the 
topography, the section can be created by manually entering the data into 
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the topography coordinates table. To do so, enter the distance station (ST) 
data, and elevation (Elev.) into the table. To get the section after the data 
has been entered, click 'Apply' in the right window. If the Vertical 
Alignment received was found partly incorrect, due to incorrect topography 
data, you can edit the existing topography coordinates data, manually. In 
order to erase a line from the table, stand on the serial number column of 
the desired row (the column to the left), and click ‘Del’ (in the keyboard). 
The line will be erased. To get the change on the drawing, click 'Apply' 
from the window on the right. 
 
 
Designing the vertical IP: 
 
A vertical design of the section can be done graphically, by entering of data 
in t table or using both methods simultaneously: 
 
Mehtod A - entering data in the table: 
The ‘Design data’ table (bottom right table), is divided into the following 
columns - station (ST), elevation (Ele), a slope between segments given in 
percentage (Slope%), and the length of the vertical arc (2T). 
Enter this data into the table, while defining the station and elevation for 
every  segment. The program will compute the slope between every two 
segments, and  present it to the relevant segment. Instead of 
elevation, you can enter the slope from a previous segment, and then the 
program will enter the elevation column. To delete an error line, stand with 
your mouse on the serial number column (the left column) at the relevant 
line and press ‘Del’. To get the designed section press ‘Apply'. 
 
Method B – designing the vertical alignment graphically  
There are two methods to draw the designed data on the existing 
topography status: 
Choose ‘Pick’ from the bottom list (Unused, Pick, Locate, Overwrite). Move 
to the drawing area, stand on the most left side of the section and (you can 
deviate a bit left of the existing topography state), and click your mouse 
button. The point you have selected will be set as the vertical IP and its 
data will appear in the ‘Design Table (bottom). Continue to draw the 
vertical alignment. While moving on the drawing area, you will see your 
exact location, height and distance, under the ‘St’ and ‘Elevation’ labels, to 
the right of the drawing. When you finish your drawing click ‘Apply’ from 
the right window.  
  
Note. If you choose a point outside the existing topography borders, from 
the left or from the right, the program will determine the IP, at the most 
extreme station (0 to the left, or end of natural ground to the right) in the 
same elevation you were in.  
 
Choose ‘Locate' from the bottom list (Unused, Pick, Locate, Overwrite). 
Using ‘Locate’ is very similar to using ‘Pick’, except for when you choose 
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an IP at a certain station, it will be set at the exact existing topography 
elevation status at the same distance. 
Using ‘Move’ – if you wish to move a vertical existing IP to a new location, 
do so using ‘Move’. From the bottom table, mark the IP line you wish to 
move and, choose  ‘Move’ from the list and move to the drawing and set 
the new IP location. Click ‘Apply’ from the window on the right to renew 
the drawing.  
 
It is also possible to combine the two methods, (manual feeding and 
graphic design). After the graphic section had been selected, it will be 
possible to change the data received in the bottom window and to click 
‘OK’ to receive the changes (you can, for example, change the slope at a 
certain segment. Click ‘Enter’ to change the height according to the slope, 
and click ‘OK’ to update the drawing). 
The graphic design is from the last IP to the new IP continued. To add an 
IP in the middle of a section, mark with your mouse the list of previous IPs 
(the point after the new point you wish to add), move to the drawing and 
mark the new IP. The new point will be added to the table at the desirable 
location. Click ‘Apply’ from the right to fix the drawing.  
 
 
Vertical Arc Design: 
 
After you have added the vertical IPs design data, it is time to add the 
vertical arc in the most right column (2T).  You can enter the arc data in 
two ways: 
the length of the arc – the length of the arc will be give as a function of the 
distance between the tangents f the vertical arc. After entering the data 
click ‘Apply’ in the right window to update the drawing . 
the radius of the arc – in order to enter the vertical radius of the arc 
(instead of length), click with your mouse on the ‘2T’ labeling (the column 
heading). The label will switch to ‘R’. Now you can enter the radius of the 
arc. Another click on ‘R’, will return you to work at – ‘2T’.  
 
To check this out for yourself, enter the following data in the design table. 
At the end click ‘Apply’.   
 

 
 
Click 'Close' from the right window to finish the vertical alignment design. 
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Method 2 – Planning on the AutoCAD environment 
 

In the previous clause we explained how to plan the longitudinal section by 
using an independent drawing environment (without AutoCAD software). in 
this clause, we'll explain the planning possibilities with AutoCAD (version 
2000 and up).  
 
Activate section's window Roads ->Vertical Alignment and continue 
according to following steps: 
*noticed, that the drawing area is the AutoCAD window. The layout is 
located in a different drawing that is located under the 'Vertical Alignment' 
window. 
Click 'Apply' from the right window – the program will go through the 
length of the road and calculate the vertical alignment's elevations. These 
elevations will appear in the existing table (the lower left table). The 
existing G.L drawing will appear in the drawing window. 
We will clarify number of points: 
The drawing scale is been defined according to the values in the 'Height' 
and 'Length' fields (under the 'View' caption). 
By default, the elevations, located in the drawing's table, appear according 
to the cross sections' locations. If the cross sections are each 20m – the 
vertical alignment elevations will appear each 20m'. To control the 
elevations' locations (without changing the cross sections) follow these 
steps: 

Click button . Enter the request distance in the 'Data intervals' field.  
To close the window click 'Ok'. 
Click 'Apply' in the right window to refresh the drawing. 
If no topography exists, you may create the profile through manual data 
entering into the existing table. To do so enter the data of station (St) and 
elevation (Elev.). Click 'Apply' in the right window to receive the section. 
If received the incorrect vertical section, as a result of wrong topography, 
you can change the existing data manually. To erase a row from the table, 
stand with the mouse on the serial number's column of the row (the left 
column) and press Del. The row will be erased. Click 'Apply' in the right 
window to refresh the drawing. 
 
Vertical IPs design 
 
You can design the vertical alignment by either entering data into the table 
or drawing. 
  
Entering data into the table 
 
The design table includes the following columns:  
serial number (the left column without the title); 
Station (St). 
Elevation (Elev.). 
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Slope between the segments (Slope %); 
Arc length (2T). 
 
Enter the data into the table. Start by entering the first IP's station 
(probably '0') and elevation. Continue to the second row and enter the next 
IP's station followed by either its elevation or the slope from the previous 
station. Continue to the end of the profile & press 'Apply' to refresh the 
drawing (you can press 'Apply' to see the result at every stage of the 
design). 
 
Tip: When entering data in the table, press 'Enter' after each data 
been entered. 
 
 
Planning on the AutoCAD environment 
 
Draw your vertical alignment in 'VerEdit' layer (when entering to the 
window will be the current layer) by using a 'Polyline'. To build the profile, 
press 'Apply'. The software will translate your 'Polyline' into the designed 
table (below) and a drawing of the profile will appear. Please notice that a 
new 'Design' layer has been created under the 'VerEdit' layer. 
 
We will clarify number of points: 
You can continue and change the profile by editing the profile's 'Polyline' 
('VerEdit' layer). Press 'Apply' to apply your changes. 
You can change the data in the table below and affect the drawing by 
pressing 'Apply'. 
When drawing your profile's 'Polyline' do not enter arcs. The Vertical 
curves will be defined in the lower design table (for more details see former 
clause). 
Entering changes in the table and the drawing in the same phase is not 
possible. Press 'Apply' after changing the 'Polyline' or changing the table (if 
you will change the 'Polyline' and change the table without pressing 'Apply' 
between the actions, the changes in the 'Polyline' will be discarded). 
 
Design of vertical curves 
Insertion data into the table 
 
 Add the data of the vertical curves into the right column (2T). You may 
enter the data by two ways: 
Length of curve – will given as the function of the distance between 
tangent points of the vertical curve. After entering the data, click Apply in 
the right window for drawing updates. 
Radius of curve – to insert radius of the vertical curves (instead of length), 
click on the caption 2T (on the title of column). The caption will turn into R. 
Now enter the curve's radius. Another pressing on the caption R will return 
it back to 2T. 
For illustration insert the following data and press Apply.  
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Marking the point where the arc will pass through (in AutoCAD work 
environment only) 
 
Another way to define a curve is to mark a point where the arc will go 
through: 
In the design table, mark the line of the desired curve. 

Click on the button  located on the left of the design table. 
Go to the AutoCAD window and mark the point which the arc will pass 
through. If the software is unable to complete this action because of an 
invalid choice, the notice: "No such a curve" will appear. 
After the point is chosen, the software will calculate the new radius value 
and update it in the Design table. 
 In order to update the drawing, click 'Apply' on the right window. 
 
 

Additional functions: 
 
Functions at the lower window 
 
Design table: 
 

 Pick point - checking ground level in a specified point. After clicking 
the button, choose the desired point in the drawing. The software will 
display over the Design table, the following data: 
Station - the station of this point. 
Elevation - the elevation of the point. 
Slp(T) - the slope of existing ground level.  
Slp (D)  - the slope of designated ground level at current point. 
 

 Define designed slope - this action enables to design the profile at a 
certain slope. In order to do so, execute the following steps: 
Click on the button. 
In the AutoCAD's command line, type the desired slope's value & 'Enter'. 
Switch the AutoCAD to ORTHO mode (F8). 
Draw the profile in the chosen slope.   
 

 Erase all data – erase all the data from the table. A warning notice will 
appear before execution. 
  



 

 

Page 209 of 508  
 
 

CivilCAD 2016 Reference manual 

 dH – Changing the profile elevation by a fixed value. To use this option 
follow these steps: 
Click on the ‘dH’ button. A new window will be opened. 
In the dH field (lower part of the window), enter the height difference. Enter 
a positive value to higher the profile or negative value for lowering it.  
In the list, choose the segments you want to change. You can press 'A' 
(All) button to choose all. 
Click ‘Ok’ to activate.  
 
 
Topography table: 
 

 Erase all data – erase all the data from the table. A warning notice will 
appear before execution. 
 

 Read data from the topography contours – click on this button to 
open the window. From this window, choose the table to which the 
topography data will be entered, the Existing G.L (Topography) table, or 
the Designed G.L (Design) table. Click ‘OK’ to continue. The data will be 
read from the topography and will be entered into the table accordingly.  
 

 Read data from the designed contours – click on this button to open 
the window. From this window, choose the table to which the design data 
will be entered, the Existing G.L (Topography) table, or the Designed G.L 
(Design) table. Click ‘OK’ to continue. The data will be read from the 
designed contours and will be entered into the table accordingly. 
  

 Copying the station of the Topography table into the Design table 
- Clicking this button will copy the stations only (without the height) from 
the Topography table into the Design table. 
 
Functions at the right window 
 

 Input of vertical alignment section data from a text file (ASCII) – 
‘Load from text file’ – this button reads the existing topography data into 
the table (the bottom left table) out of a simple text file, which holds a list of 
stations and height. The file structure has to be of lines, with station and 
height separated by a space/comma. 
  

Saving the vertical alignment data at a text file (ASCII) – the ‘Save 
file’ button  – this button saves the existing topography data read from the 
topography (or entered manually), into the text file. The structure of the text 
file is a list of stations and height. 
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 Adding ditch edges data to the vertical alignment – the ‘Get edges’ 
button  – CivilCAD 2016 can be used for designing a ditch/ regulating 
rivers.  This design will be done similar to Roads design, except that the 
vertical alignment will be used as ‘Invert level’ (IL) of the bottom of the 
ditch. The program can also add the vertical alignment of the ditch 
edges/river from left to right, to the vertical alignment of the ditch. This is 
the order of commands for receiving these vertical alignments: 
Define the vertical alignment of the bottom of the ditch (as detailed in this 
section). 
Move to the Cross sections and regulate the cross sections of the 
ditch/river (for details see section ‘The Cross sections’). 
Return to the vertical alignment window and click this button. The program 
will read the design data from the cross sections of the ditch edges, and 
add them to the vertical alignment – as a drawing and as additional lines to 
the bottom table.  
 

 Extracting topographic elevations on a specified offset - In order 
to display the existing ground level in a specified distance from the 
centerline, execute the following steps: 
Mark option G.L. at "Offset" and type in the field on the right of this option 
the distance from the left side of the centerline. 
Mark option G.L. at "Offset" and type in the field on the right of this option 
the distance from the right side of the centerline. 
After filling this data click 'Apply'. The software will add these layers on top 
of the section. 
 
‘Accurate/By sections’ – Introducing an accurate vertical alignment or 
by-sections only - When CivilCAD 2016 reads the vertical alignment from 
the topography, it does it accurately, effected by the density of the 
measured points (the program builds the vertical alignment according to 
the meeting point of the triangle sides it creates from the measuring file). 
You can see the stations in which the program had sampled the heights, 
from the bottom left (topo) table. At times, even if the sample is accurate, is 
not good for the user (for example: in the measuring file there was a 
mistake that appears in the vertical alignment, but it is not relevant since it 
is not in any one of the Cross sections). Moving from ‘Accurate’ to ‘By 
sections’, will solve this problem in the following way: 
Accurate – an accurate sample of the section. The section drawing line 
will accurate according to the topography sample. The heights from the 
bottom table will appear according to the cross sections (default – every 20 
meters), and in addition heights will appear at critical points.  
By sections – An accurate sample of the section, but the drawing line of 
the section will be built according to heights at cross sections only. The 
bottom table will remain the same.    
The advantage to this system is “smoothing” the vertical alignment. Its 
disadvantage is lack of accuracy. 
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Centerline/DitchR/DitchL- moving between the vertical alignment 
design of the center line /right side ditch/left side ditch - CivilCAD 
2016 enables separation between the vertical alignment definition of the 
center line, and the IL definition of the bottom of the ditch, to the left or right 
of the center line, if it exists. To move to an IL definition of one of the 
ditches, you can choose your desired ditch (to learn about the full process 
of defining side ditches, see section “Side ditches”, from this chapter). 
 
Include R. Ditch/ L. Ditch – if there is a ditch design in the cross sections 
of the current road, and these options are marked, the program will present 
the ‘Invert level’ on the section of the ditch bottom on the left and right side, 
according to the marks ‘R.Ditch’-right  and ‘L.Ditch-left’. 
 
Unlock datum (Work in AutoCAD window only) - ff the drawing of the 
section exceeds into the data table, click this option and then click "Apply". 
The software will elevate the section's net so the lines in the drawing will 
not exceed into the data. If this option is unmarked, the net's elevation will 
be "Locked". 
 
View - establishing a scale for the section's display. CivilCAD 2016 
enables to determine the scale in which the section in the drawing window 
will be presented. Type the desired scale in fields: Elevation, Length 
(Under caption "View") and click 'Apply' to update the drawing. 
 
Note: Changing the View scales when designing is dangerous and can 
damage your design. It is recommended to define the View scales before 
starting the design. 
 
  
Functions at the drawing window 
 
Changing the display color – it is possible to change for every layer in 
the display – its color, by clicking on any one of the color buttons located at 
the upper right-hand side of the drawing window. Clicking on any one of 
these colors, will open the ‘Color’ window, from which the desired color can 
be chosen. The colors are divided as so:   
   C.L – Center Level –designed vertical alignment  
   G.L – Ground Level – existing status section 
   D.R – Ditch Right – Right ditch section  
   D.L. – Ditch Left – Left ditch section 
  
Note: the color buttons will not appear when working with AutoCAD 
environment. You can change the layer's colors from the AutoCAD layers' 
list. 
 
 

 Zoom Extents – viewing the entire section. Clicking on this button will 
return the view option for the entire drawing. In case the user had moved 
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the drawing left/right using the scroll bars, or decreased/increased the 
drawing by clicking the left/right button in the drawing area, clicking the E 
button will return viewer ship to the entire drawing area.  
 
Note: The zoom extents button will not appear when working with 
AutoCAD environment. Instead use the regular zooming commands in 
AutoCAD. 
 

 Save project - save the entire project's data. 
 
 
Dividing the section into frames (paper space) or DXF files for 
printouts 
 

Creation of DXF files 
 

Press the button  located in the toolbar over the drawing window. 
In the opened window, define the Elevation's and Length's scale. The scale 
is in 1: X. In the elevation box, type the scale for the Elevation (example: 
100) and in the length box, type length's scale (example: 1000). 
In order to create a DXF file without division, choose option "No division" 
under the caption 'Divide by paper size'. if you wish to divide according to 
the paper's size, choose from the list the desired page size. To continue, 
click "OK". 
In the opened dialogue box, enter the drawing file's name. Click 'Save' to 
save the file. 
 
 
 
Dividing the profile into sheets 
 
 CivilCAD 2016 enables division of longitudinal section to several sheets 
automatically. This option is possible only in working with AutoCAD 2000 
version and up. In order to divide the section to sheets, execute the 
following steps:  

Click on the button  of the toolbar over the drawing's window. In the 
opened window establish the following definitions: 
Type the scale parameter below caption 'Scale '. 
Choose the sheet’s size for dividing near caption 'Divide by paper size'. 
To include in the sheet the longitudinal alignment on the same section, 
mark option Show layout. 
To include the section itself in the sheet, mark option Show sections. 
Type overlapping distance between the sheets near caption 'Paper 
overlapping'. 
Type the net’s grid near caption 'Frames grid steps'. 
In order to import a block file containing the north arrow, click on the button 
near the caption 'Table block' and choose the file’s location. If the file’s 
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location was chosen, click the block’s location on the right or left side of 
Table-Block chart in option 'Table position'. 
Type the section’s range to appear in the sheets below caption 'Range'. To 
continue, click 'OK'. 
The software will create the sheet division in 'Paper space'. 
 

Roads intersections on Vertical Alignment  
  
Along the profile, built by Vertical Alignment, the intersection of the 
present road with other roads will be shown. 
  
On the intersection points, flags will appear indicating the direction of the 
other road (flags in two directions indicate that the present road crosses 
the other road). 
The name of the intersecting road, the station of intersection point and the 
designed elevation of the other road, at the intersection point, will be 
printed beside the flags 
 

   
Notes: 
In case that the other road is defined only by horizontal alignment, without 
designed profile, the existing ground level will be printed instead designed 
elevation. 
Upon changing the design of the roads, data of the intersection points will 
be updated accordingly. 
In case that the other road is fully defined including designed profile, the 
flag will include the road's profile of the other road in the intersection point. 
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Alternative Vertical Alignment 
 
In order to design alternatives for Vertical Alignment, 
From CivilCAD main menu’ go to 'RoadsVertical Alignment'. 

Click on ‘Add new alternative’ button  and enter a name to the 
alternative (e.g. Alternative1). 
Click ‘OK’ and then design the alternative vertical alignment. 
To define the alternative as the centerline, click on the ‘Set as centerline’ 

button . ‘Set as centerline’ window will open. 
 Click on the desired operation: 
 

 
 
Note: The alternative layer will remain ‘VerEdit’ but clicking on ‘Apply’ 
button will update only the alternative table and drawing. 
 To also update the Cross sections, the alternative must be set as 
centerline. 
  
Note: Some buttons will be enabled only after designing an alternative  
 

. 
 
Every alternative will appear at the ‘Layer Properties Manager’ 
window in a separate layer according to the alternative’s name.  

To erase an alternative, click on the ‘Erase current alternative’ button  
and click ‘OK’. 

To delete all alternatives, click on the ‘Delete all alternative’ button  and 

click ‘OK’. 

To copy/paste data between alternatives/centerline, use the ‘Copy/Paste’ 

buttons . 
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Cross sections 
 
Designing cross sections is the most complex part of Roads design. We 
will show here how to define a typical section, project it along the entire 
road, define numerous typical sections, define super-elevations etc.  
 
Having defined a vertical alignment for the road (previous section), we will 
continue to define the ‘Cross sections’. 
 
Activate: ‘Roads-> Cross sections’ from the main menu, to open the 
‘Cross sections’ window. This window is divided into three parts: 
The drawing area – the main area where the drawing of the section will 
appear. The name of the current section that is being worked on, will 
appear in the heading above the drawing.  
The list of cross sections – right window. 
The existing and designed topography tables for every section – the tables 
at the lower section of your screen: 
Existing G.L. – the existing status topography data from the left table.  
Designed G.L – the designed topography data from the right hand table.  
 
From the next section up to the end of the chapter, the explanations will be 
followed by a demonstration. The demonstration can be done on the 
project that was opened in the “Preparation of Settings” section, which 
followed the Roads design instructions up until now. 

Click on the button  from the right window (Define sections) – to open 
the Cross roads setting window. Select ‘Format’ status: 
Format 1 – the first option presents the sections names as they appear in 
the sections list. 
Format 2 –by changing the parameters that appear in the bottom window, 
the program will use this option to present the section’s name in the 
following fashion: station + km. For example, if you leave the value in field 
0:KM, the program will present the sections like so: 0+000, 0+020, 
0+040……, 0+380.  
 
From this window determine the following data: 
 
Start at station – the station of the first section. The default is ‘0’. At most 
times, we will want the station for the first section in the designed segment 
of the center line, to be ‘0’. However, there are cases where we plan a 
segment that is the continuation of the center line. In such a case, the 
station of the first section will be different.  
End at station – the station for the last section. The default is according to 
the length of the center line as it was computed by the program (this length 
appears immediately when the cross section window opens, at the right  
window – ‘Roads length’). 
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Station of first section – define station of first section’s name as will be 
displayed in vertical alignment and horizontal alignment output (DXF). 
Distance between sections – the distance between the cross sections. 
The default is 20 meters. Later on we will see that creating sequential 
cross sections is not mandatory (a must), and furthermore, that all sections 
can be determined vertically in a way that is not sequential. 
Name of first section – the name of the first section (a number). The 
program will number the remaining sections in an ascending order 
according to the format specified in the window. 
Choice box – ‘By stations/By Ips’ – this box proposes a choice between 
defining a road/center line, with its cross sections arranged in ascending 
order, to a definition of an center line with sections determined by the IPs 
of the horizontal alignment. Moving the status to ‘By Ips’, will remove the 
other fields from your screen.  
Defining cross sections by its Ips’ is mostly useful for River design, in 
which we will want cross sections at specific points. To learn more see 
chapter 15: “Ditch and Reservoir Design”. 
Click ‘OK’ to build the sections. The list of sections that were built will 
appear in the table from the right according your selection of setting, and 
for each section will appear a ‘Name’ and ‘Station’.  
Intermediate sections can be added to the project at any given moment. To 
do so: 
Position the cursor (using your mouse) on the line before which you wish to 
add a section.    
Click ‘Enter’ (from your key-board). The line will jump down and a new line 
will appear.  
In the new line, enter the name (number) of the new section. The section 
can include numbers, “.” And “/” (but not letters). If the new section is, for 
example, between section ‘1’ – and ‘2’, you can call it ‘1.1’. Move with the 
right arrow to column ‘Station’, and enter the station of the section you just 
added.  
Note: Instead of defining the sections automatically using the white button, 
it is possible to move immediately to the right window and build the table 
manually, name and station for each and every section. 
 
Altering names of existing sections - it’s possible to re-define the names 
of the sections without deleting the data in it. In order to change the 
sections’ names, define them as explained in this chapter by clicking the 

button . When option “Define sections” is activated, a check will be 
launched to trace existing sections. For every existing section (a section 
that its station is available in the table) the software will inquire whether the 
user would like to execute one of the following three options: 
Rename section – altering the name of the section to the new name (by 
the new definition). 
Overwrite section - deleting the existing section and define the new 
section instead. 
Leave existing section – leaving the same section as it was prior to the 
alteration. 
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The software will display a message to each section. The action can be 
ratified for each of the sections. To ratify the action to all sections, click OK 
to all, for discarding, click Cancel. 
 

Click the Option button  from the right window. A new window will be 
opened. 
 
Define the width of section for the project. We are referring to the width of 
the ground that the program will sample for the existing status out of the 
topography. We will define a distance from the left center line and a 
distance from the right center line that will together define the width of the 
ground strip. The left end of the section we will defined in the ‘Left’ field 
(default of – 20 meters), and its right end in the ‘Right’ field (default – 20 
meters), when the distance left of the center line is a negative number and 
the distance from the right is a positive one.  
There might be a case where you will want a center line band that is all to 
the right (or left) of your center line. In such cases it is possible to define a 
section that is all on the right (or left), by using the correct stations. 
 
In order to define cross sections width by reference, 
From CivilCAD main menu, go to 'RoadsHorizontal Alignment'. 
Draw a Polyline on the desired side of the road (if there are 2 Polylines, 
one on each side of the road – they must be according to road’s direction 
and in the same layer!). 
From CivilCAD main menu, go to 'RoadsCross sections'. 

Click on the ‘Options' button . ‘Options’ window will open. 

Check the  checkbox and then click on ‘Get section width by layer’ 

button . 
‘Width by layer’ window will open. 

Select the desired layer and click 'OK' or click on 'Select' , select the 
desired layer from the horizontal alignment, then Press 'Enter' and 'OK'.  
The software will perform filtering and the following message will appear: 
 

. 
 
The selected layer’s name will appear near the ‘Get section width by layer’ 

button  
Click ‘OK’ to save definitions.  

Click on ‘Get topo data for all sections’ button  and click ‘OK’. 

Click on ‘Interpolate empty sections’  button to update the drawing in 
the cross sections window. 
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Transfer from Elevation to dH. Using CivilCAD 2016 you can define cross 
sections of absolute heights, or sections of relative heights. Working with 
absolute heights will actually cancel the effect of the vertical alignment on 
the cross sections, and commit you to defining a separate design for each 
and every section (or fill the intermediate sections by interpolation as 
illustrated in chapter 13 “ Earthworks computations on Roads”). During the 
rest of the chapter we will discuss working with typical sections, and so 
heights will be defined in a relative manner.  
 
Move from Earthworks to Design. This option defines the graphic 
presentation form of the section. The program has two options for defining 
the section: a section for presenting Earthworks, and a section for 
presenting designed sections. The difference in presentation will be shown 
both by the form of the sections in the drawing window, both by printing 
through the program to the printer, and by creating sections file on an 
AutoCAD sheet. These are the main differences between the two forms of 
presentation: 
 
In the Earthworks format appear two layers only. In the ‘Design’ format, 
there is the option of showing three layers (existing, Earthworks, section 
structure). 
You can determine which two layers will appear out of the three. When 
choosing ‘Earthworks’, the list of all three possible layers will be shown. 
Mark the two layers you want to include in your section. 
In the design section, there are several options for defining the surface, 
such as defining the thickness of the asphalt, adding blocks to the section 
–like side-walk rims, security railing etc. In the design section it is also 
possible to define retaining walls and side ditches. 
The data table is presented differently for the Design section, and the 
Earthworks section. In the Design section appears the table with the 
bottom ground data, and the design data is positioned on the section – the 
‘Earthworks’ is underneath, and the structure elevation above. In the 
Earthworks sections, all the data will appear in the bottom table, along with 
two extra lines in the table that represent the computation method of the 
section area at ‘cut’ and ‘fill’, when divided into segments. 
 
Move from ‘Close design to existing’ to ‘Close design to structure’. 
This option marks the form of closing the sides' sticks at the design edges. 
The option ‘Close design to structure’ will close the edges of the designed 
level to the structure level, and the ‘Close design to existing’ will close 
designed level edges to the existing G.L. 
  
In order to close Design to Existing in each Cross Section separately, 
From CivilCAD main menu’ go to 'RoadsCross sections'. 

Note: The default setting in ‘Options’ window is   , 
meaning that the Designed G.L. will continue the structure slopes based on 
the parameters in the Structure table. 
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This option affects the entire cross sections and does not apply to a single 
cross section. 
 
To close Design G.L. to Existing G.L. in a single cross section,  

check  checkbox in the Designed G.L. table and click on the 
‘Apply’ button. 
 
In order to send this definition to other sections, right click on the 
checkbox. 
‘Send to’ window will open. 
Select the section or sections that the definition will be sent to or click on 

'All' button  for sending the definition to all sections. 

Click on ‘Interpolate empty sections’   button to update the drawing in 
the cross sections window. 
 

To restore default definition, uncheck  checkbox in the 
Designed G.L. table and click on the ‘Apply’ button. 
In order to send this definition to other sections, right click on the 
checkbox. 
‘Send to’ window will open. 
Select the section or sections that the definition will be sent to or click on 

'All' button  for sending the definition to all sections. 

Click on ‘Interpolate empty sections’   button to update the drawing in 
the cross sections window. 
  
 

Click on the ‘GetT all’ button . From the window that opens after 

clicking  button (the ‘Select table' window), you will be asked to choose 
the table, to which the topography data will be entered. The default of the 
program is entering the data into the ‘Existing G.L’ of the sections. There 
might be cases were you will want to read the topography data into other 
tables, such as designed status. To do so select the desired table and click 
‘OK’. In our sample, just click "OK" to read the data into the 'Existing G.L'. 
When the reading of the existing topography data is finished, the first 
section will appear in the drawing window, and the existing topography 
data will appear in the table from the left down. At the head of the page (in 
the heading above the drawing), will appear the name of the presented 
section, for example ‘Sections name: 1’, and the designed level at the 
center line of this section (the height set in the profile), for example - 
/Elevation: 233.85. It is possible to move between sections by pointing to 
the desired section in the table at the right. Every section selected, will 
appear automatically on the drawing, and its data will appear in the tables 
below. To continue the instructions make sure you are in the first section.  
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We will now go to defining the design of the typical section. We will start 
with the top level (Structure). Afterwards we will move to defining the Sub-
grade level. 
 
From the bottom right hand table appears the label – ‘Designed G.L’. 
Move, using the little arrow from right of the label, to ‘Structure’ (as 
aforesaid, we begin designing the Structure level, and only afterwards 
define the elevation of 'Designed G.L'/Sub-grade). 
 
We will shortly explain the structure of the design table. In the table there 
are lines, each line representing a segment. The segments are numbered 
from -40 to +40 (a sum of 81 possible segments for each section). In the 
table there are five columns (the one on the far left is without a heading). 
To explain this, number these columns in an ascending order from left to 
right, so the column on the far left is number 1: 
 
Column number 1 - in this column appear the segment’s serial number. 
This number does not represent a distance of any kind. Segments left to 
the center line will be represented by a negative number, and numbers 
right of the center line will be represented by a positive number.  
 
Column number 2 (Offset) – this column represents the distance of the 
segment from the center line. The distance left of the center line will be 
entered as negative, and the number from the right as positive. There are 
two options for the distance from the center line: absolute distance or 
relative distance. When working with dH, as shown here (see section 3), 
the data will be entered as a relative distance, meaning that the distance 
entered is actually the length of the segment and not the absolute distance 
from the center line. When working with ‘Elevation’, this data will be 
entered as absolute heights. 
 
Column number 3 (dH) – this column has two options : dH (as shown 
here) or ‘Elevation’. The options are determined from the ‘Status’ window 
(see section 3). When working with dH, the heights will be entered as 
relative, compared to the height of the previous segment, so the height 
entered is actually the height of the segment. When working with 
‘Elevation’, the entered heights will be absolute. 
 
Column number 4 (Slope%) – in this column you can enter the slope of 
the segment. You can enter any one of two data: Entering dH at column 3, 
will automatically compute the slope of the segment and enter it in column 
4. In contrast, entering the slope will compute the dH and enter it in column 
3. 
 
Column number 5 (Cover) – this column defines the type of the segment. 
It has a number of options (see details on ‘Cover’ in the continuation of this 
section, and in section “Side ditches and additional Cover functions”). 
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Begin by entering the design data in the table. To clear this issue, we will 
demonstrate the data for a typical section, followed by a detailed 
explanation. Enter the following data in the table: 
 
Stand on segment 0 with your mouse, in column number 2. Type “0”, click 
‘Enter’ and again “0”. You have just determined that the height of this 
center line is similar to the height designed in the vertical alignment (the 
crown-level point). 
 
Move with the arrows to segment 1, column 2. Enter “3” click ‘Enter’, move 
with the right arrow to column number 3, insert “-2” and click ‘Enter’. The 
program will compute the dH interval. The segment that had just been 
defined is the asphalt segment to the right lane that was defined as 3 
meters with a slope of 2% (the slope was defined as minus since it is lower 
from the crown-level point). 
 
Before we continue, we will shortly explain a number of editing commands 
from the table: 
Clicking on ‘Del’ from a certain field will delete the field. 
Clicking on ‘Backspace’ (back arrow), to work as usual. 
To delete an entire line, or reduce lines, stand on the most left column 
(column number 1) in the desired segment and click ‘Del’. The software will 
delete the segment and reduce the lines.  
It is possible to copy a segment from the existing cross section to other 
cross sections. To copy, stand on the desired segment and right click with 
your mouse button. From the table that opens, mark the sections to which 
the segment data will be copied and (to choose all sections, click on button 
‘All’ from the bottom), and click ‘OK’. The program will copy the segment 
data for all the selected sections. 
It is important to press 'Enter' after entering each data in the table. 
Pressing 'Enter' will perform internal calculation. 
When designing a cross section, we will start entering the data from the 
C.L (segment 0) outside. This order of entering data is very important since 
each segment of data been entered is relative to the former segment. 
When designing, each segment's value is partial and not accumulative. 
Segments like the shoulders or sidewalk will be entered at its actual size 
and not accumulative from C.L. 
 
Continue to fill the table: 
Make sure you are in segment 3, column 2, enter “0” and click ‘Enter’. In 
column number 3 of this segment, enter “0.17” and click ‘Enter’. This 
segment marks the side-walk rim at 0.17 meter height. 
Move with the arrows to segment number 4, column 2, enter “2” and click 
‘Enter’. Move to column 4, and enter the slope of “2” percentage followed 
by 'Enter' (“2” as a positive number). This segment is a sidewalk of 2 meter 
width and 2% slope. 
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Note: The sidewalk slope is opposite to the slope of the road (the road's 
slope is '-2' and the sidewalk's slope is '2'). The drainage been designed in 
this sample is at the collector drain near the sidewalk. 
Continue and complete the same exact data for the negative segments (-
1,-2,-3), but this time mark the distances as negative values (minus). Do 
not forget to click 'Enter' after each data and to start the design from the 
C.L outside. 
 
After defining the segment's size and slopes, we will define each 
segment's type. Note that this stage is optional but will affect later stages 
like location of designed contours on the road's layout and the outlook of 
the Cross-Section's drawing. 
 
Double-click the cell on segment '-1', column 5 ('Cover'). Press the small 
arrow to pull the list down, and select '1 – Asphalt'. Repeat the process for 
segment '1'. 
 
Repeat the same process for segments '-3' and '3' but this time select '3 – 
Sidewalk' instead of Asphalt. 
 
When you finish entering the data, the table should look like this: 
 

 
 
 
We will continue by entering the side-slopes of the cross section (slopes 
from end of carriage way to the side-sticks at the section's edges). In the 
upper and lower ends of the Structure table (the table we have just finished 
filling in), the following fields appear: 
 
 Slp. left : Cut 1:         Fill 1: 
  

 Slp. right:  Cut 1:         Fill 1: 
  
These fields represent the side-slopes of the section, left and right, for Cut 
and Fill situation (we will enter values for both cut and fill. The software will 
use the relevant value according to the section's edge situation). The slope 
will be entered as a ratio of 1 to X (1:X), built between the most extreme 
points in the section (the far left/the far right), to the natural ground. 
Note: Ratio of 2:1 will be entered as 1:0.5. 
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Enter ‘2’ (ratio = 1:2), in the cut ratio field for right slope (next to the label 
‘Slp. Right:    Cut 1:’ located at the bottom of the 'Structure' table), and ‘3’ 
(ratio = 1:3) in the fill ratio field next to it. Enter the same values for left side 
(top of the table). 
  
Click on the 'Apply' from the right hand window. The design will appear on 
the drawing. You have now completed defining your section structure. We 
will now go to define the Design G.L (Sub-grade) levels.  
  
From the left table, move, using the small arrow next to the ‘Existing G.L’ 
labeling, to the ‘Designed G.L’ table. Enter the following data, the same 
way you have entered for the section's Structure: 
 

 
 
Note: There is no need to define the 'Cover' type – all segments are Sub-
grade's segments. 
 
Click 'Apply' when you finish entering the data. 
 
In order to send last segment’s slope to the next segment in 
Structure\Design table 
From CivilCAD main menu’ go to 'RoadsCross sections'. 
Choose the desired table (Designed G.L. / Structure) and click on ‘Slopes 

Inheritance' button . ‘Slopes Inheritance' window will open: 
 

 
 
Select the segment that will inherit the slope of the prior segment. 
Click ‘OK’ and at the ‘Send To’ window, select the section or sections that 

the new slope will be sent to or click on the 'All' button  for sending the 
new slope to all sections. 
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We have finished defining our typical cross-section. This typical cross 
section has a total structure width of 60 CM in the Asphalt's segments 
(notice the '-0.6' value in segment '0') and a width of 20 CM in the 
sidewalks segments (defined by the '0.57' value in segments '2' and '-2' -> 
-0.6 + 0.57 = -0.03 -0.17 (sidewalk height) = 0.2M). 
 
Now we will project the typical section on the entire road we have built: 
 

Click on the ‘Copy’ button  from the right window. After you click, the 
software will copy all the tables of the current section ('Design G.L' + 
'Structure') – to the clipboard memory. 
  
Scroll to the last section of the sections' list (right window) and click it. Click 

on the ‘Paste’ button  in order to copy the data from the clipboard into 
the tables ('Design G.L' + 'Structure') of this section. 
  
 The main principle of working with CivilCAD 2016, is entering of 
data in the sections in which the road changes (only in those sections!), 
and filling the remaining road parts with intermediate interpolation. Now we 
have two sections filled with data. The rest of the sections are still empty 
(you can see this by browsing between them by clicking on a certain 
section from the right hand- sections list table). 
 
Intermediate interpolation. Click on the ‘Interpolation empty sections’ 

button  from the right. From the window that opens, switch from the 
‘Designed’ table to ‘All’ (we are interested in doing interpolation for both 
‘Designed G.L’ and ‘Structure’). Click on ‘OK’. The program will perform the 
interpolation for all the empty sections in the project, and since we have 
two identical sections only, (first and last) the software will fill all the 
sections with the same design data.  
 
At the end of the interpolation, you can browse between the sections. At 
this stage, if you are interested, you can move to a certain section and 
change its data.  
  
Printing the sections (dividing the sections into sheets for printout) 
 

Click on the frames division button  located at the top of the drawing. 
The 'Frames division' window will be opened. 
Choose 'Model space' to create DXF files of cross section sheets, or 
'Paper space' to divide the sections into sheets on the AutoCAD's paper 
space (available for AutoCAD 14 users and up. Not available for Bricscad 
users). 



 

 

Page 225 of 508  
 
 

CivilCAD 2016 Reference manual 

Choose sections' scale for height and length. In our example use '200' for 
both scales (1:200 for height and length). 
Choose paper-size. In our example use A3 paper. 
 
Note: When working with Model space division, two additional options 
available in the paper-size list: 
Other - choosing 'Other' will show two additional fields - 'Page length' and 
'Page height' enabling the user to define any paper size needed. 
No division - all the sections will be located on the same sheet (file). 
When choosing this option, a new window will be opened. Choose one of 
the two following options: 
'Auto arrange' - automatically arrange the sections on the sheet. 
'Define arrangement' - manually arrange the sections on the sheet. Enter 
the following values: 
'Sections in each column' – number of sections to be located on each 
column. 
'dY (CM) between sections datum line' – the distance (in CM – printout 
units) between the sections on the column. 
Press 'Arrange' button for preview. 
Press 'OK' to finish. 
 
Arrange drawings in columns/Arrange drawings in rows - defines how 
to arrange the sections on the sheets. Choosing 'Arrange drawings in 
columns' will locate the second section above the first section, the third 
above the second and so on. 
Table block - When creating the sections' sheets, the software 
automatically add a header table to each sheet (company's logo, 'Created 
by…', 'Checked by…' etc.). The 'Table block' field contains the path to the 
block file, later to be used as the header table. By default, this file is 
'Logo.dwg' located in the software's folder. By pressing the '…' button 
located on the right side of the field you can browse your own company's 
logo file. 
 
Tip: It is strongly advised to use a logo that is at the same scale as the 
CivilCAD 2016 original 'Logo.dwg'. To do so, open 'Logo.dwg' (in the 
software's folder) and change it according to your needs, keeping it at the 
same drawing's extents. 
 
Table position – define location of the logo, right or left to the drawing. 
Range – select the sections to plot. The default is set to all sections. When 
choosing 'Select', a window containing the list of sections will appear. 
Select the sections to be included in the plot and press 'OK'. 
Align sections by row – By choosing this option, all the sections is a 
certain row will be aligned. If this option is not set, the software will try to 
locate as many as possible sections in each sheet, not keeping the 
sections aligned by rows. 
 
Press 'OK' to finish. Two situations are available: 
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'Model space' – if model space has been chosen (see the 1st setting in the 
window), the file browser window will be opened. Enter filename and press 
'Save'. The software will create files with the filename that has been 
entered followed by a serial number for each sheet ('MySection_1.DXF', 
'MySection_2.DXF' …). 
'Paper space' – when working in paper space mode, a message will 
appear warning the user that a 'Purge' command is about to be preformed 
(in the AutoCAD). Press 'OK' to continue. The AutoCAD's printing window 
will be shown. Press 'OK' again. The software will create sheets in paper 
space according to your settings. 
Notes: 
If you do not see the sections' sheets, try to manually change (in the 
AutoCAD) from the 'Model' to the 'cv_section' space. 
After sending your sheets to print (or saving them for later use), make sure 
that the current space if 'Model' and if not, change it. 
When the sheets have been created, the cross-sections window has been 
minimized. To continue working, maximize it back to its regular size (click 
on it in the window's lower tasks bar). 
  

Creating layout. Click on the ‘Layout’ button  from the right. From the 
window that opens, mark ‘v’ next to the three possible options (Layout, 
Contours, and Distances). Click ‘OK’ to continue. The program will create a 
layout on the drawing. This layout will not include contour lines. We will 
now show how to combine contour lines in a layout. 
The Layout window includes three options: 
Layout – mark ‘v’ next to this option to create the layout lines of the road 
and the sections height labeling.  
Contours - mark ‘v’ next to this option to create road's contour lines. The 
contour lines will be created at intervals according to what appears in the 
intervals box in the window. For the program to create contours, you must 
specify the segments in which these lines should be positioned. For more 
details see next section.  
Distances - mark ‘v’ next to this option to create a distance layer between 
the sections. The program will show the distances between the sections, 
as well as the distances between the section and the tangent point closest 
to it. 
 

Note. After clicking ‘OK’ from the Layout window, the cross section window 
will be minimized (so that you can see the changes in the layout). To 
maximize the screen, click on it from the Windows “Task-Bar” at the bottom 
of your screen. 
 

Setting the contour lines segments: As aforesaid, you should instruct the 
 program at which of these segments it should create contour lines. 
The contour lines are been defined by the 'Cover' definition of the 
'Structure' segments. In our example we have defined segments '1' and '-1' 
as '1 – Asphalt'. By doing so, we have instructed the software that these 
segments showed be shown with contours when creating the layout. 
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Another option is to choose '2 – Contours' as 'Cover'. The difference is that 
in the section's drawing, no bold line (marking the Asphalt will be shown). 
 
Press the 'Save project' button on the upper-left corner of the window to 
save all changes. 
Click on the ‘Close’ button to finish. 

 
Find Section – Click this button to find a section by name or by station 

. 
 
Hide Intermediate Sections – Check mark this cell to hide intermediate 

sections (sections with *)  
 
 
 
Additional Functions in the Cross Sections Window 
 
Functions on the right window 
 
We will now explain in detail additional functions from the cross sections 
window that were not discusses during the sample stages: 
 
Functions from the cross sections list (right window): 
 
The ‘Road’ box from the top of the right window – from this box you can 
browse the various roads of a multiple center line project.  
 
Deleting a single section – stand on the section you wish to delete from 

the list, and click on the button  from the sections list window (right 
window). The program will erase this section from the list.  
 

Delete all road's sections – click on the button  from the right window. 
The program will send a warning before deleting all the sections. Click ‘OK’ 
to confirm this action.    
‘Load from text file’ - Loading the text file of all the sections: 
 

 Load sections from text file - the loading and saving of a sections 
text file has many uses, one of them being the data transference from 
project to project and the other, the transference of data between existing 
to designed ground level and vice-versa. In order to leaf between this 
window’s options – use the opening list ‘Files of type’ and choose from 
one of these options: 
Roads (*.Pas files) - these files are unique to CivilCAD 2016 previous 
versions, and enable opening projects that were done using the ‘Along 
roads’ software. 
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Sec files (*Sec) - sec files are text files in a special format, that can be 
created by CivilCAD 2016, or IDAN ®.  
Text (Tab delimited) (*.Txt) – reading a text file created in Excel. For 
more details see Chapter ‘Earthworks on Roads’ – Importing Data from 
Excel. 
Template(*.Tml) – reading a typical sections file, for more details see 
section ‘Working with Typical Sections’. 
Geopak sections (*.XSR) – reading cross sections data been created in 
Geopak ® software (Bently). 
LDD ® sections (*.*) – reading sections data from AutoDesk Land 
development desktop software. 
Cross sections coordinates (*.*) – this option enables the user to read a 
coordinates' file directly into the cross sections. The software will 
automatically translate the coordinates into offsets and elevation, 
projecting them into the relevant sections. This option saves the need of 
creating contours before reading the data into the cross sections.  
Max. distance - this parameter defines the distance from the section that 
the software will use to assign the coordinates to it.  
 

Save sections to file - Click on the button  from the right window. From 
the window that opens, choose one of the options from the 'Save of type' 
list.  
Sec files (*.Sec) - Sec files can be used to transfer one of the levels 
(Existing G.L, Design G.L …) from one project to another. Enter the file 
name, and click ‘Save’. In the new window choose the table with the data 
to be saved (existing status, Earthworks height, road structure height level) 
and click ‘OK'. 
 Tip: If you wish to copy the Design G.L data of one project to the 
Existing G.L another, save the project Design G.L as '*.Sec' file, open a 
new project, enter to the cross sections window and read the file into the 
Existing G.L table. 
 
Template (*.Tml) – saving a typical sections file, for more details see 
section     ‘Working with Typical Sections’.  
 
 

GetD all  – at one of the stages of roads design, we have seen how to 
import cross section data from the existing topography (contour lines). We 
have also emphasized that it is possible to import this data into the 
section's Existing G.L table, or to any other of its tables. We have also 
mentioned that in CivilCAD 2016 it is possible to create designed 
topography. The ‘GetD all’ button allows the creation of cross sections from 
the designed topography (contour lines), and import them into the section’s 
tables. To extract Design G.L data, first open the 'Options' window and 
mark 'Design Devote -40 to 40 segments'. By marking this option, the 
software will sample the Design G.L by using the entire 81 segments in the 
Design G.L table. Otherwise, parts of these segments are been saved for 
miscellaneous additions in the design such as: ditches, berms etc. 
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Therefore if this option isn’t marked, it’s possible that the software will not 
sample all the Design G.L. data. Close the Option window by clicking 'OK'. 

To execute click . In the new window choose the table to be filled and 
press 'OK'. The software will send out a warning that it is about to delete 
the design data from all sections. Click ’OK’ to continue. The data will be 
read into the Design G.L tables of the sections. 
 

Clear all  - click on the button to delete data from several (or all) 
sections at once. From the window that opens, choose the data (table) you 
want to delete and click ‘OK’ to continue. From the table that opens, mark 
the sections that their data will be deleted. To choose all sections, click on 
the ‘All’ button from the bottom. Click ‘OK’. The software will delete the 
chosen sections data. 
 

 Adding height to the sections' data - This option is useful mainly for 
working with absolute elevations (at relative heights it is best to change the 
height of the vertical alignment to changing the data of the cross sections). 
To activate click the button. In the window that opens, enter the needed 
addition to the height (to decrease the height, enter a negative height). To 
continue click ‘OK’. From the window that opens, choose the data you wish 
to change ('Existing G.L', 'Design G.L' or 'Structure'). Click ‘OK’ to 
continue. In the additional window, choose the sections you wish to change 
(to choose all click the ‘All’ button at the bottom of the window). Click ‘OK’. 
The software will add the desired height to the selection of sections in the 
table you selected (topography, designed etc.). 
 

 Super Elevations - for more details see section Super Elevations. 
 
 
Functions at the ‘Options’ window (activate using the ‘Options' 
button from the right window 
 
Some of the functions of this window have been discussed. Here are some 
more details about the function available in the window: 
 
Max/Min interval – at times, there might be a situation when irregular data 
will be read into from the topography into the sections. There are several 
reasons for this occurrence such as incorrect measuring data, measuring 
border narrower than the desired section, extrapolation at the contour lines 
and more. To avoid this occurrence, you can define for the program the 
maximum interval between the given ground level to the center line 
elevation. The assumption is that the center line height is always true (or 
at least does not deviate from the topography ranges), and is thus used as 
a reference point. You instruct the program what the maximum interval is 
at the height we allow a ground break in the section. Each ground break 
that deviates from this interval (up or down), will be deleted from the 
ground data.  
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For example – if the height at the center line is – 230.55, and we entered 
Max/Min interval of – 3 meters, every ground data lower than 227.55 or 
higher than 233.55, will be deleted from the ground data of the section. 
The affect of the data will occur only after we will perform a ground sample 
using the ‘GetT all’ button. If there are existing ground data that you wish to 
change, enter the desired interval, click ‘OK’ to leave, and repeat all the 
‘GetT all’ functions.  
 
Include edges – the key to CivilCAD 2016 sampling ground data is : the 
program will always sample the center line existing data, and any ground 
break identified at the cross section area, will be also entered into the 
table. In addition to this data, the program will sample the height of the 
existing status at the end of the section, from left to right, according to the 
width that was defined. In order to cancel the ends sampling, uncheck (the 
‘V’ mark), and repeat all the ‘GetT all’ commands. The program will sample 
the data all over again, without sampling the ends.  
 
Include center – According to the principle explained in section 2 and up, 
it is possible to instruct the program, not to sample the center point, by un-
checking this field. 
 
Close Design to Structure/ Close Design to Existing – defining the 
section's edge closure. The software always calculates the Structure and 
the Design G.L side-sticks points, even if not been defined. The following 
options defines the method to calculate these points: 
Close Design to Structure – The Design G.L (sub-grade) will be closed to 
the structure level. This option is more common when designing.  
Close Design to Existing – The Design G.L will be closed to the Existing 
G.L. 
 
Depth check between Existing Road & Designed Road to determine 
earthworks - from CivilCAD main menu, go to 'RoadsHorizontal 
Alignment'. 
Draw Polylines which will define the existing road’s edges. 
 
From CivilCAD main menu, go to 'RoadsCross sections'. 

Click on the ‘Get references by layers' button . ‘References’ window will 
open. 

Select the desired layer and click 'OK' or click on 'Select' , select the 
desired layer from the drawing, press 'Enter' and 'OK'.  
The software will perform filtering and the following message will appear: 
 

. 
 
Change one of the tables in the bottom of the window to ‘References’. 
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At ‘References’ table, define the reference as ‘Break’ (under the ‘Cover’ 
column). 
 
In order to send this definition to other sections, right click on the ‘Cover’ 
cell in the reference’s line. ‘Send to’ window will open. 
Select ‘Yes’ for ‘Current cell’ and click ‘OK’. 
 Mark the section or sections that the definition will be sent to or click on 

'All' button  for sending the definition to all sections. 

Click on ‘Interpolate empty sections’   button to update the drawing in 
the cross sections window. 
 
To determine where earthworks will be calculated, click on ‘Options’  

Button . 

At ‘Road Expansion’ dialog box , define Min. and 
Max. depth. 
 
The Software will check the depth between the existing road (Existing G.L.) 
and the designed road (Designed G.L.) in each section - right side and left 
side (separately) at 3 points : center point, right break point and left break 
point. 
 
In each section, if the depth is bigger than the definition in Max depth or 
smaller than the definition in Min depth, the software will not create Break, 
meaning earth works will be calculated in the break area. 
 
In each section, if the depth is at the range of Max depth definition and Min 
depth definition, the software will create Break, meaning earth works will 
not be calculated in the break area. 
 
Guard rails definition in cross sections (In fill only) 
 

 from CivilCAD main menu’ go to 'RoadsCross sections' 
 Change one of the tables at the bottom of the screen to ‘Guard Rails’ 

table. 
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 If you want to use the default values, click the ‘Set Default Values’  
button. 

  ‘Height Difference Condition’ and ‘Working Width’ Tables will be filled 
with the default values 

 

 You can fill the tables manually and click the ‘Save’  button to save 
definitions. 

 In order to load the saved definitions in another project, click the ‘Load’ 

 button. 
 Select the file and click the ‘Open’ button. 

 
Note: Notice that there are 3 segments in ‘Working Width’ table, for 
designing a working width with sidewalk. 

 
 To delete data from a cell, click the left mouse button inside the cell. 

Then click the ‘Delete’ button in the keyboard. 

 To delete all data from both tables, click the ‘Delete’  button and 
then click the ‘OK’ button. 
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Note: The default definition for displaying guard rails with working width 
is ‘According To Conditions’. 
In order to display guard rails in any case, mark the ‘Always’ option. 

 

CivilCAD will add the working width’s data to segments -18, -17, -16, 
16, 17, 18 according to definitions. The guard rail’s block data will be 
displayed in segments -16, 16. 

 

Note: Make sure that ‘Enable Automatic Guard Rails’ option is check 
marked. Otherwise, CivilCAD will not create guard rails. 

 

 

If there is already existing data in segments -18, -17, -16, 16, 17, 18 
which were manually defined by the user, the following warning 
message will appear: 
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 Delete the data from these segments and then click the ‘Options’  
button. 

 Checkmark the ‘Enable Automatic Guard Rails’ option and click the 
‘OK’ button. 

 Click the ‘Apply’ button to update the current section’s drawing 
according to the guard rail conditions. 

 To send the definitions to other sections, click the left mouse button 
inside one of the cells and then click the right mouse button. 

 In the opened window, select the ‘Send To’ option. ‘Send To’ window 
will be opened. 

 Select the section or sections to be updated or click the 'All'  button 
for updating all sections and click the ‘OK’ button. 

 Click the ‘Interpolate empty sections’  button to update the sections 
drawing. 

 

Note: Guard Rail contour will be displayed in the road’s Horizontal 
Alignment for each side of the road, according to the conditions. 
A new block will be displayed in the Cross Sections drawing, GR-l for 
the left side and GR-r for the right side. 

 

 In existing projects with guard rails, which were designed by the old 
system, W-l and W-r blocks must be deleted from the Cross Sections 
before using the new system. 

 If there is a working width which was manually defined in the Designed 
G.L. table, 
It must be deleted from the relevant segments before using the new 
system. 

 
 
 
Functions in the Drawing Window 
 
The drawing window (the main window on which appears the section 
drawing), has three buttons on its right hand side. In a previous section we 
have explained the functionality of the 'Frames division' button. We will 
now explain the functionality of the two additional buttons: 
 
Printing the sections into the printer: 

Click on the button . 
In the window that opens define the printing scale: Height – scale for                        
height, Long – scale for length. We will enter 100, 100 (scale of 
1:100/1:100). Click ‘OK’ to continue.  
From the window that opens, define the type and paper size, and all other 
required parameters that have to do with your printer. Click ‘OK’ (or 
“confirm”) to continue.  
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Now choose the sections you want to print. To choose all sections, click 

the on the  button from the bottom window. Click ‘OK’ to print. 
 
 The software will print all the sections sequentially, according to the 
language defined  in the settings. To change the language, follow the 
steps below: 
Leave the cross sections by clicking ‘Close’. 
Activate – ‘File-> Configuration’. 
From the right hand window - choose from ‘languages’ the desired 
language. 
Click ‘OK’ and return to the cross sections (File-> Cross sections). 
Return and print the sections as you have learned.  
 

 Zoom extents  – there are several methods of controlling the setting 
of your section : 
The scroll bars to the bottom and left of the drawing. 
Clicking the left button from the drawing area will enlarge the drawing by 2. 
Clicking on the button from the right, will decrease it by 2.  
The button 'Zoom extents' – returns ‘view’ to the entire drawing. 
 
 
 
Functions from the tables' window (bottom window) 
 
Left of every table (left table and right table), appear a number of buttons:  
 
 Deleting the table data in the current section. 

 – import the existing G.L data of the current section out of the 
existing topography. Unlike the ‘GetTall’ button, this button imports the 
existing status data of the current section only. Before proceeding, a 
warning notice will appear and will ask whether you are sure you want to 
delete the existing status data. To continue you must confirm. 

 - importing the existing G.L data of the current section out of the 
designed topography. Unlike the ‘GetD all’ button, this button imports the 
designed status data of the current section only. Before proceeding, a 
warning notice will appear and will ask whether you are sure you want to 
delete the current status design data. To continue you must confirm. 
‘Copy’ and ‘Paste’ – Copy and paste the current table into the clipboard. 
Unlike the 'Copy' and 'Paste' button the right window, these buttons are for 
the current table only and not for the entire section's tables. 
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Super Elevations  
 

In the cross sections section we have shown how to define a 

road’s cross sections. We have dealt with defining a typical 
section, and shown how to project it in interpolation along the 

entire road. We will now show how it is possible to define Super 

Elevations along the road. The principle of building Super 
Elevations is based on setting the side slopes percentage at each 

change in slopes (beginning and end of transaction curves) and 
interpolate between these changes. 
 
Defining the Super Elevations stations  
 
Open a project containing a road's design including cross sections design. 
For illustrating the process, open the following project: Sample7. 
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Samples\Sample7\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 
 
Go to ‘Roads -> Cross sections’. 

Click on the  Super Elevations button from the right window on your 
screen. A Define & Create Super Elevations window will open presenting 
this table: 
  

 
 
 Understanding the table structure: 
 
IP – IP name – The list of the road's IPs, excluding of the 1st IP.  
Geometry – Tangents along the road, including radiuses and clothoids. 
Each radius will include size and direction (a small arrow is showing the 
direction) and each clothoid will include its length.  
Geometry station – Station of each tangent (including spirals tangents) 
along the C.L. 
SuperElev. Station – the distances that will set the start and end of Super 
Elevations. These distances will be entered by the user, and do not have to 
be according to the software's computations (as they are in the ‘Geometry 
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Station’ field). When values are not entered in these fields at a certain IP, 
the program will not create the Super Elevations in the cross sections at 
the same segment. 
SlopeLeft/SlopeRight - For these fields the desired SuperElevations will 
be entered for any status. You can see from this sample that at the start of 
the Super Elevation the for both sides is –2 at the curve peak and up to the 
curve exit it is 2, and after the curve exit it is 2 again. 
 
In the table sample, 2 stations (in addition to the station of the end of the 
road) have been calculated at the beginning and the end of the curve. 
Since no transition curves exist (there is no clothoid in this sample) we will 
create the transition at the following way: 
Stand on the 'SuperElev. Station' column of the 1st tangent row (near 
'Geometry station = 59.47') and enter '49.47' followed by 'Enter'. 
We have just set the transition to start 10M before the tangent of the curve. 
Stand on the 'SuperElev. Station' column of the row below the data you 
have just entered, right-click with the mouse, and choose 'Insert row' in the 
pull-down menu. In the new row enter '69.49'. 
We have just set the transition to reach its peak at 10M after the tangent. 
Repeat the process for the second tangent: enter '202.89' at the tangent's 
row, open a new row below and enter '222.89'. 
 
At the end of this stage the table should be like this: 
 
 
 
 
 
 
 
 
 
Defining the Super Elevations side slopes 
 
After entering the S.E (Super Elevations) stations, we will now precede to 
define the S.E side slopes. In our sample, the typical cross section is been 
defined with a side slope of '-2' for left and right lanes, creating a standard 
camber from the C.L. The lanes (Asphalt segments) have been defined as 
segments '-1' and '1'. Therefore, we will enter the S.E side slopes for these 
segments*: 
 
* '-1' and '1' are the default segments of the S.E table (please notice the 
captions 'Slope left % -1' and 'Slope right % 1'). You can define a separate 
S.E for each segment by choosing the segment to control from the drop-
down list of segments at these captions. 
 
Stand on the cell at the 'Slope left' column of the '49.47' station's row and 
enter '-2' as the side slope. Move to the 'Slope right' column (at the same 
row) and enter '-2' again. 
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The beginning of the transition will start at side slopes of '-2' for each lane, 
exactly as the typical cross section. 
Stand on the cell at the 'Slope left' column of the '69.47' station's row and 
enter '3' as the side slope. Move to the 'Slope right' column (the same row) 
and enter '-3'. 
In our sample we will super elevate the curve to a maximum side slope of 
3%. Since the curve is turning right (notice the small arrow's direction in 
the geometry column. You can also verify the same from the layout), the 
left lane will change from '-2' to '3' (positive) while the right lane will change 
from '-2' to '-3'. 
Stand on the cell at the 'Slope left' column of the '202.89' station's row and 
enter '3' as the side slope. Move to the 'Slope right' column (the same row) 
and enter '-3'. 
The slopes will remain the same for the entire curve. The changes in 
slopes will start at the end of the curve while '202.89' is the station where 
we have decided to start the transition back. 
Stand on the cell at the 'Slope left' column of the 222.89' station's row and 
enter '-2' as the side slope. Move to the 'Slope right' column (the same 
row) and enter '-2'. 
At the end of the curve we are back at the typical C.S's side slopes: '-2' for 
left and right lanes. 
 
The complete table should be like this: 

 
Click 'OK' to execute the super-elevation.  
To see the affect of the S.E you can click (on the right side table) on any 
section within the curve (sections 50 to 220) and notice the carriage way 
slopes. To effect changes in the road's contours (designed contours) 
recreate the layout (click the layout button on the right window, mark all 
fields in the new window and press 'OK'). 

 

 
Additional functions in the Super Elevations window 
 
Super elevating the Design G.L (sub-grade) – when performing super 
elevations (in our example) we have referred to the 'Structure' segments. 
By default, the software automatically super-elevate the 'Design G.L' 
segments along with the 'Structure' segments. Nevertheless, there are 
unique situation whereas the 'Structure' segments are not identical to the 
'Design G.L' segments. In this situation, you might want to match between 
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the 'Structure' segments and the 'Design G.L' segments that relates to it. 
When choosing the segment to be edit (clicking the drop-down list at the 
caption of the S.E table, near the 'Slope left' and 'Slope right' fields), a 
window will be opened showing one of the following options: 
Use identical designed G.L segments. 
Use different designed G.L segments, for left/right structure segment (X) 
use designed G.L segments: ….. 
By choosing the 1st option, the software will use the same segments to 
super-elevate the 'Design G.L' and 'Structure'. Using the 2nd option will 
match the selected 'Design G.L' segment (in the drop-down list in the new 
window) with the 'Structure' segment been chosen at the caption of the S.E 
window. 
 
 

 - Clear all Super Elevations stations and all its slopes – this button 
erases all the data entered into the ‘Superelev. Station’ and the ‘Slopes’.   
 

 - Erase current Super Elevations slopes – this button erases the 
values entered in the current line under the fields ‘Slope left’, ‘Slope 
right’. 
 

 - Load segment super-elevation data – read the entire super 
elevation data from a text file been saved by the software. 
 

 - Save segment super-elevation data – save the entire super 
elevation table into a text file, later to be read to another project or another 
segments. 
 

 - Insert an empty row - (alternatively you can right click with the 
mouse and select 'Insert row' from the pull-down list). 
 

 - Copy Geo. stations to Superelev. stations – Copy all the stations 
from the 'Geometry stations' column to the 'Superelev. stations' column. 
 

 - Send segment’s slope automatically to other segments - define 

the leader segments (on the upper part of the window) and then 
check the conforming segments that will inherit the leaders slope 

(on the lower part of the window). 

 
Change shoulders according to current segments/Change current 
segments only – This option controls the segments that will be affected by 
the Super elevations: 
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Change shoulders according to current segments – When super 
elevating the lanes segments, the software will automatically super elevate 
the shoulders so they will follow the lane's slopes. 
Change current segments only- The super elevation will affect the 
current segments (table) only. 
 

 

 

Side ditches and additional cover functions 
 
So far, we have shown how to design a road and all its parts, starting with 
the Horizontal Alignment and ending with the cross sections. We have also 
shown how to define Super Elevations. In this chapter we will discuss two 
additional options in cross sections: 
 
Defining side ditches. 
Additional ‘Cover’ functions. 
 
 
Defining Side Ditches 
 
Defining side ditches along the road is done by entering ditches data in the 
Cross Sections Window (‘Roads ->Cross sections’) into designated 
tables (‘Right ditch’ and ‘Left ditch’).  
 
 
Defining the Ditch Typical Cross Section 
 
Designing Ditches In Cut 
. 

1. Change one of the tables (Existing G.L. or Designed G.L.) to 'Right\Left 
ditch'. 

2. Define the ditch's left and right side slope and bottom width. 

 
 

3. Define the ditch's depth in cut. The depth will start from the section's 
edge. 

  
4. The depth will be determined by the "lowest" datum, in this case - From 

Existing G.L. and the depth will be calculated from the bottom center of 
the ditch to the Existing G.L. 
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Check the 'From Design G.L.' checkbox to start the ditch from the 
design height. The depth will be calculated from the design height. 

  

Check the 'From Structure lev.' Checkbox to start the ditch from the 
structure height. The depth will be calculated from the structure height. 

  

5. Check the 'At Design G.L.' checkbox to end the ditch at the design 
height.  

 

6. Check the 'At Structure level' checkbox to end the ditch at the structure 
height.  

 

 

Sending ditch's datum to other sections : 

7. Right click on one of the ditch's datum.  

8. At the selection window, click 'No' for sending current cell only or 'Yes' 
for all ditch. 

9. At the 'Send to' window, select the section or sections that the ditch's 

datum will be sent to or click on the 'All' button  for 

sending the ditch's datum to all sections. 

 

 
Designing Ditches In Fill 
 

1. Change one of the tables (Existing G.L. or Designed G.L.) to 'Right\Left 
ditch'. 

2. Define the ditch's left and right side slope and bottom width. 

 
 

3. Check the 'From Side-stick' checkbox to start the ditch at the closure of 
the section with the ground.  
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4. Check the 'From Sec. edge' checkbox to start the ditch at the section's 
edge. 

   
5. If the section's edge is (In Fill) is higher than the definition in "From 

section's edge", the depth of the ditch will be determined by the 
definition in "In Fill". 

6. Check the 'From Design G.L.' checkbox to start the ditch from the 
design height. The depth will be calculated from the design height. 

 

7. Check the 'From Structure lev.' Checkbox to start the ditch from the 
structure height. The depth will be calculated from the structure height. 

 

8. Check the 'At Design G.L.' checkbox to end the ditch at the design 
height.  

 

9. Check the 'At Structure level' checkbox to end the ditch at the structure 
height. 

 

 

Sending ditch's datum to other sections: 

 
1. Right click on one of the ditch's datum.  

2. At the selection window, click 'No' for sending current cell only or 'Yes' 
for all ditch. 

3. At the 'Send to' window, select the section or sections that the ditch's 

datum will be sent to or click on the 'All' button  for sending the 
ditch's datum to all sections. 

 
Designing Ditches' Shoulders  

 
1. Change one of the tables (Existing G.L. or Designed G.L.) to 'Right\Left 

ditch'. 

2. At the bottom of the table, select 'Shoulders in Cut' or 'Shoulders in Fill' 
according to the status of the ditch. 
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3. Type Width and slope for each shoulder (Right and Left). 

 

Sending shoulder's datum to other sections: 

 

1. Right click on one of the shoulder's datum.  

2. At the selection window, click 'No' for sending current cell only or 'Yes' 
for all ditch. 

3. At the 'Send to' window, select the section or sections that the 

shoulder's datum will be sent to or click on the 'All' button  for 
sending the shoulder's datum to all sections. 

 
 

Existing G.L. Natural Slope Check 

 
1. Change one of the tables (Existing G.L. or Designed G.L.) to 'Right\Left 

ditch'. 

2. At the bottom of the table, check the Check existing G.L. slope at offset' 
checkbox. 

3. Define the offset and dH for there will not be a ditch if the difference 
between the section's edge to the offset definition will be higher than 
the dH definition. 

 
 

Sending the slope check datum to other sections: 

 
1. Right click on one of the datum.  

2. At the selection window, click 'No' for sending current cell only or 'Yes' 
for all ditch. 

3. At the 'Send to' window, select the section or sections that the datum 

will be sent to or click on the 'All' button  for sending the 
datum to all sections. 
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Copying data into additional sections 
 
After entering the data for the left and right ditch, we would like to project 
the same data along the entire road. Make sure you are in the first field of 
the left embankment data (Slope L).  If you are not in this field, left click 
with the mouse inside this field. In order to copy the data to the remaining 
sections follow these steps: 
 
Click on the right button in this field (right mouse click). 
The program will ask if you wish to copy the entire ditch's data or just the 
field you clicked on – via the dialog box ‘Send the whole ditch?’ Click 
'Yes' to copy the entire data. 
The program will present a window containing the list of sections. From this 
window, mark the sections you wish to copy the current section to, and 
click ‘OK’. You can choose the desired sections by marking them or typing 
their names next to ‘Names’. In order to copy the data into all the sections, 

click on the  button to mark the entire list. 
Click ‘OK’. 
Repeat this process for the second ditch as well. 
Interpolate the entire sections* – press the 'interpolate empty sections' 
button in the right window and in the new window, press 'OK' for 'All 
design'. 
You can now move between the entire sections and see the result of the 
ditches' projection. 
 
* Note: After each projection of data (left ditch, right ditch, berms etc.) to 
several/all sections, you much interpolate to recalculate the section. 
Alternatively you can go to each section and press 'Apply' in the right 
window.   
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Controlling the ditches' I.L from the vertical alignment 
 
CivilCAD 2016 allows presenting and controlling the side ditches' I.L on the 
vertical alignment. Following the changes in the vertical alignment, the 
program will automatically change the ditches in cross sections. In order to 
present the ditches data on the vertical alignment, follow these steps:  
 
After defining the left and right ditches in the Cross Sections, enter into the 
vertical alignment window (from main menu activate: Roads -> vertical 
alignment).  
Mark the 'L. ditch' and 'R. ditch' checkbox in the right window (under the 
'Include' caption), and press 'Apply'. Two new vertical alignment of the left 
and right ditches' I.L will be presented. In the table at the bottom of the 
section, new rows will be shown showing the left and right ditches' I.L 
elevations.  
From the pull-down list in the right window, next to the 'Centerline’ label, 
move to ‘DitchR’ (use the small arrow right of the ‘Centerline’). The lower 
'Design' table (at the lower window) will change and the 'VerEdit' layer in 
the drawing will contain the right ditch's I.L profile.  
In the right window appears the label 'Right ditch dist. From road edge'. 
In the field next to it enter ‘1’, press the 'GetT' button on the left of the lower 
'Topography' table and click ‘Apply'. The profile of the existing ground at 
the right edge of the road + 1M will appear before you. The vertical 
alignment will be built at a distance of 1 meter (as we have just defined) to 
the right of the defined cross section end. 
To sample the ditches' I.L into the lower 'Design' table, press the 'Get ditch 
from C.S depth' button (a button to the left of the 'Design' table, showing a 
blue ditch). The software will project the ditches' I.L from the C.S into the 
table. A break in the I.L profile (C.S that do not have ditch) will be shown 
as an empty line in the table.  
Change I.L profile the same way you have designed the road's vertical 
alignment, either by drawing it (in the 'VerEdit' layer) or changing the data 
in the lower 'Design' table. 
Press the 'Close' button in the right window. 
Enter to the cross sections window ('Roads -> Cross Sections'). 
Change the lower left table to 'Left ditch' and the lower right table to 'Right 
ditch'. 
Go into the 'Depth' fields ('Cut', 'Fill' and 'In between') and change them to 
'0' (both for left and right), and press 'Apply'. 
Project the entire change ('Depth = 0') onto the entire road (for more 
details see former stage - '2. Copying data into additional sections'). 
The I.L of the Cross sections will be defined according to the I.L profile 
been designed in the Vertical Alignment window. 
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Additional 'Cover' functions 
 

In the tables that define the cross sections, both ‘Structure’ and ‘Designed 
G.L’, appears column 5 titled ‘Cover’. In Roads design, this column will be 
mainly used in the ‘Structure’ table. In ditches design (not side ditches), 
where there will be no structure at all, (to learn more, see chapter 15 “Ditch 
and Reservoir Design”), we will use the ‘Cover’ column of the ‘Designed 
G.L’. Two functions of this column: ‘1 – Asphalt' and '3 – Sidewalks' are 
discusses at length in section “Cross sections” (from this chapter). We will 
now expand the discussion to the remaining ‘Cover’ functions.  
 

For each of the segments in the cross section (reminder: each line in the 
cross section is called a segment and is numbered by positive sequential 
numbers right of the center line, and negative to its left), there is a separate 
‘Cover’ definition. The default to all the segments is no cover or as it is 
defined ‘0 - None’. To define a ‘Cover’ to a particular segment, stand on 
column 5 - in front of the segment and double click your mouse. An options 
list will open in this field, from which you can choose the desired cover. 
These are your choice options: 
 

None – the default of every segment. An empty field that is equivalent to – 
0, that signifies that the segment has no definite ‘Cover’.  
Asphalt – The selection of Asphalt for a particular segment will affect the 
segment in two ways: contour lines will be defined for this segment, in the 
same exact way, as if it was ‘Cover’ was chosen of ‘Contours-2’ type (see 
detailing later on), and thickness will be given to the road structure line, in 
this segment. To see the effect of the selection on the section, click 
‘Apply’. The chosen segment will be marked by a bold line. 
Contours – (contour lines). The usage of ‘Contours’ type ‘Cover’ has been 
demonstrated during the ‘cross sections’ section of this chapter. This type 
of cover is used for defining the area in which contour lines will be shown 
in the layout. If you want contour lines only in the asphalt road area, 
choose ‘Contours’ only for segments that define asphalt. To receive 
sample side-walk contour lines, mark these segments also with ‘Contours’. 
It is important to mention that in order to get contour line in a layout at the 
desired segments, you should define ‘Contours’ along numerous sections 
in a parallel segment. After ‘Contours’ is selected, no effect will be seen on 
the cross section. The affect will only be realized during the layout drawing 
stage.   
Sidewalk - Selecting sidewalk for a certain segment will cause a double-
line drawing in the segment on the on the cross section. 
Garden - Selecting garden for a certain segment will draw a garden in the 
chosen segment, on the cross section. 
Block - This option is for “planting” blocks such as side-walk rim stones 
security railing etc., in the cross section. CivilCAD 2016 is installed with a 
library which contains a collection of block (we are referring to the drawing 
blocks), in format DWG, that can be added to the cross sections. In the 
typical section/ specific cross section, we will define the location and type 
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of block, and afterwards it will appear as part of the section drawing. To do 
so follow these commands:  
Select ‘Block’ from the list. 
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Road Blocks\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Road Blocks\ 
 
 
After choosing click on “open”.  
Press 'Apply'. 
The software will position the chosen block in the section, at the end of the 
segment to where it belongs.  
Note: In order to watch the block that was selected for a certain field, 
choose this field (one mouse click), and remain on it with your mouse 
cursor. After two seconds, the file name will appear in yellow writing.  
In cut only – (cut only). This option enables to define the segment to 
which it belongs, as the segment that will only appear if it is in ‘cut’.  
In fill only – (fill only). This option enables to define the segment to which 
it belongs, as the segment that will appear only if it is in ‘fill’.  
 
Tip: Adding 'Cover' to an existing cross section will change the current 
section only. To project the change to the entire sections, use the 'Send to' 
method – right click on the cell to be projected, select 'Send to', choose the 
sections to project to and press 'OK'. 
 

 

Berms Design 
 
CivilCAD 2016 makes it possible to add berms at cross sections 
automatically, using ‘Berms’ mode. =We will demonstrate using this 
example: 
 
Activate - ‘File ->Open project’. 
Choose project 'Sample7' from the Samples folder. 
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Samples\Sample7\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 
 
 



 

 

Page 248 of 508  
 
 

CivilCAD 2016 Reference manual 

Enter into the cross sections using ‘Roads- > Cross sections’. 
Move to the first section from the list of sections from the right hand 
window. 
Move the ‘Designed G.L.’ table to ‘Berms’ from the list that opens. 
Fill in the details in the table that appears according to the sample below: 
 

 
 
Click ’Apply’ to show the changes on the drawing. 
Click inside the 'Width' cell of the 'Cut_zone' row. Right-click (with the 
mouse) and choose 'Send to'. Click 'Yes' to send the whole Berm data. 
Select the sections to send the data to and press OK. 
Press the 'Interpolate empty sections' button at the right window.  
 
We will explain the table structure: 
The lines ‘R’ and ‘L’ marked in green, are not the line for entering this data, 
lines that separate between the Berms design at the right edge, to the left 
edge of the section. 
The lines ‘Cut Zone’ - mark the Berms design in Cut. 
The lines ‘Fill Zone’- mark the Berms design in Fill. 
Width – the width of Berm's step. 
Height – the height of the Berm itself. 
Slope – the Berms step's slope.  
 
The Berms slopes will be identical to the slope that determines for the 
edges slopes which is defined from the ‘Designed G.L.’ in fields: 
 
Slp. Left:  Cut 1:  Fill 1: 
Slp. Right:  Cut 1:        Fill 1: 
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Working with typical sections 
 
CivilCAD 2016 makes it possible to create ‘Template’ files in cross sections 
design. This file saves a typical design of all the statuses in a certain 
section including the design, structure, side ditches, berms etc. We will 
explain using the following example, how it is possible to create a ‘TML’ 
file, save it, and afterwards use it to fill the section in a certain project.  
 
Creating a ‘Template’ File 
 
Start a new project and create a regular cross section (you can follow the 
explanation appears in the Cross-Section part of this chapter). The cross 
section can contain 'Structure', 'Design', 'Side ditches' or any other design 
element. 
Note: The cross section can be created at any one of the sections in the 
list. 

After creating the cross section, click on ‘Save sections to file’ button . 
From the files window that opens switch to ‘Template (*.Tml)' type, next to 
‘Save as type’. Choose the template's file name and click ‘Save’. 
 
Having saved the section, it can be used from here on in any project in 
which cross sections will be designed. It is best to save the ‘Template’ file 
in a special designated folder for holding files of such sort, so they are 
easy to find for future use.     
 
 
Importing from a ‘Template’ file to Cross Sections 
 
In order to create a project with cross sections filled by a ‘Template’ file, 
follow these steps: 
 
Open a new project in CivilCAD 2016 ‘File->New project’. 
Define a new road and the horizontal alignment by ‘Roads -> horizontal 
alignment’ as explained in section ‘horizontal alignment’.  
Go to the vertical alignment window by ‘Roads->vertical alignment’ and 
press 'Apply' in the right window. 
Define the designed vertical alignment. 
Exit ‘vertical alignment’ window by clicking the ‘Close’ button.  
Move to ‘cross sections’ window by – ‘Roads->cross sections’. 

Click on the ‘Options' button  and move from ‘Elevations’ to ‘dH’ 
status. As you are importing a typical section, you will have to move to a 
work mode at relative heights. 
Define the number of sections and the distances between them using the 

‘Define sections’ button .  
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Click on the ‘GetTAll’ button  to sample the existing status into the 
‘Existing’ table.  

Click on the ‘Load sections from text file’ button  . 
From the files window* choose the TML file for which you want to load into 
the sections. The section will be shown at the preview window. 
Click ‘Open’, to fill the cross sections with TML file data. 
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Templates\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Templates\ 

 

Advanced topics on cross sections 
In this clause, we will discuss the following topics: 
 
  Changing side slopes – breaking the elevation in the edges’ 

sections. 

  Beside road - designing beyond the road's edges. 
  Land development. 
 Automatic creation of Cross Sections for closing road’s edges to 

designed planes 
  Utilities – crossing infrastructures. 
  Side slope by road height. 
 Attach lines to roads – altering sections by choosing lines from the 

layout. 
 Quick thumbing through cross sections 
 Sub-Layers 

 
 

Changing side slopes – breaking the elevation in the edges’ sections 

CivilCAD enables defining changes in side slopes of the cross-sections’ 
edge. Changes can be defined at a specific depth/height from existing G.L 
or from Design G.L. In order to execute this, follow the next steps: 

   
 From the Main Menu activate 'Roads->Cross-sections'. 
 Transfer one of the tables from the list in the bottom of the screen to 

'Changing side slopes'. The table is divided to 'Left edge' and 'Right 
edge' and to 'Cut' mode and 'Fill' mode. 

 Define the elevation (difference) from which the slope has to be 
changed in Depth/Height columns, by the following rules: 

 Positive value - breaking of the slope will be executed on the 
difference from the existing G.L. 

 Negative value - breaking of the slope will be executed on the 
difference from the height of the design G.L.  



 

 

Page 251 of 508  
 
 

CivilCAD 2016 Reference manual 

 Define the slope's ratio after the changing point (the slope before the 
changing point will be defined in the 'Slope' column of the side slopes 
of the 'Design G.L.') 

 A space can be defined to create a step between the two slopes. The 
space in the space column will be defined in Meters. 

 In order to view the changes in the section's draw, click 'Apply'. 
 In order to copy the entire data to all sections or to part of the sections, 

right click on the table and choose all sections. In the opened window, 
choose the number of sections or click 'Send to' and then click 'OK'. 
 
 
 

Beside road - designing beyond the road's edges 
CivilCAD enables the addition of planning in sections edges (for example if 
a one wishes to plan a ditch beyond the edge's line).  In order to do so, 
execute the following steps: 

 From the main menu activate ‘Roads->Cross sections’. 
 Transfer to one of the tables from the list in the bottom of the screen to 

Beside road. The table is divided to right side and Left side edge, to Fill 
mode and Cut mode. 

 Enter the following data to Right side/ Left side and to Cut and Fill 
mode : 

 Distance - distance of planning from the edge of the section. 
 Width - width of the section. 
 Dh(+/-) - height of the section relatively to the elevation at the 

section’s edge. (A negative value can be entered by typing 
the minus sign). 

 Slope - the slope of the ditch/structure's edges (for example, 
entering the value: 2 will define a slope with a 1:2 ratio). 

 In order to view the changes in the section's drawing, click ‘Apply’. 
 To copy these data to all sections or to part of these sections, right-

click on the table and choose ‘Send to’. In the opened window, choose 
the number of sections or click A to select all the sections, click ‘OK’. 

 

 

Land development 

CivilCAD enables the marking definition of the land development on both 
sides of the cross-section. To clarify the matter, we'll explain an example 
through the following stages: 

 From the main menu activate ‘Roads-> cross sections’. 
 Transfer from the list in one of the tables in the bottom of the screen to 

‘Land development’. 
 Fill the following data to Left/Right side: 
 Parcel No. - Name/number of parcel. 
 Development elev. - elevation of ‘Zero’ point of parcel. 
 Earthworks elev. - elevation of Design G.L. of parcel. 
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 In order to view the changes in the section's drawing, click ‘Apply’. The 
marking on the development Height can be noticed on the drawing. 

 To copy these data to all sections or to part of these sections, right-
click on the table and choose ‘Send to’. In the opened window, choose 
the number of sections or click A to select all the sections, click ‘OK’. 

 
  

Automatic creation of Cross Sections for closing road’s edges to 

designed planes 

 Make sure that you explode the planes and change its layer before 
using this function. 

 From CivilCAD main menu, go to 'RoadsCross sections'. 

 Click on the 'Get references by layers'  button. ‘References’ window 
will be opened. 

 At the 'References' window, select the desired layer and click the 'OK' 
button, or mark the 'Select' option, select the desired layer from the 
horizontal alignment and press 'Enter' and 'OK'. 

 Make sure that the ‘Add sections according to reference’ is check 
marked. 

 

The software will perform filtering and the following message will appear: 
 

 
 

 Select one of the tables (Existing G.L. or Designed G.L.) and change to 
'References'. 

 Double click the cell that is located on the References segments, under 
the 'Cover' column. 

 From the Drop-down list, select 'Edges attachment' option. 

 
To send the ‘Edge Attachment’ definition to other sections: 
 

 Right click on the cell.  
 At the selection window, click 'No' for sending current cell. 
 At the 'Send to' window, select the section or sections that the datum 

will be sent to or click the 'All'  button for sending the datum to all 
sections. 

 Click the 'Interpolate empty sections'  button and 'OK'. 
 

The software will close the road's edges to the designed planes at the 
points which are defined by the 3D line. 
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In order to return the planes back to a 3D layer: 

 
 From CivilCAD main menu, go to 'Designplanes'. 
 Click the 'Apply' button. 

 

Utilities - infrastructure 

CivilCAD enables to present infrastructure lines that intersect the road in 
the cross-sections. We'll explain an example by the following stages: 

 From the main menu activate ‘Roads -> cross sections’. 
  Transfer from the list in one of the tables in the bottom of the screen 

to ‘Utilities’. 
 
There are two methods to enter data: 
 
Method 1 - entering the following data to a table manually, as follows: 

 Name - name of the infrastructure line (for example: 
electricity, sewage, water etc.). 

 Offset – offset from the centerline. 
 Elevation – elevation of the infrastructure. 
 Depth - depth of the infrastructure relatively to the road's 

structure. 
 Diam (cm) - diameter of the infrastructure's pipeline (in 

centimeters). 
 

Method 2 – extracting data from an AutoCAD's layer that contains 
the infrastructure: 

 Click the button  on the right hand side of the section's 
window.  

 The layout's drawing will appear and on top of it, a window 
will open containing the list of layers. 

 Mark the layers that include the infrastructure to extract from 
or click ‘Select’, select the desired layers on the drawing and 
press 'Enter'. 

 When the process is finished, a message will appear – press 
'OK' to end the process or 'Cancel' to continue and choose 
another layer. 

 The marking of the infrastructure on top the relevant sections 
can be noticed by clicking them in the right window section's 
list. 
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Side slope by road height  

Side slopes can be defined according to the height or depth of the road. 
The software will calculate the side slopes according to the defined 
options. Several options can be defined by necessity. To define the side 
slopes this way, execute the following steps: 

 From main menu activate ‘Roads->Cross sections’. 
 Transfer out the list in the bottom of the screen to ‘Side slopes by 

road height’ table. 
 Enter the following data to table: 
 Depth Height - enter depth/height (for example, when 

entering "1" the software will define the side slope where the 
height or depth of the road will be up to 1 meter). 

 Cut 1: - side slope in ‘Cut’ zone (entering "2" will create a 
slope with the ratio of 1:2). 

 Fill 1: - side slope in ‘Fill’ zone. 
 In order to see the changes in the drawing, click ‘Apply’. 
 To copy these data to all sections or to part of these sections, right-

click on the table and choose ‘Send to’. In the opened window, choose 
the number of sections or click A to select all the sections, click ‘OK’. 
 
Side slope will be determined according to the Depth/Height datum 
ratio filled in the table. 
 
If the height difference between Existing G.L. and Designed G.L. is 
bigger than the highest Depth/Height datum – side slope will be 
determined according to the highest Depth/Height datum ratio. 

 

 
Attach lines to roads - Changing the cross sections by choosing lines in 
the layout 
In CivilCAD, sections' planning can be altered by moving the segments in 
the tables. Attach lines to the road segments by choosing specific lines 
(layers) in the layout drawing. The software will pinpoint the desired 
segment (Offset) to the lines in the designated layer. To execute this 
action, execute the following steps: 

In the cross section window, click button . 
The sections window will minimize and the layout window will appear 
above it. 
Choose the desired segment in the Sections segments’ list. 
If you wish to accept this segment without changing its elevation, mark 
option ‘Don't change elevation’. 
If you wish to change the segment's elevation without moving it, click 
option ‘Don't change Offsets’. 
Choose the table you wish to change: ‘Design’ or ‘Structure’. 
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Type maximum distance (in meters) from centerline for line near caption 
‘search range’ switch to drawing and click on one line that represents the 
layer of lines we wish to pinpoint. Click ‘Select’ for plan and press ‘Enter’.  
For section's updating, click ‘OK’. 
 
 
Attach ditch to line – attaching side ditch to a reference line by choosing 
the line from the layout 
 

 From CivilCAD main menu, go to 'RoadsHorizontal Alignment'. 
 Draw a polyline which will use as reference line for the side ditch 

attachment. 
 From CivilCAD main menu, go to 'RoadsCross Sections'. 

 Click the 'Attach Ditch To Line'  button. 'Attach Ditch To Line' 
window will open. 

 Mark the relevant side (Left Ditch or Right Ditch). 
 Select the reference's layer from the layers list or click the 'Select' 

button and select the reference line from the drawing. 
 Click the 'OK' button. 

 
Note: The ditch will be attached to the reference line at the intersection 
point between the ditch's slope (closest to the road) and the bottom of the 
ditch respectively to the side of the ditch (Right or Left). 
 
 
 

Quick thumbing through cross sections - according to step & 

station definition 
 
In order to thumb through cross sections the Horizontal Alignment must be 
built with ‘Triangles’ option: 

 From CivilCAD main menu, go to 'RoadsHorizontal Alignment'. 
 Click the ‘Apply’ button. ‘Layout & Contours’ window will open. 
 Make sure that ‘Triangles’ option is checked and click ‘OK’. 
 From CivilCAD main menu, go to 'RoadsCross Sections’. 

 Click the ‘Quick Sections View’  button. ‘Quick Sections View’ 
window will open. 

 Define the distance between sections (Step Size) and the station for 
start thumbing (Start from Station). 

 Click the right arrow to go to the next section and the left arrow for 
returning to the last section 
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Sub Layers – creating sub layers for detailed earthworks report 
 
In CivilCAD, sub layers can be defined for Structure, Designed G.L. and 
Existing G.L. 

1. Click on ‘Insert Layers’  button. ‘Layers Manager’ window will open. 

2. Select the desired layer (Existing G.L. , Designed G.L. or Structure) for 
adding sub layers. 

3. Click on ‘Define a new layer’  button. ‘New Layer’ window will open. 

4. Enter new layer name and click ‘OK’. 

5. Click on the right cell to define sub layer’s color.  

Repeat steps 3-5 for each sub layer. 

6. Use ‘Order’ arrows to define the order of sub layers on drawing. 

7. Click ‘OK’ to save definitions. 

8. Change one of the tables (Existing G.L. or Designed G.L.) to ‘Structure’ 
and the other table to ‘Structure’ with sub layer (will open automatically 
with sub layer). 

9. Copy ‘Structure’ table to sub layer’s table and change dH of segment 0 
(should be lower than dH in ‘Structure’ table). 

Repeat steps 8-9 for each sub layer. 

10. Copy first section to last section and click ‘Apply’. 

11. Click on ‘Interpolate empty sections’  button to update all sections. 

 
 
Sub Layers - Creating structure layers for each segment in cross sections 
 

 From CivilCAD main menu, go to 'RoadsCross Sections'. 

 Click on ‘Options’ button . ‘Options’ window will open. 

 Click on the Materials button . ‘Materials’ window will open. 
 Enter the elements that component the structure layers and click ‘OK’. 
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For example: 

 

To delete an element from the list, click on ‘Delete one material’ button 

 and click ‘OK’. 

To delete all elements from the list, click on ‘Delete all materials’  

button  and click ‘OK’. 

To save elements list, click on  button, enter name and path and 
click ‘Save’. 

To load elements list, click on  button, select the desired file and 
click ‘Open’. 

After defining the elements, define templates which will be 
attached later to segments. 

You can define different elements for each template. 

Click on the Structure layers button . ‘Structure Layers’ window will 
open. 

On the upper part of the window, define list of templates (default name 
is Template1). 

Mark the first template and on the lower part of the window, select the 
elements which will assemble the current template and define each 
element its thickness. 
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For example: 

   

Total thickness (in cm) will be presented in ‘Template width’ cell. 

In order to change the order of elements in the current template, use 
‘Order’ arrows on the right side of the window. 
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Additional function buttons in the upper part of the window: 

 

To erase a template from the list, click on ‘Erase one template’ button 

 and click ‘OK’. 

To erase all templates from the list, click on ‘Clear all templates’ button 

 and click ‘OK’. 

To save templates list, click on  button, enter name and path and 
click ‘Save’. 

To load templates list, click on  button, select the desired file and 
click ‘Open’. 

 

Additional function buttons in the lower part of the window: 

To erase an element from the list, click on ‘Erase one material’ button 

 and click ‘OK’. 

To erase all materials from the list, click on ‘Clear all materials’ button 

 and click ‘OK’. 

To copy elements from one template to another, use ‘Copy/Paste’  

Buttons . 

In order to add new line for a new material, Click on ‘New material’  

Button . 

Click ‘OK’ to save definitions. 

Change one of the tables in the bottom of the window to ‘Structure’. 

At the Structure table, change from ‘Cover’ to ‘Sublayers’ 

 

For each segment attach the desired template. 

In order to send a template to other sections right click on the desired 
template. 

‘Send to’ window will open. 

Select the section or sections that the template will be sent to or click 

on the 'All' button  for sending the template to all sections. 
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From CivilCAD main menu, go to ‘RoadsEarthWorks’ and click 
‘Apply’ for full report. 

Note : In order to use these templates in future projects, create the 
structure layers templates in Prototype and Save. 

 

In order to update Designed G.L. according to the Structure Sub Layers 

definitions, click the  Update Designed G.L. by Structure Sub 
Layers. 

‘Sent To’ window will open. Select the desired cross sections for 

updating or click the 'All' button  for updating all cross sections. 

Click the ‘OK’ button and then Click the ‘OK’ button again. 

 

Geometric computations along the center line 
 
CivilCAD 2016 enables geometric computations along the center line 
including several options such as coordinate's computations at station and 
offset along the center line, geometric data reports of the center line and 
more. Most of the functions from this window can be activated immediately, 
following the center line definition (Horizontal Alignment window), and with 
no definition of cross sections. To start, go to 'Roads -> Coordinates 
computations’. These are the options available at the window that opens: 
 

1. Coordinates computations along the center line – calculating 
a single point. 

 
 Make sure that you choose ‘Coord’ from the options that appear in the 

window - ‘Coord’ or ‘Geom’. 
 In the ‘Station’ field - enter the station (in meters), of the point you wish 

to compute. To compute a point in the second section, for example, 
enter 20 (or 25, depend on the distance between cross-sections). Click 
‘Enter’ to continue.  

 In the ‘Offset’ field - enter the computed point offset from the center 
line. To compute the point in the center line itself, enter 0 or leave the 
field empty. To compute a point left of the center line, enter a negative 
distance, and to the right a positive one. Click ‘Enter’ to continue.  

 In the ‘New point’ field - enter the name of the new point to be 
computed. It can be a number or an alphanumeric name that includes 
letters.  

 Click ‘Enter’, or ‘Apply’ button. The program will compute the desired 
coordinate and add it to the list of coordinates at the bottom window.  

 
As default, the computed coordinate will be added to the 
‘Designed coordinates’ list (browsing between lists is done, as 
aforesaid, by choosing ‘Topography -> Coordinates’ or 
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‘Design-> Coordinates’ from the main menu). It is possible to 
instruct the program for which list to perform its computation. To 
do so, follow these steps: 

 
 From the main menu activate: ‘Geometry-> Geometry parameters’. A 

window will open from the right.  
 From the window that opens choose ‘Topo points only’ to compute 

the data for the existing table, or ‘Designed points only’ to computate 
them into the designed table.  

 Click ‘OK’ to confirm. 
(In order to determine this definition for all projects, follow this order of 
commands in the ‘Prototype’ project.) 
 
 

2. Coordinates computations along or offset to the center line – 
computing a points' sequence 

 
 Make sure that you choose ‘Coord’ from the options that appear in the 

window - ‘Coord’ or ‘Geom’. 
 In field ‘From’, enter the station of the first point you want to compute 

and click ‘Enter’. For the beginning of the center line enter ‘0’. 
 In field ‘To’ enter the station of the last point you want to compute and 

click ‘Enter’.  
 The program had computed the length of the center line and presented 

it next to the ‘Roads length’ field. In order to compute points along the 
entire center line, enter the length near the ‘To’ field, and click ‘Enter’ to 
continue.   

 In the ‘Offset’ field, enter the offset points computed from the center 
line (and offset to it). To compute the center line points themselves, 
enter 0 or leave the field empty. To compute a point left of the center 
line, enter a negative number, and to the right a positive one. Click 
‘Enter’ to continue.  

 
It is possible to compute numerous points at different offsets in one 
action. To enter several offsets, separate the offsets using spaces. For 
example, if you want to compute the road section points, when for each 
section we are interested in the center line point itself and in the points to 
the left and right of it at the offset of 5 meters, then enter “-5 0 5” into the 

‘Offset’ field. 
 

 In the ‘New point’ field, enter the first point number created. The 
program will number the points from here on.  

 

When working on a sequence of points (unlike computing a single 
point), the name of the point entered in the ‘New point’ field, must be 
a number, in order for the program to number the points in an 
ascending. You might want to give the points a characteristic prefix 
name. To do so use the ‘prefix’ field. If you wish, for example, to 
compute the actual center line points, enter ‘CL’ in the ‘Prefix’ field.  
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 Click ‘Enter’, or ‘Apply’. The program will compute the desired points 
and add them to the coordinates list at the bottom window. If ‘Prefix’ 
was entered, then the names of the points will be added with their 

matching prefix. After you finish the computation, click  to get the 
points on the drawing.  

 

After you finish the computations, and confirm that in the bottom list 
appears the desired coordinates database, you can save the list in file 
Ascii, or print it (for more detail on saving or printing coordinates in a 
Text file, see chapter 2 section 3 “Coordinates Database – command 
buttons connected to the list”). 
 

 
3. Coordinates computations of the side-sticks points along 

the center line  
 
This option enables coordinates computations of the cross sections' 
side-sticks points along the road, to its left and right. Using this 
function requires, naturally, cross section definitions aside from the 
center line. To perform follow these steps: 

 Click on the side-sticks points' computation button  from the right 
hand window (a button with a picture of a red stripe and two blue 
arrows). The window will open.  

 From the window that opens, you have the following options: 
1) By default, the program will compute the side-sticks points 

for the ‘Designed G.L'. If you wish to compute the side-
sticks points for the ‘Structure’, move the small arrow from 
the ‘Designed G.L’ dialog box, to ‘Structure’. 

2) Entering a “security distance” to the side-sticks points- left 
and right. If you want the software to compute the side-
sticks points at an offset from their real location, enter this 
distance at the proper fields: for field ‘Left’ enter the 
distance to the left edge, and for field ‘Right’ the distance 
to the right edge. The distance entered, will always be 
from the center line and outwards, (distances will always 
be entered as an absolute value without the '-' sign).  

3) Enter the ‘Prefix’ to the points about to be created. If you 
want to add any kind of text to the names of the points 
created (say the name of the road to which they belong), 
enter this text in the ‘Prefix’ field.  

 
After determining the desired window setting, click ‘Apply’ to perform 
the computation. The program will compute the points according to 
definitions and they will be added to the ‘Designed coordinates’ list at 
the bottom. The names of the points will be chosen according to the 
name of the section to which they belong, with the addition of ‘L’ or ‘R’ 
to mark the point left or right of the section. In addition, if the ‘Prefix’ 
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was entered, it will appear at the beginning of the points' names. For 

report preview click button  from the right. 
 
 
4. The center line geometric data computations 
 

In order to get the geometric data list, choose ‘Geom’ (choose between 

‘Coord’ and ‘Geom’ options), and click on the report button . In the 
report that opens you will see the center line geometric data with the IP 
coordinates data and arch data. To print this data, click on the printer 
button from the bottom of this window. The geometric data report can 
be placed on the drawing. To do so, first compute the report as detailed 
above, and perform the following steps: 

 

 Click on the 'Locate table on drawing' button  . 
 

 In the AutoCAD command ruler appears the labeling – ‘Locate table. 
Pick Location/Set/(Esc)nd:’. Mark the cursor in the location you want 
it to appear in the table. Mouse click to get the table’s borders frame. 
The borders will appear at a temporary layer that will be erased once 
you finish positioning the table. You may choose from a number of 
locations for your table, i.e. receive the frame an unlimited number of 
times, until it’s final location is set. After choosing the final location, 
click ‘S’ from the ‘AutoCAD’ line and ‘Enter’. The temporary borders 
will be erased and the table will be positioned at the location of your 
last choice.  

 
The table font size can also be changed. In order to make a change, 

click on the ‘Option' button  from the right window  . From the 
window that opens, choose the desired font size using the small arrow 
next to ‘Scale’ field. After choosing, click ‘OK’. To change the table on 
the drawing, you will have to go back and position it as explained at the 
top. 
  

 

Changing the Horizontal Alignment 
 
In section “Horizontal Alignment” from this chapter, we have shown many 
ways to define the Horizontal Alignment of an center line. During the 
course of the proceeding chapters, we have shown how, relying on this 
alignment, it is possible to base the vertical alignment and cross sections 
of a designed road. During the discussion, we have shown a case where a 
change of a certain IP location is needed. In this chapter we will expand 
the discussion on the topic of changing the Horizontal Alignment of the 
center line and its effects.  
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On the basis of this example, we will detail the order of commands that 
must be followed to change the Horizontal Alignment of a center line, and 
the affect of this alignment change: 
 
1. Changing the alignment – the Horizontal Alignment definition of the 

center line is performed, as aforesaid, from the Horizontal Alignment 
window. CivilCAD 2016 binds the IP list from the right hand table in the 
Horizontal Alignment window, to the IP list of the bottom window 
coordinates list (‘Designed coordinates’), by the points names. In case 
you change an IP coordinate in the ‘Designed coordinates’ list, and click 
‘Apply’  and ‘OK’, your center line alignment will change as well. If you 
change the name of a certain point from the ‘Designed coordinates’ list, 
‘CivilCAD 2016 will lose the connection to the point, and then the 
coordinates change of the same point will not affect the Horizontal 
Alignment. We have shown that there numerous systems to defining the 
Horizontal Alignment. We will now show how to change the Alignment 
using different methods: 

 
 Using ‘Select’ – at every choice of ‘Polyline’, the program creates an IP 

list according to its location. To change the alignment used by ‘Select’, 
start moving first, the base center line alignment (the center line on 
which you initially marked as ‘Select’), with the help of AutoCAD using 
the ‘Stretch’ functions, and choose ‘Select’ again. You can see that 
each time you choose ‘Select’, the program creates a new IP list with 
different names than the previous list, and adds the points to the 
‘Designed coordinates’ list. At this stage, to avoid confusion, you can 
physically change the previous points list from the ‘Designed 
coordinates’ list (to delete a point or a number of points, see chapter 2 
section 3 “Coordinates Database –command buttons  connected to the 
list”). 

 
 Using ‘Pick’, ‘Locate’, or manually entering points – in any case we 

have created the Horizontal Alignment of the center line, without the 
use of the ‘Select’ command, we will move its IP location or the entire 
alignment, by physically changing the coordinate point from the 
‘Designed coordinates’ list. Another method of graphically changing the 
point's coordinate is the ‘Move’ option as explained in section – 
“Horizontal Alignment”.   

 
  

2. Effects of the Horizontal Alignment on the Vertical Alignment– after 
changing the horizontal alignment, in order to get the new ground 
section, enter ‘Vertical Alignment’. The section that appears in the 
window, will remain identical to the previous section. Click on the ‘GetT’ 
button. The program will perform a re-sampling of the ground surface 
according to the new alignment. When you finish, click ‘Apply’ to get 
the new section drawing. 
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Note: It is possible that changing the Horizontal Alignment will 
change length of the Vertical Alignment. If there was already an 
existing design for Vertical Alignment, it will immediately appear on 
the new surface ground. However, there might be a case where the 
length of the designed section does not fit the existing Vertical 
Alignment, and here you must make changes as required.  
 

3. The effect of the Horizontal Alignment on Cross Sections – after 
changing the Horizontal Alignment, it is likely the length of the center 
line will be changed. When you enter the ‘Cross sections’ window, the 
program will compute the length of the new center line, and present it in 
– ‘Roads length’. In case there were (before the changing of the 
Horizontal Alignment), cross sections along the entire center line, after 
changing the length of the center line, they will no longer exist. We will 
separate between two cases : the length of the center line decreases 
relatively to its previous length, or increases. We will explain the 
required change in the cross sections using these two examples: 

 
 Example A: the decreasing center line length– let us say that before 

the change, the length of our center line was about – 215.32 meters, 
and we divided the center line to cross sections every 20 meters. The 
last two sections in the center line were therefore the station of 200 
meters and 215.32 meters. Now let us assume that after the change, 
the length of the center line has changed to – 187.32 meters. This 
distance will appear at ‘Roads length’, while in the list of sections the 
previous sections will appear, including these two sections. We will 
match between the length and the list of sections in the following 
manner: 

 Delete the sections at the distance of 200 
meters and 215.32 from the list of sections. 
Now the last section will be at a 180 meter 
distance. Move to the end of the list of 
sections and add a section 187.32 meters 
station.   
 

 Example B: the increasing center line length – let us say that before 
the change the length of the center line was 215.32, and we assume 
that it is divided every 20 meters to cross sections. Let us now assume 
that the length of the center line grew to – 240.56 meters. We will 
delete section 215.32 from the list of sections, and add these sections 
to the list: 220, 240, and 240.56. 

 
After we have adjusted the sections along the new center line, we will read 
the existing ground data again. Do this for all the sections, both new and 

old (as they changed their position). Click on the ‘GetT all’ button , and 
in the window that opens, click ‘OK’. The program will read the new 
existing status data into the sections. Complete the design of the new 
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sections you have created (you can do so by using ‘Copy’ and ‘Paste’ as 
shown in section “Cross Sections”). 

 
Note: After sampling the existing status G.L data, the program will 
compute again the dibblings and various stages of the sections segments, 
and fit the sections to the change in the surface of the existing ground. 
However, there are exceptional cases especially in side ditches, for which 
the program will not do this properly and the change will not be felt. In such 
cases, you will have to perform a new interpolation of the section. It is 

important to mention that the interpolation button , apart from doing 
interpolation to empty intermediate sections, moves and updates all 
existing cross sections.   

 

Changing the road's alignment after a full design 
 
CivilCAD allow you to change the route of the road's alignment 
(centerline alignment), either at the beginning, during or after, while 
maintaining the stations and the design of the cross sections which 
remain unchanged.  
 

Note: you can use CivilCAD sample project: 'Changing-Road-

Alignment'. 

In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Samples\Changing-Road-
Alignment.prj\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\ Samples\Changing-Road-
Alignment.prj\ 
 

You can also use CivilCAD2012 V1.0 Newsletter (paragraph 11). 
 
To use this feature: 

 From CivilCAD main menu, go to ‘RoadsHorizontal Alignment’. 

Note: changing the road's alignment can be done only by using 

CivilCAD Horizontal Alignment Tools (RoadsHorizontal Alignment 

Tools). 

 From CivilCAD main menu, go to ‘RoadsHorizontal Alignment Tools’ 

and select ‘Line_Line_Curve’ option. 

 

 



 

 

Page 267 of 508  
 
 

CivilCAD 2016 Reference manual 

 In AutoCAD Command Line you will be asked to select the ‘first’ line. 

Select the new geometry line. 

 In AutoCAD Command Line you will be asked to select the ‘second’ 

line. Select the line for extension. 

 In AutoCAD Command Line you will be asked to enter Cloto. In. Enter 

the desired datum and click ‘Enter’. 

 In AutoCAD Command Line you will be asked to enter Radius. Enter 

the desired datum and click ‘Enter’. 

 In AutoCAD Command Line you will be asked to enter Cloto. Out. 

Enter the desired datum and click ‘Enter’. 

 Repeat these steps for all segments if required. 

 From ‘RoadsHorizontal Alignment' menu, click the 'Change 

Alignment'  button. (If you are using the Sample Project – start 

from this stage) 

 In AutoCAD Command Line you will be asked to Select corrected 

segment. 

 Select the new Centerline from the drawing. CivilCAD will automatically 

recognize the centerline's segments and mark them with yellow 

arrows. 

Note: in case the first segment is not on the existing centerline, the 

following message window will appear: 

 

 

 

 

 

 

 Click the 'Yes' button and in the next message window click the 'OK' 

button to confirm the changes in the road's centerline. 



 

 

Page 268 of 508  
 
 

CivilCAD 2016 Reference manual 

 

 Click the 'Apply' button to build the road's centerline and update the 

alignment. 

 CivilCAD keeps the sections' names and stations up to the point of the 

geometry change and starting from the point where the change ends 

and creates intermediate sections along the new segment of the new 

centerline. 

Note: the distance between the intermediate sections will be based on 

the 'Distance between sections' definition. 

 From CivilCAD main menu, go to ‘RoadsVertical Alignment’. 

 Click the 'Apply' button. 

 CivilCAD keeps the sections' names and stations up to the point of the 

geometry change and starting from the point where the change ends 

and creates a new segment. 

Note: CivilCAD automatically adds -1 under 2T column to the line where 

the geometrical change starts. 

 Delete the -1 from the cell. 

 Draw a Polyline connecting the existing segments or enter the data 

manually in the 'Centerline Design' table. 

 Define the radius if necessary and click the 'Apply' button. 

 From CivilCAD main menu, go to ‘RoadsCross Sections'. 

 CivilCAD added intermediate sections with the letter A to the sections 

list. 

 Design the road in the sections which were added to the sections list 

and click the 'Create Layout'  button. 
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Note: for roads which are designed by 'Extract' – you can perform the 

Extract operation only on the added sections. 

 
Automatic junctions design 
 
CivilCAD enables designing junctions and display the junctions in the 
road's horizontal alignment and cross sections, including traffic islands. 

 

Note: At this stage, CivilCAD creates the junctions automatically. The 
user cannot define the junctions elements prior to the junctions creation. 
To use this feature (after full roads design): 

 

 From CivilCAD main menu, go to ‘RoadsVertical Alignment’. Vertical 

Alignment’ menu will open on the right side of the screen. 

 From the Roads List, select the road which will be the main road. 

 Define the centerlines elevation at the intersection point and click the 

'Apply' button. 

 In the opened window, click the 'Update All' button. 

 From CivilCAD main menu, go to: 'RoadsHorizontal Alignment'. 

 Click the 'Apply' button. 'Create Layout' window will open. 

 Checkmark the 'Create Junctions' option and click the 'OK' button. 

 
Note: CivilCAD will automatically create the junctions and update the 
roads layout, including the roads contours and cross sections. 

 

 From CivilCAD main menu, go to: 'JunctionsJunctions Definition'. 

'Junctions Definition' window will open on the right side of the screen. 

 
Note: It is possible to change the Start Station & End Station of the 
junction: 

 

 Under Range', define the Start Station in 'Start St.' cell and the End 

Station in 'End St.' cell or click the 'Pick' button and mark the Start & 

End stations on the centerline of the road which was defined as Main 

Road. 

 Click the 'OK' button. 
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 From CivilCAD main menu, go to: 'RoadsHorizontal Alignment'. 

 Click the 'Apply' button and then click the 'OK' button. 

 

In order to define Traffic Islands: 

 

 From CivilCAD main menu, go to: 'JunctionsJunctions Islands'. 

'Junctions Islands' menu will open on the right side of the screen. 

 

Note: CivilCAD will automatically identify the roads which creates the 
junction. 

 

 Click the 'New Island'  button. CivilCAD will add a traffic island to 

the 'Junctions Islands List'. 

 Click the 'Select' button and select the traffic island from the drawing 

(the traffic island must be a Polyline). 

 

Note: CivilCAD will automatically identify the number of points which 
creates the Polyline. 
 

 Click the 'OK' button to save the definitions. 

 From CivilCAD main menu, go to: 'RoadsHorizontal Alignment'. 

 Click the 'Apply' button and then click the 'OK' button. 
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Field of view planning 

 

 From CivilCAD main menu, go to ‘RoadsVisibility'. 'Visibility' window 
will open. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 For visibility report, click the 'Report'  button on the top left side of 
'Visibility' window. 

 In order to export the sections to DXF file, click the 'DXF'  button on 

the top left side of 'Visibility' window. 'Save to DXF' window will open. 

 Define From/To Station 

 Define the Steps (distance between sections) and click the 'OK' button. 

 Save the DXF file. 

Offset from the centerline 

centerline 
 

Driver's eye 
height 

Driving direction 

Obstacle height 

Delay between frames 
(seconds) 

Sections  List 
 

Road's name 
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Breaking distance test 
 

 From CivilCAD main menu, go to ‘RoadsVisibility'. 'Visibility' window 
will open. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 For breaking distance report, click the 'Report'  button on the top left 
side of 'Visibility' window. 

 In order to export the sections to DXF file, click the 'DXF'  button on 

the top left side of 'Visibility' window. 'Save to DXF' window will open. 

 Define From/To Station 

 Define the Steps (distance between sections) and click the 'OK' button. 

 Save the DXF file. 

 
 
 
 

Offset from Centerline 
 

Driver's eye height 

Driving Direction 

Sidewalk's height 

Road's name 

Cross Sections list 

Delay between steps (seconds) 
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Bridges Design 
 
It is possible to design bridges with CivilCAD and display the 

bridges in the road's vertical alignment and cross sections. 

stage, road's earthworks module does not take the At this  :Note

slopes cancelation in the bridge area under consideration. 

To use this feature (after full road design): 

 From CivilCAD main menu, go to ‘RoadsBridges/Tunnels’. 

'Bridges/Tunnels’ menu will open on the right side of the screen. 

 Define the bridge's name and under 'Bridge Name', double click in the 

'Type' cell and select the 'Bridge' option. 

 Click the ‘Pick’ button and mark with your mouse the start point and end 

point of the bridge (on the road's centerline) or type manually in 'From 

station' and 'To station'. 

 Define the bridge's width in each side of the road's centerline (under 

Offset) in 'Left/Right' cells. 

 Click the 'Apply' button to save the definitions and then click the 'Close' 

button. 

 Click the 'Create Layout'  button to update the road's horizontal 

alignment. 

 To erase a bridge, from CivilCAD main menu, go to: 

'RoadsBridges/Tunnels' and click the 'Erase Bridges/Tunnels'  

button. 

 Click 'OK' to confirm. 
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Tunnels Design  
 
It is possible to design tunnels with CivilCAD and display the tunnels 

in the road's vertical alignment and cross sections. 

At this stage, road's earthworks module does not take the  :Note

slopes cancelation in the tunnel area under consideration. 

To use this feature (after full road design): 

 From CivilCAD main menu, go to ‘RoadsBridges/Tunnels’. 

'Bridges/Tunnels’ menu will open on the right side of the screen. 

 Define the tunnel's name and under 'Bridge Name', double click in the 

'Type' cell and select the option 'Tunnel'. 

 Click the ‘Pick’ button and mark with your mouse the start point and end 

point of the Tunnel (on the road's centerline) or type manually in 'From 

station' and 'To station'. 

 Define the Tunnel's width in each side of the road's centerline (under 

Offset) in 'Left/Right' cells. 

 Click the 'Apply' button to save the definitions and then click the 'Close' 

button. 

 Click the 'Create Layout'  button to update the road's horizontal 

alignment. 

 To erase a tunnel, from CivilCAD main menu, go to: 

'RoadsBridges/Tunnels' and click the 'Erase Bridges/Tunnels'  

button. 

 Click 'OK' to confirm. 
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Design lots between roads 
 
CivilCAD enables designing lots between roads, with inverted 

slopes, in order to avoid duplication of earthworks volumes between 

the roads and the lots. 

To use this feature: 

 From CivilCAD main menu, go to ‘RoadsRoads Lots'. 'Roads Lots' 

menu will open on the right side of the screen. 

 Click the 'Filter Roads Lots from Drawing'  button'. 'Roads Lots' 

menu will change to 'Filtering' menu. 

 Click the 'Select' button, mark the desired lot in the drawing and hit the 

'ENTER' button. 

 Click the 'Apply' button. A message window will appear with the number 

of lots which were found by CivilCAD. 

 Click the 'OK' button. 'Filtering' menu will change back to 'Roads Lots' 

menu, with a list of the lots. 

 In case of lots with rounded corners, define the radius division to 

segments (meters) in 'Steps (m)' cell. 

 Click the 'Apply' button. 

 From CivilCAD main menu, go to: 'RoadsHorizontal Alignment'. 

 Click the 'Apply' button and then click the 'OK' button. CivilCAD will build 

the lots between the roads. 

 From CivilCAD main menu, go to: 'RoadsCross Sections'. CivilCAD 

will display the lots in the cross sections. 
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Culverts Design 
 

This module is ment to suggest the optimized location, size and 

shape of road's culverts. To use this Module: 

 From CivilCAD main menu, go to: 'RoadsCulverts'. 'Culverts' menu 

will open. 

 

 
 

 
 

 
 

 
 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

 
 Click the 'Apply' button. 

 A list of suggested culverts with its size and shape will be displayed, 

including station, runoff coefficients in mm/hour and rain frequency in 

minute/year will be displayed. 
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The area of the water shed and the streambeds are  :Note

determined according to the existing G.L. surface. The larger 

existing G.L. area will be – the more accurate culverts location will 

be computed. 
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:Notes 

 
 If 'Compute Rainfall (i)' option is check marked, the software will 

calculate the amount of rain in mm per hour according to the period of 

time, which is specified under t(min) column. The calculation is made 

by a built-in algorithm. In case the algorithm is not suitable for a 

particular country, the user should un-check the V mark, and enter 

data manually under i(mm/hr) column, and press 'Enter' button after 

entering any data. 

 

 The user has the option to change the culverts station, runoff 

coefficients and storm frequency. After changing the data, click the 

'Apply' button and then click the 'Update Culverts' button  in order to 

update the suggested culverts. 

Rain frequency in 
yeas. '10' 
represents the 
number of years 

Runoff Coefficients – 
the amount of rain 
which will be drained 
to the culvert 

The amount of rain in 
mm/hr according to 
the time period 
mentioned under 

t(min) column 

Suggested size 
and shape of 
culverts 
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Chapter 15: Retaining walls 
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Designing retaining walls 
 
The retaining wall design module is exclusive to the CivilCAD 2016 
program. It offers the user a comprehensive retaining wall design facility, 
both for walls that support roads and for free standing walls. It should be 
noted that the module deals with the various design features, but not with 
wall stability and structure. 
 
This chapter deals with the steps involved in retaining wall design: 

 Walls list. 
 Horizontal alignment. 
 Vertical Alignment. 
 Wall dimension. 
 Report generation. 

 
All the steps involved in carrying out retaining walls design are within the 
scope of the 'Walls' menu. The design options are available only when 
working with AutoCAD/IntelliCAD, and are not available on a Stand-Alone 
basis. 
 

 

Designing retaining walls Attached to road (Format 1) 

 
Creating the walls list 
 
The first design step is identifying each wall by naming it and by 
determining if it is part of one of the roads comprising the project.  
 

1. In the main menu box click 'Walls -> Walls List'. This opens the 
Walls List dialogue box. 

2. Enter the name of each wall that is to be designed in the Wall name 
column. 

3. To the right of the name chosen, select the road the wall supports 
(or supports its surrounds) in the Attach road cell. 

4. If a road has been selected in the previous step, select Left or Right 
(according to side of the road it supports) in the Side cell. 

 
Repeat steps 1 to 4 for each wall. There is no limit on the number of walls. 
At the end of each iteration, click Close to exit. 
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Horizontal Alignment  
 
After defining the walls, proceed to specifying their horizontal alignments 
 

1. Whilst in AutoCAD (or IntelliCAD), specify the line of wall by a 
uniform Polyline extending the whole length of the wall. The 
Polyline can have both straight and curved elements. It is 
recommended that the Polyline be drawn as a separate layer, at 
your discretion. 

2. In the main menu, select Walls > Horizontal alignment, which 
will open the Horizontal Alignment box, on the right. 

3. Select the wall to be aligned from the list displayed. 
4. Click Select, switch to drafting and select the appropriate 

Polyline. Press 'Enter', and the wall’s list of IP points, including 
radiuses, will appear on the right. 

5. Press Apply. The draft will show the line’s geometric data. 
 
 
An automatic feature is available for defining a wall that runs parallel 
to the road's centerline. 
 
This will define a wall running the length of the road, thereby obviating the 
need to draw the wall separately.  

1. Select the appropriate wall from the list displayed. 

2. Click the  button    Create wall at offset from CL. In the 
box, enter the offset distance and click 'OK'. The program will 
provide a wall at the appropriate offset. 

3. Click 'Apply' to view the line of the aforementioned wall. 
 
Additional options in the Horizontal Alignment window 
 

 Clear all IPs – deletes all IPs from the list. 

 Erase current IP – deletes only the current IP. 

 Walls options -  this window features capping the distance for 
generating changes arising out of changes in the road cross section, for a 
road attached wall, using the 'Wall range' facility. If the distance between 
the wall and the road center for a specific cross-section is above the range 
entered, the program will not display the wall for that cross-section. 
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Vertical Alignment   
 
 
The following procedure defines the longitudinal cross-section of the wall. 
 
1. Click Walls > Vertical alignment in the main menu to obtain the 

window for designing the longitudinal cross-section. The upper part of 
the window shows the cross-section, and the lower part contains two 
tables. The left hand table is for topographical data and the right hand 
table is for wall data. The topographical data table has three sub-tables 
each of which can be accessed independently by clicking it in the list 
above the table 

 Existing - for the existing ground level. 
 Design – for the required ground data (e.g. open areas). 
 Road level – if the wall is supporting a road in the project, the table will 

show the elevation of the road from the beginning to the end of the road 
in question. 

2. Click on the required wall in the list at the top right of the window. 
3. Clicking on the Apply button will automatically enter the topographical 

data in the table on the lower left – the existing ground data and, for a 
road supporting wall, and the elevation of the road at the centerline of 
the wall. 

4. Two options are provided for laying out the wall 
1. Entering the data in the Wall data table. 
 

 Station - wall length 
 Top Elev. - the height of the top of the wall 
 Base Elev.  - the height at the bottom of the wall 
 Drop in base – an additional (stepped) reduction in elevation; 

this feature provides for reducing the slope of the road base 
should this be excessively steep. 

2. Setting initial criteria, using the  button, which opens the 
Walls – Init options window.  
Enter the following data for dig and fill. 
 

  Min. height [h] – the program will create a retaining wall at 
locations where the height difference between the 
existing/planned height and that of the road is above the value 
entered 

 Min. dist – the value of this parameter will determine the depth 
of the base of the wall according to its horizontal distance to the 
ground surface. This value is the horizontal distance of the base 
of the wall from the edge of the existing ground (and will also 
automatically deepen the wall base if this horizontal distance is 
insufficient). 
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  Pop - this sets the height distance of the wall above the planned 
or existing ground, or the planned road, in accordance with the 
ground to be supported. 

  Base depth  - this sets the depth of the wall base, and can be 
specified by a formula which takes the wall’s height into account, 
e.g. the default setting is  according to the formula 

H*O.15 + 0.4 . 
 Max.  base slope[%] – the maximum slope of  the wall base. 
 Max. drop in base. 
 Min.  drop in base. 
  

Once the initial values have been set, they can be altered manually by 
keying in the appropriate values in the table. When the data have been 
entered, click on the Apply button. The program will display the drawing 
and the data table. If the wall is supporting a road in the project, the bottom 
line in the data table displays the names of the road sections in question 
opposite the rubric No. (The distance at which these names are shown is 
that measured on the wall C.L). If the wall ends before a given cross-
section of the road, the display will show the name of the previous section, 
and the suffix “1”. (For example, if the name of the last section that the wall 
impinges on is 14, the display will be 14.1).  
Sharp non-curved changes of the wall’s horizontal direction will be flagged 
on the drawing, and show the angle of turn. 
 
 
Additional options in this window 
   

  Topographical data + ground as planned + road height. 
When this button is clicked, the program will transfer the 
topographical data at the bottom left to the display. (If the wall is 
attached to a road in the project, opening the Road level list can 
fetch its data). This feature will be activated if one of the tables 
has been accidentally deleted and is to be restored. When the 
window is first opened, clicking Apply will restore the data. 
 

 Transferring the section to .DXF files – after clicking this 
button, insert the scale required, click OK and select the file 
name, including its path. Click OK. 

 

 Deleting data from tables – after clicking the button, select the 
name of the table to be deleted and click OK. 

 

 Update design to cross section land dev. – for the insertion 
of retaining wall heights to road cross-sections (if the wall is 
attached to a road in the project). After clicking, transfer to the 
Cross-sections window by selecting the Roads > Cross 
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sections menu, and transfer the appropriate table from the 
bottom of the screen. Note that the wall heights have been 
entered in the table for all cross-sections along the road. 

 Land development data extracts distances and elevation, from 
the drawing, employing the procedure set out below: 

1 Clicking on the button displays a small window above the 
window of the drawing. 

2. To select a particular distance, click on Pick in the small 
window, transfer to the drawing, and click at the point on the 
line the data of which are required. The program will display 
the point’s distance in the Station cell. 
3. One or two heights can be entered at the point in question, 
by inserting in the cells Elevation 1 and Elevation 2 
respectively, and clicking OK. 
4. Repeat as required, and to exit click Cancel. 

             5. The heights and distances abstracted will be shown 
in Design in the left hand table. 
  6. Click Apply to update the drawing with the data selected. 
 

Cross Section Display Range affords a view of the cross-section 
over a given range. Set the initial distance at From and the end 
distance at To, and click Apply. 

 

 

Wall dimensions (Cross section) 
 
 

After determining the wall’s vertical alignment, the next step is 
prescribing its dimensions. If a particular configuration is to be 
repeated, the program allows for creating types of wall. 
The steps to be carried out are set out below. 
1. Click Wall > Dimensions in the main menu to obtain the 

dimension definition window. 
2. Select the subject wall from the list at the top right. 
3. If the wall is to be divided into sections (having different 

dimensions), enter the station for each section in the upper right 
of the window. Alternatively, to select the distance by position, 
click on Pick underneath the table, to and mark the section or 
sections to be added to the table. 
If the wall is to have unitary dimensions, ignore step 3, and the 
table will have only one row. 

4. The window shows the drawing and the dimensional standards 
for a retaining wall. 
It also shows the sections and the slopes specified in the data 

tables. 
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Enter the required dimensions in the table and click Apply at the 
right of the screen. The drawing will show the wall dimensions as 
specified. To view the aforementioned standard wall, click on 

. (A second click will redisplay the dimensions specified. 
 
Entering formula generated specifications 
 
The program offers the choice of keying the absolute values of 
the dimensions or by formula*, related to the wall height [h] (with 
the height being supplied by the program) or based on other 
data** in the program. 
For example, h/4+0.20 can be specified in field B, and 2*B in 
field C, i.e. B is height relative, and C is governed by B. 
All five available fields may be utilized (a,b,c,d,e). 
* It is advisable to check that no mutually dependent formula has 
been employed. 
**Formula calculations operate from left to right, and all 
mathematical calculations should be specified bearing this in 
mind. 

5. Should the wall have been divided into sections, repeat the 
foregoing for each section in the table by clicking on the section 
in the table and entering the data. 

6. When data entry is complete, click Close. If required, return to 
the cross-section to view the wall. If the wall supports a road in 
the project, the program automatically updates the cross-
sections of the road with the specifications of the wall. 

7. To display a wall in Quick Section: 
 From CivilCAD main menu, go to ‘RoadsHorizontal 
Alignment’. 

 Click the ‘Apply’ button. ‘Layout and Contours’ window will 
open. 

 Make sure that ‘Triangles’ option is checked and click ‘OK’. 
 From CivilCAD main menu, go to ‘DesignSection’. 
 Select ‘Pick’ option and create a line on drawing which 
represent the quick section. 

 Click ‘Apply’ button. ‘Section’ window will open and the wall 
will be displayed in the section’s drawing. 

 
 

Additional options in this window  
 

 Transfer the wall dimension drawing to the .DXF file - after 
clicking this button, insert the scale required, click OK and select 
the place and the file name. 

 Zoom Extents clicking on this buttons shows the drawing in full. 
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Designing free standing retaining walls (Format 2) 
 

Creating the walls list 
 
The first design step is identifying each wall by naming it and by 
determining it as a free standing wall.  
 

1. In the main menu box click 'Walls -> Walls List'. This opens the 
Walls List dialogue box. 

2. Define wall format as ‘Format 2’. 
3. Enter the name of each wall that is to be designed in the Wall name 

column. 
4. Enter a wall prefix.  
5. Enter the desired starting point number. 

 
Repeat steps 1 to 6 for each wall. There is no limit on the number of walls. 
At the end of each iteration, click Close to exit. 
 

Horizontal Alignment  
 
After defining the walls, proceed to specifying their horizontal alignments 
 

1. Whilst in AutoCAD (or IntelliCAD), specify the line of wall by a 
uniform Polyline extending the whole length of the wall. The 
Polyline can have both straight and curved elements. It is 
recommended that the Polyline be drawn as a separate layer, at 
your discretion. 

2. In the main menu, select Walls > Horizontal alignment, which 
will open the Horizontal Alignment box, on the right. 

3. Select the wall to be aligned from the list displayed. 
4. Click Select, switch to drafting and select the appropriate 

Polyline. Press 'Enter', and the wall’s list of IP points, including 
radiuses, will appear on the right. 

5. Press Apply. The draft will show the line’s geometric data. 
6. From AutoCAD (or IntelliCAD) main menu, click Insert menu 

and select Block. 
7. Select the ‘USER_WDLEVEL’ block.  

 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Road Blocks\ 
 
In Windows Vista or Windows 7/8/10 OS the default location 
is: 
C:\ProgramData\SivanDesign\CivilCAD\Road Blocks\ 

 
8. Attach the block to the wall’s first IP on drawing. 
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9. In AutoCAD (or IntelliCAD) command line, type the desired 
datum defining the wall’s data for the specific IP according to the 
diagram below: 

 
 

A. LEVEL 1 (Wall) 
B. DLEVEL 1 (Back Design GL) 
C. LEVEL 2 (Wall) 
D. DLEVEL 2 (Back Design GL) 
E. DFLEVEL 1 (Front Design GL) 
F. DFLEVEL 2 (Front Design GL) 
 
10. Press Apply. The drawing will be updated according to wall’s 

definition. 
11. Repeat steps 6 – 10 for each wall’s IP. 

 
Additional options in the Horizontal Alignment window 
 

 Clear all IPs – deletes all IPs from the list. 

 Erase current IP – deletes only the current IP. 

 Walls option - In this window you can define CivilCAD to add wall 
prefix to wall’s IP’s automatically. 
 

 
 

Design  

GL 
F D 

C 

A 

B E 



 

 

Page 288 of 508  
 
 

CivilCAD 2016 Reference manual 

Vertical Alignment   
 
 
The following procedure defines the longitudinal cross-section of the wall. 
 
1. Click WallsVertical alignment in the main menu to obtain the 

window for designing the longitudinal cross-section. The upper part of 
the window shows the cross-section, and the lower part contains two 
tables. The left hand table is for topographical data and the right hand 
table is for wall data. The topographical data table has three sub-tables 
each of which can be accessed independently by clicking it in the list 
above the table 

 Existing - for the existing ground level. 
 Front G.L. – for the front designed ground data according to IP 

numbering. 
 Back G.L. – for the back designed ground data according to IP 

numbering. 
2. Click on the required wall in the list at the top right of the window. 
3. Clicking on the Apply button will automatically enter the topographical 

data in the table on the lower left – the existing ground data. 
4. Two options are provided for laying out the wall 

 
1. Entering the data in the Wall data table. 
 

 Station - wall length 
 Top Elev. - the height of the top of the wall 
 Base Elev.  - the height at the bottom of the wall 

The base elevation must be defined. Otherwise the report will 
not be performed. 

 Drop in base – an additional (stepped) reduction in elevation; 
this feature provides for reducing the slope of the road base 
should this be excessively steep. 

2. Setting initial criteria, using the  button, which opens the 
Walls – Init options window.  
Enter the following data for dig and fill. 
 

 Length – the wall’s length in meters will be automatically filled in 
that cell. 

 Dist – the value of this parameter will determine the distance 
between steps.  

 Delta Height - the value of this parameter will determine the 
step height.  

 Start Height - the value of this parameter will determine the 
wall’s start height. 

Once the initial values have been set, they can be altered manually by 
keying in the appropriate values in the table. When the data have been 
entered, click on the Apply button. The program will display the drawing 
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and the data table. (The distance at which these names are shown is that 
measured on the wall C.L). 
 
 
Additional options in this window 
   

  Topographical data + Designed ground data height. 
When this button is clicked, the program will transfer the 
topographical data at the bottom left to the display. For 
Back\Front designed data, change the bottom left dialog box to 
the relevant window, click ‘Get data from general project’ button 
and click ‘OK’. Click Apply to update drawing and restore data. 
 

 Transferring the section to .DXF files – after clicking this 
button, insert the scale required, click OK and select the file 
name, including its path. Click OK. 

 

 Deleting data from tables – after clicking the button, select the 
name of the table to be deleted and click OK. 

 

 Land development data extracts distances and elevation, from 
the drawing, employing the procedure set out below: 

1 Clicking on the button displays a small window above the 
window of the drawing. 
2. To select a particular distance, click on Pick in the small 
window, transfer to the drawing, and click at the point on the 
line the data of which are required. The program will display 
the point’s distance in the Station cell. 
3. One or two heights can be entered at the point in question, 
by inserting in the cells Elevation 1 and Elevation 2 
respectively, and clicking OK. 
4. Repeat as required, and to exit click Cancel. 
5. The heights and distances abstracted will be shown in 
Design in the left hand table. 

  6. Click Apply to update the drawing with the data selected. 
 

Cross Section Display Range affords a view of the cross-
section over a given range. Set the initial distance at From 
and the end distance at To, and click Apply. 
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Wall dimensions (Cross section) 
 
 

After determining the wall’s vertical alignment, the next step is 
prescribing its dimensions. If a particular configuration is to be 
repeated, the program allows for creating types of wall. 
The steps to be carried out are set out below. 
1. Click WallsDimensions in the main menu to obtain the 

dimension definition window. 
2. Select the subject wall from the list at the top right. 
3. If the wall is to be divided into sections (having different 

dimensions), enter the station for each section in the upper right 
of the window. Alternatively, to select the distance by position, 
click on Pick underneath the table, to and mark the section or 
sections to be added to the table. 
If the wall is to have unitary dimensions, ignore step 3, and the 
table will have only one row. 

4. The window shows the drawing and the dimensional standards 
for a retaining wall. 
It also shows the sections and the slopes specified in the data 
tables. 

Enter the required dimensions in the table and click Apply at the 
right of the screen. The drawing will show the wall dimensions as 
specified. To view the aforementioned standard wall, click on 

. (A second click will redisplay the dimensions specified. 
 

Additional options in this window 
 

 - Zoom Extents. clicking on this buttons shows the drawing in 
full. 

 

 - Enter the required dimensions in the table and click Apply at 
the right of the screen. The drawing will show the wall dimensions 

as specified. To view the aforementioned standard wall, click on . 
(A second click will redisplay the dimensions specified. 

 

 Transfer the wall dimensions to .DXF files – after clicking this 
button, insert the scale required, click OK and select the file 
name, including its path. Click OK. 
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Report generation 
 
 
After the definition process has been completed, a quantities report is 
available. This gives the area and volume of the wall in each cross-section 
(according to the distance markers in the horizontal alignment).  To 
generate the report: 

 In the menu, select Walls > Quantities, this opens a window on the 
right. 

 From the wall list at the top of the window, select the appropriate 
wall. 

 Click Apply to show the report. 
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Chapter 16: Extract and 
urban design 
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Extract and urban design 
 
This chapter will deal with the ‘Extract’ option - used mainly for roads 
urban design. This feature is optional only for IntelliCAD/AutoCAD users. 
Using this tool, you can automatically design a road’s cross-sections in just 
a few easy steps. This command is based on the definition of a typical 
section and sampling of the road structure from the layout itself. In the 
design of a typical road using cross sections, we have performed the 
opposite, i.e., after defining the cross sections the program created the 
layout on the drawing.  
 
In this chapter we will show a step by step of all the fundamentals of urban 
roads design: 
 

 Preparing the background. 
 Defining the project centerlines.  
 Creating the cross sections using Extract. 
 Saving and reading typical cross sections from a ‘Tml’ file. 
 Functions from the Extract window. 

 

 

Preparing the work background 
 
In the project preliminary background preparation stage, a drawing will be 
created in AutoCAD containing the road structure drawing and 
measurement of the existing status. The existing status can also be 
defined by ‘Reg’ and ‘Dis’ files and it is not obligatory to define it on the 
drawing. In addition, it is possible to begin a new project without a pre-
defined background, and import or draw the lines that describe the road 
structure after the project has begun. These lines should be drawn in 
separate designated layers. It is also best to define new layers (their 
names have no meaning) that will contain only the lines describing the 
road structure. We will define the horizontal alignment and the lines 
showing the road structure on the drawing, for example: 
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1. Open a new project (‘File-> New Project’) and name your project. 
2. * For AutoCAD users only: 

 From AutoCAD menu open ‘File -> Open’. 
 In the files window that opens choose the ‘Dwg’ file as work 

background and open it 
 From the CivilCAD 2016 menu open ‘File -> Save’. The program 

will create a copy of the original ‘Dwg’ file you have chosen in your 
project library (later on this file will receive a name similar to the 
project name in CivilCAD 2016 with the addition of the character ‘_’). 

 * Users of AutoCAD - are users that work with CivilCAD 2016 and 
AutoCAD combined, as opposed to ‘Stand-alone’. 
 

The principle of working with CivilCAD 2016 is a 3D-model. On the basis of 
this model the software performs activities such as exporting sections, 
quantities computation etc. In order to create this model, the program must 
have a coordinates file. If you have a coordinates file in an ordinary (ASCII) 
text format, skip to number 5 in this section. 
As aforesaid, the program requires a coordinates file. If this file does not 
exit, the program can create it from the Dwg drawing file under the 
following conditions: 
 
3. * For AutoCAD users only:  

 Go to ‘General -> Filtering’. A window will open from the right. 
The principle of creating a coordinates file from the drawing is the 
*‘Filtering’ of a layer (an AutoCAD layer) - containing the points or 
contour lines. First, locate the desired layer in AutoCAD. This layer 
must have ‘Z’ dimension in AutoCAD. 

 
* For more on ‘Filtering’ see Chapter 23 – “Handling DWG Files”.  
 
The right window in divided into 2 sections. In the top section appears a list 
of the drawing layers and at the bottom a list of ‘Entities’. 
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 Mark the desired layer for filtering 
 Choose the desired entity type for filtering 

 
We will explain how to determine the desired entity type. First check if the 
drawing has a measured points layer. If this layer does not exist, filter the 
contour lines layer instead (assuming it exists). After locating the 
layer/layers of the measured points, check the entity type. As a rule, it is 
better to filter blocks, by filtering the layers that have blocks. If the drawing 
does not have blocks, check if there are points entities in the drawing and if 
they have ‘Z’ dimension – filter them. In a lower priority you can also filter 
the text entities, taking into account that it is possible that the location of 
the text is a little different from the location of the measured point itself.  
If the text height is ‘0’ and the height is mentioned in the text, it is possible 
to set the height according to lettering in the text using ‘Options’. See 
Chapter 23 - Handling DWG Files section– ‘Setting Height in the Status 
Window’.  
 
If the file does not have measured heights (measured points), go to a lower 
priority option of filtering contour lines. To do so check if the contour lines 
are ‘lines’ or ‘polylines’ and if they have ‘Z’ height.  

 Click on ‘Apply’ in the right window. The program will begin 
filtering the selected layer according to type of entity selected. 
When this is finished,  

the filtered coordinates list will appear at the bottom window 
(‘Topography coordinates’). 

 Click on the  button right of the drawing. The program will 
create *new points layers on the drawing.  
 

* CivilCAD 2016 creates its own points layer. This layer will come in 
addition an     
   existing layer.  

 
 

4. For AutoCAD users only:  
 
It is possible that in the measurement file in addition to points - there are 
breaklines. The issue of breaklines has a separate section in the chapter 
‘Creating Contour Lines’ and so we will not expand the discussion here. If 
there are such lines, they are an inseparable part of the measurement file 
and must undergo an additional filtering process (in case you do not know 
if there are breaklines in the drawing, skip to the next section). 
 

 Go to ‘Topography -> Lines’. 

 Click on ‘Filter breaklines’ button . 
 From the ‘Filter breaklines’ window click on select, move you 

cursor to the drawing and click on a line from the layer of lines, 
or mark the layer and line type in the lists from the window.  
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 Click ‘Apply’. A new message will appear. Clicking ‘Yes’ will 
create the breaklines alone without the addition of points to the 
existing points list. Clicking on ‘No’ will create the breaklines in 
addition to adding the ‘Vertex’ points of the breaklines to the list 
of existing points.  

 
Note: in most cases there is no need to add the vertex to the list as these 
points already appear there. Consequentially, only if you are sure you want 
to add the vertex, click ‘No’, and in any other case click ‘Yes’.  
 

 After the confirmation the message, the breaklines will be 
filtered and added to the project.  

 
If you followed the ‘filtering’ command and the bottom points list 
‘Topography coordinates’ is filled, skip to 7 from this section. 
 
5. Receipt of existing status coordinates file: 

 In the bottom window, click on   button  (‘Load from text file’) 
and choose the desired coordinates file. After choosing the file, 
the list of points will appear in the bottom window. 

 Click on  button right of the drawing. The program will create 
a drawing layer of the points from list.  

 
To realize this explanation, we will use an existing coordinates file that is 
installed with the program. To do so open (according to the explanation in 
the paragraph above) ‘Sample7.Tco’  
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Samples\Sample7\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Samples\Sample7\ 
 
If you do not have a breaklines file skip to 7.  
 
6. Receipt of breaklines file: 
 

 From the main menu ruler activate: ‘Topography -> Lines’. A 
window will open from the right.  

 Click on button  (‘Load from text file’) from this window. 
The files window will open and the files you will be asked to 
choose will be ‘Dis’ files only (the ‘Filter’ for the files types will 
be *.Dis). 
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 Choose the breaklines file. The file will be loaded and the 
breaklines list will appear in the right window. The program 
will create a drawing layer of the breaklines. 

 
For more information on breaklines see Chapter 5 – ‘Lines 
Connections’ 
 
7. Creating contour lines: 
 
The last phase in creating existing status is creating contour lines. Even if 
you have a Dwg file that already has contour lines, you will still have to 
follow this step, given that at the contour lines creation phase, the program 
also creates the 3-D model on which it is based. This model is not visible to 
the user (even though it is possible to view), but it is important for the 
working procedure.  
  

 From the main tool-bar open - ‘Topography -> Contours’. A 
window will open from the right.  

 In the right window define the vertical interval between the 
contour lines. To do so erase the word ‘Default’ to the right of 
‘Intervals’, and enter the desired interval in meters (for 
example:1).  

 Click ‘Apply’. The program will begin to create contour lines. It 
is possible that the program will locate a certain problem in the 
point's file that will prevent the structure of lines. If the problem 
is relatively easy to solve, an error message will appear. A 
detailing of the problems will appear in the ‘Log’ file (which can 
be opened using a simple editor). Since we do not wish to get 
into the details of constructing contour lines, confirm the error 
message, and the program will continue to work as usual.  

 
The process of creating contour lines is a function of the number of points 
in a project and the number of breaklines (if there are any). In some cases 
the program will work for a long time, and you must wait patiently until the 
procedure is over.   
Once this is over, the program will have created proper drawing layers in 
which the contour lines will appear. If these layers do not appear, then this 
problem cannot be solved automatically and you will have to process the 
point’s file (on the creation of contour lines and their process see separate 
chapter).  
 
Now we will check the means for standardization testing and the 3-D 
model: 



 

 

Page 298 of 508  
 
 

CivilCAD 2016 Reference manual 

 
8. Locating an elevation at a particular point: 
 

 For AutoCAD users – click the button ‘Pick Height’  (under 
the AutoCAD window). Move with your mouse to the drawing 
and position the curser in the vicinity of the contour lines. Click 
with your mouse. The elevation of the point you are at will 
appear under the drawing, next to ‘H(T) and ‘H(D)’.  

 For Standalone version, move with your mouse to the drawing 
and position the cursor in the contour lines area. Click with your 
mouse. The elevation of the point you are at will appear under 
the drawing, next to the heading ‘H(T) and ‘H(D)’.  
 

This tool for locating elevation is the most convenient index for the 
existence and the standardization of the 3D model. H(T) is the existing 
status elevation, and H(D) is the designed elevation. In the absence of 
design, both these elevations will be the equal.    

 
 

Defining the project centerlines  
 
After you have finished preparing the work background (existing status), 
you can begin the design. In this part of the chapter you will learn how 
CivilCAD 2016 arranges the relevant centerlines for the current project. 
 

 From the main tool-bar open ‘Roads -> Roads list’. A window 
will open from the right containing the project centerlines. In 
case the centerlines definition is missing, CivilCAD 2016 will 
automatically open the centerline ‘Road1’. Once you have 
entered the centerlines list, (current screen), this centerline will 
be erased and the list will be empty.  

 In the table from the right enter the list of centerlines in the 
current project. Every centerline in the project must receive a 
name. The name can be alpha-numeric or a number. The 
centerline’s names are not important and are for the sole 
purpose of organizing the material. After each centerline name, 
click ‘Enter’. 

 Once you finish typing the list - click ‘Close’. 
  
To realize the example, enter a single centerline and label it 
‘Road1’. 

 
At the head of each window that appears during the Roads Design stages 
(defining the horizontal alignment, vertical alignment design etc.) – will 
appear the road that is at work. If there are a few centerlines in the project, 
you can always browse between them using the small arrow that appears 
near the name of the road. 
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Note: as opposed to typical cross section, the urban road width is variable. 
Therefore, attribution of different layers to each structure segment is 
needed in order to create a road layout according to structure layers.   
 
After defining the centerline names, define the horizontal alignment as 
explained in Chapter ‘Roads Design - Horizontal Alignment’. Following, 
define the vertical alignment as explained in chapter ‘Roads Design - 
Vertical Alignment’.     
 

 

Creating the cross sections using Extract 
 
Having defined existing status and the centerlines in the project, we will 
proceed with the design of cross-sections. Following is a step-by-step of 
this automatic process using ‘Extract’. 
 

1. Enter the ‘Extract’ screen from the CivilCAD 2016 menu and 
open –‘Roads> Extract’. The right side window that contains the 
centerlines list, the list of segments for each centerline, and the 
layers list and activations buttons, will open. At the left window side, 
there is a screen that introduces the typical section, and 
underneath it the structure height tables and Earthworks elevation 
Designed G.L. of the typical section. Notice that the screen 
structure is similar to the typical cross sections window.  

 
2. Choosing a centerline – choose from the list at the top of the 

screen (next to ‘Road’), the centerline for cross section design.  
 

3.  Defining segments – in a certain situation you might want to use 
more than one typical section per one cross section design. In such 
a case, define the segments for each section type in the sections 
list, at the top of the window. In this table every row represents a 
segment in which the starting and final distance for every segment 
can be entered (under the heading ‘To ST’ and ‘From ST’. In order 
to add rows to the segments table, stand on the row before the row 
you wish to add and click ‘Enter’. If you wish to define a single 
typical section along the entire center-line, enter one row only in the 
segments list and enter ‘0’ under the heading ‘From ST’, and the 
general distance (next to ‘Road’s length’), under ‘ToST’. A more 
convenient way would be to mark the segments on the drawing. 
Click on ‘Pick’ (right window), move to the drawing area and click 
on the centerline at the desired points. After using ‘Pick’, the 
segments table will automatically fill with the desired distances. 

 
4. Attributing structure layers to structure segments – For each 

segment in ‘Structure’ table, double click in ‘Layer’ cell and select 
the relevant layer. 
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5. Defining the typical section – similar to cross section design, it is 

possible to create a typical section by entering the data in the 
‘Design’ and ‘Structure’ tables at the bottom of the screen. In 
addition to this option, it is possible to import a Template Section 
(*.Tml) from the list of sections saved in the system (later on we will 
also show how to save the typical sections created in the system). 
If the designed road includes, for example, sections with medians 
and sections without medians, we will define the typical section 
differently for both these segments.  

 
6. Erasing segments from the table – in order to erase a certain row 

from a segments table, mark the row you wish to delete and click 

. It is possible to delete the entire table by clicking on . 
 

Defining the section: enter the road structure data in a table under 
‘Typical Structure’. Enter the designed data in a table under 
‘Typical Design’ (notice that the section structure is supposed to 
reflect the structure according to the layout already drawn on the 
centerline. The program will change the distances in the section 
automatically). After filling the data, click O.K to update the section 
drawing. Observe the samples below: 
 
Sample 1: data for bi-directional typical section with sidewalk 
and no median 

Enter the desired segment (from which we will feed the 
typical section data), from the right window and type… 

 
 

Typical Structure Table 
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Typical Design Table  
 

 
 
Note: the length of each segment (2 meter, 1.23 meter etc.) will 
change according to the layout section width) 

 
In case the designed road is built from median segments and 
without median, you will need to make a change in sample 1 
entered here as sample 1, so that there will be a match between the 
asphalt segments of the median sections and the sections without 
the median. In this case sample 1 will look like so (the Designed 
G.L. will remain unchanged) 

 
Typical Structure Table 

 

 
 
Add 2 empty segments to each side by marking segment 1 or -1 
and clicking ‘Enter’ button. 
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Sample 2: Data for bi-directional section with sidewalk and 
median  

 
Typical Structure Table  
 

 
 
Define median offset and slope as mentioned in typical structure table. 

 
 

Typical Design Table 
 

 
 
7. Go to the next segment from the segment list defined from the right 

and define the second typical section. Continue this way so all the 
sections are filled (it is possible to use ‘Copy’ and ‘Paste’ buttons 
from the window on the right, in order to copy the typical sections 
from one segment to another). 

 

8. Set the definitions for the division of sections – click on the  
button, and set the definitions from the window that opens 
according to the explanation below: 

 
  ‘Get structure and designed G.L. only each step’ – when 

the option is marked, the software will fill the cross sections in 
the design only according to division of steps, and will not 
consider the break points on the layout lines. 

 Get existing G.L. only each step’ – when this option is 
marked, the program will fill the existing status cross sections 
only according to the division of steps, and will not consider 
the break points on the layout lines.  

 ‘Resolution (m)’ - maximum distance to create intermediate 
sections. For example: if the value 2 is typed, the software 
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will not create intermediate sections that the distance 
between them is shorter than 2 meters. 

 ‘Sections width’ - a positive value should be typed to the 
width of the right side of the section from the center and a 
negative value to the left side of the section from the center. 

In order to determine the distance between the sections 

and the name of the first section, click on button , in 
the opened window, establish the following definitions and 
click OK when finished. 
 

 ‘Format 1’ – this option displays the names of the sections 
by numbers.  

 ‘Format 2’ – by changing the parameters that appear at the 
bottom window, the program will introduce the section in the 
following manner: station + km, for example: if you leave the 
field value as 0: KM, the program will introduce the sections 
in the following way: 0+000, 0+020, 0+040, 0+380… 

 ‘Steps’ – the distance between the cross sections the 
program will create (in addition to the possibility of also 
creating intermediate sections at breakpoints). 

 ‘Name of first section’ - the software will number the 
sections in ascending order from this name onward).  

 Click ‘OK’ when you are finished.  
 
 

9. Activating Extract  

 Press on button , if there are already existing G.L. data in 
the cross-sections, the software will indicate that and a 
window containing the option: ‘Get existing G.L. again’ will 
be displayed. Mark this option if you wish to re-import 
topography data to the sections. If this option will remain 
unmarked, the Extract action will be executed faster. Click 
‘OK’ to continue. 

 The software will show the 'Layout and contours' window, to 
get the whole layout mark all of the options: Layout, 
Contours, Distances. If you have some of roads in your 
project and you wish to update the current road only (this 
operation will save the time) – mark the option Update 
current road only. Click 'Ok' to continue. 

 After the extract action, the software will display the full layout 
that includes elevations and contours.  
   
10. The super elevation's definition can be completed by clicking the 

button  (this button is located in the cross-section's window). 
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Saving and reading typical cross sections from a 
‘.Tml’ file 
 
In many cases of Road Design, we will use similar typical sections. So as 
not to re-define the cross sections data for every design, the program 
allows saving the typical section defined in the typical sections database, 
so that later on it can be read into the design of a new road. After creating 
the typical cross sections (defining its structure and design) – click on the 

‘Save’ button  from the right window. Enter the name of the typical 
section, and click save (it is best to keep all the typical sections in a 
section’s ‘bank’ from CivilCAD 2016\Typicals library). Using the same 

method, each time you start designing you can read by clicking , to a 
‘.Tml’ file, from the list of existing sections, instead of defining the sections 
all over again.    

 
 

Functions from the Extract window 
 

 Clear current section – removal of the typical section from current 
segment. 
 

 Clear all sections - removal of all typical sections segments. 
 

 Copy current tables to clipboard – copying of typical section 
(Design+ 
           Structure) from current segment onto the clipboard. 
 

 Paste all from clipboard – copying of typical section 
(Design+Structure) from  
           the clipboard onto the current segment. 
 

 Load sections from text file – loading the typical section from a text 
file (Typ.). 
 

 Save sections to file   - saving the typical section to a text file (Typ  ( . 
 

 Extract – creating cross sections. 
 

 Options – definitions for the Extract operation. 
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Get Structure and Designed G.L. each step only – CivilCAD will create 
cross sections only according to the steps definition. 
 
Get Existing G.L. each step only  - CivilCAD will inport the existing G.L. 
data according to the sections width definition only for sections which will be 
created according to the steps definition. 
 
Resolution - CivilCAD will  search for geometric changes every X meters 
according to this definition. 
 
Include sections by Steps Definition -  Cross Sections 
which were created by Extract operation, according to ‘Road 
by Road’ definition. 
After clicking the ‘Extract’ button, ‘Select Sections to Change’ 
window will be opened. 
A Star will be displayed beside each section which was 
created according to ‘Road by Road’ definition. 
These sections will be frozen and will not be deleted by the 
‘Extract’ operation. 
 
Sections Width – Existing G.L. width from the Centerline. 
 

   Super Elevations - for more details look chapter Super Elevations. 
 

   Create layout – updating the road's layout on the drawing (this action 

is executed after performing .   
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Typical section  - detailing of options from ‘Typical section’ window  
 

 Save project – saving of all projects data. 
 

    Zoom extents  - complete view of section. 
 

 Erase current section – erasing of current table.  
 

  Copy current table to clipboard –copying of current table to 
clipboard.  
 

 Paste all from clipboard -copying of the final table from clipboard to 
the current. 
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Chapter 17: Ditch Design 
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Ditch Design 
 
These are the work stages of ditch design: 
 

 Defining the Horizontal Alignment of the ditch. 
 Defining the Invert level of the ditch bottom in the vertical alignment. 
 Ditch cross section design. 
 Additional functions from the cross sections window.  
 Computation of earthworks. 
 The vertical alignment showing the top of the ditch banks. 
 The geometric alignment of the ditch and calculating coordinates along 

it. 
  
In this chapter we will cover all of these stages.  
 
 

Horizontal Alignment of the ditch 
  
The first stage of ditch design is to prepare the topography settings (for 
more details on preparation of existing status background, see chapter 
“Road Design – Preparation of Settings”.) After preparing the settings, we 
will continue to define the Horizontal Alignment by following these steps: 
 
 
Activate ‘Roads -> Horizontal Alignment’ from the main menu. The 
window will open on the right. Note that the ‘Topography coordinates’ list 
at the bottom window has been replaced by a new, empty list, of the 
‘Designed coordinates’.  
  
 
Enter the centerline’s IP data: 
  
Defining the Horizontal Alignment of the ditch will be done according to the 
new ‘Center line’ of the future ditch alignment. This alignment will be 
defined by the horizontal IP’s. In addition to the horizontal IP’s, you may 
want to enter radiuses at IP’s, although unlike for roads, this data is not 
necessary. There are a number of methods for entering the IP data of a 
center point. We will examine two methods: 
  
Method A: (For users of AutoCAD only) 

 In AutoCAD, transfer a Polyline (2D Polyline) that will serve as the 
Horizontal Alignment of the center line.  

 Choose ‘Select’ from the table on the right (with the list of ‘Select, 
‘Locate’, ‘Pick’, ‘Unused’). 

 In command line of AutoCAD enter 'P'  and  ‘Enter’. Move to the 
drawing area and choose the Polyline , and press 'Enter'.The  table 
from the window on the right will fill with the center line IP list. Every 
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vertex in the Polyline will be set as the IP of the center line, and in the 
bottom window their coordinates list will appear. 

  
Note: the IP center line points will be determined by: xIPy, with ‘x’ - as 
the center line number, and ‘y’- the IP number. In the first chosen 
center line (first ‘Select’ function), the IP’s will be numbered in the 
following fashion: 1IP1, 1IP2, 1IP3, 1IP4 and so on. In each new 
‘Select’ function, ‘x’ will grow longer.  
 

Method B:   
 

Type the center line IP list in the bottom window. For example: 

   
   
  
Type the IP names in the right hand table as was done in the bottom 
list. The IP will be typed, of-course, under ‘IP’ in the table. In our 
example, enter the list the following way:  

 
Entering the center line radiuses: 
 
The next stage in defining the horizontal alignment is defining the radiuses 
at the IP points. If you do not define them, the program will treat them as – 
‘0’.  

  
 For every IP in the right hand table, enter the desired radius. For the 

first and last IP, do not define any radius. 
 Click on the ‘Apply’ button from the right to open the ‘Layout & 

contours’ window.  
 Click ‘OK’ again, from the window that opens (we will not detail the use 

of this window. We will return to this window at a later stage, and 
explain it in detail).  

  
The program will create the horizontal alignment of the center line, that will 
appear in separate layers. Near each ‘IP’, will appear its coordinates, and 
near every arc – the arc data.  
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For AutoCAD users only: 
 
CivilCAD 2016 can take out the horizontal alignment data from a complex 
Polyline, built from a collection of arcs and straight. After choosing the 
complex polyline by choosing the ‘Select’ function, the program will build 
the center line to include all the arcs. For each arc the radius and IP will be 
computed, that will appear on the table from the right. Click ‘Apply’ and 
‘OK’ again (see top) to make the data appear in the drawing.  
  
To realize this example, draw a Polyline in the valley of the new project 
with the measurement file - \Samples\Sample7.Tco. Transfer the Polyline 
so it includes both the lines and arcs (and choose /Arc/ during the Polyline 
drawing). 
 
Changing the IP Location: 
  
The program binds the bottom list, in which appears the center line 
coordinates, and the top list (right), of the center line definition, according 
to points names. Therefore, as long as you keep similar name points, both 
in the top and bottom list, this connection will be kept. Changing the 
coordinate of a certain point, in the bottom list, and clicking ‘Apply’ in the 
right window, and  ‘OK’ in the window that opens, will move the entire 
center line alignment according to the new location. Now you will see how 
to move IP not by manually changing the coordinate, but by making a 
graphic change: 
  

 From the bottom window choose ‘Move’ from the list (Unused, Locate, 
Pick etc.).  

 For AutoCAD users only: 
 Move to the drawing and chose the point you wish to move (you will 

notice that the ‘Object Snap’ for ‘Node’ has been operated). 
 Mark the reference point for movement (most likely that you will choose 

again the same point itself as the relevancy point). 
 Mark the location to where you wish to move the point. 

 To complete this action, click on the  button on top of the drawing. 
This point will move to its new location.  

 Click ‘Apply’ from the right window, and again in the window that 
opens. The center line will move according to the new location of the 
IP. 

 
For users of the Stand Alone version: 
 

 Move to the drawing and chose the desired point (enter the point in the 
square that appears). 

 Mark the new location of the IP.  

 Click  from the menu on top of the drawing.  
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 Click ‘Apply’ from the right window, and again in the window that 
opens. The center line will move according to the new location of the 
IP. 

  
 When you finish defining the Horizontal Alignment, click ‘Close’. 

 
 

Additional functions: 
 

  - 'Load from text file'  – reading the center line data from the .dis 
type file. 

  - 'Delete button' – deleting all center line data. A warning will 
appear before this function is activated. 

  – 'Erase button' - erasing a single IP in the center line. After 
erasing the IP, click ‘OK’, and in the window that opens, click ‘OK’ 
again, to get the new center line alignment. 

  - ‘Options’ button  – click on this button to open a new window. In 
this window you can determine this setting: 

  
1. Changing the ‘Scale’ font size: In order to change the font 

size in the center line data, choose your desired scale from 
the list. To do so click on the small arrow button next to the 
given number in the box, and choose your desired font size 
(the scale is in meter units according to the ratio of 1:X, with 
‘X’ as the chosen size). After selecting click ‘OK’ to close this 
window. To change the drawing, you will need to click on the 
‘Apply’ button from the right, and ‘OK’  in the window that 
opens. 

  
2. Changing the IP numbering when working with ‘Pick’ (“IP 

counter in coordinates”).You can define the Horizontal 
Alignment by selecting ‘pick’ from the list (see previous 
window – ‘Pick’, ‘Select’, ‘Locate’ etc.). To determine the IP 
numbering as it will be done using ‘Pick’, enter the desired 
number. The next time you use ‘pick’, the IP numbering will 
be determined by the number entered.  

  
3. IP counter in layout - changing the IP numbering in layout 

For every center line, the program numbers an IP starting 
from –0 in an ascending order. We will emphasize that there 
is no connection between the coordinate IP name as it 
appears in the center line alignment/ designed coordinates 
list, and the IP numbering on this layout. The assumption is 
that it is possible that in the table (IP Radius Clothoid) will 
appear the name of a certain point (that must be identical to 
the name that appears in the list from the bottom window), 
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and on this layout, will appear a different numbering for the 
same IP. Entering a number in this current field will determine 
the number from which the IP names will be picked for the 
current center line on the layout.  
Click ‘Apply’ to confirm the changes, and ‘Close’ to leave 
without saving.    

 
 

 Pick, Locate: 
 

The ‘Pick’ and ‘Locate’ commands enable a graphic definition of the 
center line, in addition to the ‘Select’ function that has been studied 
at the beginning of the chapter. We will show how to use these 
functions: 

  
Using ‘Pick’: 

 Choose ‘Pick’ from the list. 
 Move to the drawing area, and begin to mark the center line. When you 

finish, click ‘Set’ and ‘Enter’ (in the Stand-lone version click on the right 
button to finish). 

 Continue to insert radiuses and other road design steps.  
 

Using ‘Locate’: 
 Choose ‘Locate’ from the list. 
 Move to the drawing area and mark the points in the drawing that will 

form the IP. If you are using AutoCAD version, notice that in ‘Object 
Snap’ to ‘Node’ has been automatically activated. In the Stand-Alone 
version, the cursor will turn into a square into which you should enter 
the chosen points. When you finish, click ‘Set’ and ‘Enter’ (in the 
Stand-Alone version, click on the right button). 

 Continue to insert radiuses and go through the remaining stages of 
Roads design. The main difference between ‘Pick’ and ‘Locate’ is that 
‘Pick’ creates new points, while ‘locate’ chooses points that exist in the 
database. The advantage of ‘locate’ is that it does not “weight down” 
the list.  
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Defining the Invert level of the ditch bottom in the 
vertical alignment. 
 
  
After we have defined the Horizontal Alignment of the road, we will move 
on to the Vertical Alignment of the center line: 
  
From the main menu activate: ‘Roads -> Vertical Alignment’. The Vertical 
Alignment window will open. This window is divided into : 
 

  Drawing area - the main area of the window. Displayed in the regular 
drawing interface or by the AutoCAD, according to the project's 
definitions (in order to change this definition, activate from main menu 
File-> Configuration, near caption Vertical alignment mode, choose 
"Drawing Environment interface" for the section's display by AutoCAD 
or by Stand alone for regular display. For demonstrational purposes, 
the method described will be the "Stand alone", to learn how to operate 
with the alternative method., see details in chapter: Road design, 
clause: Definition of Longitudinal section by AutoCAD.  

 The existing ground data table – the table from the left down (topo). 
 The designed data table – the right bottom table. 
 The function window - the window on the right. 

  
Please notice that the drawing area is not an AutoCAD window (for users 
of AutoCAD also). The main drawing – the Horizontal Alignment and 
existing topography status, are in a separate window under the Vertical 
Alignment window (reducing this window to a minimum will reveal once 
again, the previous window). 
  
1. Click ‘Apply’ in the right window. The program will move along the 

Horizontal Alignment and compute the heights of the Vertical 
Alignment. These heights appear in the existing status ‘Topo’ window 
(left bottom table), as a function of station and height. In the drawing 
window, the section drawing will appear vertically – existing status.  

  
We will clarify a number of points: 

  
 The section is given in a distorted scale of height in relation to length. 

This is something the program chooses to do (the program creates the 
distortion so you get a convenient working environment).  

 At the table from the bottom of the section, appear heights and 
distances stations every 20 meters. This is a default of the program, 
assuming the Cross sections have yet been defined. In order to change 
this data, you should redefine the Cross sections and return to the 
Along Alignment that will be updated automatically.  

 Even if the Horizontal Alignment does not exist, or we do not have the 
topography, the section can be created by manually entering the data 
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into the topography coordinates table. To do so, enter the distance 
station (ST) data, and elevation (Elev) into the table. To get the section 
after the data has been entered, click ‘OK’ in the right window.  

 If the Vertical Alignment received was found partly incorrect, due to 
incorrect topography data, you can edit the existing topography 
coordinates data, manually. In order to erase a line from the table, 
stand with your mouse on the row of the line serial number (the column 
to the far left), and click ‘Del’. The line will be erased. To get the change 
on the drawing, click ‘Apply’ from the window on the right.  

 
 Designing the vertical IP:  
  
A vertical design of the section can be done by the entering of data in a 
table or by a graphic drawing: 
   

 Method A – entering data in the table. 
 The ‘Design data’ table (bottom right table), is divided into columns 

according to serial number (the column on the far left is without a 
heading) - station (ST), elevation (Ele), a slope between segments 
given in percentage (Slope%), and the length of the vertical arc 
(2T). 

 
 Enter this data into the table, while defining the station and elevation 

for every segment. The program will compute the slope between 
every two segments, and present it to the relevant segment. Instead 
of elevation, you can enter the slope from a previous segment, and 
then the program will enter the elevation column. To delete an error 
line, stand with your mouse on the serial number column (the far left 
column) at the relevant line and press ‘Del’. To get the designed 
section drawing click ‘Apply’ from the right window.    

 
 Method B – a graphic data drawing  

 There are two methods to draw the designed data on the existing 
topography status: 

  
a) Choose ‘Pick’ from the bottom list (Unused, Pick, Locate). 

Move to the drawing area, stand on the most left side of 
the section and (you can deviate a bit left of the existing 
topography state), and click your mouse button. The point 
you have selected will be set as the vertical IP and its 
data will appear in the ‘Design Table(bottom). Continue to 
draw the vertical alignment. While moving on the drawing 
area, you will see your exact location, height and 
distance, under the ‘St’ and ‘Elevation’ labels, to the right 
of the drawing. When you finish your drawing click ‘Apply’ 
from the right window.  
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Please notice: If you choose a point outside the existing 
topography borders, from the left or from the right, the 
program will determine the IP, at the most extreme 
station (0 to the left, or end of natural ground to the right) 
in the same elevation you were in. 
  

b) The second method to drawing the vertical alignment is 
using ‘Locate’. Using ‘Locate’ is very similar to using 
‘Pick’, except for when you choose an IP at a certain 
station, it will be set at the exact existing topography 
elevation status at the same distance.   

c) It is also possible to combine the two methods, (manual 
entering and graphic design). After the graphic section 
had been selected, it will be possible to change the data 
received in the bottom window and to click ‘Apply’ to 
receive the changes (you can, for example, change the 
slope at a certain segment. Click ‘Enter’ to change the 
height according to the slope, and click ‘Apply’ to update 
the drawing). 
The graphic design is from the last IP to the new IP 
continued. To add an IP in the middle of a section, mark 
with your mouse the list of previous IPs (the point after the 
new point you wish to add), move to the drawing and 
mark the new IP. The new point will be added to the table 
at the desirable location. Click ‘Apply’ from the right to fix 
the drawing.  

 
Vertical Arc Design. 
 
After you have added the vertical IPs design data, it is time to add the 
vertical arc in the far right column (2T).  You can enter the arc data in two 
ways : 

 The length of the arc – the length of the arc will be give as a function of 
the distance between the tangents f the vertical arc. After entering the 
data click ‘Apply’ in the right window to update the drawing.  

 The radius of the arc – in order to enter the vertical radius of the arc 
(instead of length), click with your mouse on the ‘2T’ labeling (the 
column heading). The label will switch to ‘R’. Now you can enter the 
radius of the arc. Another click on ‘R’, will return you to work at – ‘2T’.  
  

To check this out for yourself, enter the following data in the design 
table. At the end click ‘OK’ 
 

ST 2T Elev 

0   232 

200.88 100 233.25 

315.74   235.108 
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Create a DXF file of the vertical alignment. 
 
 After completing the design, you will need to take out a DXF file 
of the vertical alignment (you can, of-course do the same for the 
existing topography state alone): 

 Click on the DXF button  right of the drawing. 
 In the window that opens, define a scale for length and width. The scale 

is a ratio of 1 to –x. In the ‘Height’ box, enter the scale for elevation (for 
example: 100), and in the ‘Long’ box enter the scale for length (for 
example: 1000). To continue, click ‘OK’. In the file dialog box that 
opens, enter the name of the drawing file. Click ‘Save’ to save the file. 

 Click ‘Cancel’ from the right hand window to finish the vertical alignment 
design 

 Division of the vertical alignment into sheets. CivilCAD 2016 allows 
for the automatic division of the vertical alignment into several sheets. 
In order to do so, choose the desired sheet size (by which the division 
will be done), from the scroll-down list – ‘Divide by paper size’, and 
click ‘OK’. After naming the file, click ‘Save’. The program will create 
several files with your chosen name, numbered going up, starting from 
‘1’.     

 
 
Additional functions. 
  
Buttons in the right window: 
 

  - Input of vertical alignment section data from a text file (ASCII) 
– ‘Load from text file’   – this button reads the existing topography data 
into the table (the bottom left table) out of a simple text file, which holds 
a list of stations and height. The file structure has to be of lines, with 
station and height separated by a space/comma. 

  - Keeping the vertical alignment data at a text file (ASCII) – the 
‘Save file’ button  – this button saves the existing topography data read 
from the topography (or entered manually), into the text file. The 
structure of the text file is a list of stations and height. 

  - Adding ditch edges to the vertical alignment – the ‘Get edges’ 
button –more details will be coming up. 

  ‘Accurate/By sections’ – Introducing an accurate vertical alignment or 
by-sections only. When CivilCAD 2016 reads the vertical alignment 
from the topography, it does it accurately, affected by the density of the 
measured points (the program builds the vertical alignment according to 
the meeting point of the triangle sides it creates from the measuring 
file). You can see the stations in which the program had sampled the 
heights, from the bottom left (topo) table. At times, even if the sample is 
accurate, is not good for the user (for example: in the measuring file 
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there was a mistake that appears in the vertical alignment, but it is not 
relevant since it is not in any one of the Cross sections).  
  Moving from ‘Accurate’ to ‘By sections’, will solve this problem in 
the following way: 

 Accurate – an accurate sample of the section. The section 
drawing line will accurate according to the topography 
sample. The heights from the bottom table will appear 
according to the cross sections (default – every 20 meters), 
and in addition heights will appear at critical points.  

 By sections – An accurate sample of the section, but the 
drawing line of the section will be built according to heights at 
cross sections only. The bottom table will remain the same.    

The advantage to this system is “smoothing” the vertical 
alignment. Its disadvantage is lack of accuracy. 

  
Buttons in the Drawing Window: 
 

  – Zoom Extents – viewing the entire section. Clicking on this 
button will return the view option for the entire drawing. In case the user 
had moved the drawing left/right using the scroll bars, or 
decreased/increased the drawing by clicking the left/right button in the 
drawing area, clicking this button will return viewer ship to the entire 
drawing area.  

  – will create a DXF file of the section (on how to operate, keep on 
reading).  

 
 
Buttons in the bottom window:  

  in Design table – deleting all the design data from the table. Before 
operation, a warning notice will appear. 

 

  - heights elevation and lowering of the section along the dH – 
for decrease/increase of height to the elevation of the section vertically, 
follow these steps: 

 Click on the ‘dH’ button 
 In the window that opens will appear the designed heights list in the 

vertical alignment. Mark the heights you wish to change. To change 
all the heights click on ‘A’ (All) from the bottom. In the dH line 
(bottom), enter the height you want to add. To decrease elevation 
enter a negative sign (-). Click ‘OK’ to activate. The heights that 
were chosen will be changed from the ‘Design data’ table at the 
bottom. To receive the changes on the drawing, click ‘OK’ (from the 
right).  
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 The  button from the ‘Topo’ table – delete all existing status ‘topo’ 
data from the table. Before operation, a warning notice will appear. 

 

  - reading the vertical alignment from the ‘GetT’ topography – 
Click on this button to open the window. From this window, choose the 
table to which the topography data will be entered, the existing status 
table, OR the ‘Designed G.L’. Click ‘OK’ to continue. The data will be 
entered into the table accordingly.  

 

  - this button is for copying existing status stations into 
designed status. Click this button to get the stations only (without 
height), from the existing status table into the designed status table. 

  
  
Note. In the order of commands that were introduced in this chapter, 
clicking on the ‘Apply’ button from the right window triggered the reading 
of the topography data into the vertical alignment. This move will only be 
correct only if the existing status topography data table is empty! In any 
other case, the program will not perform an additional reading of the 
topography data when clicking ‘Apply’, but renew the drawing according to 
the data that already exists in the table. The main problem will occur, if 
during the project, the horizontal alignment of the center line was changed, 
and/or changes were made to the topography. To renew the existing 

topography status of the section, use the  button, which we have just 
explained.  

 
 
Ditch cross section design 
  
Having determined the vertical alignment of the ditch bottom in the 
previous chapter, we will proceed to define the cross sections.  
  

1. Activate: ‘Roads-> Cross sections’ from the main menu, to 
open the ‘Cross sections’ window. This window is divided into 
three parts: 

2. The drawing area – the main area where the drawing of the 
section will appear. The name of the current section that is 
being worked on, will appear in the heading above the 
drawing.  

3. The list of cross sections – right window. 
4. The existing and designed topography tables for every 

section – the tables at the lower section of your screen: 
5. Existing G.L. – the existing status topography data from the 

left table. Designed G.L the designed topography data from 
the right hand table.  
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6. Click on the button  from the right window (Define 
sections) – to open the Cross roads setting window. From 
this window determine the following data: 

 
 Start at station – the station of the first section. The default is ‘0’. At 

most times, we will want the station for the first section in the designed 
segment of the center line, to be ‘0’. However, there are cases where 
we plan a segment that is the continuation of the center line. In such a 
case, the station of the first section will be different.  

 End at station – the station for the last section. The default is 
according to the length of the center line as it was computed by the 
program (this length appears immediately when the cross section 
window opens, at the right window – ‘Roads length’). 

 Distance between sections – the distance between the cross 
sections. The default is 20 meters. Later on we will see that creating 
sequential cross sections is not mandatory (a must), and furthermore, 
that all sections can be determined vertically in a way that is not 
sequential. 

 Name of first section – the name of the first section (a number). The 
program will number the remaining sections in an ascending order 
according to the format specified in the window. We will explain both 
these ‘Format’ statuses: 

1. Format 1 – the first option presents the sections 
names as they appear in the sections list. 

2. Format 2 – by changing the parameters that appear in 
the bottom window, the program will use this option to 
present the section’s name in the following fashion: 
station + km. For example, if you leave the value in 
field 0:KM, the program will present the sections like 
so: 0+000, 0+020, 0+040……, 0+380.  

 
  

Another option for defining cross sections, is by marking their location 
at the horizontal alignment design stage, so the sections are 
positioned at fixed places against the measuring background. To do 
so follow these steps: 

  
1. When defining the horizontal alignment (first phase of ditch 

design), transfer the polyline that will determine the Center line, 
so its vertex points will be in the same exact places where we 
want the sections to be.  

2. From the Cross Section Window (present window), go to ‘By 
Ips’. The program will create sections at stations that are 
determined by the vertex points along the center line. 

3. After you have finished defining the sections (using any one of 
the selected systems), click ‘OK’ to build the sections. The list of 
sections that had been built will appear in the right table 
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according to the definitions. Every section will be given a name 
and Station.   

4. It is possible to add intermediate sections to the project at any 
given moment. To do so, follow the steps below: 

5. Position your cursor (using your mouse) on the line before the 
line you wish to insert the section. 

6. Click ‘Enter’ (key-board). The line will jump down and a new line 
will appear.  

7. In the new line insert the name (number) of the new section. The 
name of the section can include numbers “.” And “/” (but not the 
letters). If the new section is, for example, between section 1- 
and 2, you can name it 1.1. Move with the right arrow to the 
‘Station’ column, and insert station of the section you just added.  

  
Note. It is possible, instead of defining sections automatically using 
the white button, to immediately move to the right window and build 
the table manually – name and station for each and every section.  
 
  

Activate the Options button  from the right window. The ‘Define 
sections width’ will open.   

 
1. Define the width of section for the project. We are referring to 

the width of the ground that the program will sample for the 
existing status out of the topography. We will define a 
distance from the left center line and a distance from the right 
center line that will together define the width of the ground 
strip. The left end of the section we will defined in the ‘Left’ 
field (default of – 20 meters), and its right end in the ‘Right’ 
field (default  – 20 meters), when the distance left of the 
center line is a negative number and the distance from the 
right is a positive one.  

 
2. There might be a case where you will want a center line band 

that is all to the right (or left) of your center line. In such 
cases it is possible to define a section that is all on the right 
(or left), by using the correct stations. 

 
3. Transfer from Elevation to dH. Using CivilCAD 2016 you can 

define cross sections of absolute heights, or sections of 
relative heights. Working with absolute heights will actually 
cancel the effect of the vertical alignment on the cross 
sections, and commit you to defining a separate design for 
each and every section (or fill the intermediate sections using 
interpolation). During the rest of the chapter we will discuss 
working with typical sections, and so heights will be defined 
in a relative manner.  
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4. Move from Earthworks to Design. This option defines the 
graphic presentation form of the section. The program has 
two options for defining the section: a section for presenting 
Earthworks, and a section for presenting designed sections. 
The difference in presentation will be shown both by the form 
of the sections in the drawing window, both by printing 
through the program to the printer, and by creating a sections 
file on an AutoCAD sheet.  

  

Click on the ‘GetT all’ button . Click ‘OK’ in the window that opens. 
The program will warn that it is about to change the existing topography 
status data to new data, and that the old data will be deleted. Click ‘OK’ 
to continue. The program will move along the center line and sample 
the existing topography data, using the sections that were defined.   

  
The sampling of the existing topography data is dependent upon the 
number of measuring points in the project, the number of break-lines, 
and number of cross sections that have been defined. In large projects, 
this activity might take a long time. CivilCAD 2016 does not limit the 
project size, or the length of the center line, although in slow computers 
or computers with little memory, this might take a while, or even cause 
the computer to “crash”. 
  
When the reading of the existing topography data is finished, the first 
section will appear in the drawing window, and the existing topography 
data will appear in the table from the left down. At the head of the page 
(in the heading above the drawing), will appear the name of the 
presented section, for example ‘Sections name: 1’, and in addition the 
designed height will appear in the center line of this section (the height 
set in the section length), for example - /Elevation: 233.85. It is possible 
to move between sections by pointing to the desired section in the table 
at the right. Every section selected, will appear automatically on the 
drawing, and its data will appear in the tables below. To continue the 
instructions make sure you are in the first section.  
  
We will shortly explain the structure of the design table. In the table 
there are lines, each line representing a segment. The segments are 
numbered from -40 to +40 (a sum of 81 possible segments for each 
section). In the table there are five columns (the one on the far left is 
without a heading). To explain this, number these columns in an 
ascending order from left to right, so the column on the far left is 
number 1: 

  
1. Column number 1: In this column appear the segment’s 

serial number. This number does not represent a distance of 
any kind. Segments left to the center line will be represented 
by a negative number, and numbers right of the center line 
will be represented by a positive number.  
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2. Column number 2 (Offset) – this column represents the 
distance of the segment from the center line. The distance 
left of the center line will be entered as negative, and the 
number from the right as positive. There are two options for 
the distance from the center line: absolute distance or relative 
distance. When working with dH, as shown here (see section 
3), the data will be entered as a relative distance, meaning 
that the distance entered is actually the length of the segment 
and not the absolute distance from the center line. When 
working with ‘Elevation’, this data will be entered as absolute 
heights. 

 
3. Column number 3 (dH) – this column has two options : dH 

(as shown here) or ‘Elevation’. The options are determined 
from the ‘Status’ window (see section 3). When working with 
dH, the heights will be entered as relative, compared to the 
height of the previous segment, so the height entered is 
actually the height of the segment. When working with 
‘Elevation’, the entered heights will be absolute. 

 
4. Column number 4 (Slope%) – In this column you can enter 

the slope of the segment. You can enter any one of two data: 
Entering dH at column 3, will automatically compute the slope 
of the segment and enter it in column 4. In contrast, entering 
the slope will compute the dH and enter it in column 3. 

  
Before we continue, we will shortly explain a number of editing 
commands from the table: 

1. Clicking on ‘Del’ from a certain field will delete the field. 
2. Clicking on ‘Backspace’ (back arrow), to work as usual. 
3. To delete an entire line, or reduce lines, stand on the far left 

column (column number 1) in the desired segment and click 
‘Del’. The program will delete the segment and reduce the 
lines.  

4. It is possible to copy a segment from the existing cross 
section to other cross sections. To copy, stand on the desired 
segment and right click with your mouse button. From the 
table that opens, mark the sections to which the segment 
data will be copied and (to choose all sections, click on 
button ‘A1’ from the bottom), and click ‘OK’. The program will 
copy the segment data for all the selected sections.  

 
 
Now we will go to the typical designed section definition: 
  

Begin by entering the design data in the table (‘Designed GL table). 
To clear this issue, we will demonstrate the data for a typical section 
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that will be followed by a detailed explanation. Enter the following 
data in the table: 
  
Stand on segment ‘0’ with your mouse, in column number 2. Type 
“0”, Enter and again “0”. You have just determined that the height of 
this cross section is similar to the designed height in the vertical 
alignment.  
Move with the arrows to section 1, column number 2. Insert “1.5”, 
click ‘Enter’ move with your arrow right of column number 3, insert 
“1.5” and ‘Enter’. The segment that had just been defined is a 
bottom of the ditch and has the width of approx. 3 meters (1.5 
meters on each side). 
 
When you finish inserting the data, the table should look like this: 
  

  Offset  dH Slope% Cover 

-1 -1.5 0 -2.00   

 0     0 0     

 1   1.5 0 -2.00   

  
This writing appears, at the top and bottom section of the table: 
Slp. left : Cut 1:        Fill 1:     
Slp right: Cut 1:        Fill 1: 
right), to the natural ground   :  
  
These fields represent the slope of the ditch banks, from left and 
right : 
Enter in field: Cut 1, from the bottom of the table (next to – ‘Slp 
right’), the number “2”.Enter the same value in the field at the head 
of the table (field: Cut 1 near ‘Fill 1’). You have just defined that the 
slopes of the ditch to the right and to the left are 1:2.  
  
Click ‘Apply’ from the right hand window. The design will appear on 
the drawing. 
  

 
Now we will project    the typical section on the entire center line we 
have built. 
  

1. Click on the ‘Copy’ button  left of the Earthworks height 
table (Designed G.L). The button is located to the left of the 
table, second from the bottom, with a picture of two pages. 
After you click, the ‘Designed G.L’ table will be copied to the 
computer’s memory. 

 
2. Using the table from the left window (the sections list table, 

left of the drawing), move to the last section on the list. Click 
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on the ‘Paste’ button  (the button under the ‘Copy’), in 
order to copy the data from memory into the table, in this 
section.    

 
The main principle of working with CivilCAD 2016, is entering the data 
in the sections in which the cross section changes (only in those 
sections!), and filling the remaining center line parts with intermediate 
interpolation. Now we have two sections full of data. The remaining 
sections are still empty (you can see this by browsing between them by 
clicking on a certain section from the right hand table – the sections 
table list):  
  
Intermediate interpolation.  

Click on the ‘Interpolation empty sections’ button  from the right. 
Choose 'All Design' and click on ‘OK’. The program will do interpolation 
for all the empty sections in the project, and since we have two sections 
only, (first and last), that are similar in capacity, the program will fill all 
the sections with the same design data. At the end of the interpolation, 
you can browse through the sections. At this stage, if you are 
interested, you can move to a certain section and change its capacity.  

 
 
Moving the sections to the drawing sheet: 
 

Click on the ‘DXF’ button  to the right of the drawing 
 A window containing the sections' list will open. Click on the desired 

sections or click on button  to choose all the sections and click 'OK'. 
 In the next opened window, choose scale of the section to the Height 

("Height") and to the length ("Long"). The scale will be entered as a 
scale of 1:X. for example, type 100 for "Height" and 100 for "Long". 
Click "OK". 

 The software will display a message "DO you want to manually 
arrange cross sections, or CivilCAD 2016 to do it for you?. If you 
wish to design the file's structure click "Yes", otherwise, click "No" and 
the software will arrange the cross-sections automatically. 

 If you choose to arrange the file's structure ("Yes"), the software will 
display a window to arrange the sections in this window. Enter the 
number of sections to appear in each column near the caption 
"sections in every column" and the vertical distance to the next 
section: dY Between sections (cm). Click "Arrange" in order to see 
the structure's chart. To finish, click "OK". 
 
 

 Choose a name to the file created by the software and click 'Save'. 
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Note. The DXF file is a drawing file that can be imported by most 
drawing programs. In AutoCAD, for example, you can import this file, 
using the ‘DXFI’ command, or by ‘File->Open’, and transferring the 
filter of the files to ‘DXF’. After importing the file, click ‘Zoom’ and 
‘Extents’, to show all the sections.  

 
  

Receiving the ditch layout: Click on the ‘ Create Layout’ button  , 
from the right. From the window that opens, mark ‘v’ next to the three 
possible options (Layout, Contours, Distances). Click ‘OK’ to 
continue. The program will create a layout on the drawing that includes 
contour lines of the ditch, as well as dibbling lines.  

The Layout window includes three options:  
 Layout – mark ‘v’ next to this option to create the layout of 

the ditch and sections elevation labels.  
 Contours -  this option will not be active in ditch design. 
 Distances - mark ‘v’ next to this option to create a distance 

layer between the sections. The program will write the 
distances between each and every section and the distances 
between the section and the tangency    closest to it . 

 Update current road only - Marking "V" near this option will 
instruct the software to update only the current road's layout. 
When removing the mark, the software will update the layout 
for all the roads of the project. 

 
Note. After clicking ‘OK’ in the Layout window, the cross section 
window will be minimized (so that you can see the changes in 
layout). To maximize the screen, click on it from the Windows 
“Task-Bar” from the bottom of your screen. Continue to edit the 
sections according to need including extracting the proper layout. 
When you finish editing the sections, click ‘Close’. 

 

 

Additional functions from the cross sections 
window  
  
We will now explain in detail additional functions from the cross sections 
window that were not discusses during the sample stages: 
  
Functions from the cross sections list (right window): 
  

1.  - deleting a single section – stand on the section you 
wish to delete from the list, and click on the button with the 
picture of an eraser from the sections list window (right 
window). The program will erase this section from the list.  
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2.  - delete all the project sections – click on the button with 
the picture of – x from the right window. The program will send 
a warning before deleting all the sections. Click ‘OK’ to confirm 
this action.  
   

3.  - deleting sections group data: - to delete in unity the 
data of numerous sections, click on the ‘Clear all’ button from 
the ‘sections list’ window (right window). From the window that 
opens, choose the Existing G.L. data you want to delete, the 
Designed G.L of Earthworks height, and the height of road 
structure, or ditch edges data. Click ‘OK’ to continue. From the 
table that opens, mark the sections whose data you want to 
delete. To choose all sections, click on the ‘All’ button from the 
bottom. Click ‘OK’. The program will delete the chosen sections 
data. 
  

4.  - adding height to the sections data. This option is 
useful mainly for working with absolute heights (at relative 
heights it is best to change the height of the vertical alignment 
to changing the data of the cross sections). To activate click 
this button. In the window that opens, enter the needed 
addition to the height (to decrease the height, enter a negative 
height). To continue click ‘OK’. From the window that opens, 
choose the data you wish to change (existing G.L, Earthworks 
height, or height of structure).    Click ‘OK’ to continue. In the 
additional window, choose the sections you wish to change 
(click on ‘All’ from the bottom, and choose all the sections). 
Click ‘OK’. The program will add the desired height to the 
selection of sections in the table you selected (topography, 
designed etc.). 

 
 

Functions from the ‘Define section width’ window (activate using the 

‘Options’ button  from the sections list right window). 
Some of the functions of this window have been discussed. Here we will 
explain the ones we have not: 

  
1. Max/Min interval – At times, there might be a situation when 

irregular data will be read into from the topography into the 
sections. There are several reasons for this occurrence such 
as incorrect measuring data, measuring border narrower than 
the desired section, extrapolation at the contour lines and 
more. To avoid this occurrence, you can define for the program 
the maximum interval between the given ground level to the 
center line elevation. The assumption is that the center line 
height is always true (or at least does not deviate from the 
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topography ranges), and is thus used as a reference point. You 
instruct the program what the maximum interval is at the height 
we allow a ground break in the section. Each ground break that 
deviates from this interval (up or down), will be deleted from 
the ground data.  
For example – if the height at the center line is – 230.55, and 
we entered Max/Min interval of – 3 meters, every ground data 
lower than 227.55 or higher than 233.55, will be deleted from 
the ground data of the section. The affect of the data will occur 
only after we will perform a ground sample using the ‘GetT all’ 
button. If there are existing ground data that you wish to 
change, enter the desired interval, click ‘OK’ to leave, and 
repeat all the ‘GetT all’ functions.  
  

2. Include edges – the key to CivilCAD 2016 sampling ground 
data is : the program will always sample the center line existing 
data, and any ground break identified at the cross section area, 
will be also entered into the table. In addition to this data, the 
program will sample the height of the existing status at the end 
of the section, from left to right, according to the width that was 
defined. In order to cancel the ends sampling, uncheck (the ‘V’ 
mark), and repeat all the ‘GetT all’ commands. The program 
will sample the data all over again, without sampling the ends.  

 
 
Functions from the Drawing Window  
  
The drawing window (the main window on which appears the section 
drawing), has three buttons on its right hand side. In a previous section we 
have explained the functionality of the DXF button. We will now explain the 
functionality of the two additional buttons: 
  
1. Printing the sections into the printer: 

 Click on the ‘printer’ button  . 
 In the window that opens define the printing scale : Height – scale for    
 height, Long – scale for length. We will enter 100, 100 (scale of  
 1:100/1:100). Click ‘OK’ to continue.  
 From the window that opens, define the type and paper size, and all 

other required parameters that have to do with your printer. Click ‘OK’ 
(or “confirm”) to continue.  

 Now choose the sections you want to print. To choose all sections, click 

the on the  button from the bottom window. Click ‘OK’ to print. 
  

The program will print all the sections sequentially, according to the 
language defined in the settings. To change the language, follow the steps 
below: 
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 Leave the cross sections by clicking ‘Close’. 
 Activate – ‘File-> Configuration’. 
 From the right hand window - choose from ‘languages’ the desired 

language. 
 Click ‘OK’ and return to the cross sections (File-> Cross sections). 
 Return and print the sections as you have learned.  

  

2.  – Zoom extents – there are several methods of controlling the 
setting of your section : 

 The scroll bars to the bottom and left of the drawing. 
 Clicking the left button from the drawing area will enlarge the drawing 

by 2. Clicking on the button from the right, will decrease it by 2.  

  button (Zoom extents) – returns ‘view’ to the entire drawing. 
  

 
Functions from the tables window (bottom window). 

 
Left of every table (left table and right table), appear a number of table 
options buttons:  

  - Erase button – deleting the table data in the current section. 

  - ‘GetT’ button – import the existing G.L data of the current section 

out of the existing topography. Unlike the ‘GetTall’ button , this 
button imports the existing status data of the current section only. 
Before proceeding, a warning notice will appear and will ask whether 
you are sure you want to delete the existing status data. To continue 
you must confirm. 

  - GetD - Importing data from the designated topography. In contrast 

to the GetD all button , this button imports the status' data of the 
current section alone. Before executing this action, a notice will be 
displayed, warning about deleting of current data, confirm to continue. 
In the event of using designated ground level's data samples, the 
following actions should be executed prior to the actions described 
above: 

 Click on options button . 
In the opened window click Option Design :devote -40 to 40 
segments. By marking this option, the software will sample 
topographic data into the planning data by using all 81 
segments in the table. Part of these segments is saved for 
miscellaneous additions in the planning such as: 
ditches,berms etc. 

 

Earthworks computations in ditches   
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Once you have finished defining the ditch cross sections, you might want 
to know the Earthworks quantities (volumes) in the project according to the 
design. In this chapter we will show how to compute these quantities.  
(When you finish designing the cross sections, click ‘Cancel’ to close the 
window and keep the data). 
  
1. From the main menu Activate ‘Road -> Earthworks’. From the right, 

the quantity computation window will open.  
  

2. Click ‘Apply’. The program will compute and present the quantities 
table. It will divide the quantities table into two sections. 

 Volume computation table. 
 Stripping areas summarizing table. 

(Both tables are arranged one after the other. In order to view the 
second table, scroll the report using the right scroll bar). 
The volume computation table is the table in which the work volumes 
are centered as the multiplication of the distance between the sections 
areas. The stripping areas summarizing table presents the work 
surface as a double the length of the sections in ‘dig’ and ‘fill’ and the 
distance between them.  

  
3. Click on the printer button from the bottom of the report. In the window 

that is selected determine the printer settings and continue to print the 
tables.  
Note. The table’s language depends on the type of installation that was 
performed. If you wish to change the language in which the reports 
appears (for example from Hebrew to English) follow these steps: 

 Go to ‘Files-> Configuration’. 
 Identify the ‘Language’ labeling from the window that opens from the 

right. Click on the small arrow right of the language field and choose the 
desired language from the list. 

 Click ‘OK’ to close the window. 
 Go back and complete steps 1-3 from the top of this page. 

  
4. To close the report window Click ‘Close’. 

  

5. Click on the ‘Sections data report’  from the right. The program will 
compute and present a detailed table with the data of each and every 
section. Use the scroll bar from the right to view the data of the 
remaining sections. In the detailed report will appear the height and 
distance data for every section of every segment (please notice: this 
data includes the data entered in the section tables, and the data 
computed as the dibbling data sample), slope dibbling, the ‘dig’ and ‘fill’ 
area of the section, and the length of the section in ‘dig’ and in ‘fill’. To 
print the report click on the ‘printer’ button from the bottom.  

 
You can extract a diagram of an accumulated haul diagram or by 
sections (this option is available only Microsoft Excel is installed in 
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your computer). Click on button  excel mass haul diagram and a 
window will be opened, displaying the following two options: 
 

1) Accumulated mass haul diagram - A diagram displaying 
the cut/fill quantities accumulated along the centerline. 
2) Sections volumes diagram - A diagram displaying the 
cut/fill quantities to each section. 

Choose from one of these options and click 'OK'. The software will 
display the diagram on the Excel window. In order to save an Excel 
worksheet, save the diagram in the Excel window. 

 
6. To finish the Earthworks computations, click ‘Close’ (bottom right). 
 
 
Earthworks Quantity Computation Function Window  
  
Here are more options from the Earthworks window: 
  
Quantity computation for some of the sections – in order to compute 
the quantities for some of the sections, do the following: 
  
From the sections window, mark only the sections for which you want to 
see the Earthworks.  
Check the word ‘Block’ at the bottom of the list (‘v’ mark). 
Click 'Apply'. The table built will include only the selected sections. 
  
Stripping depth – in this field the stripping depth of the Earthworks is 
entered, if such an area exists. The stripping depth is entered in meters. 
The program divides the stripping by giving a different depth to the ‘dig’ 
area and a different depth to the ‘fill’ area. Next to field ‘Cut ar.’ enter the 
depth for area ‘Dig’, and next to field ‘Fill ar.’ the depth area ‘fill’ (not 
entering a value to a certain field indicates that there is no stripping in that 
area). Click ‘Apply’ to receive the new report that will be affected by the 
stripping depth entered. 
  

‘Options’ button  – this button opens the ‘Options’ window that 
enables a selection of definitions for the reports. (One of the definitions that 
appear in this window, has already been discussed in section 2 – ‘volume 
computation for the road structure layer’.) The main principle of this 
window is controlling the display volumes, and stripping areas summary 
reports. In this window appears a list of all the fields that appear in the 
report tables. On the left, are the table fields of the centralized volumes, 
and on the right, the table fields of the stripping areas. If you wish to delete 
a certain column from one of the reports, uncheck the ‘v’ mark near its 
column. To confirm click ‘OK’. Next time you print this report, it will appear 
without the column you deleted. Additional options in this window:  
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Accuracy in section's data – an accuracy level of showed in the 
report values (the number of digits after decimal point).               

     
Stripping length - expose length calculation method. 
Horizontal - calculating the expose will be set according to the horizontal 
alignment. 
Inclined - the actual expose parallel the planned one. 
Layers of calculation - the earthworks quantity computation between the 
Design and the Existing tables or between the Design and the Structure 
tables. 
Display after stripping areas in volumes table - Displaying calculation of 
volumes after the calculation of the expose. 

 

 
The vertical alignment showing the top of the 
ditch banks 
 
 
CivilCAD 2016 supports the introduction of ditch bank tops on the vertical 
alignment. After completing the cross sections, go to vertical alignment 
design:  
  
Activate: ‘Roads-> Vertical alignment’ to open the vertical alignment ditch 

window. Click on the ‘Get edges’ button  from the hand right window. 
The program will add to the vertical alignment of the existing and designed 
status, the vertical alignment of the ditch banks from the left and from the 
right. The banks height data will be added in the new rows that will open 
from the bottom table.    
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Coordinates along the centerline  
  
CivilCAD 2016 enables geographic computations along the center line 
from different shapes, including coordinates computations at station and 
offset along center line, geographical data reports of the center line and 
more. Most of the functions from this window can be activated immediately, 
proceeding the center line definition of the horizontal alignment, and with 
no definition of cross sections. However, it seems that there is a possibility 
to compute the coordinates of the dibbling    points    at the sections. To do 
so the program must define cross sections in the computed project.  
  
For geometric computations go to – ‘Roads-> Coordinates 
computations’. These are the options from the window that opens : 
  
Coordinates computations along or offset to the center line – 
calculating a single point - 
Make sure that you choose 'Coord’ from the options that appear in the 
window - ‘Coord’ or ‘Geom’. 
In the ‘Station’ field - enter the station (in meters), of the point you wish to 
compute. To compute a point in the second section, for example, enter 20. 
Click ‘Enter’ to continue.  
In the ‘Offset’ field - enter the computed point offset from the center line (or 
offset). To compute the point in the center line itself, enter 0 or leave the 
field empty. To compute a point left of the center line, enter a negative 
distance, and to the right a positive one. Click ‘Enter’ to continue.  
In the ‘New point’ field - enter the name of the new point to be computed. 
It can be a number or an alphanumeric name that includes letters.  
Click ‘Enter’, or 'Apply' button. The program will compute the desired 
coordinate and add it to the list of coordinates at the bottom window.  
  
 
As default, the computed coordinate will be added to the ‘Designed 
coordinates’ list (browsing between lists is done, as aforesaid, by 
choosing ‘Topography -> Coordinates’ or ‘Design-> Coordinates’ from 
the main menu). It is possible to instruct the program for which list to 
perform its computation. To do so, follow these steps: 
  
From the main menu activate: ‘Geometry-> Geometry parameters’. A 
window will open from the right.  
From the window that opens choose ‘Topo points only’ to compute the 
data for the existing table, or ‘Designed points only’ to computate them 
into the designed table.  
Click ‘OK’ to confirm. 
(In order to determine this definition for all the projects in the program, 
follow this order of commands in the ‘Prototype’ project.). 
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Coordinates computations along or offset to the center line – 
computing a points sequence. 
Make sure that you choose 'Coord’ from the options that appear in the 
window - ‘Coord’ or ‘Geom’. 
In field ‘From’, enter the station of the first point you want to compute and 
click ‘Enter’. To start the center line enter ‘0’. 
In field ‘To’ enter the station of the last point you want to compute and click 
‘Enter’.  
The program had computed the length of the center line and presented it 
next to the ‘Roads length’ field. In order to compute points along the entire 
center line, enter the length near the ‘To’ field, and click ‘Enter’ to continue.   
In the ‘Offset’ field, enter the offset points computed from the center line 
(and offset to it). To compute the center line points themselves, enter 0 or 
leave the field empty. To compute a point left of the center line, enter a 
negative number, and to the right a positive one . Click ‘Enter’ to continue.  
  
It is possible to compute numerous points at different offsets    in one 
action. To enter several    offsets,    separate the offsets using spaces.    For 
example, if you want to compute the road section points, when for each 
section we are interested in the center line point itself and in the points to 
the left and right of it at the    offset of 5 meters, then enter “-5 0 5   ”    into 
the ‘Offset’ field. 
  
In the ‘New point’ field, enter the first point number created. The program 
will number the points from here on.  
  
When working on a sequence of points (unlike computing a single point), 
the name of the point entered in the ‘New point’ field, must be a number, in 
order for the program to number the points in an ascending. You might 
want to give the points a characteristic prefix name. To do so use the 
‘prefix’ field. If you wish, for example, to compute the actual center line 
points, enter ‘CL’ in the ‘Prefix’ field.  
  
Click ‘Enter’, or ‘Apply’. The program will compute the desired points and 
add them to the coordinates list at the bottom window. If ‘Prefix’ was 
entered, then the names of the points will be added with their matching 

prefix. After you finish the computation, click  to get the points on the 
drawing.  
  
After you finish the computations, and confirm that in the bottom list 
appears the desired coordinates database, you can save the list in file   
'Ascii’, or print it (for more detail on saving or printing coordinates in a Text 
file, see chapter 2 section 3 “Coordinates Database – command buttons 
connected to the list”). 
 
Coordinates computations of the dibbling points along the center line 
– this options enables coordinates computations of the    dibbling points 
sections along the center line, to its left and right. Using this function 
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requires, naturally, cross section definitions aside from the center line 
horizontal alignment definition. To perform follow these steps: 
  

Click on the dibbling points computation button  from the right hand 
window. The window will open.  
From the window that opens, you have the following options: 
  
If you choose to compute the dibbling    points – a default, the program 
will compute the    dibbling    for the ‘Designed G.L’ points    . If you wish to 
compute the    dibbling for the ‘Structure’ layer, move the small arrow from 
the ‘Designed G.L’ dialog box, to ‘Structure’ (an example of a case in which 
you would like to compute the ‘structure    ’ dibbling points, can occur when 
in the design, you entered ‘structure’ height only, without the Earthworks 
height). 
  
Entering a “security distance”  to the dibbling points from left to 
right. If you want the program to compute the    dibbling points at an offset    
from their real location, enter this distance at the proper fields : for field 
‘Left’ enter the distance to the left dibbling, and for field ‘Right’ the distance 
to the right    dibbling.    The distance computed, will always be from the 
center line and outwards, (distances will always be entered as an absolute 
value without the    “- “ mark).     
  
Enter the prefix to the points created. If you want to add any kind of text 
to the names of the points created (say the name of the road to which they 
belong), enter this text in the ‘Prefix’ field.  
  
After determining the desired window setting, click ‘Apply’ to perform the 
computation. The program will compute the points according to definitions 
and they will be added to the ‘Designed coordinates’ list at the bottom. The 
names of the points will be chosen according to the name of the section to 
which they belong, with the addition of ‘L’ or ‘R’ to mark the point left or 
right of the section. In addition, if the prefix was entered, it will appear at 
the beginning of the point's names. 
 
 
 The center line geometric data computations – In order to get the 
geometric data list, choose ‘Geom’ (choose between ‘Coord’ and ‘Geom’ 

options), and click on the report button . In the report that opens you 
will see the center line geometric data with the IP coordinates data and 
arch data. To print this data, click on the printer button from the bottom of 
this window.  
  
The geometric data report can be placed on the drawing. To do so, first 
compute the report as detailed above, and perform the following steps: 
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Click on the report placement button drawing . 
Move to the drawing area and position the table in the desired area: 
For users of Stand Alone version –using your mouse, position the table 
borders rectangle at the desired location. The table will be built and 
presented as part of the drawing.  
For AutoCAD users only – In the AutoCAD command ruler appears the 
labeling– “Locate table. Pick Location/Set/(Esc)nd:”. Mark the cursor in 
the location you want it to appear in the table. Mouse click to get the table’s 
borders frame. The borders will appear at a temporary layer that will be 
erased once you finish positioning the table. You may choose from a 
number of locations for your table, i.e. receive the frame an unlimited 
number of times, until it’s final location is set. After choosing the final 
location, click ‘S’ from the ‘AutoCAD’ line and ‘Enter’. The temporary 
borders will be erased and the table will be positioned at the location of 
your last choice.   
The table font size can also be changed. In order to make a change, click 

on the ‘Options’ button  from the right window . From the window that 
opens, choose the desired font size using the small arrow next to ‘Scale’ 
field. After choosing, click ‘OK’. To change the table on the drawing, you 
will have to go back and position it as explained at the top.  
Receiving computation reports – sections 1-3 from the top – there are 
different ways to compute coordinates along the center line. For each one 
of these computations, you can get the computation table in the format of 
an orderly report. To get the report choose ‘Coord’ (choose between 

‘Coord’ and ‘Geom’ options), and click on the report button . The 
computation report will appear before you.  
 
 

Deleting all window fields – click on the delete button  to delete all 
fields.  
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Chapter 18: Reservoir 
Design 
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Reservoir Design 
  
This chapter includes the following sections:  
  

 Alignment design of the peripheral embankment. 
 Defining the embankment cross section up to the bottom of the 

reservoir. 
 Creating the reservoir model (including the creation of the 

bottom). 
 Balancing earthworks 
 Reservoir capacity. 
 Changing the alignment of the peripheral embankment.   
 Slope of the reservoir bottom   
 Drawing ‘Scraper plan' and sections along the reservoir. 
 Dams.  

 
CivilCAD 2016 is a strong and efficient tool for the design of reservoirs and 
pools. You can use it to define the reservoir alignment and to get the 
optimal height until the leveling of the Earthworks. The program will also 
show the capacity of the reservoir. At the end of the design, we will show 
how to receive ‘Scraper’ work plans for Earthworks, and sections along the 
reservoir. 
  
The last part of the chapter will discuss a reservoir composed from a 
‘Dam’, and not a ‘Pond’.  
 

 

Alignment of peripheral embankment  
  
The preceding step in reservoir design, is preparing the background of the 
existing G.L (for details on preparation of existing background, see the 
beginning of chapter 15 'Roads Design - Preparing the background 
(existing background)').  
The first step in planning a reservoir, is defining its peripheral embankment 
alignment. Defining the peripheral embankment will be done the same as 
in roads or ditches design –using IPs and radiuses. 
  
From the main menu go to: ‘Roads -> Horizontal Alignment’. A window 
will open from the right. Please notice that the list at the bottom window 
(Topography coordinates) has been changed, and in place of the 
existing points list, now appears a new empty list - the ‘Designed 
coordinates’. 
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A good background for exercising the subject discussed during this chapter 
is project ‘Sample 7’ that can be found installed in the ‘Samples’ directory 
installed in the program’s installation directory. You can open a new project 
and load the project’s coordinates file- ‘Samples7.Tco’. 
  
 
Inserting the IP data of the center line. 
The horizontal alignment definition of the peripheral embankment will be 
performed by defining the embankment center line. As aforesaid, this 
alignment will be defined by IP points, and radiuses (if necessary): 
   
  
Method A:  
In AutoCAD, draw a Polyline (2D Polyline) that will serve as the 
embankment's center line. The Polyline must be closed. 
Choose ‘Select’ from the table on the right (with the list of ‘Select', ‘Locate’, 
‘Pick’, ‘Unused’). 
Move to the drawing area, press 'Enter' at the AutoCAD's command line, 
choose the drawn Polyline and click ‘Enter’. The table from the window on 
the right will fill with the center line IP list. Every vertex in the Polyline will 
be set as the IP of the center line, and in the bottom window their 
coordinates list will appear. 
Notes: 
It is important to draw the Polyline in the clockwise direction.  
For the example you can draw a simple Polyline with 4 vertex (rectangle). 
 
 
Method B: 
In the bottom window, type the IP center line list. For example: 

 
 
Type in the IP names as they were typed in the bottom list, in the table 
from the right. Type the IP under the labeling 'IP' in the table. In this 
example we will enter the list in the following manner:  

 
  
  



 

 

Page 339 of 508  
 
 

CivilCAD 2016 Reference manual 

After defining the center line (both methods), click ‘Apply’ from the right 
window, and ‘OK’ in the new window that opens. The program will draw the 
center line that had been defined with the IP points. 
 
 
 
Defining the beginning and end point of the embankment 
 
The beginning and end point of the peripheral embankment cannot be an 
IP, since you might want to define radiuses for those points as well. For 
this we will add an IP (arbitrary) on the line that connects between the first 
IP and the last. This IP will be used as the beginning and end point of the 
center line. Adding this point, can be done in two ways: 
 
Method A: 
Enter the desired point in the bottom coordinates list, in continuation of the 
remaining IPs,. In the sample of method B that had just been introduced, 
you can add such a point, label it 1000 and it will be: 1000   1000   1050, 
meaning at the following coordinate: Y=1050, X=1000.  

Click on the  button, right of the drawing window. 
In the right hand table, type the new IP names at the beginning and end of 
the list. To do so, stand on the first point, click ‘Enter’, and in the line that 
opens enter the new – IP name (1000 in this example). In the sample that 
had been given, the list from the right will look like this:  
 

  
 
Click on ‘Apply’ from the right window, and again in the window that 
opens. The peripheral embankment center line will be updated according 
to the change entered.  
  
Method B: 
Click on ‘Pick’ from the options list ('Unused', 'Pick' …) at the bottom 
window (please make sure it’s the bottom ‘Designed coordinates’ window 
and not the right window). In the AutoCAD command line the following 
option will appear: ‘Pick point <1000>:'.  
Choose AutoCAD ‘Object snap’ to ‘Midpoint'.  
Move to the drawing and choose a point on the line connecting between 
the first IP and the last IP in the embankment center line. In the points list 
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from the bottom window a new point will appear labeled 1000. Move to the 
list, choose the point and erase its height.  

Click on the  button right of the drawing.  
In the table from the right, type the new IP name at the beginning and end 
of the list (as shown in the upper table). To do so, stand on the first point 
and click ‘Enter’. Type in the new IP name (1000 in this example) in the 
line that opens. Afterwards, stand on the last line, click ‘Enter’ and move 
with your arrow upwards to the new line. Enter the same IP here as well 
(also 1000).  
Click on ‘Apply’ from the right window, and 'Ok' in the window that opens. 
The peripheral embankment center line will be updated according to the 
change that had been entered.  
 
 
 Inserting the radius of the center line 
 
 The next step in the Horizontal Alignment is defining the radiuses at 
the IP points. If we do not define them, the program will refer the radiuses 
as – 0.  
Enter the desired radius for each of the IP’s in the right table. Do not define 
a radius for the first and last radius.  
Click on the ‘Apply’ button from the right. The ‘Layout & contours’ window 
will open.  
Click ‘OK’ again in the window that opens (we will not detail here the uses 
of this window. Later on we will return to this window and explain its 
usage).  
 
The program will create the Horizontal Alignment of the center line that will 
appear in several separate layers. Next to each IP will appear it’s 
coordinate, and next to each arc – the arc data.  
 
When you finish defining the Horizontal alignment, click ‘Close’ in the right 
window. 
 
 
For more information about additional functions in the Horizontal 
alignment window, please refer to Chapter 15 – 'Roads design', section 2 – 
'Horizontal alignment – additional functions'. 
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Defining the cross section of the peripheral 
embankment  
  
In the previous chapter we defined the peripheral embankment alignment 
of the reservoir. Now we will define the cross section of the embankment: 
  
Activate: ‘Roads-> Cross sections’ from the main menu, to open the 
‘Cross sections’ window. This window is divided into three parts: 
The drawing area – the main area where the drawing of the section will 
appear. The name of the current section that is being worked on will 
appear in the heading above the drawing.  
The list of cross sections – right window. 
The existing and designed topography tables for every section – the tables 
at the lower section of your screen: 
Existing G.L. – The existing status topography data from the left table. 
Designed G.L – the designed topography data from the right hand table.  
  
  

Click on the  from the right window (Define sections) – to open the 
Cross Sections setting window. From this window determine the following 
data: 
  
Start at station –station to the first section. The default will be ‘0’. Do not 
change it.  
End at station – station to the last section. The default will be according to 
the length of the center line as it will be computed by the program (this 
length appears immediately when the cross section window opens, at the 
right window – Roads length), and since we are interested in the spreading 
the sections along the entire embankment, do not change this value either.  
Distance between sections – the distance between the cross sections.  
Name of first section – the name of the first section. The program will 
number the remaining sections in an ascending order according to the 
format specified in the window. We will explain both these ‘Format’ 
statuses: 
Format 1 – the first option presents the sections names as they appear in 
the sections list. 
Format 2 –by changing the parameters that appear in the bottom window, 
the program will use this option to present the section’s name in the 
following way: KM + METER. For example, if you leave the value in field 
KM: 0, the program will present the sections like: 0+000, 0+020, 
0+040……, 0+380.  
 
After defining the desired parameters, click ‘OK’ to build the sections. The 
list of sections that were built will appear in the right table according to the 
selected definitions. Each section will have a name and station. If the 
cross-sections are already defined and the sections' names table was full, 



 

 

Page 342 of 508  
 
 

CivilCAD 2016 Reference manual 

the software will display a notice that warns of an existing section 
"Overwrite previous section named" + name of the first section. Also the 
following options will be displayed: 
 Rename section - the software will alter only the name of the section 
according to the new definitions. 
 Overwrite section -the software will delete the section's data and will 
change its name according to the new definition. 
 Leave existing section - the software won't execute any change in this 
section. 
 
By clicking 'OK', the window will display the same options to the next 
section. In order to execute this option to all section, click on button 'OK to 
all'. 
   
 

Activate the Options button  from the right window. The ‘Define 
sections width’ window will open: 
Define the width of section for the project. We are referring to the width of 
the ground that the program will sample for the existing G.L out of the 
topography. We will define a distance from the left center line and a 
distance from the right center line that will together define the width of the 
ground strip. The left end of the section will be defined in the ‘Left’ field 
(default of '– 20' meters), and its right end in the ‘Right’ field (default '20' 
meters), when the distance left of the center line is a negative number and 
the distance from the right is a positive one. In reservoir design of a large 
peripheral embankment, you will need a large strip of ground (mainly for 
the internal embankment of the reservoir – the right side), and so you must 
change the data that appears in the fields (increase it to '40' for example). 
 
When designing reservoirs define the sections' elevations as absolute – 
make sure the work status is on ‘Elevation’ and not on ‘dH’. 
 
Move from Earthworks to Design. This option defines the graphic 
presentation form of the section. The program has two options for defining 
the section: a section for presenting Earthworks, and a section for 
presenting Designed sections. The difference in presentation will be 
shown by the form of the sections in the drawing window, by printing 
through the program to the printer, and by creating a section's file on an 
AutoCAD sheet. The main difference between the two displays is the data 
table. In the section for design purposes, the existing ground data table 
appears at the bottom, and the design data are located on the section. In 
the ‘Earthworks’ sections, all the data will appear at the bottom table, as 
well as two additional lines in the table that present the computation 
method of ‘cut’ and ‘fill’ section area.   

Click on the GetT all button . Click ‘OK’ in the window that opens. The 
program will warn ' About to erase all Existing data' . Click ‘OK’ to continue. 
The program will move across the center line and sample the current 
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existing topography data along it, according to the sections that have been 
defined.  
The sampling of the existing topography data is dependent upon the 
number of measuring points in the project: the number of breaklines and 
number of cross sections that have been defined. In large projects, this 
action might take a long time. CivilCAD 2016 does not limit the project size, 
or the length of the center line, although in slow computers or computers 
with little memory, this might take a while, or even cause the computer to 
“crash”. 
 
 
When the reading of the existing topography data is done, the first section 
will appear in the drawing window and the existing topography data will 
appear in the table 'Existing G.L.'. It is possible to move between the 
sections by pointing on the desired section from the right table. Each 
selected section will automatically appear on the drawing, and its data will 
appear in the tables below. In order to continue, make sure you are in the 
first section.  
  
We will shortly explain the structure of the design table. Each line of the 
table representing a segment. The segments are numbered from -40 to 
+40 (a sum of 81 possible segments for each section). In the table there 
are five columns (the one on the far left is without a heading). To explain 
this, number these columns in an ascending order from left to right, so the 
column on the far left is number 1: 
  
Column number 1: in this column appears the segment’s serial number. 
This number does not represent a distance of any kind. Segments left to 
the center line will be represented by a negative number, and numbers 
right of the center line will be represented by a positive number.  
   
Column number 2 (Offset): this column represents the distance of the 
segment from the center line. The distance left of the center line will be 
entered as negative and the number from the right as positive. There are 
two options for the distance from the center line: absolute distance or 
relative distance. When working with 'dH', the data will be entered as a 
relative distance, meaning that the distance entered is actually the length 
of the segment and not the absolute distance from the center line. When 
working with ‘Elevation’, this data will be entered as absolute heights. 
   
Column number 3 (Elevation): the absolute height of the segment. 
   
Column number 4 (Slope%): in this column you can enter the segment 
slope.  
 
Before we continue, we will shortly explain a number of editing commands 
from the table: 
Clicking on ‘Del’ from a certain field will delete the field. 
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Clicking on ‘Backspace’ (back arrow), to work as usual. 
To delete an entire line, or reduce lines, stand on the far left column 
(column number 1) in the desired segment and click ‘Del’. The program will 
delete the segment and reduce the lines.  
It is possible to copy a segment from the existing cross section to other 
cross sections. To copy, stand on the desired segment and right click with 
your mouse button and choose 'Send to'. From the table that opens, mark 
the sections to which the segment data will be copied and (to choose all 
sections, click on button ‘All’ from the bottom), and click ‘OK’. The program 
will copy the segment data for all the selected sections.  
Begin by entering the design data in the table. To clarify this issue, we will 
demonstrate the data for a typical section that will be followed by a detailed 
explanation. Observe the embankment center line existing status that was 
computed for the current section (see ‘Existing G.L’ table, ‘Elevation’ height 
column of segment 0). Say for the sake of the example, the elevation is 
26.55. We will define the peripheral embankment with height 4 meter in the 
existing section (this height will be determined as the turning point for the 
design start and will change in the course of the design). We will further 
define the width across the load of the embankment as 5 meters, the 
external reservoir slope to be 1:3, the internal slope to be 1:4, and the 
depth of the reservoir as 6 meters.    
  
Enter the following data in the in the ‘Designed G.L ‘ table: 
 

  
 
In field  'Fill 1:', near the caption ‘Slp.left’ (see head of table), enter the 
value ‘3’ (leave all the remaining slope fields including the ‘Slp.right’, empty 
(at ‘0’ value)).  
  
Review the definitions you have entered: segments -1 and 1 mark the 
embankment load distance width as 2.5 meter for each side, 5 meters in 
all. Since you have defined the embankment alignment clockwise, the left 
side will be in the exterior to the reservoir. From this comes the definition 
‘3’, to mark the ratio of 1:3 outward (field: Slp.Left). Segment 2 marks the 
embankment slope inward to the reservoir (6 meters height in the ratio of 
1:4 are 24 meters. With the addition of 2.5 meters of the previous segment 
you get 26.5 meters). 
  
When you finish entering the data, click ‘Apply’ to receive the section. 
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Now we will project    the typical section on the entire center line we 
have built 
  

Click on the ‘Copy’ button  left of the Designed G.L table. After you 
click, the ‘Designed G.L’ table will be copied to the computer’s memory. 
 
Using the table from the left window (the sections list table, left of the 
drawing), move to the last section on the list. Click on the ‘Paste’ button 

, in order to copy the data from memory into the table, in this section.    
  
The main principle of working with CivilCAD 2016, is entering of data in the 
sections in which the road changes (only in those sections!), and filling the 
remaining road parts with intermediate interpolation.  
Now we have two sections filled with data. The rest of the sections are still 
empty (you can see this by browsing between them by clicking on a certain 
section from the right hand- sections list table). 
  
Intermediate interpolation. Click on the ‘Interpolation empty sections’ 

button  from the right. Click ‘OK’. The program will perform interpolation 
to all the empty sections in the project, and since we have only two 
sections only, (first and last), that are similar in capacity, the program will 
fill all the sections with the same design data.  
At the end of the interpolation, you can browse through the sections. At this 
stage, if you are interested you can move to a certain section and change 
its capacity.  
 

Getting the reservoir position. Click on the ‘Create Layout’ button , 
from the right. From the window that opens, mark ‘v’ next to the three 
possible options (Layout, Contours, Distances). Click ‘OK’ to continue. The 
program will create the layout of the reservoir on the drawing, which will 
include the contour lines of the reservoir including dibbling lines.  
 
Note. After clicking ‘OK’ in the Layout window, the cross section window 
will be minimized (so you can view the changes in layout). To maximize the 
screen, click on it from the Windows “Task-Bar” from the bottom of your 
screen. Now you can continue to edit the section data as you wish, and 
change the layout accordingly.  
 
Click on the ‘Close’ button to finish defining the sections and return to the 
main screen. 
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 Additional functions from the Cross Sections window. 
 
We will now explain in detail additional functions from the cross sections 
window, that were not discusses during the sample stages: 
 
 Functions from the cross sections list (right window): 
 

 - deleting a single section – stand on the section you wish to delete 
from the list, and click on this button from the sections list window (right 
window). The program will erase this section from the list.  

 - deleting all the project sections – click on this button from the right 
window. The program will send a warning before deleting all the sections. 
Click ‘OK’ to confirm this action.    

 - deleting section group data. To delete in unity the data of 
numerous sections, click on the ‘Clear all’ button from the sections list 
(right window). From the window that opens, choose to delete the following 
data - Existing G.L. data or the Designed G.L. Click ‘OK’ to continue. From 
the table that opens, mark the sections whose data you want to delete. To 
choose all sections, click on the ‘All’ button from the bottom. Click ‘OK’. 
The program will delete the chosen sections data. 

 - adding height to the sections data. This option is useful mainly for 
working with absolute heights, as demonstrated in chapter 'Roads design'. 
For more details look 'Roads design – Cross sections'.  
 

Functions from the 'Options' window (activate using the button  from the 
sections list right window), from the drawing window (the main window on 
which appears the section drawing) and the table's window(bottom 
window) are explained in the chapter 15 - 'Roads design – Cross sections 
– Additional functions from 'Options' window'. 
 

 

Creating the reservoir model  
 
 
In the previous chapter we have shown how to define the cross section of 
the peripheral embankment up to the bottom of the reservoir. At the end of 
the chapter we have also shown how to view the designed reservoir layout. 
For CivilCAD 2016 to compute the Earthworks volumes of the reservoir, 
the capacity, and create a construction plan, we will have to instruct the 
building of the reservoir 3D model. 
  
Go to ‘General -> Reservoir’ from the main menu. From the right, the 
'Reservoirs' window will open.   



 

 

Page 347 of 508  
 
 

CivilCAD 2016 Reference manual 

Click ‘Apply’ from the window that opens. The program will compute the 
reservoir’s 3D model, create the bottom of the reservoir on the cross 
section definitions of the embankment, and draw the designed contour 
lines.  
  
As explained in numerous chapters in this user guide, the program stores 
two 2D models, one of the existing status, and the other of the designed. In 
order to know the height of a certain point in the models, both in the 

existing and designed, click the ‘Pick height’ button  from the main 
CivilCAD 2016 toolbar, then go to the drawing clicking their mouse on any 
point. The existing and designed heights of the model at the point that was 
clicked, will appear under the heading 'Height_T:' and 'Height_D:' at the 
bottom of the Design coordinates table. CivilCAD 2016 allows the full 
reception of the model. To do so, use the 3D model presentation as 
explained in chapter 10 – 'Quick Sections and the 3D model'. 
  
Additional options from this window. 
 ‘Road’ field – when working on a number of reservoirs, this field will allow 
browsing between the different reservoirs. 
Choice fields – Pond/Dam: 
Pond - a closed reservoir, the example discussed reservoirs that were 
designed as a closed reservoir with a defined peripheral embankment. 
Dam – an open reservoir – the last section of the chapter will discuss the 
main differences when of designing a reservoir defined by a dam 
embankment only.          

Capacity + a capacity computation button  – we will discuss these field 
options, and button later (see “Reservoir capacity”).  
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Balancing earthworks  
  
One of the most important steps in designing a reservoir is receiving a 
relative balance of Earthworks, cut/fill. You can do the Earthworks balance 
by changing the design data on two levels: 
  
Changing the reservoir alignment. 
Changing the designed height of the reservoir. 
  
Changing the reservoir alignment is a bit of a complex option, and on this 
we will go into detail in the section “Changing the alignment of the 
peripheral embankment” of this chapter. We will be discussing the second 
option of changing the designed height in this section of the chapter.  
  
CivilCAD 2016 is a strong, quick, easy tool for balancing Earthworks in a 
project by a quickly changing the height of the project. We will not go and 
physically change the reservoir design, but use the possibility supplied by 
the program of changing the height of the designed model.  
  
Go to ‘Earthworks-> General’ from the main menu. From the right, will 
open the general Earthworks computation window.  
Click ‘Apply’ from the right window. The program will calculate the volume 
of Earthworks in the project, for ‘fill’ and ‘cut’ and present them in a report 
summarizing the table’s data. At the bottom of the table you can see the 
calculated ratio between ‘fill’ and ‘cut’. We will balance the Earthworks by 
“playing” with the height of the reservoir – both embankments and bottom. 
At the right window appears the ‘add to design’ window. Enter a positive 
or negative change of height in this field (an addition or reduction of 
height), and click ‘Apply’ to present the Earthworks quantities as if you 
were to begin designing the reservoir at a higher or lower height according 
to the value entered. For example: 
 
Say the ratio between ‘cut’ and ‘fill’ is 2.5. This indicates that the cut 
volume is 2.5 times larger than the ‘fill’ volume. Enter ‘add to design’ in 
field 2 so the program introduces the volumes by the designed height that 
is higher by 2 meters than the existing height.  
Say the ratio between ‘cut’ and ‘fill’ is 0.8. As of now, the fill volume is a bit 
bigger than the cut volume. By entering 1.5 in the ‘add to design’ field, we 
will get the volumes as if we had designed by a designed height higher by 
1.5 meters than the current height (the change, 2 meters, 1.5 meters etc. is 
always in relevance to the original designed height and not the last height 
entered.) 
Say you just received the ‘cut’ to ‘fill’ ratio   1.1. Since this ratio is 
acceptable (you would want a bit more ‘fill’ over ‘cut’), the implication is that 
if we had designed the reservoir 1.5 meters higher than the existing design 
height, the Earthworks in the project would be balanced.   
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Note: to reduce designed height, enter a negative height in the ‘add to 
design’ field (for example ‘–0.5’). 
  
To physically change the original design of the reservoir, perform the 
steps below:  
  
Return to ‘Roads -> Cross sections’ 
In the window that opens, click on the ‘dH’ button from the right.  
Enter the desired difference, 1.5 meters in this case in the window that 
opens and click ‘OK’ to continue.  
From the window that opens, move to ‘Designed G.L’ using the option 
arrow, and click ‘OK’.  
Now a window will open with the sections list. Click on button ‘A’ from the 
bottom window. All sections in the list will be chosen. Click ‘OK’ to 
continue.  
The program will warn about the change of designed height for these 
sections. Click ‘OK’ to confirm. The heights of all the sections will change 
according to the chosen height change.  

Click on the ‘Layout’ button , and from then ‘OK’ to receive the renewed 
reservoir layout.  
Close the cross section window by clicking on the ‘Close’ button.  
Go to ‘General -> Reservoir’ and in the window that opens, click ‘Apply’ to 
receive the new model and renewed reservoir bottom. 
Return to window ‘Earthworks -> General’ and click ‘Apply’ to get the new 
fill/cut ratio according to the physical change in heights.   

 

Reservoir capacity 
  
In previous sections of this chapter, we have shown how to design a 
reservoir by different stages. One of the things you need to know on the 
reservoir is its volume capacity. CivilCAD 2016 can produce a report that 
describes the reservoir capacity and surface relative to the different levels 
of the water.  
  

 Go to ‘General -> Reservoir’. The reservoir window will open from the 
right.  

 The program will automatically compute the height of the bottom of the 
reservoir, and height of the reservoir’s embankment top and fill in the 
following fields: 

Max liquid level – the maximum water level in the reservoir. The 
value of height that the program will enter as default will be the 
value of height of the embankment top rounded downwards (for 
example, if the height of a embankment top is – 31.79, then the 
maximum water level will be 31).  
Min liquid level – the minimal water level in the reservoir. The 
height the software enters as default will be the height of the 
reservoir bottom rounded upwardly.  
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Compute in steps – the steps in which the report is computed. 
As default, this field will be of ‘1’ value (1 meter). 

  
Note: the fields filled by the program as default can be changed by 
the user.  
  

 Click on the ‘Compute capacity’ button  from the right hand 
window. The program will compute the reservoir capacity report and 
present it according to the parameters in the fields.  
 

In order to locate the capacity report on drawing: 
 

 Click the 'Locate Report on Drawing'  button. 
 Click on the screen at the desired location for the report to be 

displayed. 
 In AutoCAD Command Line, type 's' (for Set) and hit the 'ENTER' 

button. The report will be displayed on drawing. 
 
 

 
Computation of capacity for the area that is not defined by a 
peripheral embankment 
  
The explanation detailed represents the method of computing the volume 
capacity of the reservoir that had been defined by the peripheral 
embankment, according to the different stages that have been detailed in 
this chapter. CivilCAD 2016 allows volume capacity calculation for a 
certain area that is bounded say by mountains, hills or by a dam as 
described in the last section of chapter - “Dams”.   
 
In order to compute the capacity of a certain area, perform these 
following steps 
  

 Go to the Reservoir window (‘General -> Reservoir’ from CivilCAD 
2016 main menu). 

 In AutoCAD, transfer a Polyline (2D Polyline) that will bound the border 
area of the reservoir you wish to compute capacity of it.  

 Transfer from ‘Pond’ to ‘Dam’ from the right hand window. 
 Mark ‘V’ near the ‘Select area’ field. Go to the drawing area and 

choose the ‘Polyline’ that was drawn. Click ‘Enter’ after choosing the 
Polyline. From the right, the writing will change from ‘None’ to 
‘Selected’.  

 Click on the ‘Apply’ button. The program will calculate the maximum 
water level and minimal water level within the Polyline area and present 
them in the fields on the right. At this stage it is possible to change the 
parameters as requested (for example, to compute the water level at 
different steps from the default of   1 meter).  
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 Click on the ‘Compute capacity’ button  from the right window. The 
program will compute a reservoir capacity report and present it 
according to the parameters that exist in the fields.  

 
 

Display 'Dead Capacity' of reservoirs in Capacity 
Report 
 
 
You can calculate 'Dead Capacity' volume and display it in Capacity Report 
of a reservoir. 
To use this feature (after full reservoir design): 
 

 From CivilCAD main menu, go to: 'GeneralReservoirs'. 'Reservoirs' 
menu will open on the right side of the screen. 

 In 'Pipe Level' option, type the desired pipelines elevation 

 Click the 'Compute Capacity'  button. CivilCAD will calculate the 
capacity volumes and display the capacity report on screen. 
 

The capacity between the Minimum Liquid Level and the Pipe Level is the 
'Dead Volume' capacity. 
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Changing the peripheral embankment alignment   
  
As part of the reservoir design, you might have to study various design 
options in which the peripheral embankment alignment of the reservoir is 
changed. In this chapter we will explain how to change the alignment of the 
peripheral embankment, and what are stages you must go through in order 
to fully complete the alignment change.  
  
1. Moving the IP of the embankment central line – there are two methods 

of changing the IP of the embankment central line:  
 A physical change of the coordinate from the ‘Designed coordinates’ 

list. Use the ‘Designed coordinates’ editor to change the coordinate of 
one or more of the IP’s to a new value. Make sure you are keeping the 
point name (say IP1), the same as it was.  

 Using the ‘Move’ option – choose ‘Move’ from the choice list at the 
bottom window (see list from bottom window: Freeze, Locate, Pick…). 
Go to the drawing area and choose the IP point of the location you wish 
to relocate. Choose the first relative point for movement then the 
second. The coordinates of the point in the bottom list of points will 
change according to the new location.  

  

After you have moved the IP to its new location, click on the  button. 
The point will change its location on the drawing. Go to ‘Roads -> 
Horizontal alignment’. Click ‘Apply’ from the window that opens on the 
right, and again in the new window that opens. The program will 
change the embankment center line drawing according to the new 
alignment. Nevertheless, since the length of the center line with the 
position of the sections has changed, you will have to correct the 
sections accordingly, and receive the layout with them (including 
dibbling lines). 

  
2. Go to ‘Roads -> Cross sections’. As you enter the ‘Cross sections’ 

window, the program will compute the length of the new center line and 
present it at ‘Roads length’. In case there were (before the change of 
horizontal alignment), cross sections across the entire center line, after 
changing the length of the center line, they will not exist. We will 
differentiate between two cases: a length of the center line is smaller 
relative to its previous length or bigger. We will explain the change 
needed in the cross sections using two examples: 
 

 Example A: a reduced center line length. Say before the change, the 
center line length was 215.32 meters, and say we divided the center 
line to cross sections every 20 meters. The last two sections of the 
center line were, as aforesaid were at offset 200 meters and   215.32 
meters. Now let us say that after the change, the length of the center 
line had changed to 187.32 meters. This distance will appear at ‘Roads 
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length’, while in the list of sections the previous sections will appear, 
namely these two sections. We will match between the length and the 
list of sections in the following manner: erase the sections at 200 meter 
distance and 215.32 meter distance from the list of sections. Now the 
last section will be at offset 180 meters. Move to the end of the sections 
list, and add a section at offset 187.32. 

 Example B: the center line length had grown. Say before the change 
the length of the center line was 215.32, and say it is divided to cross 
sections every 20 meters. Now, let us presume that it grew to 240.56 
meters. We will erase the section 215.32 from the list of sections and 
add the following sections to the list: 220, 240, and 240.56.   

After matching the sections along the new center line, read 
the existing ground data again. Do so for all the sections, 
both new and previous (since they changed location). Click 
on the ‘GetT all’ button, and click ‘OK’ in the window that 
opens. The program will read the new existing status data 
into the sections. Complete the design for the new sections 
you created (you can do so by using ‘Copy’ and ‘Paste’). 

  

3. Click on the ‘Layout’ button  from the right. In the window that 
opens, click ‘OK’. The program will fix the layout according to its new 
condition.  

 
4. Leave the cross sections window by clicking on the ‘Close’ button, and 

go to ‘General -> Reservoir’. Click ‘Apply’ in the window that opens. 
The program will build the bottom of the reservoir according to the new 
embankment alignment.  

 

Slope of the reservoir bottom  
  
In the course this chapter we have shown how to design a reservoir with a 
straight bottom. We will now show how to create a slope of the designed 
reservoir.  
  
The creation of the slope will be done using one of the two methods: 
  

 Changing the slope by changing the cross section. 
 Creating designed contour lines at the bottom. 

 
  
Changing the slope by changing the cross sections 
This principle is based on changing the bottom segment defined in the 
cross sections, in the sections in which the change in slope exists, and 
doing interpolation between these sections. 

  
 From the drawing layout, choose the sections to which you wish to 

change the bottom height from the edges of the reservoir.  
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 Go to ‘Roads -> Cross sections’ from the main menu. 
 Enter to the desired cross section in the window that opens and change 

segment number 2 in the ‘Designed G.L’ table.  

 Click on the ‘Clear all’ button  from the right. From the window that 
opens choose the ‘Designed G.L’ table (move using the small arrow), 
and click ‘OK’.  

 The list of cross sections will appear. Mark the sections you want to 
delete (these will be the intermediate sections you want to fill with 
interpolation between the sections that were changed). To choose a 
number of sections use the ‘Shift’ and ‘Control’ keys. Click ‘OK’ to 
continue.    

 The program will warn that it is about to delete the designed data. 
Confirm this message.  

 Click on the layout button  from the right. Click ‘OK’ in the window 
that opens. The new reservoir layout will be drawn.  

 Click ‘Close’ to close the window.  
 Go to ‘General-> Reservoir’ from the window that opens from the right, 

and click ‘Apply’. The program will recreate the bottom of the reservoir, 
new contour lines, and build the 3D model again. 
 
Adding of designed points into the bottom 
 

 Make sure that the list of design coordinates appears in the bottom 
window. If the list of topography coordinates appears, change it by 
Design -> Coordinates.  

 Press Pick from the bottom actions' window (Pick, Locate, Freeze…). 
 Move to the drawing area and choose the new elevation's points in the 

bottom. The points will appear in the coordinates' list in the bottom 
window. 
Note: In order to create accurate connection between reservoir internal 
slope to designed bottom, it is necessary to add designed points not 
only into the bottom of reservoir but in the internal slope area also.  

 Use the bottom window's editor to change the new points’ elevation 
(see chapter 2 "Coordinates Database - Coordinates list – Editing the 
coordinates list"). 

 Press  to get the new points in the bottom. 
 In order to build new internal slope according to new designed points, 

go to ‘Design-> Lines’ and Erase all lines from lines list. 
 From the main menu, go to ‘Design->Contours’ and click ‘Apply’ to 

run contours according to new designed points. 
 From the main menu, go to ‘Rods->Cross Sections’ and delete the 

last segment in ‘Design’ table. 
To apply the above changes to other cross sections, stand on the 
desired segment and right click with your mouse button. From the table 
that opens, mark the desired sections to which the segment data will be 
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copied to or click on ‘All’ button to select all cross sections. Click ‘OK’. 
The program will copy the segment data to all the selected sections.  

 Define new slope for reservoir internal slope . 
To apply the slope definition to other cross sections, stand on the slope 
cell and right click with your mouse button. From the table that opens, 
mark the desired sections to which the segment data will be copied to 
or click on ‘All’ button to select all cross sections. Click ‘OK’. The 
program will copy the slope data to all the selected sections. 

 Click ‘Insert Layers’ button . ‘Layers Manager’ dialog box will open. 

 Click ‘Define a new layer’ button  and define sub-layer under 
‘Existing’ e.g. “Bottom”. Click OK to save definition. 

 Click ‘Get design data for all sections’ button . ‘Select table’ dialog 
box will open. Change upper selection to ‘Exsisting G.L.’ and bottom 
selection to sub-layer (“Bottom”). 
 

 In ‘Existing’ table, delete negative segments (-1,-2,-3…) data. 
To apply the definition to other cross sections, stand on the relevant 
segment cell and right click with your mouse button. From the table that 
opens, mark the desired sections to which the segment data will be 
copied to or click on ‘All’ button to select all cross sections. Click ‘OK’. 
The program will copy the segment data to all the selected sections. 

Click ‘Interpolate empty sections’ button  and then click ‘Create 

layout button . 
 From the main menu, go to ‘Roads ->Horizontal Alignment’. Erase all 

designed points within reservoir’s internal slope area (see chapter 2: 
Coordinates database->Drawing commands affecting the list->Erase). 

Click  to update drawing. 
 From the main menu, go to ‘Roads ->Reservoir’. In the window that 

opens from the right, mark ‘V’ in ‘Use last segments’ option and click 
'Apply'. The program will create the reservoir bottom newly, the new 
contours and the new 3D model. 
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Drawing ‘Scraper plan' and sections along the 
reservoir  
 
When you finish designing the reservoir, you will want to execute the plans 
out. CivilCAD 2016 allows:  
  

1. The drawing of a ‘Scraper plan’ on the drawing layout.  
2. Taking out sections along the reservoir. 
  

Drawing the 'Scraper Plan' 
 

 Go to ‘Earthworks -> Grid’ from the main menu. A window will open 
from the right. 

 Choose the spaces in the grid to the direction of ‘X’ and to the direction 
of ‘Y’ by filling in the proper fields in ‘Grid's steps’ (head of right fields). 

 Click on  ‘Pick’ from the right window, move to the 
drawing area and mark: 

  
 The left bottom point of the base line that will define the grid - ‘Base-

first’. 
 The right bottom point of the base line that will define the grid - ‘Base-

second’. 
 A point perpendicular to the base line that will define the height of the 

grid ‘End corner’.  
 

The coordinates of the selected points will be entered in the right window 
fields. We will choose the points that define the grid so it is perpendicular 
to the reservoir.  
  

 Click ‘Apply’ from the right window. The program will create a grid on 
the drawing, according to the defined size. In every corner of the grid, 
the existing status height will appear, the designed status height and 
the difference between them. In every square of the grid, the ‘cut’ and 
‘fill’ volume of this square will appear. When the grid is completed, a 
summarizing report with all the quantities of Earthworks according to 
the grid square sums will appear.  

  
Note: for more details about additional options from this window see 
chapter 9 – “Earthworks – additional issues - Earthworks leveling 
grid.” 
  

Extracting sections along the reservoir  
  

 Go to ‘Roads -> Roads list’ from the main menu. A window will open 
from the right. 
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 From the table at the right window, add a new center line to the list 
(stand at the end of the list and enter the new road name, for example: 
Road2), click ‘OK’ to continue.  

 Draw the Polyline perpendicular to the vertical alignment which we are 
interested in creating. From the main menu activate ‘Roads -> 
Horizontal alignment’. After the right window opens, move using the 
small arrow button at the head of the window, from the embankment 
center line to a new center line we are about to define. From the right 
window choose 'Select', enter 'P' in the AutoCAD command line and 
'Enter', then move to the drawing area and select the Polyline by 
clicking the mouse button and 'Enter' again. In the right window the IP's 
list will appear. Click 'Apply'.  

 After defining the center line move to the Vertical Alignment window: 
‘Roads ->Vertical Alignment’.  

 From the 'Roads list' choose the new defined center line. 
 Click 'GetD' button from the bottom window, from the opens window 

choose the 'Designed G.L.' table and click 'OK'. The Designed table 
will fill by new data.  

 Click 'Apply' to get the designed ground level on the drawing.   
 Click on the 'Layers' button from the AutoCAD Toolbar and freeze the 

'data2' and 'flag' layer. 
 After receiving the desired vertical alignment, it will be possible to print 

them or extract them on to a DXF file using the button  right of the 
drawing 

 
 

Dams  
 
 In the last section of this chapter, we will discuss the difference between 
designing a reservoir of a full peripheral embankment - a Pond, and 
designing a reservoir built from a Dam. The principle mode of operation will 
be similar for the two systems, although designing a dam is simpler. This is 
the order of commands for designing a reservoir built from a dam, with 
emphasis on the difference between the two design types: 
  

 Go to ‘Roads -> Horizontal Alignment’ and define the dam center line. 
It is defined the same exact way as the definition of the reservoir 
peripheral embankment alignment, except here the center line will be 
open (naturally).  

 Go to ‘Roads -> Cross sections’: 

1. Define the cross sections . 

2. Define the width of the existing ground . 
3. Extract the ground sections of existing status from the 

topography.  
4. Define the designed cross section at the desired height (in 

section number 1). Unlike the definition of a cross section in a 
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closed reservoir, do not define here the bottom of the 
reservoir. An example for defining a cross section this case 
may be: 

 

 
 

5. In field: ‘Fill 1:’ near the ‘Slp. Left:’ caption (see head of 
table), and in field: ‘Fill 1:’, near the  ‘Slp. Right:’ (see bottom 
table), enter the value ‘3’ (leave the remainder of the field 
slopes for ‘Cut’ status empty (at value ‘0’)).   

We have just defined the embankment section of the road at a 5-meter 
width, and embankment slope of 1:3 for each side.  

 Copy the first section to the last, and perform interpolation between the 
sections. 

 Draw the layout of the embankment . 
 Finish by clicking ‘Cancel’, and go to ‘Roads -> Reservoir’. From the 

window that opens transfer from ‘Pond’ to ‘Dam’. Click ‘Apply’ to create 
an embankment model. 

 
Continue as explained in the regular reservoir design, in order to get 
Earthworks balances and capacity (see section “Reservoir Capacity” 
earlier in this chapter). 
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Chapter 19: Designing gas 
pipelines 
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Designing of gas pipelines 
 

This chapter will discuss the gas pipelines' planning process. This 
planning founded on road planning. In the chapter the following steps 
will be explained: 

 Project initializing. 
 Layout of the pipeline. 
 Defining of the vertical alignment. 
 Creating DXF files and sheet dividing from the longitudinal 

section. 
 Designing the ditch for laying the pipeline. 

 
 

Project initializing 
 
In order to start the gas line planning project, first follow these steps: 

 
 From the main toolbar activate Roads->Roads list. A window 

will be opened from the right, on this window, the names of the 
pipelines. 

 Type on the table on the right the list of pipelines in the current 
project. Every pipeline in the project has to be titled. The name 
can be Alphanumeric or a number. In contrast to road design, 
the centerlines' names are crucial and should be typed with the 
letters: GAS in the beginning of each name. This way, the 
software acknowledges that a gas line was defined. 

 When finished typing the list, click 'Ok'. 
 Now, execute the background preparation stages (existing G.L) 

as explained in Road design chapter. 
 

 

Designing pipelines' layout 
 
Next, we'll plan the horizontal alignment of the pipelines. 
1) From main toolbar, activate 'Roads-> Horizontal alignment'. A window 
will be opened to the right. Note that the list in the window at the bottom of 
the screen (Topography points) had been replaced and instead of the 
existing points' list,  a new , empty, list appeared on the designed points 
2) Typing the IP data of the centerline. 
There are several methods to enter the centerline's IP data. Two methods 
will be demonstrated here: 
 Method 1- (For AutoCAD users only) -   

 in AutoCAD, transfer Polyline (2D Polyline) that will constitute the 
horizontal alignment of the centerline.  

 Choose "Select" in the table on the right (the table with the list: 
Unused, Pick, Locate, Select).    
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 in the command line of the AutoCAD a notice will appear: Enter an 
option. (<Polyline>/Segment**) type p and click 'Enter'. The 
Segment option enables horizontal planning with the use of advanced 
tools. This option is discussed in detail in chapter 'Road Design - 
Horizontal alignment planning'. 

 Switch to drawing area, choose the drawn Polyline and click Enter. The 
table in the window on the right, will be filled with the data of the 
centerline's IP. Every fraction (Vertex) in the Polyline, will be 
determined as the centerline's IP and the list of their points will appear 
on the window in the bottom of the screen. 

 
Note: The names of the IP points for the centerline will be determined by 
:xIPx, when "x" indicates the number of the centerline and "y" indicates the 
number of the IP. In the first designated centerline (First Select option), the 
IP's will be numbered as follows: 1IP1, 1IP2, 1IP3, 1IP4 etc. In every new 
Select action, the "x" value will grow. 
Another method is available to create the alignment with the AutoCAD by 
using advanced tools. See details in the next clause (Advanced tools for 
horizontal alignment planning). 
 
 

Defining the vertical alignment 
 
After defining the horizontal alignment of the line, the longitudinal section 
will be defined. CivilCAD 2016 software enables longitudinal section 
planning with two methods: Planning In the drawing environment of the 
software and planning in the AutoCAD environment (only in the AutoCAD 
2000 version and up). In order to define the working methods, the several 
stages should be executed: 

 From main menu activate File->Configuration 
 By caption "Vertical alignment mode" choose one of the 

following options: 
o Stand alone - working in the design 

environment of the software (old version). 
o Drawing environment interface - working in 

AutoCAD environment. 
 

1) From the main menu activate Roads->Vertical Alignment. The 
longitudinal window will be opened. The opened window is divided 
to: 

 Drawing area - The main area of the window (black platform). 
 Existing G.L. data table- the table in the bottom left side of the 

screen ("Topography"). 
 Data planning table- The table in the bottom right part of the 

screen. 
 Actions window - right side window. 
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The main drawing - Horizontal alignment and existing G.L., located in a 
separate window below the longitudinal section window (minimizing the 
window will reveal the previous one). 
 
2)  Click the 'Apply' button in the window on the right. The software will 
scan across the horizontal section and calculate the longitudinal section's 
elevations. These elevations will appear on the existing G.L. table (on the 
bottom left side of the screen), as a function of Station and Elevation. In 
the drawing window, the longitudinal section- existing G.L. will be 
displayed. 
The following points should be clarified: 

 The section is scaled by the values in "Elevation" and 
"Length" fields (below caption "View"). 

 The elevations in the bottom screen table, are displayed at 
the location of the cross-sections. For example, if cross-
sections are defined every 20 meters, elevations will be 
displayed in the longitudinal section every 20 meters. In order 
to change the data of the designated elevations, the cross-
sections' location must be change as well. For example, we'll 
change the location to every 25 meters. 

o Click on button  (Options). The main 
definitions window will be opened with caption: 
"Vertical alignment". Enter the desired distance 
by caption "Data intervals". 

o Click ‘Apply’ in the window on the right to 
refresh the drawing. 

 
 

- Even if no horizontal alignment exists or the 
topography is unavailable, the section can be formed 
by entering the data manually to the existing G.L. 
table. To do so, the table should be filled with station 
data (ST) and elevation (Elev). In order to display the 
section after the data is entered, click 'Apply' in the 
window on the right. 

 
- If, following inaccurate topographical data, a partly 

false longitudinal window is displayed, the hand-typed 
existing G.L's data could be rewritten. To delete a line 
from the table, point the mouse pointer over the serial 
number column of the row (far left column) and click 
"Del". The row will be deleted. To accept the change 
on the drawing, click 'Apply' on the window on the 
right. 
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Designing the vertical IP 
 

The following table is an example to a gas pipeline data table: 
 

 
  

 
 St- Station. 
 T.O.P - Top pipe elevation. 
 Slope(%)- The pipe's slope. 
 R - Radius of the vertical arch. 
 Diameter() - The pipe's diameter. 
 Bedding width - Elevation of bedding. 

 
The longitudinal section's planning can be executed by entering data in the 
table or by graphic drawing: 
 

o Method 1 - entering data in the table. 
The data planning table (the table on the bottom right side of the 
screen) is divided to columns by - Number of degrees (far left and 
untitled column), station (ST), Elevation, slope between the 
sections- measured in percentage (Slope %) . Radius of vertical arc, 
pipe diameter (in inches) and bedding width. 
Enter the data in the table and for every section, define its station 
and elevation. The software will calculate the slope between every 
pair of sections and will display it in the relevant section. Instead of 
elevation the slope for the previous section can be entered, than the 
software will fill the elevation column. To delete a false line, point 
your mouse pointer on the serial numbers column (the column on 
the left) against the relevant and click "Del". In order to display the 
planned section's drawing, click 'Apply' on the right window. 
 

o Method 2  - graphical drawing of the data (by using AutoCAD 
window). By this method, it's possible to draw  the longitudinal 
section on the drawing area: 
  

1) Verify that the current layer in the AutoCAD is VerEdit. 
2) Begin to draw the longitudinal section with Polyline (it's possible 

to join several lines). 
3) If you wish to draw the polyline in a specified slope, execute the 

following steps: 
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  Click on button  Define design slope.  
  In the AutoCAD window the notice "Enter slope" will be 

displayed. 
  Type the slope's value and click Enter. 
  Verify that ORTHO option in the AutoCAD is marked 
  Now you will be able to draw the Polyline in the desired 

slope. 
 To change the slope, click aforementioned button and type a 

new value. 
  To finish, click this button, again and then click Esc. 

 
4) In order to update the vertical arcs, their values can be filled 

manually under the caption "R" in the planning table or by 
marking the point through which the arc has to pass.  

 

 Click on button  arc through point        
 Click the desired point in the drawing area. 
 If the arch's transition will be impossible to attain at this point, 

the software will warn about it. 
 * After the point is marked, the value in the radiuses column 

will be updated. 
 

5) Click 'Apply' to finish. 
 
 

o Method 3 - Graphical drawing of the data (without using the 
AutoCAD) 
 Two systems to draw the designated section on the existing G.L. 
section will be demonstrated: 
  

1) Choose 'Pick' in the bottom list (Unused, Pick, Locate, overwrite). 
Switch to the drawing area. Point your pointer to the left side of 
the section (exceeding from the existing G.L. is possible) and 
click on the button on the mouse. The designated point will be 
defined as a vertical turning point and its data will be displayed on 
the planning table (on the bottom of the screen). Continue to 
draw the longitudinal section. In the course of your movement in 
the drawing area, you will be able to see your exact location, 
elevation and distance, below caption "Elevation" and "St" on the 
right of the drawing. When finishing the drawing, click 'Apply' in 
the window on the right. 

 
Note: if you choose a point outside the range of the existing G.L, 
left or right of it, the software will determine the turning point in 
the station located on the edge (0 to the left or the end of the 
existing G.L. section, on the right) of the elevation you were 
positioned at. 
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2) The second method to draw the longitudinal section is by 

’Locate‘. The use of "Locate" is very similar in its modus 
operandi to the "Pick" action accept, when   you choose the 
turning point in any given distance, that point will be determined 
exactly on the elevation of the existing G.L on the same distance. 
 
Note: if you choose a point outside the range of the existing G.L, 
left or right of it, the software will determine the turning point in 
the station located on the edge (0 to the left or the end of the 
natural ground level, on the right) of the elevation you were 
positioned at. 

  
3) Using of 'Move'. If the current vertical IP is to be moved to a new 

location, the action will be executed by "Move". Point on the 
bottom table the IP's location you wish to move. Choose "Move" 
from the list, move to the drawing and determine the new location 
of the IP. Click 'Apply' in the window on the right to refresh the 
drawing. 
It goes without saying that the systems could be integrated 
(manual filling and graphic planning). After the section was 
chosen by graph, the data displayed on the bottom window can 
be changed and click 'Apply' to approve the changes. (For 
example, you can change the slope in ratio to a specific section, 
click 'Enter' to change the elevation according to the slope and 
click 'Apply' to update the drawing). 
The graphic planning is from the old turning point to the new one 
ahead. To add another turning point in the middle of the section, 
point with your mouse pointer the line of the old turning point (at 
the following point, the new point we wish to add is displayed). 
Switch to the drawing and mark the new turning point. The new 
point will be added in the desired place in the table. Click 'Apply' 
on the right to adjust the drawing. 

 
 
Details of the data of the section's drawing 
 

 Accumulated Distance - accumulated distance 
 Existing G.L.- existing ground level 
 T.O.P Elevation - top elevation of pipe 
 Min cover required - this line will be manually updated by the user 
 Horizontal distance - horizontal distance 
 Accumulated construction dist  
 Type of pipe bend - type of arc (vertical, horizontal or 3D) 
 Reference drawings - this line will be updated manually by the user 
 Pipe DATA - diameter of pipe and construction material 
 Section Nr.- section number 
 Excavation depth  
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 Designed slope/bend description - the software will determine the 
bends by the following parameters: 

1) Bend E - radius equal or above 1000D (diameter of pipe). 
2) Bend C - radius between 10D and 40D. 
3) Bend H - Radius up to 10D. 

* The software will display a user error message if the range of the 
radius is between 40D-1000D. 
 
 
Additional actions in the section's window:  
 
Bend numbering - every group of bends will be numbered in an ascending 
order, separately. The user will be able to determine the first serial number 
for every kind of bend. To define this number, follow the next steps: 

 In the Vertical alignment window click the options  button. 
 In the opened window, under caption "Gas, radius indexes", update the 

numbering according to the following bend types: 
 E - Elastic 
 C - Cold 
 H - Hot 

 Click 'OK' to approve and closing of the window and click 'Apply' to 
update the drawing. 

  
Accurate/By sections - Displaying an accurate data of ground level 
longitudinal section or in sections only. When CivilCAD 2016 reads the 
data of longitudinal section of the topography, it executes it accurately, 
correlated from the points' density of the measured points (the software 
builds the longitudinal section of the topography, by the conjunction of the 
triangles' sides it creates of the measurement file). Occasionally, this 
sample, although accurate, isn’t helpful to the user (for example: there is a 
mistake in the measurement file, the mistake appears on the longitudinal 
section but it isn't relevant since it's not in one of the cross-sections). 
Switching from accurate to By sections, will solve this problem as following:   
 

 Accurate - an accurate sample of the section. The line of the section's 
drawing will be the sample taken from the topography. The elevations 
of the table on the bottom will appear according to the cross-sections 
(the default is every 20 meters). In addition, the elevations will appear 
on critical points. 

 By sections - an accurate sample of the section. The line of the 
section's drawing will be constructed by the elevations of the cross-
section's alone. The table on the bottom will remain unchanged. 

 
The advantage of the "By sections" system is in "smoothing" the 
longitudinal section. Its flaw is inaccuracy. 
 
Unlock datum (Working with AutoCAD window, only) - If the section's 
drawing exceeds in the data table, mark this option and click 'Apply'. The 
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software will elevate the section's grid so the lines in the drawing will not 
exceed into the data. When this option is unmarked, the grid's elevation 
will be on 'Lock' mode. 
 
Additional action buttons: 
 

 Pick Point (AutoCAD users) - and pointing at a specified point. After 
clicking this button, the software will display over the design table the 
following related data: 
 

 Station. 
 Elevation. 
 Slp (T) - the existing G.L.'s slope at the specified point. 
 Slp(D) - the designated G.L. slope at that point 

 

 Define design slope (AutoCAD users) - This action enables the 
defining of the slope to the line's drawing. In order to do so, execute the 
following steps: click on this button and on the AutoCAD window, type the 
desired slope's value. By switching the AutoCAD window to "ORTHO" 
mode (on the bottom of the AutoCAD window) the line can be illustrated by 
the specified slope. 

 Importing longitudinal section's data from an ASCII file. This action 
reads existing G.L. into the table (left table on the bottom of the screen) out 
of a text file that contains stations and elevation list. The file should be 
comprised of lines containing station and elevation separated with a coma 
or space. 

 Saving of longitudinal section's data in the ASCII file. This action saves 
the existing G.L. read from the topography (or typed manually), in the text 
file. The text file will be comprised of stations and elevation. 

 Imprinting the Geometric report on top of the layout's drawing. In order 
to imprint the report on ` of the drawing, click this button and the layout 
window will be displayed. Click for the report's location and then type "set" 
and "Enter" on the AutoCAD window. 
 

 Get edges button. Adding the longitudinal section. CivilCAD 2016 can 
be used to ditch/river stream adjusting. This planning will be done in a 
similar manner to the manner of road planning only the longitudinal section 
will be used as the Invert Level (IL) of the ditch. The software can add to 
the longitudinal section of the ditch, the longitudinal sections of the ditch's 
banks left and right. The following is the course of actions to get these 
longitudinal sections:  
Define the longitudinal section of the ditch's bottom. 
Switch to cross-sections and regulate the cross-sections of the 
ditch/stream (for details, see chapter Cross sections' defining). 
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Return to the longitudinal sections window and click the aforementioned 
button. The software will read the planning data from the cross-sections of 
the ditch's edges and will add them in the longitudinal section. The data will 
be displayed both as a drawing and as the additional lines on the table at 
the bottom of the screen.    

 Getting the topography elevations in the specified Offset. In order to 
present the elevations of the topography in a specified distance from 
the centerline, execute the following stages: 

 Mark the option G.L. at Offset (L) and type at the field on the right to 
this option, the distance from the left side of the centerline. 

 Mark the option G.L. at Offset(R) and type at the field on the right to this 
option, the distance from the right side of the centerline. 

 After filling this data, click 'Apply'. The software will add the layers to the 
section. 
 
 

 

Creating DXF and sheet dividing from the 
longitudinal section 
 
After finishing the planning, we would want to display a DXF file of the longitudinal section 
(we could display it only for Existing G.L. ). 
 

 Click button  located on the toolbar above the drawing window. 
 In the opened window, define a scale both for length and height Length 

(example: 1000) 
 In order to create a DXF file without the dividing, choose option "No 

division" below caption "Divide by paper size". If you wish to execute a 
division by paper size, choose the desired page size of the list. 

 To continue, click 'Ok'. 
 In the opened dialogue box, enter the drawing's file name. Click "save" 

to save the file. 
 

The CivilCAD 2016 software enables the division of the 
longitudinal section to several sheets, automatically. This action is 
available only with AutoCAD 2000 and up. In order to divide the 
section to sheets, execute the following steps: 

 

 Click on button  from the toolbar located over the drawing window. 
 In the opened window, define the following data: 

 Type the scale below caption 'Scale' 
 Choose the paper size near caption 'Divide by paper size' 
 Mark option "Show layout"- in order to include the horizontal 

alignment of the same section in the sheet 
 Mark the option "Show sections" - in order to include the section 

itself in the sheet. 
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 Enter overlapping distance between the sheets near caption "Paper 
overlapping". 

 Enter grid distances near caption "Frames grid steps". 
 If you wish to import a BLOCK file containing the north arrow, click 

on the aforementioned button near the caption 'Arrow-block' and 
choose the file's location. 

 If you wish to imprint a Block containing the Logo/Company details, 
click the button near caption Table-block and choose the file's 
location. When choosing, click the block's location on the right or left 
of the sheet in "Table position" option. 

 Click the section's perimeter to appear on the sheets below caption 
'Range'. 

 Click 'OK' to continue. 
 The software will create the sheet division in 'Paper space'. 

 
 
 

Designing the ditch for laying the pipeline 
 
After defining the longitudinal section of the line in the previous 
chapter, we'll define the cross-sections:  
 
1) From the main toolbar activate Roads -> Cross-sections. 

The cross-section's window will be opened. 
The cross-section window is divided to three parts: 

 Drawing area - the main area where the section will be 
displayed. The name of   the current section that is edited, 
will appear on the title above the drawing. 

 The cross-sections list's table - the right side of the window. 
 Existing G.L. and Design G.L. data tables for each section.   

The tables on the bottom of the screen are Existing G.L. - left 
table and Designed G.L. - right table. 

2) Click on button  at the window on the right (Define 
sections)- the cross-sections' definition window will be 
opened. In the window, define the following data: 

 Start at station - station of the first section. The default will be 
0. Usually preferred that the given station for the first section 
at the designated centerline section will be 0. Nevertheless, 
in certain cases we plan a section that is a continuance of a 
centerline. In this case, the distance of the section's runner 
will differ. 

 End at station - station of the final section.  The default will be 
the length of the centerline as calculated by the software (the 
length appear right along with the cross-section's opened 
window on the Road's length window on the right). 

 Distance between sections - the distance between cross 
sections. The default is 20 meters. We'll see later on that 
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there is no necessity in creating serial cross sections. 
Furthermore, the entire centerline can be defined in a non-
serial manner. 

 Name of the first section - the name of the first section 
(number). The software will number the additional sections in 
ascending order according to the designated format in the 
window. The two format situations will be explained: 
The first option is "Format1", displaying the sections' names as they 
appear on the sections' list. 
In choosing "Format2" by altering the parameters displayed on the 
bottom of the window, the software will display the name of the section 
as follows: station +KM, for example: the value at field KM remains 0, 
the software will display the sections as follows: 000+0, 020+0, 
040+0…380+0 

 
Another option for defining cross-sections is by marking the sections' 
location in the horizontal layout planning stage so the sections will be 
placed in fixed locations on top of the measuring background. In order to 
do so execute the following steps: 

 When defining the centerline topography draw Polyline that 
will determine the centerline so its fragment point (Vertex) will 
be on the exact locations where the sections should be 
placed. 

 On the cross-sections' definition window (current window), 
transfer to By Ips. The software will create sections at the 
stations that will be determined by the vertex along the 
centerline. 

 After defining the sections (by either method chosen) click 
OK to build the sections. The built sections' list will be 
displayed in the table on the right, according to the 
definitions. Every section will have a Name and a station. 

 Intermediate sections can be added to the project of any 
stage. To do so execute the following: 

 Place the pointer (with your mouse) on the line into which you 
wish to insert a section. 

 Click 'Enter' on the keyboard all existing lines line will move 
downward and a new line will be displayed. 

 In the new line, enter the name (Number) of the new section. 
The section name can include numbers, "." and "/" (but not 
letters). For example, if the new section is located between 
section 1 and section 2, it can be named 1.1. Move the 
mouse to the station column and enter the station of the 
inserted section. 

Note: instead of defining sections automatically with the white button, it's 
possible to outright move to the window on the right and build the table 
manually- name and station for every section. 

3) Click on the options button  on the right window. The 
cross sections' defining window will be displayed: 
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 Define the section's working width. Meaning, the width of the ground 
level that the software will sample as existing G.L. from the topography. 
We will define the distance of the section’s edges to the left side of the 
centerline and to the right side of the centerline, when combined, will 
define the width of the sections. The left edge of the section will be 
defined in 'Left' field (default is 20 meters) and its right edge- on the 
'Right' field) same default).Distance left of the centerline has a negative 
value number and the distance of the right have a positive value. 

 In the event that a centerline that is all on the right (or on the left) of the 
centerline is desired, an all right (or all left) section can be defined by 
the relevant stations. 

 Switch from Elevation to dH. CivilCAD 2016 software enables to define 
cross section with absolute elevation offset, or sections with relative in 
the centerline. Working with absolute elevation offset will abolish this 
distance’s influence of the longitudinal section over the cross-sections 
and will bide us to define separate planning for every section (or filling 
intermediate section by interpolations). Later in the chapter working 
with typical sections will be discussed and when the sections are 
defined relatively. 

 Switch from 'Earthwork' to 'Design'. This option defines the graphic 
display manner of the section. The software has two options of 
section's definition: section for Earthwork display and a section for 
Design display. The difference in the display will be evident both in the 
section's form on the drawing window, by the printing through the 
software to the printer and by the sections file creation by the AutoCAD. 

4) Click button GetT all . In the opened window, click 'OK'. 
The software will warn that it's about to change the existing 
G.L. to new data and that the previous data will be deleted. 
Click 'OK' to continue. The software will browse through the 
centerline and sample existing G.L. data from it by the 
according to the defined sections. 

 
When finishing reading the existing G.L data, the first section will appear in 
the drawing window and the existing G.L. data will appear on the bottom-
left table. 
At the top of the page (the title above the drawing), the name of the 
displayed section will appear for example - Section name:1. In addition, the 
designated elevation of the centerline will be displayed (the elevation 
defined in the longitudinal section) for example- /Elevation:233.85. The 
sections can be browsed by clicking on the desired section on the table on 
the right. Any chosen section will appear automatically in the drawing and 
its data will appear in the bottom tables. To continue instructions, verify you 
are in the first section. 
 
We'll briefly explain the Design G.L. to be on this table lines are displayed 
and every line stands for a fragment. In the cross-section, the segments 
are numbered from -40 to 40 (total of 81 segments). There are five 
columns in the table (the left one is untitled). In this explanation, these 
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columns are on ascending order from, left to right so the column on the left 
is numbered at 1. 

 Column 1 : on this column the segments' serial number is displayed. 
This number doesn't stand for any measurement. The segments on the 
left of the centerline will be numbered in a negative value numbers and 
numbers in the right of it- on positive value numbers. 

 Column 2 (Offset). This column stands for the distance of the segment 
from the centerline. A distance on the left of the centerline will be 
entered in negative numbers and a number on the right of it- as 
positive. The distance of the centerline has two options: Absolute 
distance or relative one. While working with dH as demonstrated here 
(see clause 24), the data will be typed as relative distances, meaning 
that the entered distance is, in fact, the length of the segment and not 
the absolute distance of the centerline. when working with Elevation, 
this data will be entered in absolute elevation values.  

 
 Column 3 (dH) . This column has two options: dH (as demonstrated 

here) or Elevation. The options are determined in the Status window 
(see clause 24) . When working with dH, the elevations will be entered 
as relative to the earlier segment so the entered elevation is, in fact, the 
elevation of the segment. 

 Column 4 (slope%). In this column, the segment's slope can be 
entered. One of two data typed can be entered: typing dH on column 3 
will calculate the segment's slope automatically and enter it in the fourth 
column. On the other hand, when entering the slope the software will 
calculate the dH and enter it on column 3. 
 
Before we continue, we'll explain certain edit actions that can be 
performed in the table: 

- Clicking on Del in a specified field will cause to erase its content. 
- Clicking on backspace will work ordinarily. 
- In order to erase the entire line, stand on the column on the left 
(column 1) in the desired line and click Del. The software will delete 
the segment and narrow the lines number. 
- It's possible to copy a segment from the current cross section to 
the other cross section. To copy, point your mouse over the desired 
column and right click it. In the opened table, mark the sections that 
the segments data will be copied to (to choose all sections, click on 
the "All" button below) and click "OK". The software will copy the 
segment's data to the designated section. 
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The typical section: 
 

1) Start to enter the table with Designed G.L. data. For further 
clarification we demonstrate a set of data for a typical section. 
Enter the following data to the table: 
Point your pointer to segment "0" (zero), on column 2 enter "1.5" and 
click Enter, move with the pointer to column 3 on the right and enter 
"1.5", then click Enter. The data defines the bottom of the ditch with the 
width of approximately 3 meters (1.5 meters on each side of the 
centerline). 

 
After the data was entered, the table should be displayed as follows: 
 

 
 
on the upper and lower end of the table the following captions are 
displayed: 
Slp. left : Cut 1:        Fill 1:     
Slp right: Cut 1:        Fill 1: 
These fields represent the ditches' banks' slopes on the left and on the 
right: 
Enter “2”  on field: Cut 1: in the bottom of the screen (near caption Slp 
right) Enter the same data to the field located in the top of the table (field: 
Cut 1) The ditch's slopes to the left and right had just been defined to 1:2 
(respectively).  
 

2) Click on 'Apply' on the window to the right. The Design will 
appear on top of the drawing. 

 

3) Click on the ‘Copy’  button on the left of the Designed 
G.L. table. The button is located on the left of the table. And 
the Designed G.L. table will be copied to the computer's 
memory. 

 
4) Using the section's list table on the left of the drawing, move 

to the last section on the list. Click on the ’Paste’  button 
(the button beneath the copy in station in order to copy the 
data from the memory to the table in this section. 
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The principle in CivilCAD 2016 is by entering data in varying sections 
where the cross-section variable and filling the other parts of the centerline 
in by interpolations. In our example, we have two sections filled with data. 
The other sections are still empty (these sections can be viewed by 
browsing between them by clicking on a specified section on the table on 
the right- the section table): 

5) Executing an intermediate interpolation: click on button  
(Interpolate empty sections) on the right. In the opened 
window choose "All Design" and click the OK button. The 
software will interpolate all the empty sections in the project. 
Since we have only two sections (the first and the last) that 
are identical in content, the software will fill all the sections 
with the same Design G.L. data. 

 
 
 
Extracting sections to the drawing sheet: 
 

1) Click on the  button over the drawing window. 
o A window containing the list of sections will be 

opened, mark the desired sections or click the 

button  to choose all the sections and click 
"OK". 

o The software will display a message: " Do you 
want to manually arrange cross sections, or 
CivilCAD 2016 to do it for you?". If you wish to 
arrange the file's structure click "Yes", 
otherwise, click "No" and the software will 
arrange the cross-sections automatically. 

o If you choose to arrange the file's structure 
("Yes"), the software will display a window to 
arrange the cross sections. In this window enter 
the number of sections appearing in each 
column near caption 'Sections in every column' 
and the vertical distance between them near 
caption dY sections (cm). Click 'Arrange' to 
view the structure's chart. To finish, click 'OK'. 

o Choose the name of the file that the software 
will create and click 'Save'. 

Note: DXF file is a drawing file that can be imported by most drawing 
software programs. For example this file can be imported by command: 
DXFIN or by File->Open and converting the file Filter to DXF. After the file 
is imported, click "Zoom" and "Extents" to see all of the sections. 
 

2) Receiving the ditch's layout: in our example click on button 

Create layout  on the right. In the opened window mark in 
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"V" all available three options (Layout, contours, distances). 
Click on the OK button to continue. The software will create 
the layout on top of the drawing. The layout contains the 
contour lines of the ditch, including the edges. 

The layout window contains three options: 
- Layout - marking "V" on this option will create the layout 

lines of the ditch and the caption of the elevations in the 
sections. 

- Contours- this option is inactive in ditch design. 
- Distances - marking "V" on this option will create a layer 

of distances between sections. The software will note the 
distances between every section as well as the distances 
between the section and its nearby tangent. 

- Update current read only - marking "V" on this option will 
instruct the program to update only the current road's 
layout. By removing the "V" mark when several roads are 
defined in the project, the software will update the layout 
of all of them. 

Note: after clicking "OK" on the layout window, the cross section window 
will be minimized (so the layout changes can be viewed). To restore the 
window's former size, click on it on the "mission toolbar" in Windows 
located at the bottom of the screen. Continue to edit the sections as 
needed including extracting the proper layout. When edit of the layouts is 
finished click 'Close'. 

 

Elaboration of the cross section's window 
 
The following is detailed description of the additional actions that exist in 
the cross-sections' window and weren't discussed in the demonstration: 
Actions in the cross sections' window (window on the right): 

 

 Deleting a single section - point your pointer on the desired section 
to be deleted of the list and click the button with the illustration of the 
eraser on the sections' list window (window on the right). The software 
will delete this section from the list. 

 Deleting all sections in the project - click on the button with the X 
illustration in the window on the right. The software will warn before all 
files are deleted. To delete, click 'OK'. 

 Deleting the data of a group of sections - to delete the data of 
several sections simultaneously, click the 'Clear all' button on the 
section's list window (the window on the right). In the opened window 
choose one of the following data to be deleted: Existing G.L., Designed 
G.L, Structure (elevation of the surface of the road) or side- ditches' 
data. Click 'OK' to continue. In the opened table, mark the sections that 
you wish to delete its data. To delete all sections, click 'All' button and 
click 'OK' the software will delete the data of the designated sections. 
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 Adding elevation to the sections' data - this option is useful mainly 
in working with absolute elevations (in relative elevations, it's preferred 
to change the longitudinal sections' data in order to change the cross-
sections' data). To activate, click on the button. In the opened window 
enter the desired elevation addition (to decrease the elevation, enter a 
negative value). To continue, click 'OK'. In the additional window, 
choose the sections you wish to change (Existing G.L., Designed G.L 
or Structure).  Click 'OK' to continue. In the additional window, choose 
the sections you want to change (clicking on 'All' on the bottom of the 
screen will choose all sections). Click 'OK'. The software will add the 
desired elevations to the designated sections as well as the chosen 
table. 
 

Actions on the Options window (activation by button  in the list of 
sections window- the window on the right): 
Some of the actions in this window were discussed in detail on some of the 
stages in this clause. The following are details of the actions that weren't 
detailed: 

 Max/Min interval - occasionally, a scenario where exceeded 
data entered into the sections of the topography. There are 
several reasons for this phenomenon such as false 
measuring data, measuring limit narrower than the desired 
section's limit, extrapolations in the contour etc. To avoid this 
phenomenon, the maximum interval between the elevation of 
the ground and the elevation of the centerline,  can be 
defined. The basic assumption is that the elevation on the 
centerline is always correct (or at least doesn't exceed the 
topography limits). The software is instructed what is the 
maximum elevation interval allowed existing ground level in 
the section. Every fragment that exceeds this interval (on 
either direction) will be deleted of the ground level's data. For 
example, if the elevation in the centerline is 230.55 and we 
entered a Max/min interval of about 3 meters, every ground 
level lower than 227.55 or higher than 233.55 will be deleted 
from the ground level’s data of the section. The effect of the 
data will occur after we sample the ground level by clicking 
the button 'GetT all'. If ground level's data already existent 
that we wish to change, we'll enter the desired interval, click 
'OK' to exit and repeat the 'GetT all' action. 

 Include edges - the principle of action that lies in the 
sampling of ground level's data in CivilCAD 2016 is as 
follows: the software will always sample existing G.L. on the 
centerline and every ground level's fragment identified in the 
cross section will be added to the table. In addition to these 
data, the software will sample the existing G.L. elevation on 
the section's edge, left and right, by the specified width. In 
order to abolish the sampling on the edges, unmark the 'V' 
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and repeat the 'GetT all' action. The software will re-sample 
the data without sampling the edges. 

 
 
Actions of the drawing window:  
The drawing window (the main window on which the section's 
drawing is displayed) has three buttons on its right. The DXF function 
was explained in the instructions. We'll elaborate over the additional 
two buttons:  
 

  Printing the sections at the printer       
 Click on the printer button. 
 In the opened window define the scale to print: Height - scale for 

elevation, Long- scale for length. We'll enter 100, 100 (scale of 
1:100, 1:100). Click 'OK' to continue. 

 In the opened window, define the paper size and other printer 
related parameters. Click 'OK' to continue. 

 Now, choose the sections you wish to print. To choose all 

sections click the button  on the bottom of the screen. Click 
'OK' to print. 

The software will print the sections continuously, by the operating language 
defined in the system. To change the language, execute the following 
actions: 

 Exit the cross sections by clicking 'Close'. 
 Activate File->Configuration. 
 In the opened window, choose by caption Language the desired 

language. 
 Click 'OK' and return to cross sections (File->Cross sections). 
 Repeat the process and print the sections as explained. 

 Zoom extents - there are several actions to control the section's 
display: 
 

 The scroll bars on the left and right of the drawing. 
 Clicking on the left button in the drawing's area-double magnifies 

the drawing. Clicking the right button double reduces it. 

 The zoom extents button   restores the viewing to all of the 
drawing area. 

 
 
Actions in the table window (the window on the bottom): 
 
On the left of every table (left or right), several buttons are displayed that 
enable actions on these tables: 

1)  Deleting all the data on the table in the current section. 

2)  GetT - Import existing G.L. of the current section from topography. 
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 As opposed to the Get all button , this button imports the existing G.L. 
of the current section only. Before the action is executed a warning will be 
displayed of deleting the current existing G.L. data. Approve the warning to 
continue. 

3) GetD  - importing the data of the planned topography. As opposed to 

the GetD all , this button imports the design G.L. of the current section 
only.  Before executing this action, a warning will be displayed of deleting 
the current data approve the warning to continue. If the designated G.L. 
data will be sampled, it’s recommended to execute the following actions 
before performing the aforementioned one: 

1) Click on the options  button. 
2) In the opened window, click the option Design: allocate -40 to 40 
segments. This option enables the software to designate topography data 
of the project by using all 81 segments in the table (Normally, some of the 
segments are reserved for other options such as ditches etc.) 
 
The "copy" and "paste" options were explained at the course of this 
chapter 
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Chapter 20: Drainage and 
Sewage Pipeline Design 
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Drainage and Sewage Pipeline Design 
 
Before you begin, open a new project in CivilCAD 2016 according to the 
directions in the manual.  
 
The work stages in designing sewage and drainage lines are as follows: 
 

 Initializing the project. 
 Preparing the topography and/or designed settings. 
 Designing the pipelines’ layout. 
 Marking crossings with other utilities. 
 Designing sections. 
 Producing reports. 

 

Initializing the project 
 
From the main menu, activate PipelinesPipelines list. 
On the right, a window titled 'Pipelines list'   will open. This is the project’s 
general settings window. 
 

1. Select the pipeline type for the project (sewage or drainage). 
2. Select the work units for the pipeline diameter (mm, cm, inches). 
3. Under Pipelinesnames, fill in every line the names of the 

designed pipelines for the project. 
4. In case of drainage pipeline, under ‘Profile’ cell, double click 

inside the cell with the left mouse button and select ‘Square’ or 
‘Round’ profile. 

5. Click ‘OK’ button to save definitions. 
 

 
We will now go on to designing the pipelines. 
 
You have two design options: 

1.  Design including layout. The layout design will allow you to 
obtain the ground section along the pipeline. 

2.  Design without layout. 
 
For design including layout, go to the 'Preparing the topography and/or 
designed settings' section. 
If you would like to design without layout, go to the 'Designing sections' 
section. 
 
Note: you can mark line crossings whether you are designing pipelines 
with or without layout. To do this, go to the 'Marking the lines crossings' 
section of this chapter. 
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Options from the ‘Pipeline’s list’ window 
 
 

 - New pipeline – adding a new pipeline to the list of pipelines. 
Possible also by clicking ‘ENTER’. 
 

 - Clear all pipelines – clearing all pipelines list (the pipelines will be 
erased from the list and if they have been defined by data it will be deleted 
from the project as well). 
   

 - Erase pipeline – erasing a certain pipeline. Mark the pipeline’s name 
in the list and click this button in order to delete it from the list (if any data 
was defined for this pipeline it will be erased from the project). 
 

 - Find Pipeline – find a pipeline by name in the pipelines list. If you try 
to add a pipeline, using a name which already exists in the Pipelines List, a 
warning window will appear. Click the 'OK' button and type a different 
name for the pipeline. 

 

Preparing the topography and/or designed 
settings 
 
In order to design the pipes’ layout, you will first have to prepare the 
topography settings for the design. You can work with up to two 
topography layers: existing topography settings and designed settings. If 
you are working on a single topography layer, refer to it as existing 
topography setting (even if it is a designed topography such as roads 
surface). 
 
You have several options for inserting the topography settings into the 
project: 
 

 If you have a .DWG file, insert it into the project, as explained in 
Chapter 25 – Handling   

.Dwg Files (follow the steps: Importing a .Dwg file and extracting 
points from .Dwg). 
 

 If you have an ASCII file of the ground, do the following: 
1.    From the coordinate list command buttons (the group of 

buttons located on the top of the 'Topography coordinates' 

list), click on . 
 In the dialog box that opened, select the topography 

coordinates file. The coordinate's data will be entered into the 
coordinate list on the bottom of the screen. 
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 You may enter the topography data manually. 
In the coordinates editing line (the empty line under the title – 
'Topography coordinates'), enter the coordinates’ data in the following 
manner: 
Coordinate name  x y Height 

 
Press ‘Enter’ after entering each coordinate. 
If you have the data of another, designed, layer, replace the Topography 
Coordinates list with Designed coordinates, by choosing Design  
Coordinates from the main menu. 
Enter the designed settings data in the same way that you entered the 
topography coordinates. 
 

After entering the coordinates data press  and create contours. 
 

 From the main menu, select Topography  Contours. 
 Click 'Apply' in the Topography contours window that opens on the 

right. 
 The program will create contours. Wait until the process is completed. 

  
If you have entered designed status data as well, create designed 
contours: 
 

 From the main menu, select Design  Contours. 
 Click 'Apply' in the Design contours window that opens on the right.  
 The program will create designed contours. Wait until the process is 

completed. 

 

Designing the pipelines’ layout 
 

1. From the main menu, activate Pipelines  Layout. On the right-hand 
side, the Layout window will open.  

2. Select the name for the pipeline that you would like to mark in the box 
at the top of the Layout window. 

3. Mark the pipelines’ alignment. 
There are three ways in which you can do it: 

 
Method A: 
   

 In AutoCAD, draw a Polyline (2D Polyline) that will constitute the 
pipeline’s horizontal alignment. 

 Choose 'Select' from the menu:   
 Go over to the drawing area, select the drawn Polyline and click 'Enter'. 

The table in the right-hand window will be filled with the pipeline’s 
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manholes data. In the bottom window – the Design coordinates window 
– the manholes’ coordinates will appear. 

      
 Method B:  

 In the right-hand window, select Pick from the menu:  
 Go over to the drawing area and draw the pipeline’s alignment, press 

'Esc' to finish the drawing.. 
 
Note that while you are drawing, the manholes table is filled with 
coordinates and Stations. In addition, the designed coordinates list 
is filled with the coordinates that you are marking. 

 
 
Method C:   
 

 Enter coordinates into the designed coordinates list on the bottom of 
the screen. Do this by typing in the coordinates in the editing line on the 
top of the list. For example: 
 

256123.76 175143.56 MN1 

256325.56 175200.40 MN2 

256327.12 175256.00 MN3 

 
 In the Layout table on the right-hand side, type in the coordinates’ 

names (MN1, MN2, MN3), according to the following example: 
  

Diam. St. Man Coor.  

      MN1 

      MN2 

      MN3 

 
 
  
You can draw a pipeline that connects with another pipeline in a joint 
manhole, in the following ways: 
 
If you are using Method A, after you have followed all the steps for the 
layout design for the primary pipeline and proceeded to plan the secondary 
pipeline that connects with the primary one, do the following: 

 When you are drawing 2D Polyline of the secondary pipeline, connect 
its Polyline to the main pipeline at an intersection point (IP) that is 
shared by both pipelines.  

 Proceed with the other commands normally. The IP will be interpreted 
as a joint manhole for both pipelines. The program will mark the joint 
manhole with a “+” in the secondary pipeline. 
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Note that for each manhole in the Layout table, the coordinates name 
appears on the left (Column: Coor.). The coordinates data appears in the 
Design coordinates table on the bottom of the screen on the left. 
It is advisable to leave the coordinates’ name in the Layout table 
unchanged, so as not to lose the connection between a manhole and its 
coordinate. 
In fact, you may change a manhole’s location by changing its coordinates’ 
data in the Design coordinates table. 
In the 'Additional options in the layout window' section you will find details 
on moving manholes. 
  
4. Type in the pipes’ diameters. Across from every manhole in the Layout 

table on the right hand side, type in the desired radius. 
 

5. Click 'Apply' to draw the lines.  
The program will create a drawing of the line’s horizontal alignment.  

  
In order to proceed to designing the next line, select the line’s name in the 
box at the top of the Layout window, and perform the design as explained 
above.  
 
Note: you do not need to click 'Apply' after the design of each and every 
line. You can finish designing all the lines, and click 'Apply' to have the 
program build the lines’ drawing.  
 
 

Additional options in the Layout window 
 

1. Changing the font size. Click on the Options button:  
 Scale - in the window that opens, type in the desired scale. 
 Pipes number in select mode (manholes prefix) – changing of 

names' numeration of manholes' points. For example: enter the value 2, 
and the next pipeline will include the following names: 2MN1, 2MN2, 
2MN3 etc. Click 'OK' after the changing.  

 Pipeline width – the pipeline width on the drawing. 0 indicates the 
default width, 1 – without width.   

    Click 'OK' again to update the drawing. 
 Display angle value – mark ‘V’ to receive angle data on pipeline’s 

layout. 
  

2. Clear all manholes, using the button . 
  

3. Delete one manhole – mark the desired manhole and click . 
 

4. Show pipeline in the drawing. Click  The current pipeline will be 
marked yellow. 
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5. Pipe type – entering of free data by user. 
 
6. Moving a manhole. 
 

Note that each manhole is tied to a coordinate. If you alter coordinate 
data in the coordinate's window on the bottom of the screen, the location 
of the manhole that is defined by that coordinates will change 
accordingly. 
In order to move a manhole, you have to move the coordinate that is tied 
to it. 
You can do this in two possible ways: 
 
 Manual change of the coordinates’ data. 

 Select the coordinate you would like to change from the coordinate 
list on the bottom of the screen. Re-edit the coordinate in the points 
editing line (the empty line under the caption: ‘Design coordinates’). 

 To actualize the change in the drawing, click 'Apply' in the Layout 
window on the right-hand side. 
 

 Moving the manhole from within the drawing. 
Select the 'Move' option from the rectangle on the right-hand side of the 
deigned coordinates list on the bottom of the screen:  

  
 
Go over to the drawing area. Select the point that you would like to 
move and click on it twice. Now click on the new location to which 
you would like to move the point. To actualize the change in the 
drawing, click 'Apply' in the Layout window on the right-hand side. 

 
7.  Changing the shape of a manhole in the drawing. 

You can determine whether the shape of the manhole will be round or 
square. The default is round manholes for sewage projects and square 
ones for drainage projects. In order to change the shape of the manhole 
– mark the manhole you wish to change in the Layout table using your 
mouse stand on the right column (Diam.), and click on the right button. A 
box will open, with 2 options: Round and Square. Choose the desired 
shape by clicking twice. The next time you click 'Apply' the drawing will 
be updated accordingly.  
 

8.  Drawing a pipeline that ends without a manhole. 
If you want to end a pipeline without a manhole (for example, in an 
estuary area), add the (-) sign to the right of the name of the manhole. 
For example: 1.3-. 
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The program will recognize that this is a point without a manhole and will 
not draw a manhole for it. 
 

9.  Changing the name of a manhole.  
You can change the name of the manhole in the Man. column in the 
Layout table. 

 

Marking crossings of the pipeline with other 
utilities 

 
You can mark crossing points between project pipelines and pipelines that 
don’t belong to the project, if these points are known to you. 
To do so, select Pipelines Crossings from the main menu. 
The Crossings window will open on the right. 
 
St. - station. The place where the crossing pipeline passes upon the 
designed pipeline (in meters). 
I.L. – the crossing pipeline’s elevation (not obligatory to enter). 
Dpt. – the depth of pipeline (not obligatory to enter). 
Diam. – the crossing pipeline’s diameter (not obligatory to enter). 
Type – the layer of the crossing pipeline. 
 
 
1. In the box at the top of the window, select the pipeline for which you 
want to mark crossings.  
2. Fill in the Station data 
   There are several options for entering the Station data: 
 
 
Method A: manually. 
In the Crossings table, enter the Station of the crossing pipelines in meters. 
 
Method B: using Pick. 

 Mark ‘Pick’ in the bottom box of the window. 
 Move to the drawing area and mark the point near the desired 

pipeline. The Station data will be automatically entered into the 
Crossings table. If you want to mark coordinates that already 
exist in the drawing, you can snap them by using the ‘Object 
Snap Settings’ option to a coordinate in AutoCAD. 

Method C: using Locate. For this you must first add the crossing 
coordinates to the designed coordinates list in CivilCAD 2016, show them 
in the drawing, and then select them by using ‘Locate’: 
 

 From the main menu, select ‘DesignCoordinates’. 
 Enter the crossing point’s coordinates in the Design Coordinates 

table, on the bottom left-hand side of the window. Typing in the 
coordinates is preformed in the coordinates editing line at the top 
of the Design Coordinates window, in the following format:    
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      coordinate name           x             y 
 

(Do not enter coordinate elevation). Press ‘Enter’ after entering 
each coordinate. 
 

 Click  to refresh the drawing. When refreshed, the 
coordinates will appear in the drawing. 

 Select ‘Locate’ in the Crossings window on the right. 
 Move to the drawing area and mark the coordinates you have 

previously entered in the Design Coordinates table by snapping 
them. The Station data will be automatically entered into the 
Crossings table.  

 
 
Method D: using Select. You can choose the crossing of the current line 
by marking a drawn line on the layout – even if it is not defined as a project 
centerline. Click on ‘Select’, move to the drawing area and mark the 
desired line. Click ‘Enter’ to update the table with stations and compute the 
elevation intersection according to the elevation defined in the line that is 
drawn. If the line you chose has no elevation – the program will define the 
intersection elevation as 1.5 meters under existing status elevation at the 
same point.  

 
Method D: using Filtering - (for AutoCAD users only). You have the 
option of choosing between a number of pipelines crossing the designed 
pipeline by filtering these lines from the drawing, from a number of layers 
and a number of pipelines simultaneously by repeating the following: 
 

 Filter crossings lines from a .dwg file – click this 

button  to open the ‘Filter crossings’ window.  
 ‘Layers’ – it is possible to mark from the list of layers, 

the layers containing the lines and the Entities list, the 
type of lines, or use ‘Select’ and click on the line or 
lines symbolizing the line type and layer from which 
the filtering will be done.  

 Click ‘Apply’ to filter. For lines that do not have 
elevation, the program will select the intersection 
elevation as 1.5 meters under existing status elevation 
at the same point.  
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Additional options from the Crossings window 
 

 - Delete one crossing. 
 

 - Clear all crossings.  
 

 - Options button. This button brings us to the window of 'Table of 
crossings'. This button is used for description of crossing pipelines in the 
sections window drawing. 
Type – the name of the intersection point of crossing and designed 
pipelines. 
Description – you can enter the description of the crossing pipeline and it 
will appear on the drawing of the sections window.   
Min. (m) - this option defines a minimum distance between the crossing 
pipeline and the designed pipeline. Assuming the crossing pipeline is 
nearer than the defined distance, the software will automatically change 
the design, moving the designed pipeline's location to fit the Min. distance. 
If no distance has been entered the default minimum distance between the 
crossing pipeline and the designed pipeline is 0.3M. 

 - Delete one description.  

 - Clear all descriptions. 

 - locate crossing pipelines in the layout drawing, directly from the 
'PipelinesCrossings' menu. 

 

 
Designing sections 
 
1. From the main menu, activate: PipelinesSections.  
    The Sections window will open before you. 
    The window that opens is divided into three parts: 
 

 The drawing area (the black surface) 
 The Ground level table – the table on the bottom left-hand side 

(Topo). 
 The Manhole's details table – the table on the bottom right-hand 

side. 
 
2. Select the line that you would like to design in the box at top right-hand 
side of the   

    window:  
  

3. Click on the Options button:  
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    The Options window will open on the left. In this window you can 
determine the   
    status by which the program will apply the design: 
 

 Slope calculation – you can choose to calculate the slope 
either from the center of the manhole or from its edges.  

 Min. Manhole's Cover  - coverage of a manhole in case it is 
exposed above ground level. 

 Min. Pipe's Cover – if this data exists, the program will warn you 
at the points where the pipeline is exposed, by marking the 
ground of the exposed areas in orange. 

 External Drop – you can determine that the program will draw 
an external drop, for drops over a certain elevation.   

 Keep slopes inside manholes – if this option is marked, the 
program will maintain the entering slope of the pipeline into the 
manhole, inside the manhole itself. 

 Fit pipes top levels  -  
 Check crossings – the program will check the designed 

pipeline's height in the intersection with crossing pipeline and will 
change it if required according to the value in Min. (m) column 
(Options button of the Crossing window). 

 Keep fixed IL – with this option the software will save the fixed 
Invert level of manholes, even if we'll change the slope of one of 
manholes. 

 Keep fixed slopes - with this option the software will save the 
fixed slopes of manholes, even if we'll change the IL of one of 
manhole. 

 Slopes precision – the type of precision of slopes' captions' 
showing in the table of section's drawing. 

 Manhole's size table – the change of manholes' size division 
according to the depths (for more details look the chapter 
'Additional options in the sections window'). 

 
  
4. Get the topography data. 

 If you preformed the steps in the sections: ‘Preparing 
the existing Ground level’ and ‘Designing the pipeline’s 
Layout’, the program can create the existing 

topography from the layout: click on the  button 
that appears left to the topography table. The 
topography table will then be filled with the existing 
ground level according to the Station and ground level 
elevation data. 

- If you haven’t preformed the ‘Designing the Layout’ step – 
enter the topography data in the topography table, according 
to Station, Distance and Elevation. 

 
5. Entering the designed ground level (not obligatory). 
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 If you preformed the steps in sections: ‘Preparing the 
existing ground level’ and ‘Designing the Pipeline’s 
Layout’, the program can create the designed ground 

level from the layout: click on the  button that 
appears left to the topography table. The design table 
will then be filled with the topography data. If you 
would like to enter designed ground level manually: in 
the Ground Level table, select ‘Design’.  

Enter the designed ground level data the same way as you 
entered the ground level. 

 
6. Click ‘Apply’ to bring the drawing (appears on the right). The topography 
drawing will appear on the screen marking the manhole locations, if 
existing. 
 
7. Enter the manhole data: 
 

 Man. – the manhole numeration. 
 St. - Station (in meters). If you preformed Location Design, this data 

will already appear in the table. If the data does not appear, enter it 
for the designed manholes. To add a manhole, press ‘Enter’. 

 Distance – the distance between two manholes. You can enter the 
distance between manholes instead of Station, as long as you enter 
0 in the St. of the first manhole. 

 IL Lt. – Invert Level in. You can enter the Invert Level 
in several ways: 

 Entering the IL Lt. data for all the manholes. 
 Entering the manhole depth (see – Depth). 
 Entering IL Lt. for the first manhole and the 

slopes for the remaining manholes (see 
Sl.%). 

 Interactive pipeline design (physical drawing 
the manholes – see the ‘Additional Options’ 
section). 

 Drop - the drop inside a manhole. Meaning, the difference between 
Invert level in (IL Lt.) and Invert Level out (IL Rt.) (in meters(. 

 Depth - the manhole’s depth (in meters). You can enter this data for 
a manhole, instead of entering IL Lt. If designed ground level exists, 
the depth will refer to it. 

 Sl.(%) – the slope of the pipeline entering the manhole. You can 
enter the Slope level instead of the Invert level. 

 Diam.– the pipeline’s diameter. 
 Wall thick – the pipeline’s wall thick. 
 Receptors – Define receptors. 
 Size – the size of the manhole. If the manhole is round, enter ‘*’ to 

the left of the size, for example: *100. If the manhole is square, 
enter as following: 100/80. Size units of your choice. 

 Pop – the bulge of the manhole above ground level (in centimeters). 
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 Ground – the manhole ground level elevation. Not to be entered by 
the user. The program will fill in this data. If designed ground level 
exists, it will appear in this column. If there is only existing ground 
level, it will appear in this column. 

 Gr.Sl.(%) – the ground slope. Not to be entered by the user. As in 
its precedent, the slope refers to the designed topography, if it 
exists. If it does not, the slope will refer to the existing ground level. 

 
6. Click ‘Apply’ to draw the design. 

 
 

Additional options from the sections' window 
 

 Save project - (from the top toolbar) – saving of the entire project 
data, without exit from sections' window. 

 

  
     Creating a DXF file for a longitudinal section: 

 Click on the  button to open this window. 
 Fill in the scale in fields ‘Length, Height’ 
 In order to type the section by a specific sheet size, 

choose the desired sheet size from the list that 
opens under ‘Divide by paper size’. 

 In order to extract the current section only, click ‘OK’. To create a 
file with all sections, click ‘DXF all’. 

 A box will open for saving files. Choose the directory for saving the 
files, enter the file name and click to save.  

 

 Button Section printing – clicking this button will open a new 
window. Enter the scale and click ‘OK’ to print this section. 
 

 Button Full display – click this button for a full display of the entire 
section on the drawing window.  

 

 Deleting a manhole. This button deletes the entire manhole, 
including the Station. 
 

 Deleting the data of all manholes. (This function does not totally 
delete the manhole – the Station data and distance between manholes 
are saved). 
 
Adding a manhole. Mark the first column (from the left) in the manhole 
table, in the row following the row of the manhole you would like to add, 
and press ‘Enter’ on the keyboard. In the new row that appears, enter 



 

 

Page 392 of 508  
 
 

CivilCAD 2016 Reference manual 

either the station for the new manhole, or the distance between it and 
the preceding manhole and the rest of its details. 
 

 Copying the ground level Stations to the manholes table. This 
function will copy the Stations from the Topography table to the 
Manhole's table, for convenient designing. 
 

 Getting the designed ground level. (On condition that designed 
ground data, including designed contours, exists in the project, as well 
as a designed pipeline layout). 
 

 Entering the manhole size automatically. 
The program will fill in the respective manhole size according to its 

standard height.  
 

Modifying the division of manhole sizes according to depths – 
You can determine the way the program will enter the manhole sizes. 

 Click on the Options button  :  
 In the window that opens, click on the ‘Manhole's Size 

Table’ button. 
 A ‘Manhole's sizes’ window will open. 
 In the column labeled ‘Size’, enter the manhole size 

(for a square manhole, enter according to the format: 
80/100). 

 In the column labeled ‘Up to depth’, enter the 
maximum depth for which the respective size will be 
given. 

 Click 'OK’ to confirm. 
 

You can determine a permanent desired division for each new project 
in CivilCAD 2016 by following the aforementioned steps in a project 
named ‘Prototype.prj’, and saving the changes. 
 

 Automatic designing. The ‘Auto Design’ window will open before 
you. You can use automatic designing in two methods: 

 Method 1: in this method, the user enters 
one manhole’s IL Lt. in the manholes table, 
minimum pipeline coverage, and minimal 
pipeline slope. The program will build a line 
with minimum slope and will change the 
line’s slope in the case of pipeline exposure. 

 Method 2: in this method, the user enters 
one manhole’s IL Lt. in the manholes table, 
minimum pipeline coverage, and a slope for 
the pipeline. The program will maintain a 
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constant slope for the pipeline, and if the 
pipeline is exposed, it will create a drop in 
the manhole before the exposure. 

Fill in the data respectively and click ‘OK’. 
Notice that the manholes data has been filled accordingly. 
 

 Method 3: gravitational pipeline design. 
 
 From CivilCAD main menu, go to ‘PipelinesList’ and define 

the pipeline's type as Sewage/Drainage. 

 From CivilCAD main menu, go to ‘PipelinesLayout’ and 

design the pipeline's layout. 

 From CivilCAD main menu, go to ‘PipelinesSections’. 

 In 'Manholes details' table, under 'Il Lt.' column, define the IL 

for the first station and click the 'ENTER' button. 

 Click the 'Auto Design'  button. 'Auto Design' window will 

open. 

 Click the 'Auto Design'  button. 'Auto Design' window will 

open. 

 Checkmark 'Mode 3: Gravitational design' and click the 'Define 

slopes according to stations'  button. 'Pipes stations' 

window will open. 

 Type the desired conditions for the gravitational pipeline's 

design. 

Note: CivilCAD will check the data entered in 'Slope' and 'Depth' 

columns. For example: for slope of 1% and I.L. depth of 60 cm, if 

the I.L. in the next manhole is  less than 60 cm, CivilCAD will 

deepen the I.L. up to 60 cm and the slope's percentage will 

increase. 

 Click the 'OK' button to start the design. 

 

 Getting the topography settings for all pipelines. (On condition 
that designed ground level, including contours, exists in the project, as 
well as a designed pipeline layout). 
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 Getting the designed ground level for all pipelines. (On 
condition that designed ground data, including designed 
contours, exists in the project). 

 The sections' file importation. By clicking this button it's possible 
to choose the ASCII file that includes the section's data from the list of 
files.  

 Adding of manholes' height. After clicking this button mark the 
manholes you want to add\lower their height in opened window, or 
press 'A' to choose all of manholes, and press 'OK'. In the next window 
that opens enter the value to change the height (the negative value will 
lower the manholes' height).  

        

 
Options from the right window 
 

Topography data - smoothing the ground level. By moving to 
’Smooth’ option the ground level will be drawn smoother but less exact 
(the program will have created certain a distortion in the drawing so the 
line can be smoother). 
 
View – the section’s display range. Leaving the data under this 
heading empty defines the section’s full display for the software (the 
section’s full length appears next to ‘Total range’). It is possible to 
display the section of a particular segment by entering the starting and 
final station into the fields ‘From, to’. The change of section elevation 
will be done according to the change of ‘Height factor’ parameter. 
Click ‘Apply’ after changing this data to update preview.    
  

 Changing colors in the section layer – it is possible to control the 
colors in each section layer by clicking on the squares located at the 
top section on your screen next to these headings: 

 Ground level - existing status elevations layers. 
 Design level – designed status elevations layers. 
 Manholes - coordinates layer. 

 
Clicking the layer color opens a window containing colors from which 
you can select the desired color.  

 
 

Interactive pipeline design. You can interactively draw a 
pipeline on the screen, instead of entering Invert Level data. 

 Select the option ‘Pick’ in this box:  .  
 Move to the drawing area and draw the pipeline. 

Notice that you can both snap to existing manholes 
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and create new ones. The table will be updated while 
you are drawing. 

 
Using Locate – enables you to locate a manhole in the drawing. 

 In the table, select the manhole you wish to locate or 
modify. 

 Select ‘Locate’ in the box:  
 Move to the drawing area. The curser will link to the 

chosen manhole.  
 Click new point for moving the manhole, then 'Esc' and 

'Apply'. 
 

 

Producing reports 
 
Activate form main menu 'Pipeline -> reports'. 
In the opened window on the right, choose the report's type that you wish 
to get: 
 
Manholes report. 
By clicking on the report extracting button the software will display a 
detailed report of the manholes' data. This report can be displayed on top 
of the drawing by executing the following actions: 

 From the opened list choose 'Manholes'. 
 To produce the report click 'Apply'. 
 After the software will display the report, close the report's window and 

click on button . 
 Switch to the drawing's area and click on the desired point for the report 

to be located at the bottom left corner of the report’s table. 
 A yellow frame will appear on the drawings, type 'S' in the AutoCAD 

command line and click 'Enter'. 
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Quantities Report. 
For sewage and drainage pipes only. 
This quantities report is comprised from two reports: 

1) Manholes report in drawing their diameters and depths. 
2) Manholes report by sizes and depths.  

  Mark "V" the number of pipelines that you wish to include in the report 

or click   button  to mark all pipelines. 
  Division by depth existing coincides with the conventional division. A 

different depths division exists for sewage pipelines and sewage 
manholes. In order to change the depth division system for the report 
production: 

 Click on button  depth segments. Under the headline 'Depth 
segments' enter the depths for division and at the end, click 'OK'. 
  

 Click 'Apply'. 
 
 

Setting a permanent depths division 
 
You are capable of changing the division method to depths for a 
quantities report on a regular basis, for every future project opened 
in CivilCAD 2016. 

 
To do so you must enter the division of your choice in the ‘Prototype’ 
project. Open project Prototype (File ->Open Project’).  
 
In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Prototype.prj\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Protorype.prj\ 
 
 
From the main command ruler open: Pipelines-> Pipelines list. 
Choose the type of desired project (Sewage/Drainage). 
 

 Open menu Pipelines-> Reports. 
 From the Reports window choose the Quantities.  

 Click on  button (Depth Segments).  
 From the window that opens enter the depths for division. 
 Click ‘OK’ to confirm and close the window.  
 Close the project and save the changes. 
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Now every new report opened will receive the division you have entered in 
Prototype Project. 
 
Pipes report. 
Pipes' length report by diameters. This report displays the sum of pipelines’ 
length for every diameter   defined in the project. 
 
Detailed report . 
A detailed report displaying the manholes' data, existing G.L. and designed 
settings along the pipelines. It's possible to choose all pipelines by clicking 

on button  or to mark "V" for the pipelines we wish to include in the 
report. 
 
Discharge. 
Flow chart report. A report displaying the chart flow for every pipeline. 
Choose from the list in report window Discharge. 

Click on button 'Discharge Input'  . In the opened window enter the 
discharge (Q.(lt./sec)) at each station. 
In flow report the following computations will appear: 
 Q [lt./sec] – discharge. 
 H [m.] – height of fluid in pipe. 
 V [m./sec] – velocity of flow. 
 Q max [lt./sec] – maximum discharge in pipe. 
 
 

Additional options from the reports window  
 

 Print the report by clicking this button from the report window.  
 

 Save the report as a text file - click this button appearing in the reports 
window will open a window for saving files. Select the desired location for 
saving, type in the file name in the right line, and click ‘Save’. Now you can 
open the file and edit it as you like. 

 

 Exporting the report to an ‘Excel’ file – click this button from the 
report window to open an Excel sheet the program has filled with data from 
the last report.  
 

 Clear report. 
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Chapter 21: Water pipeline 
design 
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Water pipeline design 
 
Before you begin, open a new project in CivilCAD 2016 according to the 
directions in the manual.  
 
The work stages in designing water pipelines are as follows: 
 

 Initializing the project. 
 Preparing the topography and/or designed settings. 
 Designing the pipelines’ layout. 
 Marking crossings of the pipeline with other utilities. 
 Designing sections. 
 Producing reports. 

 

Initializing the project 
 
From the main menu, activate Pipelines Pipelines list. 
On the right, a window titled 'Pipelines list'   will open. This is the project’s 
general settings window. 
 

1.  Select the pipeline type for the project (water supply). 
2.  Select the work units for the pipeline diameter (mm, cm, inches). 
3.  Under Pipelines names, fill in every line the names of the 

designed    
     pipelines for the project. 

 
We will now go on to designing the pipeline. 
 
You have two design options: 

1.  Design including layout. The layout design will allow you to 
obtain the ground section along the pipeline 

2.  Design without layout. 
 
For design including layout, go to the preparing the topography and/or 
designed settings section. 
If you would like to design without layout, go to “Designing Sections” 
section in this chapter. 
 
* You can mark line crossings whether you are designing pipelines with or 
without layout. To do this, go to the “Marking Pipeline Crossings” section in 
this chapter. 
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Options from the ‘Pipeline’s list’ window 
 
 

 - New pipeline – adding a new pipeline to the list of pipelines. 
Possible also by clicking ‘ENTER’. 
 

 - Clear all pipelines – clearing all pipelines lists (the pipelines will be 
erased from the list and if they have been defined by data it will be deleted 
from the project as well). 
   

 - Erase pipeline – erasing a certain pipeline. Mark the pipeline’s name 
in the list and click this button in order to delete it from the list (if any data 
was defined for this pipeline it will be erased from the project). 
 

 - Find Pipeline – find a pipeline by name in the pipelines list. If you try 
to add a pipeline, using a name which already exists in the Pipelines List, a 
warning window will appear. Click the 'OK' button and type a different 
name for the pipeline. 
 

 

Preparing the topography and/or designed 
settings 
 
In order to design the pipes’ layout, you will first have to prepare the 
topography settings for the design. You can work with up to two 
topography layers: existing topography settings and designed settings. If 
you are working on a single topography layer, treat it as existing 
topography setting (even if it is a designed topography such as roads 
surface). 
 
You have several options for inserting the topography settings into the 
project: 
 

 If you have a DWG file, insert it into the project, as explained in 
Chapter 19 – Handling   

DWG Files (follow the steps: Importing a DWG file and extracting 
points from DWG). 
 

 If you have an ASCII file of the ground, do the following: 
 

1. From the coordinate list command buttons (the group of buttons 
located to the right of the Topography coordinates on the bottom of the 

screen, click on . 
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2. In the dialog box that opened, select the topography coordinates file. 
The coordinates data will be entered into the coordinate list on the 
bottom of the screen. 

 
 You may enter the topography data manually. 

In the coordinates editing line (the empty line under the title – 
Topography coordinates), enter the coordinates’ data in the following 
manner: 
Coordinate name  x y Height 

 
Press ‘Enter’ after entering each coordinate. 
If you have the data of another, designed, layer, replace the Topography 
Coordinates list with Designed coordinates, by choosing Design  
Coordinates from the main menu. 
Enter the designed settings data in the same way that you entered the 
topography coordinates. 
 

After entering the coordinates data press  and create contours. 
 

 From the main menu, select Topography  Contours. 
 Click 'Apply' in the Topography contours window that opens on the 

right. 
 The program will create contours. Wait until the process is completed. 

  
If you have entered designed status data as well, create designed 
contours: 
 

 From the main menu, select Design  Contours. 
 Click 'Apply' in the Design contours window that opens on the right.  
 The program will create designed contours. Wait until the process is 

completed. 

 

Designing the pipelines’ layout 
 

1. From the main menu, activate Pipelines  Layout. On the right-hand 
side, the Layout window will open.  

2. Select the name for the pipeline that you would like to mark in the box 
at the top of the Layout window. 

3. Mark the pipelines’ alignment. 
There are three ways in which you can mark the alignment: 

 
Method A:  for AutoCAD users only. 

 In AutoCAD, draw a Polyline (2D Polyline) that will constitute the 
pipeline’s horizontal alignment. 

 Choose Select from the menu:   
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 Go over to the drawing area, select the drawn Polyline and click 'Enter'. 
The table in the right-hand window will be filled with the pipeline’s 
manholes data. In the bottom window – the Topography coordinates 
window – the manholes’ coordinates will appear. 

      
 Method B: available for AutoCAD users and for non-AutoCAD users. 

 In the right-hand window, select Pick from the menu:  
 Go over to the drawing area and draw the pipeline’s alignment. 

 
Note that while you are drawing, the manholes table is filled with 
coordinates and Stations. In addition, the designed coordinates list 
is filled with the coordinates that you are marking. 

 
 
 Method C:  available for AutoCAD users and for non-AutoCAD users. 
 

 Enter coordinates into the designed coordinates list on the bottom of 
the screen. Do this by typing in the coordinates in the editing line on the 
top of the list. For example: 
 

256123.76 175143.56 MN1 

256325.56 175200.40 MN2 

256327.12 175256.00 MN3 

 
 In the Layout table on the right-hand side, type in the coordinates’ 

names (MN1, MN2, MN3), according to the following example: 
  

Diam. St. Man Coor.  

      MN1 

      MN2 

      MN3 

 
  
4. Type in the pipes’ diameters. Across from every manhole in the Layout 

table on the right hand side, type in the desired radius. 
 

5. Click 'Apply' to draw the lines.  
The program will create a drawing of the line’s horizontal alignment.  
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Additional options in the Layout window 
 

1. Changing the font size. Click on the Options button:  
Scale - in the window that opens, type in the desired scale. 
Pipes number in select mode (manholes prefix) – change the 
numeration of manholes' points. For example: enter the value 2, and the 
next pipeline will include the following names: 2MN1,2MN2,2MN3 etc. 
Click OK  after the changing.  
Pipes first number – start of points' numeration.    
Pipeline width – the pipeline width on the drawing. 0 indicates the 
default width, 1 – without width.  
Data intervals – the interval between the lines' data.  
 
Click OK again to update the drawing. 

  

2. Clear all manholes, using the button:  
  

3. Delete one manhole – mark the desired manhole and click  
 

4. Show pipeline in the drawing. Click  The current pipeline  will be 
marked yellow. 
 

5. Compute water supply coordinates  - the coordinates' 
computation . After clicking this button the software will compute the 
coordinates of the line in steps of 20 meters and will add them to the 
design coordinates' list. 
 
6. Pipe type – entering of free data by user. 
 
7. Moving an IP - Note that each IP is tied to a coordinate. If you alter 
coordinate data in the coordinates window on the bottom of the screen, the 
location of the IP that is defined by that coordinates will change 
accordingly. 
In order to move an IP, you have to move the coordinate that is tied to it. 
You can do this in two possible ways: 
 
Manual change of the coordinates’ data. 
Select the coordinate you would like to change from the coordinate list on 
the bottom of the screen. Re-edit the coordinate in the points editing line 
(the empty line under the caption: ‘Topography Coordinates’). 
To actualize the change in the drawing, click 'Apply' in the Layout window 
on the right-hand side. 
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Moving the IP from within the drawing. 
Select the 'Move' option from the rectangle on the right-hand side of the 
deigned coordinates list on the bottom of the screen:  

  
 
Go over to the drawing area. Select the point that you would like to move 
and click on it twice. Now click on the new location to which you would like 
to move the point. To actualize the change in the drawing, click 'Apply' in 
the Layout window on the right-hand side. 
 

 

Marking crossings of the pipeline with other 
utilities 

 
You can mark crossing points between project pipelines and pipelines that 
don’t belong to the project, if these points are known to you. 
To do so, select Pipelines Crossings from the main menu. 
The Crossings window will open on the right. 
 
St. - station. The place where the crossing pipeline passes upon the 
pipeline existing in the project (in meters). 
I.L. – the crossing pipeline’s elevation (not obligatory to enter). 
Dpt. – the depth of pipeline (not obligatory to enter). 
Diam. – the crossing pipeline’s diameter  (not obligatory to enter). 
Type – right or left crossing (enter R for right crossing or L for left crossing) 
(not obligatory to enter). 
 
 
1. In the box at the top of the window, select the pipeline for which you 
want to mark crossings.  
2. Fill in the Station data: 
    There are several options for entering the Station data: 
 
 
Method A: manually. 
In the Crossings table, enter the Station of the crossing pipelines in meters. 
 
Method B: using Pick. 

 Mark ‘Pick’ in the bottom box of the window. 
 Move to the drawing area and mark the point near the desired 

pipeline. The Station data will be automatically entered into the 
Crossings table. AutoCAD version users: If you want to mark 
coordinates that already exist in the drawing, you can snap them 



 

 

Page 405 of 508  
 
 

CivilCAD 2016 Reference manual 

by using the ‘Object Snap Settings’ option to a coordinate in 
AutoCAD. 
 

Method C: using Locate. 
For this you must first add the crossing coordinates to the designed 
coordinates list in CivilCAD 2016, show them in the drawing, and then 
select them by using ‘Locate’: 
 

 From the main menu, select ‘DesignCoordinates’. 
 Enter the crossing point’s coordinates in the Design Coordinates 

table, on the bottom left-hand side of the window. Typing in the 
coordinates is preformed in the coordinates editing line at the top 
of the Design Coordinates window, in the following format:    
      coordinate name           x             y 
 

(Do not enter coordinate elevation). Press ‘Enter’ after entering 
each coordinate. 
 

 Click  to refresh the drawing. When refreshed, the 
coordinates will appear in the drawing. 

 Select ‘Locate’ in the Crossings window on the right. 
 Move to the drawing area and mark the coordinates you have 

previously entered in the Design Coordinates table by snapping 
them. The Station data will be automatically entered into the 
Crossings table.  

 
 

 Using Select – (for AutoCAD users only). You can choose the 
crossing of the current line by marking a drawn line on the layout 
– even if it is not defined as a project centerline. Click on ‘Select’, 
move to the drawing area and mark the desired line. Click 
‘ENTER’ to update the table with stations and compute the 
elevation intersection according to the elevation defined in the 
line that is drawn. If the line you chose has no elevation – the 
program will define the intersection elevation as 1.5 meters 
under existing status elevation at the same point.  
 

 Using Filtering - (for AutoCAD users only). You have the option 
of choosing between a number of pipelines crossing the current 
line by filtering these lines from the drawing, from a number of 
layers and a number of pipelines simultaneously by repeating 
the following: 

 
 Filter crossings lines from a .dwg file – click this 

button  to open the ‘Filter crossings’ window.  
 ‘Layers’ – it is possible to mark from the list of layers, 

the layers containing the lines and the Entities list, the 
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type of lines, or use ‘Select’ and click on the line or 
lines symbolizing the line type and layer from which 
the filtering will be done.  

 Click ‘Apply’ to filter. For lines that do not have 
elevation, the program will select the intersection 
elevation as 1.5 meters under existing status elevation 
at the same point.  

 
 
 
3. In the Crossings table, enter the IL data and the pipeline diameter, if 
existing (both are not obligatory). 
    The pipeline crossings will appear in the Sections drawing. 

 

Designing sections 
 
1. From the main menu, activate: PipelinesSections.  
    The Sections window will open before you. 
    The window that opens is divided into three parts: 
 

 The drawing area (the black surface) 
 The ground data table – the table on the bottom left-hand side 

(Topo). 
 The design data table – the table on the bottom right-hand side. 

 
2. Select the line that you would like to design in the box at top right-hand 
side of the   

    window:  
  

3. Click on the Options button:  
    The Status window will open on the left. In this window you can 
determine the   
    status by which the program will apply the design: 

  
 Min. Pipe's Cover – if this data exists, the program will warn you 

at the points where the pipeline is exposed, by marking the 
ground of the exposed areas in orange. 

 Check crossings –  the program will check the pipeline's height 
in the intersection points with another pipeline and will change it 
if required. 

 Keep fixed IL – with this option the software will save the fixed 
Invert level of the point, even if we'll change the slope of one of 
manholes. 

 Keep fixed slopes - with this option the software will save the 
fixed slopes between points, even if we'll change the IL of one of 
manhole. 
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 Slopes precision – the precision of the pipeline slopes in the 
table of section's drawing. 

 Show turns along pipelines – showing the turns along the 
section. If choose this option, the flags that marks the turns' 
location will appear in the vertical section. Near each flag the 
turn's angle will appear. 

 Pipes division – for comfortable design it's possible to ask the 
program to divide the pipeline in steps of 20m' or at each IP, or 
both of them. To do so mark the wanted division.   
 

 
4. Get the topography data. 

 If you preformed the steps in the sections: ‘Preparing the existing 
Ground level’ and ‘Designing the pipeline’s Layout’, the program 
can create the existing topography from the layout: click on the 

 button that appears left to the topography table. The 
topography table will then be filled with the existing ground level 
according to the Station and ground level elevation data. 

 If you haven’t preformed the ‘Designing the Layout’ step – enter 
the topography data in the topography table, according to 
Station, Distance and Elevation. 

 
5. Entering the designed ground level (not obligatory). 

 If you preformed the steps in sections: ‘Preparing the existing 
ground level’ and ‘Designing the Pipeline’s Layout’, the program 
can create the designed ground level from the layout: click on the 

  button that appears left to the topography table. The design 
table will then be filled with the topography data. If you would like 
to enter designed ground level manually: in the Ground Level table, 
select ‘Design’.  

Enter the designed ground level data the same way as you 
entered the ground level. 

 
6. Click ‘Apply’ to bring the drawing (appears on the right). The topography 
drawing will appear on the screen marking the manhole locations, if 
existing. 
 
7. Enter the water line’s sectional data: 

 
 St. (m) - Station. 
 Distance – Instead of entering the Station, you can enter the 

distances between turning points, as long as you enter ‘0’ in the St. 
of the first turning point. 

 Elev. (m) – the elevation or elevation increment from the designed 
ground level, if existing. If not, the increment refers to the existing 
ground level. 
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 Depth (m) - the IP's depth (in meters). You can enter this data for 
an IP, instead of entering IL Lt. If designed ground level exists, the 
depth will refer to it.   

 Slope(%) – the slope percent. You can enter Slope% instead of 
designed elevation. 

 Diam. (mm) – entering pipeline diameters. (You can choose to use 
this option before designing the longitudinal section, or after it). 

 In CivilCAD’s main menu, select 
PipelinesLayout. 

 If you have entered a pipeline layout into the 
project, enter a respective diameter in front 
of each IP. 

 If there is no layout, in the layout table enter 
Station (in the column labeled St.) and 
diameter (in the column labeled Diam.). For  
example: 

 

 
 

 Material – define the material of the pipeline. 
 Wall thick (mm) – define the pipeline’s wall thick. 
 Devices – define devices along pipeline (pump, tank, check valve, 

etc.). 
 Flow rate (Cu. m/h) – flow rate in pipeline’s segment. 
 Ground – – the ground level elevation. This data is exhibited by the 

program and is not to be entered by the user. If designed ground 
level exist in the project, it will appear here. If not, the existing 
ground level will appear.  

 Gr. Sl. – the ground slope. Not to be entered by the user. As in its 
precedent, the slope refers to the designed topography, if it exists. If 
it does not, the slope will refer to the existing ground level. 

 
8. Click ‘Apply’ to draw the design. 
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Additional options from the section window 
 

 - Save project - (at the top of the toolbar) – saving the project data, 
without exit from the sections' window. 

 

  
     Creating a DXF file for a longitudinal section: 

 Click on the  button to open this window: 
 Fill in the scale in fields ‘Length, Height’ 
 In order to type the section by a specific sheet size, 

choose the desired sheet size from the list that 
opens under ‘Divide by paper size’. 

 In order to extract the current section only, click 
‘OK’. To create a file with all sections, click ‘DXFall’. 

 A box will open for saving files. Choose the directory 
for saving the files, enter the file name and click to 
save.  

 

 Button Section printing – clicking this button will open a new 
window. Enter the scale and click ‘OK’ to print this section. 
 

 Button Full display – click this button for a full display of the entire 
section on the drawing window.  

 

 Deleting a manhole using. This button deletes the entire 
manhole, including the Station. 
 

 Deleting the data of all manholes (This function does not totally 
delete the manhole – the Station data and distance between manholes 
are saved). 
 
Adding an IP. Mark the first column (from the left) in the design table, 
in the row following the row of the IP you would like to add, and press 
‘Enter’ on the keyboard. In the new row that appears, enter either the 
station for the new IP, or the distance between it and the preceding IP 
and the rest of its details. 
 

 Elevating/lowering a pipeline. A window containing the design 
data will open. Mark the coordinates you would like to elevate/lower (to 
mark all coordinates press A). At the bottom of the table enter the 
desired elevation (for lowering, enter a negative number) and click ‘OK’. 
The design table will change accordingly 
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 Getting the designed ground level. (On condition that designed 
ground data, including designed contours, exists in the project, as well 
as a designed pipeline layout). 
 

 Getting the designed ground level all pipelines. (On 
condition that designed ground data, including designed 
contours, exists in the project). 
 
View – the section’s display range. Leaving the data under this 
heading empty defines the section’s full display for the software (the 
section’s full length appears next to ‘Total range’). It is possible to 
display the section of a particular segment by entering the starting and 
final station into the fields ‘From, to’. The change of section elevation 
will be done according to the change of ‘Height factor’ parameter. 
Click ‘Apply’ after changing this data to update preview.    
  
Topography data - smoothing the ground level. By moving to 
’Smooth’ option the ground level will be drawn smoother but less exact 
(the program will have created certain a distortion in the drawing so the 
line can be smoother). 
 

 Changing colors in the section layer – it is possible to control the 
colors in each section layer by clicking on the squares located at the 
top section on your screen next to these headings: 

 Ground level - existing status elevations layers. 
 Design level – designed status elevations layers. 
 Manholes - coordinates layer. 

 
Clicking the layer color opens a window containing colors from which 
you can select the desired color.  

 

 Copying the ground level Stations to the design table. This 
function will copy the Stations from the Topography table to the Design 
table, for convenient designing. 
 
Interactive pipeline design. You can interactively draw a 
pipeline on the screen, instead of entering Invert Level data. 

 Select the option ‘Pick’ in this box:  .  
 Move to the drawing area and draw the pipeline. 

Notice that you can both snap to existing manholes 
and create new ones. The table will be updated while 
you are drawing. 

 
Using Locate – enables you to locate a manhole in the drawing. 
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 In the table, select the manhole you wish to locate or 
modify. 

 Select ‘Locate’ in the box:  
 Move to the drawing area. The curser will link to the 

chosen manhole.  

 
 

Producing Reports 
 

Activate  Pipelines  Reports  from main menu. 
 

 IP's Report – a report of the line’s turning points in a project 
(meaning layer points)- possible only if a line’s layout exists in 
the project. 

 
 Pipe’s Report – pipeline’s lengths report by diameters 

 
 Quantities Report  - for sewage and drainage pipes only. 
1) Manholes report in drawing their diameters and depths 

 Mark "V" the number of pipelines that you wish to include in 

the report or click   button  to mark all pipelines. 
 Division by depth existing coincides with the conventional 

division. A different depths division exists for sewage 
pipelines and sewage manholes. In    order to change the 
depth division system for the report production: 

 Click on button  depth segments. Under the headline 
"Depth segments" enter the depths for division and at the 
end, click 'OK'.   

 Click 'Apply'. 
 

 Detailed report - a detailed report presenting the pipeline’s data, 
existing status, and designed status - along the Pipeline.  

 
 
Additional Options from the Reports Window  
 

 Print the report by clicking this button from the report window.  
 

 Save the report as a text file - click this button appearing in the reports 
window will open a window for saving files. Select the desired location for 
saving, type in the file name in the right line, and click ‘Save’. Now you can 
open the file and edit it as you like. 
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 Exporting the report to an ‘Excel’ file – click this button from the 
report window to open an Excel sheet the program has filled with data from 
the last report.  
 
Setting a Permanent Depths Division Setting a Permanent Depths 
Division 
You are capable of changing the division method to depths for a quantities 
report on a regular basis, for every future project opened in CivilCAD 2016. 
 
To do so you must enter the division of your choice in the ‘Prototype’ 
project. This project is the software’s “master”. All the definitions that 
appear in it will appear for every new project you open with CivilCAD 2016. 
Open project Prototype (File ->Open Project’). 
 

In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Prototype.prj\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Protorype.prj\ 

 
From the main command ruler open: Pipelines-> Pipelines list. Choose 
the type of desired project (Sewage/Drainage). 

 Open menu Pipelines-> Reports. 
 From the Reports window choose the Quantities.  

 Click on  button (Depth Segments).  
 From the window that opens enter the depths for division. 
 Click ‘OK’ to confirm and close the window.  
 Close the project and save the changes. 

 
Now every new report opened will receive the division you have entered in 
Prototype Project. 
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Chapter 22: Cables lines 
design 
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Cables lines design 
 
As a preliminary stage, open a work project in CivilCAD 2016 according 
to the instructions from other chapters. The work steps for Cable 
Design are as follows: 
 

 Initializing the project. 
 Preparing the topography and/or designed settings. 
 Horizontal Alignment. 
 Defining the maintenance boxes along the line. 
 Defining the maintenance boxes size. 
 Marking crossings of the cable with other utilities. 
 Designing sections. 
 Producing reports. 

  

 

Initializing the project 
 
From the main menu, activate Pipelines Pipelines list 
On the right, a window titled “Pipelines list” will open. This is the project’s 
general settings window. 
 

1.    Select ‘Cables’ from under ‘Pipeline’s type’. 
2.    Select the work units for the pipeline diameter (mm, cm, 

inches). 
3. Under Pipelines names, fill in every line the names of the 

designed     
pipelines for the project. 

 
We will now go on to designing the pipelines. 
You have two design options: 

1.   Design including layout.  The layout design will allow you to 
obtain the ground section along the pipeline. 

2.   Design without layout. 
 
For design including layout, go to the 'Preparing the topography and/or 
designed settings' section. 
If you would like to design without layout, go to ‘Design section’. 
 
* You can mark crossings whether you are designing pipelines with or 
without layout.    To do this, go to the Crossings section. 
 
Options from the ‘Pipeline’s list’ Window 
 

 New cable – adding a new cable to the list of cables. Possible also by 
clicking ‘ENTER’. 



 

 

Page 415 of 508  
 
 

CivilCAD 2016 Reference manual 

 

 Clear all cables – clearing all cables lists (the cables will be erased 
from the list and if they have been defined by data it will be deleted from 
the project as well). 
   

 Erase a cable – erasing a certain cable. Mark the cable’s name in the 
list and click this button in order to delete it from the list (if any data was 
defined for this pipeline it will be erased from the project). 
 

 - Find Pipeline – find a pipeline by name in the pipelines list. If you try 
to add a pipeline, using a name which already exists in the Pipelines List, a 
warning window will appear. Click the 'OK' button and type a different 
name for the pipeline. 
 
 

 

Preparing the topography and/or designed 
settings 
 
In order to design the pipes’ layout, you will first have to prepare the 
topography settings for the design. You can work with up to two 
topography layers: existing topography settings and designed settings. If 
you are working on a single topography layer, treat it as existing 
topography setting (even if it is a designed topography such as roads 
surface). 
 
You have several options for inserting the topography settings into the 
project: 
 

 Importing a DWG file – if you have a DWG file insert it into the project, 
as explained in Chapter 23 –  ‘Handling DWG Files’ (follow the steps: 
Importing a DWG file and extracting points from DWG file). 

 
 Importing an ASCII file - if you have an ASCII file containing the 

topography data: 
1.    From the coordinates list command buttons (the group of 

buttons located to the right of the Topography coordinates list 

at the bottom of the screen), click on . 
 In the dialog box that opened, select the existing status 

topography coordinates file. The coordinates data will be 
entered into the coordinate list at the bottom of the screen. 

 
 You may enter the topography data manually: 

In the coordinates editing line (the empty line under the title – 
‘Topography coordinates’), enter the coordinates’ data in the following 
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manner: 
 Coordinates name x y Height        

 
Press ‘Enter’ after entering each coordinate. 
 

Once you have entered the coordinates data, click on the  button to 
create contour lines: 

 From the main menu, select Topography  Contours. 
 Click ‘Apply’ in this window that opens from the right.  

The program will build the contour lines according to the coordinates 
entered.  

 
 
 
Adding a Designed Status Layer 
 
If you have the data of an additional designed, layer - replace the 
‘Topography Coordinates list’ with ‘Designed coordinates’, by choosing 
‘Design  Coordinates’ from the main menu. 
Enter the designed status data the same way you entered the existing 
status coordinates. 
 
Once you have entered the designed status data, create the designed 
contour lines: 
 

 From the main menu, select ‘Design Contours’. 
 Click ‘Apply’ in this window that opens from the right.  

The program will build the designed contour lines according to the 
coordinates entered.  

 
 

 

Horizontal Alignment  
 
1.   From the main menu, activate PipelinesLayout. On the right-hand 

side, the Layout window will open.  
2.   Select the name for the pipeline that you would like to mark in the box 

at the top of the Layout window. 
3.   Mark the pipelines’ alignment. 

There are three ways in which you can mark the alignment: 
 

Method A:  for AutoCAD users only. 
 In AutoCAD, draw a Polyline (2D Polyline) that will constitute the 

pipeline’s horizontal alignment. 

 Choose Select from the menu:   
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 Go over to the drawing area, select the drawn Polyline and click Enter. 
The table in the right-hand window will be filled with the alignment IP’S. 
The IP coordinates list will appear in the bottom window (Design 
coordinates). 

      
 Method B: available for AutoCAD users and for non-AutoCAD users 
alike. 

  In the right-hand window, select Pick from the menu:   
  Go over to the drawing area and draw the pipeline’s alignment. 

Note that while you are drawing, the Layout table is filled with 
coordinates and Stations. In addition, the designed coordinates list 
is filled with the coordinates that you are marking. 
 

Method C:  available for AutoCAD users and for non-AutoCAD users 
alike. 

 
 Enter coordinates into the designed coordinates list on the bottom of 

the screen. Do this by typing in the coordinates in the editing line on the 
top of the list. For example: 
 

256123.76 175143.56 MN1 

256325.56 175200.40 MN2 

256327.12 175256.00 MN3 

  
 

 In the Layout table on the right-hand side, type in the coordinates’ 
names (MN1, MN2, MN3), according to the following example: 

  

Diam. St. Man Coor.  

      MN1 

      MN2 

      MN3 

  
  

 It is possible to mark radiuses. Enter the desired radius under ‘Radius’. 
 

Click 'Apply' to draw the lines.  
   The program will create a drawing of the line’s horizontal 
alignment.  

 

 
Additional options from the Layout window 
 

 - Clicking this button from the window that opens, will make it possible 
to change the following definitions:   
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Scale – changing the pipeline’s data lettering size 
Pipes number in select mode (manholes prefix) – changing the 
numbering beginning of the manholes coordinates’ names. For example – 
entering the value ‘2’ will cause the subsequent pipeline defined to contain 
the names: 2MN1 , 2MN2,  2MN3 and for the line that follows – names that 
start with ‘3’ and so on.   
  

 - Clear all IP's - deleting all current line data. 
  

 - Deleting one IP – deleting a single IP. Mark the desired IP and click  
         this button. 
 

 - Show pipeline – locating a pipeline on the drawing. Clicking on this 
current pipeline will mark it in yellow.  
 
Moving an IP. 
Note that each IP is tied to a coordinate. If you alter coordinate data in the 
coordinate's window on the bottom of the screen, the location of the IP that 
is defined by that coordinates will change accordingly. 
In order to move an IP, you have to move the coordinate that is tied to it.  
 
You can do this in two possible ways: 
 
Manual change of the coordinates’ data: 
Select the coordinate you would like to change from the coordinate list on 
the bottom of the screen.   Re-edit the coordinate in the coordinates editing 
line (the empty line under the caption: ‘Topography Coordinates’). 
To actualize the change in the drawing, click OK in the Layout window on 
the right-hand side. 
 
Moving the IP from within the drawing. 
Select the “Move” option from the rectangle on the right-hand side of the 

designed coordinates list on the bottom of the screen: -   
Go over to the drawing area. Select the point that you would like to move 
and click on it twice. Now click on the new location to which you would like 
to move the point. (AutoCAD users: you can snap a marked coordinate by 
using ‘Object Snap Settings’ to a coordinate.) 
 
To actualize the change in the drawing, click OK in the Layout window on 
the right-hand side. 
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Defining the maintenance boxes along the line 
 
To go to this option, choose ‘Cables’ from Pipeline Layout Window.  
You can define the manholes on the current cable line using two methods: 
 
Option 1 
From the right window, choose ‘Pick’ 
Move to the drawing area and click along the line in location in need of a 
test cell 
Please notice that when you click on a line, the ‘Layout’ table is filling with 
coordinates and stations. In addition, the designed coordinates list is filling 
with the coordinates you are marking.  
 
Option 2  
Enter the coordinates from the coordinates table at the screen bottom. Do 
so by typing the coordinates in the editing line at the head of the list. For 
example: 
 
In the layout table from the right – enter the coordinate's names (MN1, 
MN2, MN3) according to the example below: 
 

 
 
Click ‘OK’ after clicking on the field ‘Man’ (manhole on drawing), and ‘St’ 
(stations) will automatically be filled in the table. 
Pipe’s definition. For every manhole in the table, define the number of 
pipes under ‘No’, and the diameter of every pipe under ‘D-r’.  
 
 

Additional options 
 

 - Clicking this button from the window that opens, will make it possible 
to change the following definitions:   
     
Scale – changing the pipeline’s data lettering size. 
Pipes number in select mode (manholes prefix) – changing the 
numbering beginning of the manholes coordinates’ names. For example – 
entering the value ‘2’ will cause the subsequent pipeline defined to contain 
the names: 2MN1 , 2MN2,  2MN3 and for the line that follows – names that 
start with ‘3’ and so on.   
  

 - Clear all manholes - deleting all current line data. 
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 - Deleting one manhole – deleting a single IP. Mark the desired IP 
and click   this button. 
 

 - Show pipeline – locating a pipeline on the drawing. Clicking on this 
current   pipeline will mark it in yellow.  
     
 

 

Defining the maintenance boxes size 
 
In order to transfer to this definition, choose Manholes from the list at (next 
to Cables title) the Pipeline layout window. 
Enter the size for every cell in the table, (via units defined from the Pipeline 
list window), by typing the values under ‘Width’; and ‘Length’. See 
following example: 
 

 
 
It is possible to set the test cell sizes regularly by following these 
steps:  
 
From menu activate: ‘Pipeline->Sections’ and click on the ‘Options’ 

button . A table will open. Enter a name for the size type of your choice 
under ‘Type’, and the test cell size for every type under ‘Length’, ‘Width’ 
(according to units defined in the ‘Pipeline list’). See example: 
 

 
 
 
Now from the ‘Pipeline layout’ window you can enter the name of the type 
you have defined – under ‘Type’, instead of entering the same sizes over 
and over. See example: 
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Additional Options from the Layout Window 
 

 - Clear all manholes - deleting all current line data. 
  

 - Deleting one manhole – deleting a single IP. Mark the desired IP 
and click this button. 
 

 - Show pipeline – locating a pipeline on the drawing. Clicking on this 
current   pipeline will mark it in yellow.  

 

 

Marking crossings of the cable line with other 
utilities 
 
You can mark crossing points between project pipelines and pipelines that 
don’t belong to the project, if these points are known to you. 
To do so, select ‘Pipelines Crossings’ from the main menu. 
The Crossings window will open on the right. 
 
St. - Station. Meaning, the place where the crossing pipeline passes upon 
the pipeline existing in the project (in meters). 
IL. – the crossing pipeline’s elevation (not obligatory to enter). 
Diam. – the crossing pipeline’s diameter (not obligatory to enter). 
R/L – right or left crossing (enter R for right crossing or L for left crossing) 
(not obligatory to enter). 
 
1. In the box at the top of the window, select the pipeline for which you 
want to mark    
    crossings.  
2. Fill in the Station data:  
    There are several options for entering the Station data: 
 
Method A: manually. 
In the Crossings table, enter the Station of the crossing pipelines in meters. 
 
Method B: using Pick. 
Mark ‘Pick’ in the bottom box of the window. 
Move to the drawing area and mark the point near the desired pipeline. 
The Station data will be automatically entered into the Crossings table. 
AutoCAD version users: If you want to mark coordinates that already exist 
in the drawing, you can snap them by using the ‘Object Snap Settings’ 
option to a coordinate in AutoCAD. 
 
Method C: using Locate. For this you must first add the crossing 
coordinates to the designed coordinates list in CivilCAD 2016, show them 
in the drawing, and then select them by using ‘Locate’: 
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From the main menu, select ‘DesignCoordinates’. 
Enter the crossing point’s coordinates in the Design Coordinates table, on 
the bottom left-hand side of the window. Typing in the coordinates is 
preformed in the coordinates editing line at the top of the Design 
Coordinates window, in the following format:    
      coordinate name           x             y 
(Do not enter coordinate height) 
Press ‘Enter’ after entering each coordinate. 

Click  to refresh the drawing. When refreshed, the coordinates will 
appear in the drawing. 
Select ‘Locate’ in the Crossings window on the right. 
Move to the drawing area and mark the coordinates you have previously 
entered in the Design Coordinates table by snapping them. The Station 
data will be automatically entered into the Crossings table.  
 
Using Select – (for AutoCAD users only). You can choose the crossing of 
the current line by marking a drawn line on the layout – even if it is not 
defined as a project centerline. Click on ‘Select’, move to the drawing area 
and mark the desired line. Click ‘ENTER’ to update the table with stations 
and compute the elevation intersection according to the elevation defined 
in the line that is drawn. If the line you chose has no elevation – the 
program will define the intersection elevation as 1.5 meters under existing 
status elevation at the same point.  
 
Using Filtering - (for AutoCAD users only). You have the option of 
choosing between a number of pipelines crossing the current line by 
filtering these lines from the drawing, from a number of layers and a 
number of pipelines simultaneously by repeating the following: 
 

Filter crossings lines from a .dwg file – click the button  to open the 
‘Filter crossings’ window.  
‘Layers’ – it is possible to mark from the list of layers, the layers containing 
the lines and the entities list, the type of lines, or use ‘Select’ and click on 
the line or lines symbolizing the line type and layer from which the filtering 
will be done.  
Click ‘Apply’ to filter. For lines that do not have elevation, the program will 
select the intersection elevation as 1.5 meters under existing status 
elevation at the same point.  
 
3. In the Crossings table, enter the IL data and the pipeline diameter, if 

existing (both are not obligatory). 
     
The pipeline crossings will appear in the Sections drawing. 
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Designing sections 
 
1. From the main menu, activate: PipelinesSections. The Sections 
window will open before you. 
The window that opens is divided into three parts: 

 The drawing area (the black surface) 
 The ground data table – the table on the bottom left-hand side 

(Topo). 
 The design data table – the table on the bottom right-hand side. 

 
 

2. Select the pipeline that you would like to design in the box at top right-

hand side of the window:  
 
3. Automatic determination of the control cells sizes. Click on the Options 

button:   to open the table. Enter a name for the size type of your choice 
under the heading ‘Type’, and the cell type for each type under the 
headings ‘Length’, ‘Width’ (according to units defined in the ‘Pipeline list’. 
See this example below: 

 
 
4. Get the topography data: 
 

 If you preformed the steps in sections: ‘Preparing the 
Topography Data’ and ‘Designing the pipeline’s Layout’, the 
program can cut the ground level data from the layout: click on 

the  button that appears left to the topography table. The 
topography table will then be filled with the existing ground level 
according to Station and ground level elevation data. 

 If you haven’t preformed the ‘Designing the Layout’ step – enter 
the topography data in the topography table, according to 
Station, Distance and Elevation. 

 
5. Entering the designed ground level data (not obligatory): 

 If you preformed the steps in sections: ‘Preparing the existing 
ground level’ and ‘Designing the Pipeline’s Layout’, the program 
can create the designed ground level from the layout: click on 

the  button that appears left to the topography table. The 
design table will then be filled with topography data.  

 If you would like to enter designed ground level manually: in the 
Ground Level table, select ‘Design’.  
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Enter the designed ground level data the same way as you 
entered the ground level. The ground level section will appear on 
your screen with a marking for the test cells. 

 
6. Click ‘OK’ to bring the drawing (appears on the right). The topography 
drawing  
    will appear on the screen marking the manhole locations, if existing. 
 
6. Enter the line’s vertical alignment data in the designed table at the 
bottom of your screen (with the heading ‘Designed’). It is possible to enter 
the absolute depth for each manhole by filling under ‘Elevation’, or filling 
the line depth under the heading ‘Depth’. The program will automatically 
update the second set of data according to the typing of the first set.  
 

7. In the design table, enter the water line’s sectional data, as following: 
 

 Man- manhole number 
 St. – Station  
 Distance –Instead of entering the Station, you can enter the 

distances between turning points, as long as you enter ‘0’ in the 
St. of the first turning point. 

 Elevation/dH – the elevation or height interval from the 
designed ground level status, if existing. If not, the interval will 
refer to the existing ground level.   

 Ground – the ground level elevation. This data is exhibited by 
the program and is not to be entered by the user. If designed 
ground level exist in the project, it will appear here. If not, the 
existing ground level will appear.  

 Number – the number of pipelines for the existing manhole 
 Diameter- the diameter of the entire pipe in the current manhole 
 Type – manhole type (if manholes types are defined in ‘Status’) 
 Length- manhole length (no need to fill unless you are using 

type) 
 Width – manhole width (no need to fill unless you are using 

type) 
 

 
8. Click ‘Apply’ to draw the design. 
 
 
 

Additional Options in the Sections Window 
 

 - Save project - (at the top of the toolbar) – saving the project data, 
without exit from the sections' window. 
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Creating a DXF file for a longitudinal section: 

 Click on the  button to open this window: 
 Fill in the scale in fields ‘Length, Height’ 
 In order to type the section by a specific sheet size, 

choose the desired sheet size from the list that opens 
under ‘Divide by paper size’. 

 In order to extract the current section only, click ‘OK’. To 
create a file with all sections, click ‘DXFall’. 

 A box will open for saving files. Choose the directory for 
saving the files, enter the file name and click to save.  
 

 Button Section printing – clicking this button will open a new window. 
Enter the scale and click ‘OK’ to print this section. 

 

 Button Full display – click this button for a full display of the entire 
section on the drawing window.  

 

 Erasing a manhole -  this button totally deletes the current manhole 
including station. 

 

 (near the Design table) –deleting all design data. 
 

 (near the ground level table) - deleting all Topography data of 
current table (Design/Existing). 

Adding a test cell: mark the column farthest on the left from the 
designed table, in the line before the point you wish to ad, and click 
‘Enter’. Add the new data in the line that enters.  
 

 - Elevating/lowering a pipeline. A window containing the design data 
will open. Mark the coordinates you would like to elevate/lower (to mark all 
coordinates press A). At the bottom of the table enter the desired elevation 
(for lowering, enter a negative number) and click ‘OK’. The design table will 
change accordingly 

 

 Getting the topography settings for all pipelines (on condition the 
project contains Topography including contours, and line’s layout). 

 

 Getting the designed ground level. (On condition that designed 
ground data, including designed contours, exists in the project, as well as a 
designed pipeline layout). 

 Getting the designed ground level all pipelines. (On condition that 
designed ground data, including designed contours, exists in the project). 
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‘View’ – the section’s display range. Leaving the data under this heading 
empty defines the section’s full display for the software (the section’s full 
length appears next to ‘Total range’). It is possible to display the section of 
a particular segment by entering the starting and final station into the fields 
‘From, to’. The change of section elevation will be done according to the 
change of ‘Height factor’ parameter. Click ‘OK’ after changing this data to 
update preview.    

  
Topography data - smoothing the ground level. By moving to ’smooth’ 
option the ground level will be drawn smoother but less exact (the program 
will have created certain a distortion in the drawing so the line can be 
smoother). 
Changing colors in the section layer – it is possible to control the colors 
in each section layer by clicking on the squares located at the top section 
on your screen next to these headings: 

 
 Ground level - existing status elevations layers 
 Design level – designed status elevations layers 
 Manhole - coordinates layer 

 
Clicking the layer color opens a window containing colors from which you 
can select the desired color.  

 

 Copying the ground data stations into the designed table – this 
command will copy ‘Stations’ from the ‘Topography’ table to the design 
table for design conveniences.   

 
1. Interactive pipeline design. You can interactively draw a 

pipeline on  
 

 Select the option ‘Pick’ in this box: .  
 Move to the drawing area and draw the pipeline. The 

design table will be updated while you are drawing. 
 
2. Using Locate – enables you to locate and to join a vertical 

turning point in the drawing. 
 In the table, select the point you wish to locate. 

 Select ‘Locate’ in the box: .  
 Move to the drawing area. The curser will link to the 

chosen coordinate.  
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Producing Reports 
  
From the main menu, activate: PipelinesReports. 
 

 Pipes Report – a pipe’s lengths report by diameters. 
 IP’s Report – a report of pipeline turning points in the project (meaning 

layout points) – possible only if a pipeline layout exists in the project. 
 
Options for Managing Reports 
 

 Printing the report, using . 
 

Saving the report as a text file. Click on . A box for saving 
files will open. Select the desired saving location, type in the file 
name, and click ‘Save’. Now you can open the file and edit it as 
you like. 

 

 Imprint the IP’s or Manholes report on the drawing. After 
clicking this button, move to the drawing area and click in the desired 
spot for the report location. Afterwards, click ‘Set’ in the AutoCAD line 
and click ‘Enter’. The size of the report can be determined on the 
drawing by changing the value next to ‘Scale’ (imprint the report again 
after changing the size). 

 
 

 Exporting the report to an ‘Excel’ file – click this button from the 
report window to open an Excel sheet the program has filled with data 
from the last report.  
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Chapter 23: General Issues 
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General Issues 
 
This chapter discusses CivilCAD 2016 general issues. The options 
described will allow the setting of definitions for working with projects. 
 
These chapter topics are: 
 

 Options from Configuration window. 
 Creating a coordinates frame.     
 Division into sheets. 
 Determining project parameters. 
 Computations of poles offsets. 

 
 

 

Options from Configuration window 
 
The options from this window determine the project work mode. CivilCAD 
2016 can determine these definitions, regularly, for each new project that 
opens, unless you want them changed. Setting the definitions for all the 
new projects will be done by changing the definitions in project 
‘Prototype’. 
 

In Windows XP OS the default location is: 
C:\Documents and Settings\All Users\Application 
Data\SivanDesign\CivilCAD\Prototype.prj\ 
 
In Windows Vista or Windows 7/8/10 OS the default location is: 
C:\ProgramData\SivanDesign\CivilCAD\Protorype.prj\ 

 
 
To activate this window, choose from Main Menu File->Configuration or 

click  from the main toolbar. This window comprised of four screens by 
use of the buttons located in the upper hand side of this window. 
 We will explain the definitions by their order of appearance in window ‘File 
-> Configuration’. This window is built of 4 screens, which can be leafed 
through using the ‘Next’ and ‘Back’ buttons.  
 
 
General settings . 
 

 Language - CivilCAD 2016 software operates in both English, Hebrew 
and Portuguese. It's imperative to remember that when we produce a 
report that the software issues a report in the chosen language. After 
the altering of the language of choice this action has to be executed 
again. 
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 System of units - choosing the measuring system the software will 
use. 

Metric - the metric systems (Meters). 
English feet - the English system. 
 

 Angle's unit - the angle system the software has to use. 
 

 Printout font's size – fixing the fonts' size in the reports, that the 
program creates. 

 

 Auto Save - save your project automatically. In order to define 

the auto save, follow these steps: 
 Go to ‘File-> Open project’  

 Choose ‘Prototype.prj’ project and click ‘OK’.  

 Go to ‘File Configuration’ 

 In 'General' tab, check mark the Auto Save cell and define the 
cyclicality (in minutes). 

 Click ‘OK’ 

 Leave the program by : ‘FileExit’ 

 Confirm the changes you have made. 
 

 Save Backup - allows saving a project in several backup 

versions. To use this feature: 
 From CivilCAD main menu, go to ‘FilesConfigurations’. 

 In ‘General Settings’ Tab, mark ‘V’ in ‘Save Backup’ option. 

 Click the  button and define the desired path for the backup 
versions and click the 'Open' button. 

 Define the desired number of backup versions (default number is 3 
backup versions). 

 In case you defined 3 backup versions, the 4th save will overwrite 
the first backup. 

 In order to load a backup project, from CivilCAD main menu go to: 
'FileRestore Project'. 

 Select the desired file and click the 'Open' button. 
 

Note: the backups are saved to *.Lha format. 

 In order to define X number of backup versions for all future 
projects, you will need to define it in the Prototype project. 
  

 Auto launch – the setting of drawing environment. It's possible to 
choose the program to use it as the drawing environment for CivilCAD 
2016. If choosing option No the program will work as independent unit 
without external program such as AutoCAD or IntelliCAD. The program 
will activate the new drawing environment only after the exit from the 

program and reactivation.   
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 Auto Vertical alignment mode - work frame in the vertical section 
window (in roads). 

AutoCAD's drawing environment interface - only on 
AutoCAD 2000 and later versions' framework. 
AutoCAD stand alone - frame work without a supplementary 
software. 
  

 AutoCAD styles - the status of the AutoCAD window. These definitions 
should be determined on project Prototype. 

Menu - main menu's display. 
Toolbars. 
Command line. 
Status bar - the status bar (always located at the lower side 
of the software's window). 

 
 
 
Drawing environment   
 

 2D/3D Work State – it's possible to create the lines – to do so, mark 
the option 3D work state. In this case the .dwg file that the program 
creates will be larger. In 2D work state the program will create the lines 
without height. These definitions influence on the displaying of the lines, 
but not on the program's computations. 

 Blocks mode – this option enables the project to work with blocks. 
Check this value on prototype projects only and save it. Afterwards, 
every new opened project will be defined according to the prototype 
project. For more details see the chapter 'Working with blocks'. 

 Standard mode -  working with text mode. Marking this option enables 
to create a project for work with standard mode texts. Check this value 
on prototype projects only and then, save. Afterwards, every new 
opened project, will be defined according to the prototype project. 

 Purge all when refreshing – deleting of unnecessary layers. If this 
option is marked, each time that we'll press the button Refresh or 
Refresh the entire program will erase the all unnecessary layers, 
including the layers not relevant to the program.  

 *.DXF files format – Changing this parameter will determine the Dxf 
files format that the software creates when we ‘save’ from anywhere in 
the program. Using this parameter it is possible to create a DXF file like 
vertical alignment, cross sections, drawings from the 3-D window etc. 

 Do not reverse section's labels (Hebrew mode only) – when we are 
working in Hebrew, the program reverses the captions in the section's 
drawings and shows them in Hebrew. Sometimes we don't want the 
program will execute this , for example if the program that reverses the 
captions is installed in AutoCAD, each time we'll load the section with 
.DXF format, we'll get the inverse captions in case  this option is not 
chosen. 
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Coordinates format 
 

 *.Dis files format – setting the .dis file format. When importing or 
exporting a DIS file, the program will read it as defined in this option. 
For example if the values ‘1’ and ‘11’ appear next to the labels ‘X start’ 
and ‘X end’ - when importing a .DIS file, the program will read from 
these file columns the X - parameter. The same goes for other 
parameters defined for this option.    

 
 Code columns – location of codes in the list. This value will determine 

the range of columns in the coordinates list in which the codes will be 
presented, if you are working with codes in a project. 

  
 New points counter – Setting points names. When inserting new 

points to the list by choosing them from the drawing itself, the software 
gives the names automatically. In order to begin the numbering using 
the names you want, type the first name next to ‘Start Counting 
From’. If ‘Auto Names’ is selected, the software will create points 
according to the number of points in the list. This implies that each point 
will get its name according to its location in the list, and in addition, the 
letter ‘T’ or ‘D’ will be attached to it according to its list origin (Design or 
Topography). 

 
 Coordinates' length 

 Max 10 digits – 6 digits from the left of decimal point. 
 Max 11 digits  - 7 digits from the left of decimal point. 

 
 
 
Files settings 
 
File's paths - defining the program’s default file.       

 Project’s files – default file for opening or saving project's coordinates' 
files – default file for opening or saving coordinates file 

 Coordinate`s files files – default file for opening or saving coordinates' 
file. 

 Distomat`s file - default file for opening or saving an observation’s file 
in the distomat window. 

 
Save/Load from text file format – when saving to the coordinates' 
list text format, it is possible to select ahead-of-time in which format 
the program will save, by choosing the tool to which we want to 
transfer the file or from which we are interested in reading.  
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Creating a coordinates frame 
 
CivilCAD 2016 makes it possible to add a coordinates frame onto the 
drawing.  
From the Menu open ‘General -> Coordinates frame’. Following any 
changes you make to the data in this window, click ‘Apply’ so the program 
can mark the entire frame according to the new definitions set. Possible 
options from this window: 
 

End corner – the value of the coordinate representing the frame top 
corner   
Base corner - the value of the coordinate representing the first 
corner of the frame base. 
Base second - the value of the coordinate representing the second 
corner of the frame base.  

 

 This button sets the frame borders as the ‘Extends’ – the border 
of the entire drawing. The program will change the values of the 
coordinates that represent the frame automatically. 

 

 This button erases the coordinates' values representing the 
frame corners.  

 
Steps – the distances between the coordinates' markings on the 
frame 
Scale – the frame size value  

 
Select – click on this button and mark the line representing the 
desired frame, to set the frame according to choice.  

 
Pick – choose the frame corners by clicking this button. Go to the 
drawing – click on the first corner, second corner and top corner.  
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Division into sheets 
 
By defining each sheet separately, CivilCAD 2016 makes it possible to 
divide the drawing to several different sheets. From main menu go to 
‘General -> Frames maker’ (this option is available only for AutoCAD 
2000 and above). We will proceed in explaining the options from this 
window and how to produce division into sheets: 
 
Options from ‘Frames maker’ window. 
 

 New border – this button adds a new frame to the frames list in the 
top section of the window. The name in this window represents the current 
frame.  
 

 Erase border - this button erases a frame from the list of frames 
 

 Set the border coordinates – this button sets the coordinates listed in 
the window for the current frame 
 

 Mark project's border as the frame window – this button determines 
the borders of the entire project drawing as the border of the current frame 
 

 Show border contour - this button presents the borders of the current 
frame. 
 

 Options  - this button allows defining the following options:  
 Steps – the distances between the coordinates markings on the 

frame. 
 Scale – the frame size value.  
 Arrow block – the location of the block file representing the 

north arrow. 
 Table block – the location of the block file representing the 

company logo. 
  
Pick - choose the frame by clicking on this label and choosing three 
corners on the drawing. 
Select  - choose frame by clicking on this label and marking ‘Polyline’ in 
the drawing defining the frame. 
Find - locate current frame on the drawing (the frame is marked in 
the frames list).  
 
Using this sample we will explain the steps for creating sheets: 
 

 Open ‘General -> Frames maker’ from menu 
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 Set the frame borders using one of the following: 
1. Select – Using AutoCAD, draw a frame according to size, 

location and desired angle by using a closed Polyline to 
define the frame borders. Click ‘Select’, mark the frame you 
have created in the drawing and click ‘Enter’.  

2. Pick - click on this button, then move to the drawing and 
mark the first base corner, the second corner and the top 
upper corner in three clicks.  

3. Clicking on  will determine the entire drawing border as 
the frame border.  

4. Another option is to manually insert the corners coordinates 
values in the fields: 
‘End corner’, 'Base first’, 'Base second’. 
 

 Click on the  button to determine the borders for the current 
frame. 

 If you wish to define additional systems subsequent to the definition of 

the first system click .   
 In order to add another frame to the list repeat the steps from the 

beginning up to this stage as many times as the desired frames.  
 It is possible to create the sheet of the current frame only, by 

clicking on ‘OK’, or by clicking ‘Apply’ after defining all the 
frames.  

 

Determining project parameters 
 
When CivilCAD 2016 performs ground level computations in a project, 
the user is unable to see this calculation. This calculation is done 
according to certain precision. In some cases during Earthworks 
computations you will want to get even more accurate results. Setting 
the system to enhance precision in its computations method can do 
this. In order to define the precision you must repeat the steps below: 
 

 Activate ‘General -> Project Parameters’. 
 Under the heading ‘STEPS’ choose the precision level for ‘X’ axis and 

‘Y’ axis, with maximum precision being 0.25. 
 

Note:  in large topography projects, choosing maximum precision might 
cause certain computers to work very slowly with the software 
(according to processor speed).  
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Computations of poles offsets 
 
CivilCAD 2016 allows for poles offsets computations. The computation is 
based on the designed poles offsets calculations on the drawing and field 
measurements.  
The program performs this calculation by comparing between existing and 
designed status, displaying a detailed report of each point measured in the 
field, its original design, horizontal vertical and general offset.  
Following the report display of this computation, the program will create 
new layers on the original drawing. In these layers will appear arrows and 
distances that mark the horizontal vertical and general offset between 
existing and designed status. According to these steps a few preparations 
must be made on the original drawing in order for the program to perform 
calculations the right way. 
 
Drawing preparations steps: 
 

1. A precision change in measurements by transferring them to a 
meters work mode with precision of three digits after the decimal 
point. The precision system can be changed from AutoCAD menu 
by clicking ‘Format ->Units’. Choose ‘precision’ from the ‘Drawing 
units’ window that opens and select the three digits after the 
decimal point.  

 
2. Changing the measurements to meters is done by writing ‘Scale -> 

All’ in the AutoCAD command ruler, and selecting base and factor 
(if you have transferred from centimeters to meters, write 0.01 when 
the command ‘scale-factor’ appears). 
Note – there may be layers that will not be changed by this 
command (DIM). These layers should be turned off. 
 

3. Change the drawing angle by choosing ‘rotate -> all’ from the 
AutoCAD command ruler, and entering the new angle desired for 
the alignment of the drawing. 

 
 
Inserting the drawing to the project and extraction of data: 
 
Having completed the drawing preparation stage, continue to the next step 
of extracting details: 
 

1. Open a new project in CivilCAD 2016. 
 
2. From the AutoCAD main menu activate: ‘File -> Open’ and choose 

the drawing file which you have prepared. 
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3. After the drawing appears, choose ‘General -> Filtering’ from the 
main menu. From the window that opens the right, two lists will 
appear. The top list will contain all the names of the layers 
appearing in the drawing and the bottom will hold all the names of 
entities that have coordinated which can be extracted. It is possible 
to manually mark the entities and layers from these lists, or click on 
‘select’ to go to the drawing immediately (the curser will turn into a 
small square), and click on the desired form. After the form (or 
entities) has been marked, click ‘enter’ to automatically mark the 
boxes in the desired layers and shapes. To expand on ‘Filtering’ see 
Chapter 23 ‘Handling the DWG Files’.  

 
4. From the ‘topography, design’ options choose ‘Topography’, to 

move the scanned coordinates to the ‘topography-coordinates’ list. 
 
The software scans the designated layers and automatically numbers the 
points' names. In order to choose the points' names by a specific layer in 
the blueprint (a layer that contains text figures that symbolize the point's 

name), open the option window by clicking the  button or select the text 
layer from the window, mark option "Set names by layer" and then, press 
OK 
 
 

5. Click ‘Apply’ to scan the chosen layers, automatically number the 
points names, or coordinate the scanned names in the text layer (if 
this option is selected), in addition to adding the coordinates to the 
‘Topography coordinates’ list (in large and complex drawings this 
command can take a few minutes.  

 

 
 
Entering the measurements into the project 
 
Having extracted the designed data from the drawing to the project, you 
can load the surveyed file. 
 

Click  (load from text file) right of the coordinates list, and choose the 
text file form the box that opens.  
The file will load and appear in the coordinates list (Designed-coordinates). 
 
Offsets calculations 

 
Following the creation of existing and designed status, all that remains is to 
compute the offsets. 
 

1. From the main menu choose ‘General -> poles computations’ and 
choose the maximum offset size ‘maximum distance’. Click ‘Apply’ 
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and the program will automatically compute the offsets between 
existing and designed status, and produce a detailed report in the 
window that opens. From this window it will be possible to either 
print the report or save it as a text file. 

2. It is also possible to insert the report onto the drawing itself by 

clicking - . Click this button to move to the drawing area and 
mark the place where you wish to add the report. Click ‘SET’ from 
the AutoCAD command ruler, and the report will appear on the 
drawing (it is possible to change its size by choosing the desired 
size from the ‘Scale entities’ list).   

  

3. Changing the value in the ‘Scale -> entities’ list according to 
the computation will affect the arrows size that will appear 
next to every point.  

 

Additional options from the ‘Poles computations’ window 

 

After clicking on the ‘Apply’ button, the program will present the 
computerized report and offsets on the drawing. It is possible to control the 
offset preview by selecting or removing any one of the options (marking ‘V’ 
next to each option will instruct the program to present it on the drawing 
after the calculation). 

 Drawn offsets values - horizontal and vertical offset value 
 Drawn offsets arrows – arrows that show the horizontal and vertical 

offset direction 
 Draw total values – the general offset value (estimate of direct 

distance from existing to designed status). 
 Draw total arrows – arrows that point the direction of general offset 
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Chapter 24: Handling 
*.DWG files 
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Handling .DWG files 
  
This chapter discusses the different activities that can be performed with 
CivilCAD 2016 on AutoCAD files – *.DWG files. The options shown are for 
exporting data from the drawing, as single units of data, or by “filtering 
data” from layers. The sections in this chapter are: 
  

 Importing a *.DWG file. 
 Exporting points from a .DWG file.  
 Using a filter to export points and lines from a .DWG file.  
 Setting the names of the filtered points 
 Setting the elevation of  the filtered  points 

 

 

Importing a *.DWG file 
  
Importing a DWG file to CivilCAD 2016 is usually the first phase in building 
a project. You will need to import the file so it will serve as work 
background or in order to extract from it various coordinates data as 
explained later in this chapter.  
  
First, open a new project and name it (use ‘File -> New project’, as 
explained in previous chapters). 
Go to ‘File -> Open’ from the main menu of AutoCAD. 
Choose the desired DWG file in the window that opens. After saving the 
project by 'File -> Save' CivilCAD 2016 will copy the selected file into the 
directory in which the project was opened and change its name to the 
project name with the addition of _. From here on, every time this project is 
opened, the program will automatically open the copied .DWG file as well.  
  
Note: If certain actions were already performed in the program, such as 
elevating measurement point, creating contour lines, etc., this action will 
erase the layers that were already created. 
In this case you will need to perform the reconstruction of project's layers 

by clicking 'Refresh All' button .  
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Extracting points from a .DWG file  
  
CivilCAD 2016 supplies an easy tool for the input of coordinates from a 
.DWG file for the purpose of marking them in the field. In order to input 
points from a .DWG file perform the following: 
  
Open a new project and import a .DWG file to it as explained in the 
previous chapter, 'Importing a .DWG file'. 
In the bottom window (‘Topography coordinates’), choose ‘Pick’ from the 
list (Pick, Locate, Freeze..). In the AutoCAD command ruler (Command:) 
you will see the caption: ‘Pick point/<1000>’. If you wish to new point’s 
name to be something other than 1000, enter its new number and click 
‘Enter’. The command ruler will change accordingly.  
Move to the drawing area and select the point you wish to input using your 
mouse. You can use all of AutoCAD ‘Object Snap’ options (such as 
Endpoint for example), in order to choose an exact point. After the point 
had been selected, it will appear, name and coordinate, in the bottom 
points list. Continue selecting the remaining points. 

Once you finish inputting the points, click  in the right-hand window. 
The points you have selected will be added to the drawing. Continue 
selecting more points until you obtain the desired list. 
  
During the point input process, it is possible to use editor options such as 

erasing an incorrect point with the erase button , changing the names 
of a number of points by marking them as ‘block’, adding a specific 
character etc. (for a detailed description of the editor functions, see the 
Chapter 2: “Coordinates Database”).  
 
Suggested work process:  
  
One of the most convenient work processes is inputting a project, editing 
all the project points first, then graphically selecting the points by locations. 
We will explain how to use the program using this method: 
  
Open a new project and import a DWG file into it. 
Use the actions learned in this chapter to edit the measurement points for 
each project. Move with ‘Pick’ and choose points, edit the points’ name and 

numbering, click  to have them appear on the screen.  

Save the project . After saving, you can close the program and return to 
it at any time in order to “extricate” data from the project. 
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“Extricating” data from a finished project: 
  
Open the project with the points you have prepared. 
From the bottom ‘Topography coordinates’ window choose ‘Locate’ from 
the list  (Pick, Locate, Freeze…). In the AutoCAD command ruler 
(Command:) you will see the caption: 
‘polygonIn/polygonOut/<Single>/(Esc)nd’. Enter “I” (polygonIn) and click 
‘Enter’. The caption in the command line will change to: ‘From 
point/Close/(Esc)nd’. Go over to the drawing area and border the area from 
which you wish to export points. To complete the action, click “C” (‘Close’) 
and ‘Enter’. CivilCAD 2016 will locate the points within the area you 
marked, and mark them in the bottom coordinates list.      
  

 
You have several options:  
  
Creating a file of the points you marked: mark the word ‘Block’ in the 

bottom window with a ‘v’. Click on ‘save points in a text file' . You will 
get the message “Block mode is on, saving only block selection”. 
Confirm this message. From the file window that appears, choose the file 
name you wish to create and save it. In this file, the program will save only 
the points that were marked in the block, i.e. the points that were bordered 
by the polygon.  
 
Dispatching the marked points to the instrument: mark the word ‘Block’ in 

the bottom window with a ‘v’. Click on the ‘Distomat’ button . Confirm 
the message you receive. The communication window will open. Choose 
the desired parameters (instrument marker, communication pace, etc.). 
Prepare the instrument for data receipt and click ‘Send’. The program will 
save the data in the instrument.  
 
Creating a list of angles and distances for the marked points: From the 
main menu go to ‘Geometry -> Distance & Angle’. A window will open on 
the right. In the ‘Station’ field enter the name of the station from which the 
observations will be calculated. From the ‘Zero point’ window, enter the 
name of the relevance point that will serve as a “0” (if there is no such 
point, enter one of the points instead). Now use ‘Locate’ to choose the 
points on which the observations will be calculated. Mark the points in a 
block (“V” next to the word ‘Block’ in the bottom window), and click on the 

button . The program will transfer the list of points marked as a blocked 
to the list of points in the right-hand window. Click ‘Apply’ in the right 
window. The program will calculate and present a report of distance, 
angles, and azimuths for the points marked.   
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Using a filter to extract points and lines from a 
.DWG file 
  
As raw material for the creation of a 3D model, CivilCAD 2016 needs the 
topography settings coordinates file. Often this file is not on hand, and we 
only have access to the background file, as a drawing in DWG format. 
CivilCAD 2016 provides a convenient and effective tool for “extracting” 
height points from a .DWG file:  
  
Open a new project and import the .DWG file into it as explained at the 
beginning of the chapter (see “importing a .DWG file”). 
Go to ‘General -> Filtering’ from the main menu. On the right-hand side, 
the filter window will open with two lists: the drawing layers list, and the list 
of entities for selection. 
Mark the list you want to filter and where you want to save the data by 
choosing Topography/Design. 
Locate the measuring points layer within the drawing, and the type of entity 
characterizing it (Point, Block, etc.). 
  
Note: the measuring points may have several characteristics such as 
‘Point’ and ‘Text’. You should locate the most precise entity (an entity such 
as ‘Text’, for example, is not in the precise location of the point but a small 
distance away from it). 
  
In the list on the right, mark the layer and selected type of entity or click 
Select, mark one of shapes represents the layer and the type of entity and 
press 'ENTER'. By using 'Select' the program will indicate the layer and the 
entity's type automatically. 
Click ‘Apply’. The program will scan the drawing and filter the measuring 
points by the layer and entity that were chosen. When the process is 
completed, a list of measuring points will appear in the window 
‘Topography coordinates’ at the bottom of the toolbar.  

If you want to filter from a certain area click on button  Select inside 
window at the right, move to the drawing and click on two paints that will 
represent the corners of window from which the software will scan the 
points.  

Click . The program will add to the drawing the layers of points that it 
had created.  
  
From here you can continue to work as usual, including creating contour 
lines, etc. 
Notes:  
  
It is possible that there are points with “0” height in the layer that you have 
chosen, which will interrupt the work process. To remove these points, do 
the following: 
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In the bottom window click on the ‘Find’ button . 
In the ‘Find’ window that opens, select ‘Height’, ‘All’ and 'Accurate'.  
Enter “0” in the field line and click ‘OK’. The program will signal and mark 
the points with “0”  height. 

Mark “V” next to the word ‘Block’, and click on the ‘erase’ button  from 
the button cluster. The program will erase all points with “0” height.  

Click  to refresh the drawing and proceed as usual. 
 
 
 

Setting the names of the filtered points 
  
If you have activated the filtering process in order to export points from the 
drawing to the list, and you wish to determine the points names according 
to the text layer containing the names next to each point, or by layer 
containing blocks in which the point names are defined – perform the steps 
detailed below and click ‘Apply’ from ‘General -> Filtering’.  
 

 Click on the Options button .  
 Mark ‘V’ next to the writing ‘Set points names by layer’ 
 From the list that opens under ‘Scan from layer’ choose the layer 

containing the names. 
  Next to ‘Scan names radius’, enter the maximum value of the radius 

scan. The program will scan for each point in the given radius and 
search for text in the chosen layer. If it is found, it will use the text value 
for the point’s name.  

 If you are filtering blocks, and the name is found in the ‘Block’s’ 
Attribute’ - mark the option ‘Attribute’ and choose the from under 
‘Scan from Layer’ the layer in which Attribute is in. 

 Click ‘OK’ to exit the ‘Status’ window and activate filtering by clicking 
‘Apply’. 
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Setting the elevation of the filtered points 
  
In order to export points from a drawing and to the list and determine the 
points’ heights according to the text layer containing the heights next to 
each point, or by layer containing blocks in which the point height’s are 
defined – perform the steps detailed below and click ‘OK’ from ‘General -> 
Filtering’.  

 Click on the ‘Status’ button   
 Mark ‘V’ next to the writing ‘Set points height by layer’ 
 From the list that opens under ‘Scan from layer’ choose the layer 

containing the names. 
 Next to ‘Scan heights radius’, enter the maximum value of the radius 

scan. The program will scan for each point in the given radius and 
search for text in the chosen layer. If it is found, it will use the text value 
for the point’s height.  

 If you are filtering blocks, and the height is found in the ‘Block’s’ 
Attribute’ - mark the option ‘Attribute’ and choose the from under 
‘Scan from Layer’, the layer in which ‘Attribute’ is in. 

 Click ‘OK’ to exit the ‘Status’ window and activate filtering by clicking 
‘Apply'. 

 

Downsizing the number of filtered points 
 

In certain cases, required a filtering of a Measure file comprised of a large 
number of lines and on each line - a large number of points that are close 
to each other, CivilCAD 2016 will filter every point on the line. 
On space consuming blueprints, this action will over burden the computer 
processor as well as the file's size. 
Downsizing the number of points, can be attained by defining a minimal 
distance from point to point. 
 

1. After selecting the desired layers and type of line (as explained in 

previous clauses), click the  button in order to open the 'Options' 
window.  
2. Mark "V" near caption 'Reduce Polyline points'.  
3. Enter the minimal distance between points that the software will 
filter (in meters) near caption 'Minimum distance'. In order to exit the 
'Options ' window, click 'OK' and 'Apply'. 
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Chapter 25: Exporting 
Roads, Planes (Lots) & 

Infrastructure Design to 
3D Models 
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This chapter discusses the possibility to instantly export Roads, 
Infrastructure and Lots design from CivilCAD to 3DGIS in the Cloud. The 
sections in this chapter are: 
  

 3D GIs in the Cloud Application. 
 Export Roads Design to 3D GIS data files and create a 3D model.  
 Export Planes (Lots) Design to 3D GIS data files and create a 3D 

model.  
 Export Infrastructure Design to 3D GIS data files and create a 3D 

model.  
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3D GIS in the Cloud Application 
 

CivilCAD now supports 3D GIS in the Cloud and enables you to instantly 
export Roads, Infrastructure and Lots design from CivilCAD to 3DGIS in 
the Cloud. 

 
 Just by a few steps, you can convert your design into GIS data files, 

that can be rendered and handled as an independent layer within the 
3D model. Such a layer can represent Terrain, Roads, Pipelines, 
Manholes, etc. 

 3DGIS in the Cloud provides decision makers, stakeholders, 
professionals, and public users with 3D views and 3D analysis tools of 
spatial information. The application offers information-based decision 
making tool of urban and rural environments in a Smart 3D City model. 

 3DGIS in the Cloud enables real-world views that improve users’ 
orientation and increase their efficiency in performing their tasks 
related to city planning, infrastructures, roads, and cadaster 
management. The application can be accessed by any standard 
compliant web browser and is also available as an iPad App 

 3DGIS in the Cloud supports existing GIS spatial data from various 
files (e.g. Shapefile, GDB, Multipatch, GeoTiff, ECW, GML, SDF, 
WMF, WFS) and database sources (e.g. ArcSDE, SQL Server, 
Oracle). 

 
 

 
You can read more about 3D GIS in the Cloud here: 

 

http://www.sivandesign.com/products/3dgis 

http://www.sivandesign.com/products/3dgis
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Export Roads Design to 3D GIS data files and 
create a 3D model 

 
CivilCAD enables you to export your road or roads design to 3D GIS 
data files and create a 3D Model in 3DGIS in the Cloud. To use this 
feature: 

 
 From CivilCAD main menu, go to: RoadsHorizontal Alignment 

 Click the Apply button. Layout & Contours window will open. 

 Make sure that Triangles option is check-marked. 

 
 

 Click the OK button for building the roads layout. 

 From CivilCAD main menu, go to: FileExport to 3D Models. Export 
3D Models window will open. 

 
 

 Check-mark the options Roads and Topography. 

 Click the OK button. 

 Define the path for the GIS data file to be saved (you need to create a 
folder). 
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Note 1: 
 
CivilCAD will create the following GIS data files: 
 
  obj.mtl 
  asphalt.tga 
  sidewalk.tga 
  soil.tga 
  xxxx.bat 
  xxxx.csv 
  xxxx.tiff 
  xxxx.vrt 
  xxxx_roads.obj 

 
Note 2: 
 
xxxx represents the name you give to the file in the saving process. 

 

 

You can evaluate 3D GIS in the Cloud for 30 days. Register here: 

http://3dgisonline.com/free-demo/ 

 
 
Creating a 3D Project just by 3 steps: 
 

1. Create a new Project and add it to the Projects List. 

2. Create Connections to the GIS data files. 

3. Create Layers. 

http://3dgisonline.com/free-demo/
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Create a new project 

 
 After you register to 3DGIS in the Cloud, load the application. 

 
 

 Enter the User Name and Password & click the Login button. The 
main window will open. 

 



 

 

Page 452 of 508  
 
 

CivilCAD 2016 Reference manual 

 
 From the main menu, go to: ProjectNew Project. 

 Define a name to the Project. 

 
 

 Click the Add Elevated Basemap (Optional) link. 
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 In the opened window, select the Israel Map option and click the OK 
button. 
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 Click the Add button. 

 
 

 

Create Connections to the GIS data files 

 
 From the main menu, go to: DataNew Connection 

 Select the GeoTiff/ECW option. 
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 Click the Browse button and select the *.Tiff file from the GIS data 

files. 

 
 

 Define the Connection's name as Terrain and click the Test button. 
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 Make sure you receive Pass notification and click the Save button. 

 From the main menu, go to: DataNew Connection again. 

 Define the Connection Type as 3D Models. 
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 Define the Connection Type as Wavefront (.obj). 

 
 

 Click the Browse button and select the *.obj file from the GIS data 
files. 
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 Define the Connection's name as Road-11 and click the Test button. 

 
 

 Make sure you receive Pass notification and click the Save button. 
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Create Layers 

 
 From the main menu, go to: DataNew Layer. 

 In Connection definition, select the Terrain option. 

 In Layer definition, select the Road-11.Tiff option. 

 Define the Layer's name as Terrain. 

 Click the Next button. 
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 In the opened window, select the Use elevation map only option. 

 Click the Add Layer button. 

 
 

 In the opened window, click the Yes button. 

 
 

 A massage window will appear: Build Layer has succeeded. Click the 
OK button. 
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 From the main menu, go to: DataNew Layer again. 

 In Connection definition, select the Road-11 option. 

 The Connection Type will automatically be updated to 3D Models. 

 Define the Layer's name as Road-11. 

 Click the Next button. 
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 In the opened window, mark the Road-11_roads.obj and click the Add 

Layer button. 

 
 

 In the opened window, click the No button. 

 
 

 In the opened window, click the Yes button. 
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 Notice that 3 layers were created in this project. 

 
 

 Right click on Road-11 and select the Locate option. 
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 Select Road-11_roads and click the OK button. 
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Export Planes (Lots) Design to 3D GIS data files 
and create a 3D model 
 
CivilCAD enables you to export your Planes (Lots) design to 3D GIS data 
files and create a 3D Model in 3DGIS in the Cloud. To use this feature: 

 
 From CivilCAD main menu, go to: DesignedPlanes 

 Click the Apply button. 

 From CivilCAD main menu, go to: FileExport to 3D Models. Export 
3D Models window will open. 

 
 

 Check-mark the options Planes and Topography. 

 Click the OK button. 

 Define the path for the GIS data file to be saved (you need to create a 
folder). 
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Note 1: 
 
CivilCAD will create the following GIS data files: 
 
  obj.mtl 
  asphalt.tga 
  sidewalk.tga 
  soil.tga 
  xxxx.bat 
  xxxx.csv 
  xxxx.tiff 
  xxxx.vrt 
  xxxx_planes.obj 
  xxxx_borders.dbf 
  xxxx_borders.shp 
  xxxx_borders.shx 

 
 

Note 2: 
 
xxxx represents the name you give to the file in the saving process. 

 

 

You can evaluate 3D GIS in the Cloud for 30 days. Register here: 

http://3dgisonline.com/free-demo/ 

 
 

Creating a 3D Project just by 3 steps: 
 

1. Create a new Project and add it to the Projects List. 

2. Create Connections to the GIS data files. 

3. Create Layers. 

http://3dgisonline.com/free-demo/
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Create a new project 

 
 After you register to 3DGIS in the Cloud, load the application. 

 
 

 Enter the User Name and Password & click the Login button. The 
main window will open. 
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 From the main menu, go to: ProjectNew Project. 

 Define a name to the Project. 

 
 

 Click the Add Elevated Basemap (Optional) link. 
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 In the opened window, select the Israel Map option and click the 

OK button. 
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 Click the Add button. 
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Create Connections to the GIS data files 

 
 From the main menu, go to: DataNew Connection 

 Select the GeoTiff/ECW option. 
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 Click the Browse button and select the *.Tiff file from the GIS data 
files. 

 
 

 Define the Connection's name as Terrain and click the Test 
button. 
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 Make sure you receive Pass notification and click the Save 
button. 

 From the main menu, go to: DataNew Connection again. 

 Define the Connection Type as 3D Models. 

 
 



 

 

Page 476 of 508  
 
 

CivilCAD 2016 Reference manual 

 

 Define the Type as Wavefront (.obj). 

 
 

 Click the Browse button and select the *.obj file from the GIS data 
files. 

 
 



 

 

Page 477 of 508  
 
 

CivilCAD 2016 Reference manual 

 
 Define the Connection's name as Designed-Planes and click the 

Test button. 

 
 

 Make sure you receive Pass notification and click the Save 
button. 
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 From the main menu, go to: DataNew Connection again. 

 Define the Connection Type as Shapefile. 

 
 

 Click the Browse button and select the *.shp file from the GIS 
data files. 
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 Define the Connection's name as Designed-Planes-Contours and 

click the Test button. 
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 Make sure you receive Pass notification and click the Save 

button. 
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Create Layers 

 
 From the main menu, go to: DataNew Layer. 

 In Connection definition, select the Terrain option. 

 In Layer definition, select the Designed-Planes.Tiff option. 

 Define the Layer's name as Terrain. 

 Click the Next button 
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 In the opened window, select the Use elevation map only option. 

 Click the Add Layer button. 

 
 

 In the opened window, click the Yes button. 

 
 

 A massage window will appear: Build Layer has succeeded. Click 
the OK button. 
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 From the main menu, go to: DataNew Layer again. 

 In Connection definition, select the Designed-Planes option. 

 The Connection Type will automatically be updated to 3D Models. 

 Define the Layer's name as Designed-Planes. 

 Click the Next button. 
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 In the opened window, mark the Planes-Design_planes.obj and 
click the Add Layer button. 

 
 

 In the opened window, click the No button. 

 
 

 In the opened window, click the Yes button. 
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 A massage window will appear: Build Layer has succeeded. Click 
the OK button. 

 
 

 From the main menu, go to: DataNew Layer again. 

 In Connection definition, select the Planes-Design-Contours 
option. 

 In Layer definition, select the Planes-Design_planes_borders 
option. 

 Define the Layer's name as Design-Planes-Borders. 

 Click the Next button 
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 In the opened window, leave the default definitions as is ]From 

feature geometry (Z value)] and click the Add layer button. 

 
 

 In the opened window, click the Yes button. 

 



 

 

Page 487 of 508  
 
 

CivilCAD 2016 Reference manual 

 
 Notice that 4 layers were created in this project. 

 
 

 Right click on Designed-Planes and select the Locate option. 
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 Select Planes-Design_planes and click the OK button. 
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Export Infrastructure Design to 3D GIS data files 
and create a 3D model 
 
CivilCAD enables you to export your Infrastructure 
(Drainage/Sewage/Water) design to 3D GIS data files and create a 3D 
Model in 3DGIS in the Cloud. To use this feature: 

 
 From CivilCAD main menu, go to: PipelinesLayout 

 Click the Apply button. 

 From CivilCAD main menu, go to: FileExport to 3D Models. 
Export 3D Models window will open. 

 
 

 Check-mark the options Pipes and Topography. 

 Click the OK button. 

 Define the path for the GIS data file to be saved (you need to 
create a folder). 
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Note 1: 
 
CivilCAD will create the following GIS data files: 
 
 
  obj.mtl 
  asphalt.tga 
  sidewalk.tga 
  soil.tga 
  xxxx.bat 
  xxxx.csv 
  xxxx.tiff 
  xxxx.vrt 
  xxxx_manholes.dbf 
  xxxx_manholes.shp 
  xxxx_manholes.shx 
  xxxx_pipes.dbf 
  xxxx_pipes.shp 
  xxxx_pipes.shx 

 
 

Note 2: 
 
xxxx represents the name you give to the file in the saving process. 

 

 

You can evaluate 3D GIS in the Cloud for 30 days. Register here: 

http://3dgisonline.com/free-demo/ 

 
 

Creating a 3D Project just by 3 steps: 
 

1. Create a new Project and add it to the Projects List. 

2. Create Connections to the GIS data files. 

3. Create Layers. 

 

http://3dgisonline.com/free-demo/
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Create a new project 

 
 After you register to 3DGIS in the Cloud, load the application. 

 
 

 Enter the User Name and Password & click the Login button. The 
main window will open. 
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 From the main menu, go to: ProjectNew Project. 

 Define a name to the Project. 

 
 

 Click the Add Elevated Basemap (Optional) link. 
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 In the opened window, select the Israel Map option and click the OK 

button. 
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 Click the Add button. 
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Create Connections to the GIS data files 

 
 From the main menu, go to: DataNew Connection 

 Select the GeoTiff/ECW option. 
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 Click the Browse button and select the *.Tiff file from the GIS data 

files. 

 
 

 Define the Connection's name as Pipelines-Terrain and click the 
Test button. 

 
 

 Make sure you receive Pass notification and click the Save button. 
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 From the main menu, go to: DataNew Connection again. 

 Define the Connection Type as Shapefile. 
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 Click the Browse button and select the *.shp file from the GIS data 

files. 

 
 

 Define the Connection's name as Pipelines and click the Test 
button. 

 
 



 

 

Page 499 of 508  
 
 

CivilCAD 2016 Reference manual 

 

 Make sure you receive Pass notification and click the Save button. 

 
 

 From the main menu, go to: DataNew Connection again. 

 Define the Connection Type as Shapefile. 
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 Click the Browse button and select the *.shp file from the GIS data 
files. 

 
 

 Define the Connection's name as Manholes and click the Test 
button. 
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 Make sure you receive Pass notification and click the Save button. 
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Create Layers 

 
 From the main menu, go to: DataNew Layer. 

 In Connection definition, select the Terrain option. 

 In Layer definition, select the Pipelines-Design.Tiff option. 

 Define the Layer's name as Pipelines-Terrain. 

 Click the Next button 
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 In the opened window, select the Use elevation map only option. 

 Click the Add Layer button. 

 
 

 In the opened window, click the Yes button. 

 
 

 A massage window will appear: Build Layer has succeeded. Click 
the OK button. 
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 From the main menu, go to: DataNew Layer again. 

 In Connection definition, select the Pipelines option. 

 In Layer definition, select the Pipelines-Design_pipes option. 

 Define the Layer's name as Pipelines. 

 Click the Next button 
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 In the opened window, click the Add layer button. 

 
 

 In the opened window, click the Yes button. 

 
 

 A massage window will appear: Build Layer has succeeded. Click 
the OK button. 
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 From the main menu, go to: DataNew Layer again. 

 In Connection definition, select the Manholes option. 

 In Layer definition, select the Pipelines-Design_manholes option. 

 Define the Layer's name as Manholes. 

 Click the Next button 
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 In the opened window, make sure that in Base Height definition - 

From feature geometry (Z value) is check-marked. 

 In Extrusion Upward definition, mark the Field option and change 
from SIZEA to MANHOLEH. 

 Click the Add layer button. 
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 In the opened window, click the Yes button. 

 
 

 A massage window will appear: Build Layer has succeeded. Click 
the OK button. 
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